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Manual Purpose and Structure

Windows Users

The documentation explains and describes how to use the TASKING TSK3000 toolset to program a TSK3000 processor.

You can use the tools either with the graphical Altium Designer or from the command line in a command prompt window.

Structure

The toolset documentation consists of a user’s manual (Using the TSK3000 Embedded Tools), which includes a Getting Started
section, and a separate reference manual (this manual).

Start by reading the Getting Started in Chapter 1 of the user’s manual.

The other chapters in the user’s manual explain how to use the compiler, assembler, linker and the various utilities.

Once you are familiar with these tools, you can use this reference manual to lookup specific options and details to make full use
of the TASKING toolset.

The reference manual describes the C language implementation and the  assembly language.
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Short Table of Contents

Chapter 1: C Language

The TASKING  C compilers are fully compatible with ISO−C. This chapter describes the specific target features of the C
language, including language extensions that are not standard in ISO−C. For example, pragmas are a way to control the
compiler from within the C source. The following language extensions are described:

• Data types

• Keywords

• Function qualifiers

• Intrinsic functions

• Pragmas

• Predefined macros

Chapter 2: Libraries

Contains overviews of all library functions you can use in your C source. First libraries are listed per header file that contains the
prototypes.These tables also show the level of implementation per function. Second, all library functions are listed and
discussed into detail.

Chapter 3: Assembly Language

Describes the specific features of the assembly language as well as ’directives’, which are pseudo instructions that are
interpreted by the assembler.

Chapter 4: Tool Options

Contains a description of all tool options:

• C compiler options

• Assembler options

• Linker options

• Control program options

• Make utility options

• Librarian options

Chapter 5: List File Formats

Contains a description of the following list file formats:

• Assembler List File Format

• Linker Map File Format

Chapter 6: Object File Formats

Contains a description of the following object file formats:

• ELF/DWARF 2 Object Format

• Motorola S−Record Format

• Intel Hex Record Format

Chapter 7: Linker Script Language

Contains a description of the linker script language (LSL).

Chapter 8: MISRA−C Rules

Contains a description the supported and unsupported MISRA−C code checking rules.
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Conventions Used in this Manual

Notation for syntax

The following notation is used to describe the syntax of command line input:

bold Type this part of the syntax literally.

italics Substitute the italic word by an instance. For example:

filename

Type the name of a file in place of the word filename.

{ } Encloses a list from which you must choose an item.

[ ] Encloses items that are optional. For example

c3000 [ −? ]

Both c3000 and c3000 −? are valid commands.

| Separates items in a list. Read it as OR.

... You can repeat the preceding item zero or more times.

Example

c3000 [option]... filename

You can read this line as follows: enter the command c3000 with or without an option, follow this by zero or more options and
specify a filename. The following input lines are all valid:

c3000 test.c
c3000 −g test.c
c3000 −g −s test.c

Not valid is:

c3000 −g

According to the syntax description, you have to specify a filename.

Icons

The following illustrations are used in this manual:

Note: notes give you extra information.

Warning: read the information carefully. It prevents you from making serious mistakes or from loosing information.

This illustration indicates actions you can perform with the mouse. Such as Altium Designer menu entries and dialogs.

Command line: type your input on the command line.

Reference: follow this reference to find related topics.
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• ISO/IEC 9899:1999(E), Programming languages − C [ISO/IEC]
More information on the standards can be found at http://www.ansi.org
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MISRA−C

• Guidelines for the Use of the C Language in Vehicle Based Software [MIRA limited, 1998]
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• MISRA−C:2004: Guidelines for the use of the C Language in critical systems [MIRA limited, 2004]
See also http://www.misra−c.com

TASKING Tools

• Using the TSK3000 Embedded Tools
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• TSK3000A 32−bit RISC Processor Core Reference
[Altium, CR0121]
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1 C Language

Summary This chapter describes the target specific features of the C language, including
language extensions that are not standard in ISO−C. For example, pragmas are a
way to control the compiler from within the C source.

1.1 Introduction

The TASKING C compiler fully supports the ISO C standard but adds possibilities to program the special functions of the
TSK3000.

In addition to the standard C language, the compiler supports the following:

• intrinsic (built−in) functions that result in target specific assembly instructions

• pragmas to control the compiler from within the C source

• predefined macros

• the possibility to use assembly instructions in the C source

• keywords to specify memory types for data and functions

• attribute to specify absolute addresses

• keywords for inlining functions and programming interrupt routines

• libraries

All non−standard keywords have two leading underscores (__).

In this chapter the target specific characteristics of the C language are described, including the above mentioned extensions.
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1.2 Data Types

The TASKING C compiler for the TSK3000 architecture (c3000) supports the following data types:

Type C Type Size
(bit)

Align
(bit) Limits

Boolean _Bool 8 8 0 or 1

Character char

signed char
8 8 −27 .. 27−1

unsigned char 8 8 0 .. 28−1

Integral short

signed short
16 16 −215 .. 215−1

unsigned short 16 16 0 .. 216−1

enum 32 32 −231 .. 231−1

int

signed int

long

signed long

32 32 −231 .. 231−1

unsigned int

unsigned long
32 32 0 .. 232−1

long long

signed long long
64 32 −263 .. 263−1

unsigned long long 64 32 0 .. 264−1

Pointer pointer to function or data 32 32 0 .. 232−1

Floating−Point
float (23−bit mantissa) 32 32 −3.402E+38 .. −1.175E−38

1.175E−38 .. 3.402E+38

double

long double (52−bit mantissa)
64 32 −1.798E+308 .. −2.225E−308

2.225E−308 .. 1.798E+308

Table 1−1: Data Types for the TSK3000

1.2.1 Changing the Alignment: __unaligned, __packed__ and __align()

Normally data, pointers and structure members are aligned according to the table in the previous section.

Suppress alignment

With the type qualifier __unaligned you can specify to suppress the alignment of objects or structure members. This can be
useful to create compact data structures. In this case the alignment will be one bit for bit−fields or one byte for other objects or
structure members.

At the left side of a pointer declaration you can use the type qualifier __unaligned to mark the pointer value as potentially
unaligned. This can be useful to access externally defined data. However the compiler can generate less efficient instructions to
dereference such a pointer, to avoid unaligned memory access.

Example:

struct
{
    char c;
    __unaligned  int i;   /* aligned at offset 1 ! */
} s;

__unaligned int * up = & s.i;
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Packed structures

To prevent alignment gaps in structures, you can use the attribute __packed__. When you use the attribute __packed__
directly after the keyword struct, all structure members are marked __unaligned. For example the following two
declarations are the same:

struct __packed__
{
    char c;
    int i;
} s1;

struct
{
    __unaligned char c;
    __unaligned int i;
} s2;

The attribute __packed__ has the same effect as adding the type qualifier __unaligned to the declaration to suppress the
standard alignment.

You can also use __packed__ in a pointer declaration. In that case it affects the alignment of the pointer itself, not the value of
the pointer. The following two declarations are the same:

int * __unaligned p;
int * p __packed__;

Change alignment

With the attribute __align(n) you can overrule the default alignment of objects or structure members to n bytes.

1.3 Memory Qualifiers

You can use static memory qualifiers to allocate static objects in a particular part of the addressing space of the processor or to
use a specific addressing mode.

In addition, you can place variables at absolute addresses with the keyword __at().

You can specify the following memory types:

Qualifier Description

__no_sdata Direct addressable RAM

__sdata Direct short addressable RAM
(Small data, +/− 32kB offset from global pointer register $gp)

Table 1−2: Memory Type Qualifiers for the TSK3000

By default, all global and static data objects smaller than 4 bytes are placed in small data sections. With the __no_sdata and
__sdata keywords, you overrule this default.

See C compiler option −−sdata=size in section 4.1, C Compiler Options in Chapter Tool Options to change the size
beneath which data objects are placed in small memory.

Examples using explicit memory types:

long long l = 1234;                                  long long reserved in data (by default)

__sdata  long long  k = 1234;      long long reserved in sdata

The memory type qualifiers are treated like any other data type specifier (such as unsigned). This means the examples above
can also be declared as:

long long __sdata k = 1234;
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1.3.1 Placing an Object at an Absolute Address: __at()

Just like you can declare a variable in a specific part of memory (using memory type qualifiers), you can also place an object at
an absolute address in memory.

With the attribute __at() you can specify an absolute address.

Examples

unsigned char Display[80*24] __at( 0x2000 );

The array Display is placed at address 0x2000. In the generated assembly, an absolute section is created. On this position
space is reserved for the variable Display.

int i __at(0x1000) = 1;

The variable i is placed at address 0x1000 and is initialized at 1.

void f(void) __at( 0xf0ff + 1 ) { }

The function f is placed at address 0xf100.

Restrictions

Take note of the following restrictions if you place a variable at an absolute address:

• The argument of the __at() attribute must be a constant address expression.

• You can place only global variables at absolute addresses. Parameters of functions, or automatic variables within functions
cannot be placed at absolute addresses.

• A variable that is declared extern, is not allocated by the compiler in the current module. Hence it is not possible to use the
keyword __at() on an external variable. Use __at() at the definition of the variable.

• You cannot place structure members at an absolute address.

• Absolute variables cannot overlap each other. If you declare two absolute variables at the same address, the assembler and
/ or linker issues an error. The compiler does not check this.

• If you use 0 as an address, this value is ignored. A zero value indicates a relocatable section.

1.4 Using Assembly in the C Source: __asm()

With the __asm keyword you can use assembly instructions in the C source. Be aware that C modules that contain assembly
are not portable and harder to compile in other environments.

Furthermore, assembly blocks are not interpreted by the compiler: they are regarded as a black box. So, it is your responsibility
to make sure that the assembly block is syntactically correct.

General syntax of the __asm keyword

__asm( "instruction_template"
       [ : output_param_list 
       [ : input_param_list 
       [ : register_save_list]]] );

instruction_template Assembly instructions that may contain parameters from the input list or
output list in the form: %parm_nr

%parm_nr[.regnum] Parameter number in the range 0 .. 9. With the optional .regnum you can
access an individual register from a register pair. 

output_param_list [[ "=[&]constraint_char"(C_expression)],...]

input_param_list [[ "constraint_char"(C_expression)],...]

& Says that an output operand is written to before the inputs are read, so
this output must not be the same register as any input.

constraint _char Constraint character: the type of register to be used for the
C_expression.
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C_expression Any C expression. For output parameters it must be an lvalue, that is,
something that is legal to have on the left side of an assignment.

register_save_list [["register_name"],...]

register_name:q Name of the register you want to reserve.

Typical example: adding two C variables using assembly

char a, b;
int result;

void main(void)
{
    a = 3;
    b = 4;
    __asm( "ADD %0,%1,%2" : "=r"(result): "r"(a), "r"(b) );
}

%0 corresponds with the first C variable, %1 with the second and so on.

Generated assembly code:

main: .type func
    li   $v0,0x3
    sb   $v0,@gprel(a)($gp)
    li   $v1,0x4
    sb   $v1,@gprel(b)($gp)
    ADD  $v0,$v0,$v1
    jr   $ra
    sw   $v0,@gprel(result)($gp)

Specifying registers for C variables

With a constraint character you specify the register type for a parameter. In the example above, the r is used to force the use of
registers (Vn) for the parameters a and b.

You can reserve the registers that are already used in the assembly instructions, either in the parameter lists or in the reserved
register list (register_save_list, also called "clobber list"). The compiler takes account of these lists, so no unnecessary register
saving and restoring instructions are placed around the inline assembly instructions.

Constraint
character

Type Operand Remark

R general purpose
register (64 bits)

$v0,$v1, $a0 .. $a3, 
$kt0, $kt1, $t0..$t9, 
$s0 .. $s8

Based on the specified register, a register pair is formed
(64−bit). For example $v0:$v1.

r general purpose
register (32 bits)

$v0,$v1, $a0 .. $a3, 
$kt0, $kt1, $t0..$t9, 
$s0 .. $s8

i immediate value #value

l label label

m memory label variable stack or memory operand, a fixed address

H multiply and
devide register
higher result

$hi
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RemarkOperandTypeConstraint
character

L multiply and
devide register
lower result

$lo

number other operand same as %number Input constraint only. The number must refer to an output
parameter. Indicates that %number and number are the same
register.

Table 1−3: Available input/output operand constraints for the TSK3000

Loops and conditional jumps

The compiler does not detect loops that are coded with multiple __asm statements or (conditional) jumps across __asm
statements and will generate incorrect code for the registers involved.

If you want to create a loop with __asm, the whole loop must be contained in a single __asm statement. The same counts for
(conditional) jumps. As a rule of thumb, all references to a label in an __asm statement must be contained in the same
statement.

Example 1: no input or output

A simple example without input or output parameters. You can use any instruction or label. Note that you can use standard C
escape sequences.

__asm( "nop\n\t"
       "nop" );

Generated code:

    nop
    nop

Example 2: using output parameters

Assign the result of inline assembly to a variable. A register is chosen for the parameter because of the constraint r; the
compiler decides which register is best to use. The %0 in the instruction template is replaced with the name of this register.
Finally, the compiler generates code to assign the result to the output variable.

char out;

void main(void)
{
    __asm( "li %0,0xff" : "=r"(out));
}

Generated assembly code:

li  $v0,0xff
jr  $ra
sb  $v0,@gprel(out)($gp)
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Example 3: using input and output parameters

Add two C variables and assign the result to a third C variable. Registers are used for the input parameters (constraint r, %1 for
a and %2 for b in the instruction template) and for the output parameter (constraint r, %0 for result in the instruction template).
The compiler generates code to move the input expressions into the input registers and to assign the result to the output
variable.

char a, b;
int result;

void main(void)
{
    a = 3;
    b = 4;
    __asm( "ADD %0,%1,%2" : "=r"(result): "r"(a), "r"(b) );
}

Generated assembly code:

main: .type func
    li   $v0,0x3
    sb   $v0,@gprel(a)($gp)
    li   $v1,0x4
    sb   $v1,@gprel(b)($gp)
    ADD  $v0,$v0,$v1
    jr   $ra
    sw   $v0,@gprel(result)($gp)

Example 4: reserve registers

Sometimes an instruction knocks out certain specific registers. The most common example of this is a function call, where the
called function is allowed to do whatever it likes with some registers. If this is the case, you can list specific registers that get
clobbered by an operation after the inputs.

Same as Example 3, but now register $V0 is a reserved register. You can do this by adding a reserved register list (: "$V0").
As you can see in the generated assembly code, register $V0 is not used (the first register used is $V1).

char a, b;
int result;

void main(void)
{
    a = 3;
    b = 4;
    __asm( "ADD %0,%1,%2" : "=r"(result): "r"(a), "r"(b) : "$V0" );
}

Generated assembly code:

main: .type func
    li   $v1,0x3
    sb   $v1,@gprel(a)($gp)
    li   $a0,0x4
    sb   $a0,@gprel(b)($gp)
    ADD  $v1,$v1,$a0
    jr   $ra
    sw   $v1,@gprel(result)($gp)
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1.5 Pragmas to Control the Compiler

Pragmas are keywords in the C source that control the behavior of the compiler. Pragmas overrule compiler options.

For example, you can set a compiler option to specify which optimizations the compiler should perform. With the #pragma
optimize flags you can set an optimization level for a specific part of the C source. This overrules the general optimization
level that is set in the C compiler Optimization page in the Project Options dialog (command line option −−optimize (−O)).

The general syntax for pragmas is:

#pragma pragma−spec [ON | OFF | DEFAULT | RESTORE]

or:

_Pragma( "pragma−spec [ON | OFF | DEFAULT | RESTORE]" )

Pragmas marked with (*) accept the following special arguments:

default set the pragma to the initial value

restore restore the previous value of the pragma

Pragmas marked with (+) are boolean flags, and accept the following arguments:

on switch the flag on (same as without argument)

off switch the flag off

The compiler recognizes the following pragmas, other pragmas are ignored.

alias symbol=defined_symbol

Define symbol as an alias for definined_symbol. It corresponds to an equate directive (.equ) at assembly level. The symbol
should not be defined elsewhere, and defined_symbol should be defined with static storage duration (not extern or
automatic).

See assembler directive .EQU in section 3.8.2, Assembler Directives, in Chapter Assembly Language.

call {near|far}  (*)

By default, functions are called with 28−bit PC−region calls. This near call is directly coded into the instruction, resulting in
higher execution speed and smaller code size.

The other call mode is a 32−bit indirect call. With far calls you can address the full range of memory. The address is first
loaded into a register after which the call is executed.

Near calls are only possible if the destination address of the call is located within the same 256 MB region as the address
of the call itself (hardware restriction). If you need to call a function (just) outside the 256 MB region from where it is
called, you must use a far call.

See C compiler option −−call (−m) in section 4.1, C Compiler Options, in Chapter Tool Options.

extern symbol

Force an external reference (.extern assembler directive), even when the symbol is not used in the module.

See assember directive .EXTERN in section 3.8.2, Assembler Directives, in Chapter Assembly Language.

extern_sdata  (*)  (+)
endextern_sdata

With this pragma you tell the compiler to use small data addressing for external data as well as for symbols defined in the
current module. endextern_sdata restores the default setting for the −−extern−sdata option.

See C compiler option −−extern−sdata in section 4.1, C Compiler Options, in Chapter Tool Options.
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inline
noinline
smartinline

Instead of the qualifier inline, you can also use pragma inline and pragma noinline to inline a function body:

int  w,x,y,z;

#pragma inline
int add( int a, int b )
{
     int i=4;
     return( a + b );
}
#pragma noinline

void main( void )
{
     w = add( 1, 2 );
     z = add( x, y );
}

If a function has an inline or __noinline function qualifier, then this qualifier will overrule the current pragma setting.

See section 1.7.3, Inlining Functions: inline / __noinline.

By default, small fuctions that are not too often called (from different locations), are inlined. This reduces execution speed at
the cost of code size (C compiler option −Oi). With the pragma noinline / pragma smartinline you can temporarily
disable this optimization.

With the C compiler options −−inline−max−incr and −−inline−max−size you have more control over the automatic function
inlining process of the compiler.

See for more information the C compiler options −−inline−max−incr and −−inline−max−size in section 4.1, C Compiler
Options in Chapter Tool Options.

macro
nomacro  (*)  (+)

Turns macro expansion on or off. By default, macro expansion is enabled.

message "message" ...

Print the message string(s) on standard output.

optimize flags  (*)
endoptimize

You can overrule the compiler option −O for the code between the pragmas optimize and endoptimize. The pragma
works the same as compiler option −O.

See section 2.6, Compiler Optimizations in Chapter Using the Compiler in the user’s manual.
See C compiler option −−optimize (−O) in section 4.1, C Compiler Options, in Chapter Tool Options.

profile [flag,...]  (*)
endprofile

Control the profile settings. The pragma works the same as compiler option −−profile (−p). Note that this pragma will only be
checked at the start of a function. endprofile switches back to the previous profiling settings.

See C compiler option −−profile (−p) in section 4.1, C Compiler Options, in Chapter Tool Options.
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profiling  (*)  (+)

If profiling is enabled on the command line, C compiler option −−profile (−p), you can disable part of your source code for
profiling with the pragmas profiling off and profiling.

protect  (*)  (+)
endprotect

With these pragmas you can protect sections against linker optimizations. This excludes a section from unreferenced section
removal and duplicate section removal by the linker. endprotext restores the default section protection.

runtime [flag,...]  (*)

Check for run−time errors. The pragma works the same as compiler option −−runtime (−r).

See C compiler option −−runtime (−r) in section 4.1, C Compiler Options, in Chapter Tool Options.

sdata size  (*)

With this pragma you tell the compiler to place all data objects smaller than the specified size (bytes) in sdata or sbss
sections. You can still overrule this option with the keywords __no_sdata and __sdata for individiual data objects in your
source.

See C compiler option −−sdata in section 4.1, C Compiler Options, in Chapter Tool Options.

section [name=]{suffix |−f|−m|−fm}  (*)
endsection

Rename sections by adding a suffix to all section names specified with name, or restore default section naming. If you
specify only a suffix (without a name), the suffix is added to all section names.

See C compiler option  −−rename−sections in section 4.1, C Compiler Options in Chapter Tool Options.
See assembler directive .SECTION (Start or continue section), in section 3.8.2, Assembler Directives, in Chapter
Assembly Language.

section_code_init  (*)  (+)
section_no_code_init

Copy or do not copy code sections from ROM to RAM at application startup.

section_const_init  (*)  (+)
section_no_const_init

Copy or do not copy read−only data sections from ROM to RAM at application startup.

source  (*)  (+)
nosource

With these pragmas you can choose which C source lines must be listed as comments in assembly output.

See also C compiler option −−source (−s)

stdinc  (*)  (+)

This pragma changes the behavior of the #include directive. When set, the C compiler options −−include−directory and
−−no−stdinc are ignored.

tradeoff level  (*)

Specify tradeoff between speed (0) and size (4).

See also C compiler option −−tradeoff (−t)
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warning [number,...]  (*)

With this pragma you can disable warning messages. If you do not specify a warning number, all warnings will be suppressed.

See also C compiler option −−no−warnings (−w)

weak symbol

Mark a symbol as "weak" (.weak assembler directive). The symbol must have external linkage, which means a global or
external object or function. A static symbol cannot be declared weak.

A weak external reference is resolved by the linker when a global (or weak) definition is found in one of the object files.
However, a weak reference will not cause the extraction of a module from a library to resolve the reference. When a weak
external reference cannot be resolved, the null pointer is substituted.

A weak definition can be overruled by a normal global definition. The linker will not complain about the duplicate definition,
and ignore the weak definition.

See assembler directive .WEAK in Section 3.8.2, Assembler Directives, in Chapter Assembly Language.

1.6 Predefined Preprocessor Macros

In addition to the predefined macros required by the ISO C standard, such as __DATE__ and __FILE__, the TASKING C
compiler supports the predefined macros as defined in the table below. The macros are useful to create conditional C code.

Macro Description

__BIG_ENDIAN__ Expands to 1, indicating the processor accesses data in big−endian.

__BUILD__ Identifies the build number of the compiler, composed of decimal digits for the build number, three
digits for the major branch number and three digits for the minor branch number. For example, if
you use build 1.22.1 of the compiler, __BUILD__ expands to 1022001. If there is no branch
number, the branch digits expand to zero. For example, build 127 results in 127000000.

__C3000__ Expands to 1 for the TSK3000 toolset, otherwise unrecognized as macro.

__DOUBLE_FP__ Expands to 1 if you did not use option −−no−double (Treat ’double’ as ’float’), otherwise
unrecognized as macro.

__REVISION__ Identifies the revision number of the compiler. For example, if you use version 1.0r2 of the
compiler, __REVISION__ expands to 2.

__SINGLE_FP__ Expands to 1 if you used option −−no−double (Treat ’double’ as ’float’), otherwise unrecognized
as macro.

__TASKING__ Identifies the compiler as a TASKING compiler. Expands to 1 if a TASKING compiler is used.

__TSK3000__ Expands to 1 for the TSK3000 toolset, otherwise unrecognized as macro.

__VERSION__ Identifies the version number of the compiler. For example, if you use version 1.0r2 of the
compiler, __VERSION__ expands to 1000 (dot and revision number are omitted, minor version
number in 3 digits).

Table 1−4: Predefined preprocessor macros

Example

#ifdef __C3000__
/* this part is only compiled for the TSK3000 */
...

#endif
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1.7 Functions

1.7.1 Parameter Passing

A lot of execution time of an application is spent transferring parameters between functions. The fastest parameter transport is
via registers. Therefore, function parameters are first passed via registers. If no more registers are available for a parameter, the
compiler pushes parameters on the stack. See the table below.

Parameter Type Parameter Number

1 2 3 4

_Bool a0 a1 a2 a3

char a0 a1 a2 a3

short a0 a1 a2 a3

int / long a0 a1 a2 a3

float a0 a1 a2 a3

32−bit pointer a0 a1 a2 a3

32−bit struct a0 a1 a2 a3

long long a0, a1 a1, a2 a2, a3

double a0, a1 a1, a2 a2, a3

64−bit struct a0, a1 a1, a2 a2, a3

Table 1−5: Register usage for parameter passing

If a register corresponding to a parameter number is already in use the next register is used.

Example with three arguments

func1( int a, int b, int *c )

• a (first parameter) is passed in register a0.

• b (second parameter) is passed in register a1.

• c (third parameter) is passed in register a2.

Example with one long long/double arguments and one other argument

func2( long long d, char e )

• d (first parameter) is passed in registers a0 and a1.

• e (second parameter) is passed in register a2.

Example with two long long/double arguments and one other argument

func3( double f, long long g, char h )

• f (first parameter) is passed in registers a0 and a1.

• g (second parameter) is passed in registers a2 and a3.

• h (third parameter) cannot be passed through registers anymore, and is passed via the stack.

1.7.2 Function Return Types

The C compiler uses registers to store C function return values, depending on the function return types.

Return Type Register

_Bool v0

char v0

short v0

int / long v0
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RegisterReturn Type

float v0

32−bit pointer v0

32−bit struct v0

long long v0, v1

double v0, v1

64−bit struct v0, v1

Table 1−6: Register usage for function return types

Objects larger than 64 bits are returned via the stack.

1.7.3 Inlining Functions: inline / __noinline

With the C compiler option −−optimize=+inline, the C compiler automatically inlines small functions in order to reduce
execution time (smart inlining). The compiler inserts the function body at the place the function is called. The C compiler decides
which functions will be inlined. You can overrule this behavior with the two keywords inline (ISO−C) and __noinline.

With the inline keyword you force the compiler to inline the specified function, regardless of the optimization strategy of the
compiler itself:

inline unsigned int abs(int val)
{
    unsigned int abs_val = val;
    if (val < 0) abs_val = −val;
    return abs_val;
}

If a function with the keyword  inline is not called at all, the compiler does not generate code for it.

You must define inline functions in the same source module as in which you call the function, because the compiler only inlines a
function in the module that contains the function definition. When you need to call the inline function from several source
modules, you must include the definition of the inline function in each module (for example using a header file).

With the __noinline keyword, you prevent a function from being inlined:

__noinline unsigned int abs(int val)
{
    unsigned int abs_val = val;
    if (val < 0) abs_val = −val;
    return abs_val;
}

Using pragmas: inline, noinline, smartinline

Instead of the inline qualifier, you can also use #pragma inline and #pragma noinline to inline a function body:

#pragma inline
unsigned int abs(int val)
{
    unsigned int abs_val = val;
    if (val < 0) abs_val = −val;
    return abs_val;
}
#pragma noinline
void main( void )
{
    int i;
    i = abs(−1);
}

If a function has an inline/__noinline function qualifier, then this qualifier will overrule the current pragma setting.
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With the #pragma noinline / #pragma smartinline you can temporarily disable the default behavior that the C compiler
automatically inlines small functions when you turn on the C compiler option −−optimize=+inline.

1.7.4 Intrinsic Functions

Some specific assembly instructions have no equivalence in C. Intrinsic functions give the possibility to use these instructions.
Intrinsic functions are predefined functions that are recognized by the compiler. The compiler generates the most efficient
assembly code for these functions.

The compiler always inlines the corresponding assembly instructions in the assembly source (rather than calling it as a
function). This avoids parameter passing and register saving instructions which are normally necessary during function calls.

Intrinsic functions produce very efficient assembly code. Though it is possible to inline assembly code by hand, intrinsic
functions use registers even more efficiently. At the same time your C source remains very readable.

You can use intrinsic functions in C as if they were ordinary C (library) functions. All intrinsics begin with a double underscore
character.

The TASKING TSK3000 C compiler recognizes the following intrinsic functions:

__alloc

void * volatile __alloc( __size_t size );

Allocate memory. Same as library function malloc().

Returns: a pointer to space in external memory of size bytes length. NULL if there is not enough space left.

__break

volatile int __break(int val);

Generates the assembly break instruction. val is a 20−bit value which will be encoded in the code field of the break instruction.

Returns: nothing.

__free

void volatile __free( void *p );

Deallocates the memory pointed to by p. p must point to memory earlier allocated by a call to __alloc(). Same as library
function free().

Returns: nothing.

__nop

void __nop( void );

Generate NOP instructions.

Returns: nothing.

Example:

__nop();  /* generate NOP instruction */

__get_return_address

__codeptr volatile __get_return_address( void );

Used by the compiler for profiling when you compile with the −−profile (−p) option.

Returns: return address of a function.

__mfc0

volatile int __mfc0(int spr);

Get the value from coprocessor 0 special function register spr.

Returns: the value of the spr register of coprocessor 0.
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__mtc0

volatile void __mtc0(int val, int spr);

Put a value val into special purpose register spr  of coprocessor 0.

Returns: nothing.

1.7.5 Interrupt Functions

The TASKING C compiler supports a number of function qualifiers and keywords to program interrupt service routines (ISR). An
interrupt service routine (or: interrupt function, interrupt handler, ) is called when an interrupt event (or: service request) occurs.

1.7.5.1 Defining an Interrupt Service Routine: __interrupt()

With the function type qualifier __interrupt() you can declare a function as an interrupt service routine. The function type
qualifier __interrupt() takes one or more vector numbers (0..31) as argument(s). All supplied vector numbers will be
initialized to point to the interrupt function.

Interrupt functions cannot return anything and must have a void argument type list:

void __interrupt(vector_number[, vector_number]...)
isr( void )
{
...
}

The different type of interrupts are explained in detail in the Core Processor reference manuals delivered with the
product. You can find them in the Help system under FPGA Design » Core References »  Processors.

Example

void __interrupt( 7 ) serial_receive( void )
{
  ...
}

1.8 Libraries

The TASKING compilers come with standard C libraries (ISO/IEC 9899:1999) and header files with the appropriate prototypes
for the library functions. All standard C libraries are available in object format and in C or assembly source code.

A number of standard operations within C are too complex to generate inline code for (too much code). These operations are
implemented as run−time library functions to save code.

See section 2.2, Library Functions, in Chapter Libraries, for an extensive description of all standard C library functions.

1.8.1 Printf and Scanf Routines

The C library functions printf(), fprintf(), vfprintf(), vsprintf(), ... call one single function, _doprint(), that
deals with the format string and arguments. The same applies to all scanf type functions, which call the function _doscan(),
and also for the wprintf and wscanf type functions which call _dowprint() and _dowscan() respectively. The C library
contains three versions of these routines: int, long and long long versions. If you use floating−point the formatter function
for floating−point _doflt() or _dowflt() is called. Depending on the formatting arguments you use, the correct routine is
used from the library. Of course the larger the version of the routine the larger your produced code will be.

Note that when you call any of the printf/scanf routines indirect, the arguments are not known and always the long long
version with floating−point support is used from the library.
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Example

#include <stdio.h>

long L;

void main(void)
{
    printf( "This is a long: %ld\n", L );
}

The linker extracts the long version without floating−point support from the library.

See also the description of #pragma weak in section 1.5, Pragmas to Control the Compiler in the user’s manual.
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2 Libraries

Summary This chapter lists all library functions that you can call in your C source.

2.1 Introduction

This chapter contains an overview of all library functions that you can call in your C source. This includes all functions of the
standard C library (ISO C99) and some functions of the floating−point library.

A number of standard operations within C are too complex to generate inline code for (too much code). These operations are
implemented as run−time library functions to save code.

Section 2.2, Library Functions, gives an overview of all library functions you can use, grouped per header file. A number of
functions declared in wchar.h are parallel to functions in other header files. These are discussed together.

The following libraries are available. Altium Designer automatically selects the appropriate libraries depending on the specified
options.

Libraries Description

c3000.lib
c3000md.lib

C library (some functions also need the floating−point library)
C library with support for hardware multiply/divide

c3000s.lib
c3000mds.lib

Single precision C library
(some functions also need the floating−point library)

fp3000.lib
fp3000md.lib

Floating−point library (non trapping)

fp3000t.lib
fp3000mdt.lib

Floating−point library (trapping)

pb3000.lib
pc3000.lib
pct3000.lib
pd3000.lib
pt3000.lib
p*3000md.lib

Profiling libraries: pb = block/function counter
pc = call graph
pct = call graph and timing
pd = dummy
pt = function timing

Table 2−1: Overview of libraries
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2.2 Library Functions

The following sections list all library functions, grouped per header file in which they are declared. Some functions are not
completely implemented because their implementation depends on the context where your application will run. These functions
are for example all I/O related functions. Where possible, these functions are implemented using file system simulation (FSS).
This system can be used by the debugger to simulate an I/O environment which enables you to debug your application.

A number of wide−character functions are available as C source code, but have not been compiled with the C library. To use
complete wide−character functionality, you must recompile the libraries with the macro WCHAR_SUPPORT_ENABLED and
keep this macro also defined when compiling your own sources. (See C compiler option −−define (−D) in section 4.1, C
Compiler Options, in Chapter 4, Tool options.)

2.2.1 assert.h

assert(expr) Prints a diagnostic message if NDEBUG is not defined.

(Implemented as macro)

2.2.2 complex.h

The TSK3000 does not support complex numbers.

2.2.3 ctype.h and wctype.h

The header file ctype.h declares the following functions which take a character c as an integer type argument. The header file
wctype.h declares parallel wide−character functions which take a character c of the wchar_t type as argument.

ctype.h wctype.h Description

isalnum iswalnum Returns a non−zero value when c is an alphabetic character or a number ([A−Z][a−z][0−9]).

isalpha iswalpha Returns a non−zero value when c is an alphabetic character ([A−Z][a−z]).

isblank iswblank Returns a non−zero value when c is a blank character (tab, space...)

iscntrl iswcntrl Returns a non−zero value when c is a control character.

isdigit iswditit Returns a non−zero value when c is a numeric character ([0−9]).

isgraph iswgraph Returns a non−zero value when c is printable, but not a space.

islower iswlower Returns a non−zero value when c is a lowercase character ([a−z]).

isprint iswprint Returns a non−zero value when c is printable, including spaces.

ispunct iswpunct Returns a non−zero value when c is a punctuation character
(such as ’.’, ’,’, ’!’).

isspace iswspace Returns a non−zero value when c is a space type character (space, tab, vertical tab,
formfeed, linefeed, carriage return).

isupper iswupper Returns a non−zero value when c is an uppercase character ([A−Z]).

isxdigit iswxdigit Returns a non−zero value when c is a hexadecimal digit ([0−9][A−F][a−f]).

tolower towlower Returns c converted to a lowercase character if it is an uppercase character, otherwise c is
returned.

toupper towupper Returns c converted to an uppercase character if it is a lowercase character, otherwise c is
returned.

_tolower − Converts c to a lowercase character, does not check if c really is an uppercase character.
Implemented as macro. This macro function is not defined in ISO C99.

_toupper − Converts c to an uppercase character, does not check if c really is a lowercase character.
Implemented as macro. This macro function is not defined in ISO C99.

isascii Returns a non−zero value when c is in the range of 0 and 127. 
This function is not defined in ISO C99.

toascii Converts c to an ASCII value (strip highest bit).
This function is not defined in ISO C99.
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2.2.4 errno.h

int errno External variable that holds implementation defined error codes.

The following error codes are defined as macros in errno.h:

EPERM           1       Not owner
ENOENT          2       No such file or directory
EINTR           3       Interrupted system call
EIO             4       I/O error
EBADF           5       Bad file number
EAGAIN          6       No more processes
ENOMEM          7       Not enough core
EACCES          8       Permission denied
EFAULT          9       Bad address
EEXIST          10      File exists
ENOTDIR         11      Not a directory
EISDIR          12      Is a directory
EINVAL          13      Invalid argument
ENFILE          14      File table overflow
EMFILE          15      Too many open files
ETXTBSY         16      Text file busy
ENOSPC          17      No space left on device
ESPIPE          18      Illegal seek
EROFS           19      Read−only file system
EPIPE           20      Broken pipe
ELOOP           21      Too many levels of symbolic links
ENAMETOOLONG    22      File name too long

Floating−point errors

EDOM            23      Argument too large
ERANGE          24      Result too large

Errors returned by prinff/scanf

ERR_FORMAT      25      Illegal format string for printf/scanf
ERR_NOFLOAT     26      Floating−point not supported
ERR_NOLONG      27      Long not supported
ERR_NOPOINT     28      Pointers not supported

Encoding error stored in errno by functions like fgetwc, getwc, mbrtowc, etc ...

EILSEQ          29      Invalid or incomplete multibyte or wide character

Errors set by RTOS

EILSEQ          30      Operation canceled
ENODEV          31      No such device

2.2.5 fcntl.h

The file fcntl.h contains the function open(), which calls the low level function _open(), and definitions of flags used by the
low level function _open(). This header file is not defined in ISO C99.

open Opens a file for reading or writing. Calls _open.
(FSS implementation)
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2.2.6 fenv.h

Contains mechanisms to control the floating−point environment. The functions in this header file are not implemented.

fegetenv Stores the current floating−point environment. (Not implemented)

feholdexept Saves the current floating−point environment and installs an environment that ignores all floating−point
exceptions. (Not implemented)

fesetenv Restores a previously saved (fegetenv or feholdexcept) floating−point environment. (Not implemented)

feupdateenv Saves the currently raised floating−point exceptions, restores a previousely saved floating−point environ�
ment and finally raises the saved exceptions. (Not implemented)

feclearexcept Clears the current exception status flags corresponding to the flags specified in the argument. (Not im�
plemented)

fegetexceptflag Stores the current setting of the floating−point status flags. (Not implemented)

feraiseexcept Raises the exceptions represented in the argument. As a result, other exceptions may be raised as well.
(Not implemented)

fesetexceptflag Sets the current floating−point status flags. (Not implemented)

fetestexcept Returns the bitwise−OR of the exception macros corresponding to the exception flags which are current�
ly set and are specified in the argument. (Not implemented)

For each supported exception, a macro is defined. The following exceptions are defined:

FE_DIVBYZERO FE_INEXACT FE_INVALID

FE_OVERFLOW FE_UNDERFLOW FE_ALL_EXCEPT

fegetround Returns the current rounding direction, represented as one of the values of the rounding direction mac�
ros. (Not implemented)

fesetround Sets the current rounding directions. (Not implemented)

Currently no rounding mode macros are implemented.

2.2.7 float.h

The header file float.h defines the characteristics of the real floating−point types float, double and long double.

Float.h used to contain prototypes for the functions copysign(f), isinf(f), isfinite(f), isnan(f) and scalb(f).
These functions have accordingly to the ISO C99 standard been moved to the header file math.h. See also section
2.2.15, math.h and tgmath.h.

2.2.8 fss.h

The header file fss.h contains definitions for the debugger’s file system simulation (FSS). This header file is not defined in ISO
C99.

fss.h Description

_fss_break(void) Buffer and breakpoint functions for the debugger.

_fss_init(fd,is_close) Opens file descriptors 0 (stdin), 1 (stdout) and 2 (stderr) and associates them with terminal
window FSS 0 of the debugger.
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2.2.9 inttypes.h and stdint.h

The header files stdint.h and inttypes.h provide additional declarations for integer types and have various characteristics.
The stdint.h header file contains basic definitions of integer types of certain sizes, and corresponding sets of macros. This
header file clearly refers to the corresponding sections in the ISO C99 standard.
The inttypes.h header file includes stdint.h and adds portable formatting and conversion functions. Below the conversion
functions from inttypes.h are listed.

intmax_t imaxabs(intmax_t j); Returns the absolute value of j

imaxdiv_t imaxdiv(intmax_t numer,
intmax_t denom);

Computes numer/denom and numer % denom. The result is stored in the quot
and rem components of the imaxdiv_t structure type.

intmax_t strtoimax(const char *
restrict nptr, char ** restrict
endptr, int base);

Convert string to maximum sized integer. (Compare strtol)

uintmax_t strtoumax(const char *
restrict nptr, char ** restrict
endptr, int base);

Convert string to maximum sized unsigned integer. (Compare strtoul)

intmax_t wcstoimax(const wchar_t
* restrict nptr, wchar_t ** re�
strict endptr, int base);

Convert wide string to maximum sized integer. (Compare wctol)

uintmax_t wcstoumax(const wchar_t
* restrict nptr, wchar_t ** re�
strict endptr, int base);

Convert wide string to maximem sized unsigned integer. (Compare wctoul)

2.2.10 io.h

The header file io.h contains definitions and prototypes for low level I/O functions. This header file is not defined in
ISO/IEC9899.

_close(fd) Used by the functions close and fclose.
(FSS implementation)

_lseek(fd,offset,whence) Used by all file positioning functions: fgetpos, fseek, fsetpos, ftell, rewind. (FSS imple�
mentation)

_open(fd,flags) Used by the functions fopen and freopen. 
(FSS implementation)

_read(fd,*buff,cnt) Reads a sequence of characters from a file.
(FSS implementation)

_unlink(*name) Used by the function remove.
(FSS implementation)

_write(fd,*buffer,cnt) Writes a sequence of characters to a file.
(FSS implementation)

2.2.11 iso646.h

The header file iso646.h adds tokens that can be used instead of regular operator tokens.

#define and     &&
#define and_eq  &=
#define bitand  &
#define bitor   |
#define compl   ~
#define not     !
#define not_eq  !=
#define or      ||
#define or_eq   |=
#define xor     ^
#define xor_eq  ^=
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2.2.12 limits.h

Contains the sizes of integral types, defined as macros.

2.2.13 locale.h

To keep C code reasonable portable accross different languages and cultures, a number of facilities are provided in the header
file local.h.

char *setlocale( int category, const char *locale )

The function above changes locale−specific features of the run−time library as specified by the category to change and the
name of the locale.

The following categories are defined and can be used as input for this function:

LC_ALL          0 LC_NUMERIC      3
LC_COLLATE      1 LC_TIME         4
LC_CTYPE        2 LC_MONETARY     5

struct lconv *localeconv( void )

Returns a pointer to type stuct lconv  with values appropriate for the formatting of numeric quantities according to the
rules of the current locale. The struct lconv in this header file is conforming the ISO standard.

2.2.14 malloc.h

The header file malloc.h contains prototypes for memory allocation functions. This include file is not defined in ISO C99, it is
included for backwards compatibility with ISO C90. For ISO C99, the memory allocation functions are part of stdlib.h. See
section 2.2.23, stdlib.h and wchar.h.

malloc(size) Allocates space for an object with size size. The allocated space is not initialized. Returns a point�
er to the allocated space.

calloc(nobj,size) Allocates space for n objects with size size. The allocated space is initialized with zeros. Returns
a pointer to the allocated space.

free(*ptr) Deallocates the memory space pointed to by ptr which should be a pointer earlier returned by the
malloc or calloc function.

realloc(*ptr,size) Deallocates the old object pointed to by ptr and returns a pointer to a niew object with size size.
The new object cannot have a size larger than the previous object.

2.2.15 math.h and tgmath.h

The header file math.h contains the prototypes for many mathematical functions. Before ISO C99, all functions were computed
using the double type (the float was automatically converted to double, prior to calculation). In this ISO C99 version, parallel sets
of functions are defined for double, float and long double. They are respectively named function, functionf, functionl. All long
type functions, though declared in math.h, are implemented as the double type variant which nearly always meets the
requirement in embedded applications.

The header file tgmath.h contains parallel type generic math macros whose expansion depends on the used type. tgmath.h
includes math.h and the effect of expansion is that the correct math.h functions are called. The type generic macro, if
available, is listed in the second column of the tables below.

Trigonometric and hyperbolic functions

math.h tgmath.h Description

sin sinf sinl sin Returns the sine of x.

cos cosf cosl cos Returns the cosine of x.

tan tanf tanl tan Returns the tangent of x.

asin asinf asinl asin Returns the arc sine sin−1(x) of x.

acos acosf acosl acos Returns the arc cosine cos−1(x) of x.

atan atanf atanl atan Returns the arc tangent tan−1(x) of x.



Libraries

2−7

math.h Descriptiontgmath.h

atan2 atan2f atan2l atan2 Returns the result of: tan−1(y/x).

sinh sinhf sinhl sinh Returns the hyperbolic sine of x.

cosh coshf coshl cosh Returns the hyperbolic cosine of x.

tanh tanhf tanhl tanh Returns the hyperbolic tangent of x.

asinh asinhf asinhl asinh Returns the arc hyperbolic sinus of x.

acosh acoshf acoshl acosh Returns the non−negative arc hyperbolic cosinus of x.

atanh atanhf atanhl atanh Returns the arc hyperbolic tangent of x.

Exponential and logarithmic functions

All of these functions are new in ISO C99, except for exp, log and log10.

math.h tgmath.h Description

exp expf expl exp Returns the result of the exponential function ex.

exp2 exp2f exp2l exp2 Returns the result of the exponential function 2x.
(Not implemented)

expm1 expm1f expm1l expm1 Returns the result of the exponential function ex−1
(Not implemented)

log logf logl log Returns the natural logarithm ln(x), x>0.

log10 log10f log10l log10 Returns the base−10 logarithm of x, x>0.

log1p log1pf log1pl log1p Returns the base−e logarithm of (1+x). x <> −1.
(Not implemented)

log2 log2f log2l log2 Returns the base−2 logarithm of x. x>0.
(Not implemented)

ilogb ilogbf ilogbl ilogb Returns the signed exponent of x as an integer. x>0.
(Not implemented)

logb logbf logbl logb Returns the exponent of x as a signed integer in value in floating−point notation. x
> 0.
(Not implemented)

frexp, ldexp, modf, scalbn, scalbln

math.h tgmath.h Description

frexp frexpl frexpf frexp Splits a float x into fraction f and  exponent n, so that:
f = 0.0 or 0.5 ≤ | f | ≤ 1.0 and f*2n = x. Returns f, stores n.

ldexp ldexpl ldexpf ldexp Inverse of frexp. Returns the result of x*2n.
(x and n are both arguments).

modf modfl modff − Splits a float x into fraction f and integer n, so that:
| f | < 1.0 and f+n=x. Returns f, stores n.

scalbn scalbnl scalbnf scalbn Computes the result of x*FLT_RADIXn. efficiently, not normally by computing
FLT_RADIXn explicitly.

scalblnscalblnl scalblnf scalbln Same as scalbn but with argument n as long int.
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Rounding functions

math.h tgmath.h Description

ceil ceilf ceill ceil Returns the smallest integer not less than x, as a double.

floor floorf floorl floor Returns the largest integer not greater than x, as a double.

rint rintl rintf rint Returns the rounded integer value as an int according to the current rounding
direction. See fenv.h. (Not implemented)

lrint lrintf lrintl lrint Returns the rounded integer value as a long int according to the current
rounding direction. See fenv.h. (Not implemented)

llrint lrintf lrintl llrint Returns the rounded integer value as a long long int according to the
current rounding direction. See fenv.h. (Not implemented)

nearbyint  nearbyintf
           nearbyintl

nearbyint Returns the rounded integer value as a floating−point according to the current
rounding direction. See fenv.h. (Not implemented)

round roundl roundf round Returns the nearest integer value of x as int. (Not implemented)

lround lroundl lroundf lround Returns the nearest integer value of x as long int. (Not implemented)

llroundllroundl llroundf llround Returns the nearest integer value of x as long long int. (Not implemented)

trunc truncl truncf trunc Returns the truncated integer value x. (Not implemented)

Remainder after devision

math.h tgmath.h Description

fmod fmodl fmodf fmod Returns the remainder r of x−ny. n is chosen as trunc(x/y). r has the same
sign as x.

remainder   remainderl
            remainderf

remainder Returns the remainder r of x−ny. n is chosen as trunc(x/y). r may not have
the same sign as x. (Not implemented)

remquo remquol remquof remquo Same as remainder. In addition, the argument *quo is given a specific value
(see ISO). (Not implemented)

Power and absolute−value functions

math.h tgmath.h Description

cbrt cbrtl cbrtf cbrt Returns the real cube root of x (=x1/3).
(Not implemented)

fabs fabsl fabsf fabs Returns the absolute value of x (|x|).  (abs, labs, llabs, div, ldiv, lldiv
are defined in stdlib.h)

fma fmal fmaf fma Floating−point multiply add. Returns x*y+z.
(Not implemented)

hypot hypotl hypotf hypot Returns the square root of x2+y2.

pow powl powf power Returns x raised to the power y (xy).

sqrt sqrtl sqrtf sqrt Returns the non−negative square root of x. x�0.

Manipulation functions: copysign, nan, nextafter, nexttoward

math.h tgmath.h Description

copysign    copysignl
            copysignf

copysign Returns the value of x with the sign of y.

nan nanl nanf − Returns a quiet NaN, if available, with content indcated through tagp. (Not
implemented)

nextafter   nextafterl
            nextafterf

nextafter Returns the next representable value in the specified format after x in the
direction of y. Returns y is x=y. (Not implemented)

nexttoward  nexttowardl
            nexttowardf

nexttoward Same as nextafter, except that the second argument in all three variants is
of type long double. Returns y if x=y. (Not implemented)
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Positive difference, maximum, minimum

math.h tgmath.h Description

fdim fdiml fdimf fdim Returns the positive difference between: |x−y|.
(Not implemented)

fmax fmaxl fmaxf fmax Returns the maximum value of their arguments.
(Not implemented)

fmin fminl fminf fmin Returns the minimum value of their arguments.
(Not implemented)

Error and gamma (Not implemented)

math.h tgmath.h Description

erf erfl erff erf Computes the error function of x.
(Not implemented)

erfc erfcl erfcf erc Computes the complementary error function of x.
(Not implemented)

lgamma lgammal lgammaf lgamma Computes the *loge|Γ(x)|
(Not implemented)

tgamma tgammal tgammaf tgamma Computes Γ(x)
(Not implemented)

Comparison macros

The next are implemented as macros. For any ordered pair of numeric values exactly one of the relationships − less, greater,
and equal − is true. These macros are type generic and therefor do not have a parallel function in tgmath.h. All arguments
must be expressions of real−floating type.

math.h tgmath.h Description

isgreater − Returns the value of (x) > (y)

isgreaterequal − Returns the value of (x) >= (y)

isless − Returns the value of (x) < (y)

islessequal − Returns the value of (x) <= (y)

islessgreater − Returns the value of (x) < (y) || (x) > (y)

isunordered − Returns 1 if its arguments are unordered, 0 otherwise.

Classification macros

The next are implemented as macros. These macros are type generic and therefor do not have a parallel function in tgmath.h.
All arguments must be expressions of real−floating type.

math.h tgmath.h Description

fpclassify − Returns the class of its argument:
FP_INFINITE, FP_NAN, FP_NORMAL, FP_SUBNORMAL or FP_ZERO

isfinite − Returns a nonzero value if and only if its argument has a finite value

isinf − Returns a nonzero value if and only if its argument has an infinit value

isnan − Returns a nonzero value if and only if its argument has NaN value.

isnormal − Returns a nonzero value if an only if its argument has a normal value.

signbit − Returns a nonzero value if and only if its argument value is negative.
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2.2.16 setjmp.h

The setjmp and longjmp in this header file implement a primitive form of nonlocal jumps, which may be used to handle
exceptional situations. This facility is traditionally considered more portable than signal.h.

int setjmp(jmp_buf env) Records its caller’s environment in env and returns 0.

void longjmp(jmp_buf env,
            int status)

Restores the environment previously saved with a call to setjmp().

2.2.17 signal.h

Signals are possible asynchronous events that may require special processing. Each signal is named by a number. The
following signals are defined:

SIGINT    1 Receipt of an interactive attention signal
SIGILL    2 Detection of an invalid function message
SIGFPE    3 An errouneous arithmetic operation (for example, zero devide, overflow)
SIGSEGV   4 An invalid access to storage
SIGTERM   5 A termination request sent to the program
SIGABRT   6 Abnormal terminiation, such as is initiated by the abort function.

The next function sends the signal sig to the program:

int raise(int sig)

The next function determines how subsequent signals will be handled:

signalfunction *signal (int, signalfunction *);

The first argument specifies the signal, the second argument points to the signal−handler function or has one of the following
values:

SIG_DFL Default behaviour is used
SIG_IGN The signal is ignored

The function returns the previous value of signalfunction for the specific signal, or SIG_ERR if an error occurs.

2.2.18 stdarg.h

The facilities in this header file gives you a portable way to access variable arguments lists, such as needed for as fprintf
and vfprintf. va_copy is new in ISO C99. This header file contains the following macros:

va_arg(ap,type) Returns the value of the next argument in the variable argument list. It’s return type has the type
of the given argument type. A next call to this macro will return the value of the next argument.

va_copy(va_list dest,
va_list src)

This macro duplicates the current state of src in dest, creating a second pointer into the
argument list. After this call, va_arg() may be used on src and dest independently.

va_end(va_list ap) This macro must be called after the arguments have been processed. It should be called before
the function using the macro ’va_start’ is terminated (ANSI specification).

va_start( va_list ap,
         lastarg );

This macro initializes ap. After this call, each call to va_arg() will return the value of the next
argument. In our implementation, va_list cannot contain any bit type variables. Also the
given argument lastarg must be the last non−bit type argument in the list.

2.2.19 stdbool.h

This header file contains the following macro definitions. These names for boolean type and values are consistent with C++. You
are allowed to #undefine or redefine the macros below.

#define bool                            _Bool
#define true                            1
#define false                           0
#define __bool_true_false_are_defined   1
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2.2.20 stddef.h

This header file defines the types for common use:

ptrdiff_t signed integer type of the result of subtracting two pointers.

size_t unsigned integral type of the result of the sizeof operator.

wchar_t integer type to represent character codes in large character sets.

Besides these types, the following macros are defined:

NULL expands to the null pointer constant

offsetof(_type,_member) expands to an integer constant expression with type size_t that is the offset in bytes of
_member within structure type _type.

2.2.21 stdint.h

See section 2.2.9, inttypes.h and stdint.h

2.2.22 stdio.h and wchar.h

Types

The header file stdio.h contains functions for performing input and output. A number of functions also have a parallel wide
character function or macro, defined in wchar.h. The header file wchar.h also includes stdio.h.

In the C language, many I/O facilities are based on the concept of streams. The stdio.h header file defines the data type
FILE which holds the information about a stream. An FILE object is created with the function fopen. The pointer to this object
is used as an argument in many of the in this header file. The FILE object can contain the following information:

• the current position within the stream

• pointers to any associated buffers

• indications of for read/write errors

• end of file indication

The header file also defines type fpos_t as an unsigned long.

Macros

stdio.h / wchar.h Description

NULL expands to the null pointer constant

BUFSIZ Size of the buffer used by the setbuf/setvbuf function: 512

EOF End of file indicator. Expands to −1.

WEOF End of file indicator. Expands to UINT_MAX (defined in limits.h)
NOTE: WEOF need not to be a negative number as long as its value does not correspond to a member
of the wide character set. (Defined in wchar.h).

FOPEN_MAX Number of files that can be opened simultaneously: 10

FILENAME_MAX Maximum length of a filename: 100

_IOFBF
_IOLBF
_IONBF

Expand to an integer expression, suitable for use as argument to the setvbuf function.

L_tmpnam Size of the string used to hold temporary file names: 8 (tmpxxxxx)

TMP_MAX Maximum number of unique temporary filenames that can be generated: 0x8000

SEEK_CUR
SEEK_END
SEEK_SET

Expand to an integer expression, suitable for use as the third argument to the fseek function.

stderr
stdin
stdout

Expressions of type "pointer to FILE" that point to the FILE objects associated with standard error, input
and output streams.
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File access

stdio.h Description

fopen(name,mode) Opens a file for a given mode. Available modes are:

"r" read; open text file for reading

 "w" write; create text file for writing; if the file already exists its contents is discarded

"a" append; open existing text file or create new text file for writing at end of file

 "r+" open text file for update; reading and writing

 "w+" create text file for update; previous contents if any is discarded

 "a+" append; open or create text file for update, writes at end of file

fclose(name) Flushes the data stream and closes the specified file that was previously opened with
fopen.

fflush(name) If stream is an output stream, any buffered but unwritten date is written. Else, the effect is
undefined.

freopen(name,mode,stream) Similar to fopen, but rather then generating a new value of type FILE *, the existing value
is associated with a new stream.

setbuf(stream,buffer) If buffer is NULL, buffering is turned off for the stream.
Otherwise, setbuf is equivalent to:
 (void) setvbuf(stream,buf,_IOFBF, BUFSIZ).

setvbuf(stream,buffer,
        mode,size)

Controls buffering for the stream; this function must be called before reading or writing.
Mode can have the following values:

_IOFBF  causes full buffering
_IOLBF  causes line buffering of text files
_IONBF  causes no buffering

If buffer is not NULL, it will be used as a buffer; otherwise a buffer will be allocated. size
determines the buffer size.

Character input/output

The format string of printf related functions can contain plain text mixed with conversion specifiers. Each conversion
specifier should be preceded by a ’%’ character. The conversion specifier should be build in order:

− Flags (in any order):

− specifies left adjustment of the converted argument.

+ a number is always preceded with a sign character.
+ has higher precedence than space.

space a negative number is preceded with a sign, positive numbers with a space.

0 specifies padding to the field width with zeros (only for numbers).

# specifies an alternate output form. For o, the first digit will be zero. For x or X, "0x" and "0X" will be prefixed to the
number. For e, E, f, g, G, the output always contains a decimal point, trailing zeros are not removed.

− A number specifying a minimum field width. The converted argument is printed in a field with at least the length specified
here. If the converted argument has fewer characters than specified, it will be padded at the left side (or at the right when the
flag ’−’ was specified) with spaces. Padding to numeric fields will be done with zeros when the flag ’0’ is also specified (only
when padding left). Instead of a numeric value, also ’*’ may be specified, the value is then taken from the next argument,
which is assumed to be of type int.

− A period. This separates the minimum field width from the precision.

− A number specifying the maximum length of a string to be printed. Or the number of digits printed after the decimal point
(only for floating−point conversions). Or the minimum number of digits to be printed for an integer conversion. Instead of a
numeric value, also ’*’ may be specified, the value is then taken from the next argument, which is assumed to be of type
int.

− A length modifier ’h’, ’hh’, ’l’, ’ll’, ’L’, ’j’, ’z’ or ’t’. ’h’ indicates that the argument is to be treated as a short or unsigned
short. ’hh’ indicates that the argument is to be treated as a char or unsigned char. ’l’ should be used if the argument is
a long integer, ’ll’ for a long long. ’L’ indicates that the argument is a long double. ’j’ indicates a pointer to intmax_t
or uintmax_t, ’z’ indicates a pointer to size_t and ’t’ indicates a pointer to ptrdiff_t.
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Flags, length specifier, period, precision and length modifier are optional, the conversion character is not. The conversion
character must be one of the following, if a character following ’%’ is not in the list, the behavior is undefined.

Character Printed as

d, i int, signed decimal

o int, unsigned octal

x, X int, unsigned hexadecimal in lowercase or uppercase respectively

u int, unsigned decimal

c int, single character (converted to unsigned char)

s char *, the characters from the string are printed until a NULL character is found. When the given precision is
met before, printing will also stop

f double

e, E double

g, G double

a, A double

n int *, the number of characters written so far is written into the argument. This should be a pointer to an inte�
ger in default memory. No value is printed.

p pointer (hexadecimal 24−bit value)

% No argument is converted, a ’%’ is printed.

Table 2−2: Printf conversion characters

All arguments to the scanf related functions should be pointers to variables (in default memory) of the type which is specified in
the format string.

The format string can contain :

− Blanks or tabs, which are skipped.

− Normal characters (not ’%’), which should be matched exactly in the input stream.

− Conversion specifications, starting with a ’%’ character.

Conversion specifications should be built as follows (in order) :

− A ’*’, meaning that no assignment is done for this field.

− A number specifying the maximum field width.

− The conversion characters d, i, n, o, u and x may be preceded by ’h’ if the argument is a pointer to short rather than int,
or by ’hh’ if the argument is a pointer to char, or by ’l’ (letter ell) if the argument is a pointer to long, or by ’ll’ for a pointer to
long long, ’j’ for a pointer to intmax_t or uintmax_t, ’z’ for a pointer to size_t or ’t’ for a pointer to ptrdiff_t. The
conversion characters e, f, and g may be preceded by ’l’ if the argument is a pointer to double rather than float, and by
’L’ for a pointer to a long double.

− A conversion specifier. ’*’, maximum field width and length modifier are optional, the conversion character is not. The
conversion character must be one of the following, if a character following ’%’ is not in the list, the behavior is undefined.

Length specifier and length modifier are optional, the conversion character is not. The conversion character must be one of the
following, if a character following ’%’ is not in the list, the behavior is undefined.

Character Scanned as

d int, signed decimal.

i int, the integer may be given octal (i.e. a leading 0 is entered) or hexadecimal (leading "0x" or "0X"), or just
decimal.

o int, unsigned octal.

u int, unsigned decimal.

x int, unsigned hexadecimal in lowercase or uppercase.

c single character (converted to unsigned char).

s char *, a string of non white space characters. The argument should point to an array of characters, large
enough to hold the string and a terminating NULL character.
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Scanned asCharacter

f float

e, E float

g, G float

a, A float

n int *, the number of characters written so far is written into the argument. No scanning is done.

p pointer; hexadecimal 24−bit value which must be entered without 0x− prefix.

[...] Matches a string of input characters from the set between the brackets. A NULL character is added to termi�
nate the string. Specifying []...] includes the ’]’ character in the set of scanning characters.

[^...] Matches a string of input characters not in the set between the brackets. A NULL character is added to termi�
nate the string. Specifying [^]...] includes the ’]’ character in the set.

% Literal ’%’, no assignment is done.

Table 2−3: Scanf conversion characters

stdio.h wchar.h Description

fscanf(stream,
      format,...)

fwscanf(stream,
      format,...)

Performs a formatted read from the given stream. Returns the number of
items converted succesfully. (FSS implementation)

scanf(format,...) wscanf(format,...) Performs a formatted read from the stdin stream. Returns the number
of items converted succesfully. (FSS implementation)

sscanf(*s,
      format,...)

swscanf(*s,
       format,...)

Performs a formatted read from the string s. Returns the number of items
converted succesfully.

vfscanf(stream,
       format,arg)

vfwscanf(stream,
        format,arg)

Same as fscanf/fwscanf, but extra arguments are given as variable
argument list arg.
(See section 2.2.18, stdarg.h)

vscanf(format,arg) vwscanf(format,arg) Same as scanf/wscanf, but extra arguments are given as variable ar�
gument list arg.
(See section 2.2.18, stdarg.h)

vsscanf(s,format,
       arg)

vswscanf(s,format,
        arg)

Same as scanf/wscanf, but extra arguments are given as variable ar�
gument list arg.
(See section 2.2.18, stdarg.h)

fprintf(stream,
       format,...)

fwprintf(stream,
       format,...)

Performs a formatted write to the given stream. Returns EOF/WEOF on
error.
(FSS implementation)

printf(format,...) wprintf(format,...) Performs a formatted write to the stream stdout. Returns EOF/WEOF
on error.
(FSS implementation)

sprintf(*s,
       format,...)

− Performs a formatted write to string s. Returns EOF/WEOF on error.

snprintf(*s,n
       format,...)

swprintf(*s,n
       format,...)

Same as sprintf, but n specifies the maximum number of characters
(including the terminating null character) to be written.

vfprintf(stream,
        format,arg)

vfwprintf(stream,
    format,arg)

Same as fprintf/fwprintf, but extra arguments are given as variable
argument list arg. (See section 2.2.18, stdarg.h)
(FSS implementation)

vprintf(format,
        arg)

vwprintf(format,
         arg)

Same as printf/wprintf, but extra arguments are given as variable
argument list arg. (See section 2.2.18, stdarg.h)
(FSS implementation)

vsprintf(*s,
        format,arg)

vswprintf(*s,
        format,arg)

Same as sprintf/swprintf, but extra arguments are given as variable
argument list arg. (See section 2.2.18, stdarg.h)
(FSS implementation)
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Character input/output

stdio.h wchar.h Description

fgetc(stream) fgetwc(stream) Reads one character from stream. Returns the read character, or EOF/
WEOF on error.
(FSS implementation)

getc(stream) getwc(stream) Same as fgetc/fgetwc except that is implemented as a macro. (FSS
implementation)

NOTE: Currently #defined as getchar()/getwchar() because FILE
I/O is not supported. Returns the read character, or EOF/WEOF on error.

getchar(stdin) getwchar(stdin) Reads one character from the stdin stream. Returns the character read
or EOF/WEOF on error. Implemented as macro.
(FSS implementation)

fgets(*s,n,
     stream)

fgetws(*s,n,
      stream)

Reads at most the next n−1 characters from the stream into array s until
a newline is found. Returns s or NULL or EOF/WEOF on error.
(FSS implementation)

gets(*s,n,stdin) − Reads at most the next n−1 characters from the stdin stream into array
s. A newline is ignored. Returns s or NULL or EOF/WEOF on error.
(FSS implementation)

ungetc(c,stream) ungetwc(c,stream) Pushes character c back onto the input stream. Returns EOF/WEOF on
error.

fputc(c,stream) fputwc(c,stream) Put character c onto the given stream.
Returns EOF/WEOF on error.
(FSS implementation)

putc(c,stream) putwc(c,stream) Same as fpuc/fputwc except that is implemented as a macro. (FSS
implementation)

putchar(c,stdout) putwchar(c,stdout) Put character c onto the stdout stream.
Returns EOF/WEOF on error.
Implemented as macro. (FSS implementation)

fputs(*s,stream) fputws(*s,stream) Writes string s to the given stream.
Returns EOF/WEOF on error.

puts(*s) − Writes string s to the stdout stream.
Returns EOF/WEOF on error.
(FSS implementation)

Direct input/output

stdio.h Description

fread(ptr,size,nobj,stream) Reads nobj members of size bytes from the given stream into the array pointed to by
ptr. Returns the number of elements succesfully read.
(FSS implementation)

fwrite((ptr,size,nobj,stream) Writes nobj members of size bytes from to the array pointed to by ptr to the given
stream. Returns the number of elements succesfully written.
(FSS implementation)

Random access

stdio.h Description

fseek(stream,offset,
     origin)

Sets the position indicator for stream. (FSS implementation)

When repositioning a binary file, the new position origin is given by the following macros:

SEEK_SET 0 offset characters from the beginning of the file
SEEK_CUR 1 offset characters from the current position in the file
SEEK_END 2 offset characters from the end of the file
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ftell(stream) Returns the current file position for stream, or −1L on error.
(FSS implementation)

rewind(stream) Sets the file position indicator for the stream to the beginning of the file. This function is
equivalent to:
  (void) fseek( stream, 0L, SEEK_SET );
  clearerr( stream );

(FSS implementation)

fgetpos(stream,pos) Stores the current value of the file position indicator for stream in the object pointed to by
pos.
(FSS implementation)

fsetpos(stream,pos) Positions stream at the position recorded by fgetpos in *pos.
(FSS implementation)

Operations on files

stdio.h Description

remove(file) Removes the named file, so that a subsequent attempt to open it fails. Returns a non−zero
value if not succesful.

rename(old,new) Changes the name of the file from old name to new name. Returns a non−zero value if not
succesful.

tmpfile() Creates a temporary file of the mode "wb+" that will be automatically removed when
closed or when the program terminates normally. Returns a file pointer.

tmpnam(buffer) Creates new file names that do not conflict with other file names currently in use. The new
file name is stored in a buffer which must have room for L_tmpnam characters. Returns a
pointer to the temporary name. The file names are created in the current directory and all
start with "tmp". At most TMP_MAX unique file names can be generated.

Error handling

stdio.h Description

clearerr(stream) Clears the end of file and error indicators for stream.

ferror(stream) Returns a non−zero value if the error indicator for stream  is set.

feof(stream) Returns a non−zero value if the end of file indicator for stream  is set.

perror(*s) Prints s and the error message belonging to the integer errno.
(See section 2.2.4, errno.h)

2.2.23 stdlib.h and wchar.h

The header file stdlib.h contains general utility functions which fall into the following categories (Some have parallel
wide−character, declared in wchar.h)

• Numeric conversions

• Random number generation

• Memory management

• Envirnoment communication

• Searching and sorting

• Integer arithmetic

• Multibyte/wide character and string conversions.

Macros

EXIT_SUCCES  0
EXIT_FAILURE 1

Predefined exit codes that can be used in the exit function.

RAND_MAX 32767 Highest number that can be returned by the rand/srand function.

MB_CUR_MAX   1 Maximum number of bytes in a multibyte character for the extended character set specified by the
current locale (category LC_CTYPE, see section 2.2.13, locale.h).
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Numeric conversions

The following functions convert the intial portion of a string *s to a double, int, long int and long long int value
respectively.

double      atof(*s)
int         atoi(*s)
long        atol(*s)
long long   atoll(*s)

The following functions convert the initial portion of the string *s to a float, double and long double value respectively. *endp will
point to the first character not used by the conversion.

stdlib.h wchar.h

float       strtof(*s,**endp)
double      strtod(*s,**endp)
long double strtold(*s,**endp)

float       wcstof(*s,**endp)
double      wcstod(*s,**endp)
long double wcstold(*s,**endp)

The following functions convert the initial portion of the string *s to a long, long long, unsigned long and unsigned
long long respectively. Base specifies the radix. *endp will point to the first character not used by the conversion.

stdlib.h wchar.h

long          strtol(*s,**endp,base)
long long     strtoll(*s,**endp,base)
unsigned long strtoul(*s,**endp,base)
unsigned long long
              strtoull(*s,**endp,base)

long          wcstol(*s,**endp,base)
long long     wcstoll(*s,**endp,base)
unsigned long wcstoul(*s,**endp,base)
unsigned long long
              wcstoull(*s,**endp,base)

Random number generation

rand Returns a pseudo random integer in the range 0 to RAND_MAX.

srand(seed) Same as rand but uses seed for a new sequence of pseudo random numbers.

Memory management

malloc(size) Allocates space for an object with size size. The allocated space is not initialized. Returns a
pointer to the allocated space.

calloc(nobj,size) Allocates space for n objects with size size. The allocated space is initialized with zeros. Returns
a pointer to the allocated space.

free(*ptr) Deallocates the memory space pointed to by ptr which should be a pointer earlier returned by the
malloc or calloc function.

realloc(*ptr,size) Deallocates the old object pointed to by ptr and returns a pointer to a niew object with size size.
The new object cannot have a size larger than the previous object.

Environment communication

abort() Causes abnormal program termination. If the signal SIGABRTis caught, the signal handler may
take over control. (See section 2.2.17, signal.h).

atexit(*func) Func points to a function that is called (without arguments) when the program normally
terminates.

exit(status) Causes normal program termination. Acts as if main() returns with status as the return value.
Status can also be specified with the predefined macros EXIT_SUCCES or EXIT_FAILURE.

_Exit(status) Same as exit, but no registered by the atexit function or signal handlers registerd by the
signal function are called.

getenv(*s) Searches an environment list for a string s. Returns a pointer to the contents of s.
NOTE: this function is not implemented because there is no OS.

system(*s) Passes the string s to the environment for execution.
NOTE: this function is not implemented because there is no OS.
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Searching and sorting

bsearch(*key,*base,
       n,size,*cmp)

This function searches in an array of n members, for the object pointed to by key. The initial base
of the array is given by base. The size of each member is specified by size. The given array must
be sorted in ascending order, according to the results of the function pointed to by cmp. Returns a
pointer to the matching member in the array, or NULL when not found.

qsort(*base,n,
      size,*cmp)

This function sorts an array of n members using the quick sort algorithm. The initial base of the
array is given by base. The size of each member is specified by size. The array is sorted in as�
cending order, according to the results of the function pointed to by cmp.

Integer arithmetic

int       abs(j)
long      labs(j)
long long llabs(j)

Compute the absolute value of an int, long int, and long long int j  resepectively.

div_t     div(x,y)
ldiv_t    ldiv(x,y)
lldiv_t   lldiv(x,y)

Compute x/y and x%y in a single operation. X and y have respectively type int, long int and
long long int. The result is stored in the members quot and rem of  struct div_t,
ldiv_t and lldiv_t which have the same types.

Multibyte/wide character and string conversions

mblen(*s,n) Determines the number of bytes in the multi−byte character pointed to by s. At most n characters
will be examined. (See also mbrlen in section 2.2.27, wchar.h)

mbtowc(*pwc,*s,n) Converts the multi−byte character in s to a wide−character code and stores it in pwc. At most n
characters will be examined.

wctomb(*s,wc) Converts the wide−character wc into a multi−byte representation and stores it in the string pointed
to by s. At most MB_CUR_MAX characters are stored.

mbstowcs(*pwcs,*s,n) Converts a sequence of multi−byte characters in the string pointed to by s into a sequence of
wide characters and stores at most n wide characters into the array pointed to by pwcs. (See also
mbsrtowcs in section 2.2.27, wchar.h)

wcstombs(*s,*pwcs,n) Converts a sequence of wide characters in the array pointed to by pwcs into multi−byte charac�
ters and stores at most n multi−byte characters into the string pointed to by s. (See also
wcsrtowmb in section 2.2.27, wchar.h)

2.2.24 string.h and wchar.h

This header file provides numerous functions for manipulating strings. By convention, strings in C are arrays of characters with a
terminating null character. Most functions therefore take arguments of type *char. However, many functions have also parallel
wide−character functions which take arguments of type *wchar_t. These functions are declared in wchar.h.

Copying and concatenation functions

stdio.h wchar.h Description

memcpy(*s1,*s2,n) wmemcpy(*s1,*s2,n) Copies n characters from *s2 into *s1 and returns *s1. If *s1 and *s2
overlap the result is undefined.

memmove(*s1,*s2,n) wmemmove(*s1,*s2,n) Same as memcpy, but overlapping strings are handled correctly. Returns
*s1.

strcpy(*s1,*s2) wcscpy(*s1,*s2) Copies *s2 into *s1 and returns *s1. If *s1 and *s2 overlap the result is
undefined.

strncpy(*s1,*s2,n) wcsncpy(*s1,*s2,n) Copies not more than n characters from *s2 into *s1 and returns *s1. If
*s1 and *s2 overlap the result is undefined.

strcat(*s1,*s2) wcscat(*s1,*s2) Appends a copy of *s2 to *s1 and returns *s1.  If *s1 and *s2 overlap the
result is undefined.

strncat(*s1,*s2,n) wcsncat(*s1,*s2,n) Appends not more than n characters from *s2 to *s1 and returns *s1. If
*s1 and *s2 overlap the result is undefined.
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Comparison functions

stdio.h wchar.h Description

memcmp(*s1,*s2,n) wmemcmp(*s1,*s2,n) Compares the first n characters of *s1 to the first n characters of *s2.
Returns < 0 if *s1 < *s2, 0 if *s1 = = *s2, or > 0 if *s1 > *s2.

strcmp(*s1,*s2) wcscmp(*s1,*s2) Compares string *s1 to string *s2. Returns < 0 if *s1 < *s2, 0 if *s1 = =
*s2, or > 0 if *s1 > *s2.

strncmp(*s1,*s2,n) wcsncmp(*s1,*s2,n) Compares the first n characters of *s1 to the first n characters of *s2.
Returns < 0 if *s1 < *s2, 0 if *s1 = = *s2, or > 0 if *s1 > *s2.

strcoll(*s1,*s2) wcscoll(*s1,*s2) Performs a local−specific comparison between string *s1 and string *s2
according to the LC_COLLATE category of the current locale. Returns <
0 if *s1 < *s2, 0 if *s1 = = *s2, or > 0 if *s1 > *s2. (See section 2.2.13,
locale.h)

strxfrm(*s1,*s2,n) wcsxfrm(*s1,*s2,n) Transforms (a local) string *s2 so that a comparison between
transformed strings with strcmp gives the same result as a comparison
between non−transformed strings with strcoll. Returns the
transformed string *s1.

Search functions

stdio.h wchar.h Description

memchr(*s,c,n) wmemchr(*s,c,n) Checks the first n characters of *s on the occurence of character c.
Returns a pointer to the found character.

strchr(*s,c) wcschr(*s,c) Returns a pointer to the first occurence of character c in string *s or the
null pointer if not found.

strrchr(*s,c) wcsrchr(*s,c) Returns a pointer to the last occurence of character c in string *s or the
null pointer if not found.

strspn(*s,*set) wcsspn(*s,*set) Searches *s for a sequence of characters specified in *set. Returns the
length of the first sequence found.

strcspn(*s,*set) wcscspn(*s,*set) Searches *s for a sequence of characters not specified in *set. Returns
the length of the first sequence found.

strpbrk(*s,*set) wcspbrk(*s,*set) Same as strspn/wcsspn but returns a pointer to the first character in *s
that also is specified in *set.

strstr(*s,*sub) wcsstr(*s,*sub) Searches for a substring *sub in *s. Returns a pointer to the first
occurence of *sub in *s.

strtok(*s,*delim) wcstok(*s,*delim) A sequence of calls to this function breaks the string *s into a sequence
of tokens delimited by a character specified in *delim. The token found in
*s is terminated with a null character. The function returns a pointer to the
first position in *s of the token.

Miscellaneous functions

stdio.h wchar.h Description

memset(*s,c,n) wmemset(*s,c,n) Fills the first n bytes of *s with character c and returns *s.

strerror(errno) − Typically, the values for errno come from int errno. This function re�
turns a pointer to the associated error message. (See also section 2.2.4,
errno.h)

strlen(*s) wcslen(*s) Returns the length of string *s.

2.2.25 time.h and wchar.h

The header file time.h provides facilities to retrieve and use the (calendar) date and time, and the process time. Time can be
represented as an integer value, or can be broken−down in components. Two arithmetic data types are defined which are
capable of holding the integer representation of times:

clock_t unsigned long long
time_t unsigned long
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The type struct tm below is defined according to ISO/IEC9899 with one exception: this implementation does not support leap
seconds. The struct tm type is defines as follows:

struct tm
{
  int   tm_sec;         /* seconds after the minute − [0, 59]   */
  int   tm_min;         /* minutes after the hour − [0, 59]     */
  int   tm_hour;        /* hours since midnight − [0, 23]       */
  int   tm_mday;        /* day of the month − [1, 31]           */
  int   tm_mon;         /* months since January − [0, 11]       */
  int   tm_year;        /* year since 1900                      */
  int   tm_wday;        /* days since Sunday − [0, 6]           */
  int   tm_yday;        /* days since January 1 − [0, 365]      */
  int   tm_isdst;       /* Daylight Saving Time flag            */
};

Time manipulation

clock Returns the application’s best approximation to the processor time used by the program since it was
started. This low−level routine is not implemented because it strongly depends on the hardware. To
determine the time in seconds, the result of clock should be divided by the value defined as

   CLOCKS_PER_SEC   12000000

difftime(t1,t0) Returns the difference t1−t0 in seconds.

mktime(tm *tp) Converts the broken−down time in the structure pointed to by tp, to a value of type time_t. The
return value has the same encoding as the return value of the time function.

time(*timer) Returns the current calendar time.  This value is also assigned to *timer.

Time conversion

asctime(tm *tp) Converts the broken−down time in the structure pointed to by tp into a string in the form Mon Jan
21 16:15:14 2004\n\0. Returns a pointer to this string.

ctime(*timer) Converts the calender time pointed to by timer to local time in the form of a string. This is equivalent
to: asctime(localtime(timer))

gmtime(*timer) Converts the calender time pointed to by timer to the broken−down time, expressed as UTC.
Returns a pointer to the broken−down time.

localtime(*timer) Converts the calendar time pointed to by timer to the broken−down time, expressed as local time.
Returns a pointer to the broken−down time.

Formatted time

The next function has a parallel function defined in wchar.h:

stdio.h wchar.h

strftime(*s,smax,*fmt,tm *tp) wstrftime(*s,smax,*fmt,tm *tp)

Formats date and time information from struct tm *tp into *s according to the specified format *fmt. No more than smax
characters are placed into *s. The formatting of strftime is locale−specific using the LC_TIME category (see section 2.2.13,
locale.h). You can use the next conversion specifiers:

%a abbreviated weekday name
%A full weekday name
%b abbreviated month name
%B full month name
%c local date and time representation (same as %a %b %e %T %Y)
%C last two of the year
%d day of the month (01−31)
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%D same as %m/%d/%y
%e day of the month (1−31), with single digits preceded by a space
%F ISO 8601 date format: %Y−%m−%d
%g last two digits of the week based year (00−99)
%G week based year (0000˘9999)
%h same as %b
%H hour, 24−hour clock (00−23)
%I hour, 12−hour clock (01−12)
%j day of the year (001−366)
%m month (01−12)
%M minute (00−59)
%n replaced by the newline character
%p local equivalent of AM or PM
%r locale’s 12−hour clock time; same as %I:%M:%S %p
%R same as %H:%M
%S second (00−59)
%t replaced by horizontal tab character
%T ISO 8601 time format: %H:%M:%S
%u ISO 8601 weekday number (1−7), Monday as first day of the week
%U week number of the year, Sunday as first day of the week (00−53)
%V ISO 8601 week number (01−53) in the week−based year
%w weekday (0−6, Sunday is 0)
%W week number of the year (00−53), week 1 has the first Monday
%x local date representation
%X local time representation
%y year without century (00−99)
%Y year with century
%z ISO 8601 offset of time zone from UTC, or nothing
%Z time zone name, if any
%% %

2.2.26 unistd.h

The file unistd.h contains standard UNIX I/O functions. These functions are all implemented using the debugger’s file system
simulation. Except for lstat and fstat which are not implemented. This header file is not defined in ISO C99.

access(*name,mode) Use the file system simulation of the debugger to check the permissions of a file on the host. mode
specifies the type of access and is a bit pattern constructed by a logical OR of the following values:

  R_OK  Checks read permission.
  W_OK  Checks write permission.
  X_OK  Checks execute (search) permission.
  F_OK  Checks to see if the file exists.

(FSS implementation)

chdir(*path) Use the file system simulation feature of the debugger to change the current directory on the host
to the directory indicated by path.
(FSS implementation)

close(fd) File close function. The given file descriptor should be properly closed. This function calls
_close().
(FSS implementation)

getcwd(*buf,size) Use the file system simulation feature of the debugger to retrieve the current directory on the host.
Returns the directory name.
(FSS implementation)

lseek(fd,offset,
            whence)

Moves read−write file offset. Calls _lseek().
(FSS implementation)

read(fd,*buff,cnt) Reads a sequence of characters from a file. This function calls _read(). (FSS implementation)

stat(*name,*buff) Use the file system simulation feature of the debugger to stat() a file on the host platform.
(FSS implementation)
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lstat(*name,*buff) This function is identical to stat(), except in the case of a symbolic link, where the link itself is
’stat’−ed, not the file that it refers to. 
(Not implemented)

fstat(fd,*buff) This function is identical to stat(), except that it uses a file descriptor instead of a name. (Not
implemented)

unlink(*name) Removes the named file, so that a subsequent attempt to open it fails. Calls _unlink().
(FSS implementation)

write(fd,*buff,cnt) Write a sequence of characters to a file. Calls _write().
(FSS implementation)

2.2.27 wchar.h

Many in wchar.h represent the wide−character variant of other so these are discussed together. (See sections 2.2.22, stdio.h
and wchar.h, 2.2.23, stdlib.h and wchar.h, 2.2.24, string.h and wchar.h and 2.2.25, time.h and wchar.h).

The remaining are described below. They perform conversions between multi−byte characters and wide characters. In these, ps
points to struct mbstate_t which holds the conversion state information necessary to convert between sequences of multibyte
characters and wide characters:

typedef struct
{
     wchar_t         wc_value;  /* wide character value solved so far */
     unsigned short  n_bytes;   /* number of bytes of solved multibyte */
     unsigned short  encoding;  /* encoding rule for wide character <=>
                                   multibyte conversion */
} mbstate_t;

When multibyte characters larger than 1 byte are used, this struct will be used to store the conversion information when not all
the bytes of a particular multibyte character have been read from the source. In this implementation, multi−byte characters are 1
byte long (MB_CUR_MAX and MB_LEN_MAX are defined as 1) and this will never occur.

mbsinit(*ps) Determines whether the object pointed to by ps, is an initial conversion state. Returns
a non−zero value if so.

mbsrtowcs(*pwcs,**src,n,*ps) Restartable version of mbstowcs. See section 2.2.23, stdlib.h and wchar.h. The initial
conversion state is specified by ps. The input sequence of multibyte charactersis
specified indirectly by src.

wcsrtombs(*s,**src,n,*ps) Restartable version of wcstombs. See section 2.2.23, stdlib.h and wchar.h. The initial
conversion state is specified by ps. The input wide string is specified indirectly by src.

mbrtowc(*pwc,*s,n,*ps) Converts a multibyte character *s to a wide character *pwc according to conversion state
ps. See also mbtowc in section 2.2.23,  stdlib.h and wchar.h.

wcrtomb(*s,wc,*ps) Converts a wide character wc to a multi−byte character according to conversion state
ps and stores the multi−byte character in *s.

btowc(c) Returns the wide character corresponding to character c. Returns WEOF on error.

wctob(c) Returns the multi−byte character corresponding to the wide character c. The returned
multi−byte character is represented as one byte. Returns EOF on error.

mbrlen(*s,n,*ps) Inspects up to n bytes from the string *s to see if those characters represent valid
multibyte characters, relative to the conversion state held in *ps.



Libraries

2−23

2.2.28 wctype.h

Most in wctype.h represent the wide−character variant of declared in ctype.h and are discussed in section 2.2.3, ctype.h and
wctype.h. In addition, this header file provides extensible, locale specific, wide character classification.

wctype(*property) Constructs a value of type wctype_t that describes a class of wide characters identified by the
string *property. If property identifies a valid class of wide characters according to the LC_TYPE
category (see section 2.2.13, locale.h) of the current locale, a non−zero value is returned that can
be used as an argument in the iswctype function.

iswctype(wc,desc) Tests whether the wide character wc is a member of the class represented by wctype_t desc.
Returns a non−zero value if tested true.

Function Equivalent to locale specific test

iswalnum(wc) iswctype(wc,wctype("alnum"))

iswalpha(wc) iswctype(wc,wctype("alpha"))

iswcntrl(wc) iswctype(wc,wctype("cntrl"))

iswdigit(wc) iswctype(wc,wctype("digit"))

iswgraph(wc) iswctype(wc,wctype("graph"))

iswlower(wc) iswctype(wc,wctype("lower"))

iswprint(wc) iswctype(wc,wctype("print"))

iswpunct(wc) iswctype(wc,wctype("punct"))

iswspace(wc) iswctype(wc,wctype("space"))

iswupper(wc) iswctype(wc,wctype("upper"))

iswxditig(wc) iswctype(wc,wctype("xdigit"))

wctrans(*property) Constructs a value of type wctype_t that describes a mapping between wide characters identi�
fied by the string *property. If property identifies a valid mapping of wide characters according to
the LC_TYPE category (see section 2.2.13, locale.h) of the current locale, a non−zero value is
returned that can be used as an argument in the towctrans function.

towctrans(wc,desc) Transforms wide character wc into another wide−character, described by desc.

Function Equivalent to locale specific transformation

towlower(wc) towctrans(wc,wctrans("tolower")

towupper(wc) towctrans(wc,wctrans("toupper")
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3 Assembly Language

Summary This chapter describes the most important aspects of the TASKING assembly
language and contains a detailed description of all built−in assembly functions and
assembler directives. For a complete overview of the architecture you are using and
a description of the assembly instruction set, refer to the target’s Core Reference
Manual.

3.1 Assembly Syntax

An assembly program consists of zero or more statements. A statement may optionally be followed by a comment. Any source
statement can be extended to more lines by including the line continuation character (\) as the last character on the line. The
length of a source statement (first line and continuation lines) is only limited by the amount of available memory.

Mnemonics and directives are case insensitive. Labels, symbols, directive arguments, and literal strings are case sensitive.

The syntax of an assembly statement is:

[label[:]] [instruction | directive | macro_call] [;comment]

label A label is a special symbol which is assigned the value and type of the current program location counter. A label
can consist of letters, digits and underscore characters (_). The first character cannot be a digit. The label can
also be a number.  A label which is prefixed by whitespace (spaces or tabs) has to be followed by a colon (:). The
size of an identifier is only limited by the amount of available memory.

number is a number ranging from 1 to 255. This type of label is called a numeric label or local label. To refer to a
numeric label, you must put an n (next) or p (previous) immediately after the label. This is required because the
same label number may be used repeatedly.

Examples:

   LAB1:  ; This label is followed by a colon and
          ; can be prefixed by whitespace
LAB1      ; This label has to start at the beginning
          ; of a line

1: j 1p   ; This is an endless loop
          ; using numeric labels

instruction An instruction consists of a mnemonic and zero, one or more operands. It must not start in the first column.

Operands are described in section 3.3, Operands of an Assembly Instruction. The instructions are described in
the target’s Core Reference Manual.

The instruction can also be a so−called ’generic instruction’. Generic instructions are pseudo instructions (no
instructions from the instruction set). Depending on the situation in which a generic instruction is used, the
assembler replaces the generic instruction with appropriate real assembly instruction(s). For a complete list, see
section 3.10, Generic Instructions.

directive With directives you can control the assembler from within the assembly source. Except for preprocessing
directives, these must not start in the first column. Directives are described in section 3.8, Assembler Directives.

macro_call A call to a previously defined macro. It must not start in the first column. See section 3.9 Macro Operations.

comment Comment, preceded by a ; (semicolon).

You can use empty lines or lines with only comments.
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3.2 Assembler Significant Characters

You can use all ASCII characters in the assembly source both in strings and in comments. Also the extended characters from
the ISO 8859−1 (Latin−1) set are allowed.

Some characters have a special meaning to the assembler. Special characters associated with expression evaluation are
described in section 3.6.3, Expression Operators. Other special assembler characters are:

Character Description

; Start of a comment

\ Line continuation character or

Macro operator: argument concatenation

? Macro operator: return decimal value of a symbol

% Macro operator: return hex value of a symbol

^ Macro operator: override local label

" Macro string delimiter or

Quoted string .DEFINE expansion character

’ String constants delimiter

@ Start of a built−in assembly function

* Location counter substitution

[ ] Substring delimiter

Note that macro operators have a higher precedence than expression operators.

3.3 Operands of an Assembly Instruction

In an instruction, the mnemonic is followed by zero, one or more operands. An operand has one of the following types:

Operand Description

symbol A symbolic name as described in section 3.4, Symbol Names. Symbols can also occur in expressions.

register Any valid register as listed in section 3.5, Registers.

expression Any valid expression as described in section 3.6, Assembly Expressions.

address A combination of expression, register and symbol.

3.4 Symbol Names

User−defined symbols

A user−defined symbol can consist of letters, digits and underscore characters (_). The first character cannot be a digit. The size
of an identifier is only limited by the amount of available memory. The case of these characters is significant. You can define a
symbol by means of a label declaration or an equate or set directive.

Predefined preprocessor symbols

These symbols start and end with two underscore characters, __symbol__, and you can use them in your assembly source to
create conditional assembly. See section 3.4.1, Predefined Preprocessor Symbols.

Labels

Symbols used for memory locations are referred to as labels.

It is allowed to use reserved symbols as labels as long as the label is followed by a colon or starts at the first column
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Reserved symbols

Symbol names and other identifiers beginning with a period (.) are reserved for the system (for example for directives or section
names). Instructions are also reserved. The case of these built−in symbols is insignificant.

Examples

Valid symbol names:

loop_1
ENTRY
a_B_c
_aBC

Invalid symbol names:

1_loop     (starts with a number)

.DEFINE    (reserved directive name)

3.4.1 Predefined Preprocessor Symbols

The TASKING assembler knows the predefined symbols as defined in the table below. The symbols are useful to create
conditional assembly.

Macro Description

__AS3000__ Expands to 1 for the TSK3000 toolset, otherwise unrecognized as macro.

__BUILD__ Identifies the build number of the assembler, composed of decimal digits for the build number,
three digits for the major branch number and three digits for the minor branch number. For
example, if you use build 1.22.1 of the compiler, __BUILD__ expands to 1022001. If there is no
branch number, the branch digits expand to zero. For example, build 127 results in 127000000.

__REVISION__ Identifies the revision number of the assembler. For example, if you use version 1.0r2 of the
compiler, __REVISION__ expands to 2.

__TASKING__ Identifies the assembler as a TASKING assembler. Expands to 1 if a TASKING compiler is used.

__VERSION__ Identifies the version number of the assembler. For example, if you use version 1.0r2 of the
assembler, __VERSION__ expands to 1000 (dot and revision number are omitted, minor version
number in 3 digits).

Table 3−1: Assembler predefined preprocessor symbols

3.5 Registers

The following register names, either upper or lower case, should not be used for user−defined symbol names in an assembly
language source file:

TSK3000 general CPU registers

Name Register Usage

$zero $0 zero register, when reading always has
the value 0

$at $1 assembler temporary

$v0 − $v1 $2 − $3 function value registers

$a0 − $a3 $4 − $7 argument registers

$t0 − $t7 $8 − $15 caller saved registers (temporary)

$s0 − $s7 $16 − $23 callee saved registers

$t8 − $t9 $24 − $25 caller saved registers (temporary)

$k0, $kt0 $26 kernel temporary

$k1, $kt1 $27 kernel temporary

$gp $28 global pointer
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UsageRegisterName

$sp $29 stack pointer

$s8, $fp $30 callee saved register, frame pointer

$ra $31 return address

TSK3000 coprocessor CP0 registers

Name Register Usage

$Status $0 status register

$IEnable $1 interrupt enable register

$IPending $2 interrupt pending register

$TBLO $3 time base low register

$TBHI $4 time bas high register

$PIT $5 programmable interval timer register

$DebugData $6 debug data register

$ER $7 exception return register

$EB $8 exception base register

$IMode $9 interrupt mode register (edge or level−
triggered)

3.6 Assembly Expressions

An expression is a combination of symbols, constants, operators, and parentheses which represent a value that is used as an
operand of an assembler instruction (or directive).

Expressions may contain user−defined labels (and their associated integer values), and any combination of integers or ASCII
literal strings.

Expressions follow the conventional rules of algebra and boolean arithmetic.

Expressions that can be evaluated at assembly time are called absolute expressions. Expressions where the result is unknown
until all sections have been combined and located, are called relocatable or relative expressions.

When any operand of an expression is relocatable, the entire expression is relocatable. Relocatable expressions are emitted in
the object file and evaluated by the linker.

The assembler evaluates expressions with 64−bit precision in two’s complement.

The syntax of an expression can be any of the following:

− numeric contant

− string

− symbol

− expression binary_operator expression

− unary_operator expression

− ( expression )

− function call

All types of expressions are explained in separate sections.
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3.6.1 Numeric Constants

Numeric constants can be used in expressions. If there is no prefix, by default the assembler assumes the number is a decimal
number.

Base Description Example

Binary A 0b prefix followed by binary digits (0,1). Or use a b suffix 0b1101
11001010b

Hexadecimal A 0x prefix followed by a hexadecimal digits (0−9, A−F, a−f). Or use a h suffix
0x12FF
0x45
0fa10h

Decimal,
integer Decimal digits (0−9).

12
1245

Table 3−2: Numeric constants

3.6.2 Strings

ASCII characters, enclosed in single (’) or double (″) quotes constitue an ASCII string. Strings between double quotes allow
symbol substitution by a .DEFINE directive, whereas strings between single quotes are always literal strings. Both types of
strings can contain escape characters.

Strings constants in expressions are evaluated to a number (each character is replaced by its ASCII value). Strings in
expressions can have a size of up to 8 characters or less depending on the operand of an instruction or directive; any
subsequent characters in the string are ignored. In this case the assembler issues a warning. An exception to this rule is when a
string is used in a .DB assembler directive; in that case all characters result in a constant value of the specified size. Null strings
have a value of 0.

Square brackets ([ ]) delimit a substring operation in the form:

[string,offset,length]

offset is the start position within string. length is the length of the desired substring. Both values may not exceed the size of
string.

Examples

’ABCD’              ; (0x41424344)

’’’79’              ; to enclose a quote double it

"A\"BC"             ; or to enclose a quote escape it

’AB’+1              ; (0x4143) string used in expression

’’                  ; null string

[’TASKING’,0,4]     ; results in the substring ’TASK’

3.6.3 Expression Operators

The next table shows the assembler operators. They are ordered according to their precedence. Operators of the same
precedence are evaluated left to right. Parenthetical expressions have the highest priority (innermost first).

Valid operands include numeric constants, literal ASCII strings and symbols.

Type Oper
ator

Name Description

( ) parenthesis Expressions enclosed by parenthesis are evaluated first.

Unary + plus Returns the value of its operand.

− minus Returns the negative of its operand.

~ complement Returns complement, integer only

! logical negate Returns 1 if the operands’ value is 0; otherwise 0. For example, if buf is 0 then
!buf is 1.
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DescriptionNameOper
ator

Type

Arithmetic * multiplication Yields the product of two operands.

/ division Yields the quotient of the division of the first operand by the second.
With integers, the divide operation produces a truncated integer.

% modulo Integer only: yields the remainder from a division of the first operand by the
second.

+ addition Yields the sum of its operands.

− subtraction Yields the difference of its operands.

Shift << shift left Integer only: shifts the left operand to the left (zero−filled) by the number of bits
specified by the right operand.

>> shift right Integer only: shifts the left operand to the right (sign bit extended) by the number
of bits specified by the right operand.

Relational <

<=

>

>=

==

!=

less than

less or equal

greater than

greater or equal

equal

not equal

Returns:

    an integer 1 if the indicated condition is TRUE.

    an integer 0 if the indicated condition is FALSE.

Bitwise & AND Integer only: yields bitwise AND

| OR Integer only: yields bitwise OR

^ exclusive OR Integer only: yields bitwise exlusive OR

Logical && logical AND Returns an integer 1 if both operands are non−zero; otherwise, it returns an
integer 0.

|| logical OR Returns an integer 1 if either of the operands is non−zero; otherwise, it returns an
integer 1

Table 3−3: Assembly expression operators

3.7 Built−in Assembly Functions

The TASKING assemblers have several built−in functions to support data conversion, string comparison, and math
computations. You can use functions as terms in any expression.

Syntax of an assembly function

@function_name([argument[,argument]...])

Functions start with ’@’ character and have zero or more arguments, and are always followed by opening and closing
parentheses. White space (a blank or tab) is not allowed between the function name and the opening parenthesis and between
the (comma−separated) arguments.

3.7.1 Overview of Built−in Assembly Functions

The following table provides an overview of all built−in assembly functions. Next all functions are described into more detail. expr
can be any assembly expression resulting in an integer value. Expressions are explained in section 3.6, Assembly Expressions.

Overview of assembly functions

Function Description

@ARG(’symbol’|expr) Test whether macro argument is present

@CNT() Return number of macro arguments

@DEFINED(’symbol’|symbol) Test whether symbol exists

@GPREL(symbol) Offset of symbol from the global pointer (R28)
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DescriptionFunction

@HI(expr) Most significant half word of the expression, sign adjusted

@LO(expr) Least significant half word of the expression, sign adjusted

@LSB(expr) Least significant byte of the expression

@LSH(expr) Least significant half word of the absolute expression

@LSW(expr) Least significant word of the expression

@MSB(expr) Most significant byte of the expression

@MSH(expr) Most significant half word of the absolute expression

@MSW(expr) Most significant word of the expression

@STRCAT(str1,str2) Concatenate str1 and str2

@STRCMP(str1,str2) Compare str1 with str2

@STRLEN(str) Return length of string

@STRPOS(str1,str2[,start]) Return position of str1 in str2

3.7.2 Detailed Description of Built−in Assembly Functions

@ARG(’symbol’ | expression)

Returns integer 1 if the macro argument represented by symbol or expression is present, 0 otherwise.

You can specify the argument with a symbol name (the name of a macro argument enclosed in single quotes) or with expression
(the ordinal number of the argument in the macro formal argument list).

If you use this function when macro expansion is not active, the assembler issues a warning.

Example:

.IF @ARG(’TWIDDLE’) ;is argument twiddle present?

.IF @ARG(1)         ;is first argument present?

@CNT()

Returns the number of macro arguments of the current macro expansion as an integer.

If you use this function when macro expansion is not active, the assembler issues a warning.

Example:

ARGCOUNT .SET @CNT() ; reserve argument count

@DEFINED(’symbol’ | symbol)

Returns 1 if symbol has been defined, 0 otherwise. If symbol is quoted, it is looked up as a .DEFINE symbol; if it is not quoted, it
is looked up as an ordinary symbol, macro or label.

Example:

.IF @DEFINED(’ANGLE’)            ;is symbol ANGLE defined?

.IF @DEFINED(ANGLE)              ;does label ANGLE exist?

@GPREL(symbol)

Returns the offset of symbol from the global pointer ($28).

If you want the assembler to generate GP−relative offsets automatically (option −−gp−relative) enable the option Automatically
generate GP−relative offsets in the Assembler Miscellaneous page of the Project Options dialog.

@HI(expression)

Returns the most significant half word of the result of the expression, adjusted for signed addition. @HI(expression) is
equivalent to ((expression>> 16) + ((expression & 0x8000) ? 1 : 0)) & 0xFFFF. expression can be any
relocatable or absolute expression.
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Example:

; The instruction  lw $2, label expands to
lui at, @hi(label)
lw  $2, @lo(label)(at)

@LO(expression)

Returns the least significant half word (bits 0..15) of the result of the expression, adjusted for signed addition. expression can be
any relocatable or absolute expression.

@LSB(expression)

Returns the least significant byte of the result of the expression.
The result of the expression is calculated as 16 bits.

@LSH(expression)

Returns the least significant half word (bits 0..15) of the result of the absolute expression.
The result of the expression is calculated as a word (32 bits).

@LSW(expression)

Returns the least significant word (bits 0..31) of the result of the expression.
The result of the expression is calculated as a double−word (64 bits).

@MSB(expression)

Returns the most significant byte of the result of the expression.
The result of the expression is calculated as16 bits.

@MSH(expression)

Returns the most significant half word (bits 16..31) of the result of the absolute expression.
The result of the expression is calculated as a word (32 bits).  @MSH(expression) is equivalent to ((expression>>16) &
0xffff).

@MSW(expression)

Returns the most significant word (bits 32..63) of the result of the expression.
The result of the expression is calculated as a double−word (64 bits).

@STRCAT(string1,string2)

Concatenates string1 and string2 and returns them as a single string.
You must enclose string1 and string2 either with single quotes or with double quotes.

Example:

.DEFINE ID "@STRCAT(’TAS’,’KING’)"  ; ID = ’TASKING’

@STRCMP(string1,string2)

Compares string1 with string2 by comparing the characters in the string. The function returns the difference between the
characters at the first position where they disagree, or zero when the strings are equal:

<0 if string1 < string2

0 if string1 == string2

>0 if string1 > string2

Example:

.IF (@STRCMP(STR,’MAIN’))==0  ; does STR equal ’MAIN’?
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@STRLEN(string)

Returns the length of string as an integer.

Example:

SLEN SET @STRLEN(’string’)    ; SLEN = 6

@STRPOS(string1,string2[,start])

Returns the position of string2 in string1 as an integer. If string2 does not occur in string1, the last string postition + 1 is returned.

With start you can specify the starting position of the search. If you do not specify start, the search is started from the beginning
of string1.

Example:

ID .set @STRPOS(’TASKING’,’ASK’)  ; ID = 1
ID .set @STRPOS(’TASKING’,’BUG’)  ; ID = 7

3.8 Assembler Directives

An assembler directive is simply a message to the assembler. Assembler directives are not translated into machine instructions,
but can produce data. There are three types of assembler directives.

• Assembler directives that tell the assembler how to go about translating instructions into machine code. This is the most
typical form of assembly directives. Typically they tell the assembler where to put a program in memory, what space to
allocate for variables, and allow you to initialize memory with data. When the assembly source is assembled, a location
counter in the assembler keeps track of where the code and data is to go in memory.

The following directives fall under this group:

− Assembly control directives

− Symbol definition directives

− Data definition / Storage allocation directives

− HLL directives

• Directives that are interpreted by the macro preprocessor. These directives tell the macro preprocessor how to manipulate
your assembly code before it is actually being assembled. You can use these directives to write macros and to write
conditional source code. Parts of the code that do not match the condition, will not be assembled at all. Unlike other
directives, preprocesssor directives can start in the first column.

• Some directives act as assembler options and most of them indeed do have an equivalent assembler (command line) option.
The advantage of using a directive is that with such a directive you can overrule the assembler option for a particular part of
the code. A typical example is to tell the assembler with an option to generate a list file while with the directives .NOLIST
and .LIST you overrule this option for a part of the code that you do not want to appear in the list file. Directives of this kind
sometimes are called controls.

Each assembler directive has its own syntax. Some assembler directives can be preceded with a label. If you do not precede an
assembler directive with a label, you must use white space instead (spaces or tabs). You can use assembler directives in the
assembly code as pseudo instructions.

3.8.1 Overview of Assembler Directives

The following tables provide an overview of all assembler directives. For a detailed description of these directives, refer to
section 3.8.2, Detailed Description of Assembler Directives.

Overview of assembly control directives

Directive Description

.END Indicates the end of an assembly module

.INCLUDE Include file

.MESSAGE Programmer generated message
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Overview of symbol definition directives

Directive Description

.EQU Set permanent value to a symbol

.EXTERN Import global section symbol

.GLOBAL Declare global section symbol

.RESUME Resume a previously defined section

.SECTION/.ENDSEC Start a new section

.SET Set temporary value to a symbol

.SIZE Set size of symbol in the ELF symbol table

.SOURCE Specify name of original C source file

.TYPE Set symbol type in the ELF symbol table

.WEAK Mark a symbol as ’weak’

Overview of data definition / storage allocation directives

Directive Description

.ALIGN Align location counter

.BS/.BSB/.BSH/

.BSW/.BSD
Define block storage (initialized)

.DB Define byte

.DH Define half word

.DW Define word

.DD Define double−word

.DS/.DSB/.DSH/

.DSW/.DSD
Define storage

.OFFSET Move location counter forwards

Overview of macro and conditional assembly directives

Directive Description

.DEFINE Define substitution string

.BREAK Break out of current macro expansion

.REPEAT/.ENDREP Repeat sequence of source lines

.FOR/.ENDFOR Repeat sequence of source lines n times

.IF/.ELIF/.ELSE Conditional assembly directive

.ENDIF End of conditional assembly directive

.MACRO/.ENDM Define macro

.UNDEF Undefine .DEFINE symbol or macro

Overview of listing control assembly directives

Directive Description

.LIST/.NOLIST Print / do not print source lines to list file

.PAGE Set top of page/size of page

.TITLE Set program title in header of assembly list file
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Overview of HLL directives

Directive Description

.CALLS Pass call tree information

TSK3000 specific directive

Directive Description

.NOPINSERTION Insert a NOP instruction after jump and branch instructions

.NONOPINSERTION No extra NOP instruction after jump and branch instructions

3.8.2 Detailed Description of Assembler Directives

.ALIGN

Syntax

.ALIGN expression

Description

With the .ALIGN directive you tell the assembler to align the location counter.

When the assembler encounters the .ALIGN directive, it moves the location counter forwards to an address that is aligned as
specified by expression and places the next instruction or directive on that address. The alignment is in minimal addressable
units (MAUs). The assembler fills the ’gap’ with NOP instructions. If the location counter is already aligned on the specified
alignment, it remains unchanged. The location of absolute sections will not be changed.

The expression must be a power of two: 2, 4, 8, 16, ... If you specify another value, the assembler changes the alignment to the
next higher power of two and issues a warning.

Examples

.SECTION .text

.ALIGN 16    ; the assembler aligns
instruction  ; this instruction at 16 MAUs and
             ; fills the ’gap’ with NOP instructions.

.SECTION .text

.ALIGN 12    ; WRONG: not a power of two, the
instruction  ; assembler aligns this instruction at
             ; 16 MAUs and issues a warning.
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.BREAK

Syntax

.BREAK

Description

The .BREAK directive causes immediate termination of a macro expansion, a .FOR loop exansion or a .REPEAT loop
expansion. In case of nested loops or macros, the .BREAK directive returns to the previous level of expansion.

The .BREAK directive is, for example, useful in combination with the .IF directive to terminate expansion when error conditions
are detected.

Example

.FOR MYVAR IN 10 TO 20
  ...   ;
  ...   ; assembly source lines
  ...   ;
  .IF MYVAR > 15
    .BREAK
  .ENDIF
.ENDREP
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.BS/.BSB/.BSH/.BSW/.BSD

Syntax

[label]  .BS expression1[,expression2]

[label]  .BSB expression1[,expression2]

[label]  .BSH expression1[,expression2]

[label]  .BSW expression1[,expression2]

[label]  .BSD expression1[,expression2]

Description

With the .BS directive (Block Storage) the assembler reserves a block of memory. The reserved block of memory is initialized to
the value of expression2, or zero if omitted.

With expression1 you specify the number of minimum addressable units (MAUs) you want to reserve, and how much the
location counter will advance. The expression must be an integer greater than zero and cannot contain any forward references
to address labels (labels that have not yet been defined).

With expression2 you can specify a value to initialize the block with. Only the least significant MAU of expression2 is used. If
you omit expression2, the default is zero.

If you specify label, it gets the value of the location counter at the start of the directive processing.

You cannot initialize of a block of memory in sections with prefix .sbss or .bss. In those sections, the assembler issues
a warning and only reserves space, just as with .DS.

The .BSB, .BSH, .BSW and .BSD directives are variants of the .BS directive:

.BSB The expression1 argument specifies the number of bytes to reserve.

.BSH The expression1 argument specifies the number of half words to reserve (one half word is16 bits).

.BSW The expression1 argument specifies the number of words to reserve (one word is 32 bits).

.BSD The expression1 argument specifies the number of double−words to reserve (one double−word is 64 bits).

Example

The .BSB directive is for example useful to define and initialize an array that is only partially filled:

.section .sdata

.DB 84,101,115,116  ; initialize 4 bytes

.BSB 96,0xFF        ; reserve another 96 bytes, initialized with 0xFF

Related information

.DS    (Define Storage)
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.CALLS

Syntax

.CALLS ’caller’, ’callee’

or

.CALLS ’caller’, ’’,stack0_usage[,stack1_usage]...

Description

The first syntax creates a call graph reference between caller and callee. The linker needs this information to build a call graph.
If applicable the call graph is used to create a static stack overlay. caller and callee are names of functions.

The second syntax specifies stack information. When callee is an empty name, this means we define the stack usage of the
function itself. The values specified are the stack usage in bytes at the time of the call including the return address. This
information is used by the linker to compute the used stack within the application. The information is found in the generated
linker map file within the Memory Usage.

Normally .CALLS directives are automatically generated by the compiler. Use the .CALLS directive in hand coded assembly
when the assembly code calls a C function. If you manually add .CALLS directives, make sure they connect to the compiler
generated .CALLS directives: the name of the caller must also be named as a callee in another directive.

Example

.CALLS ’main’,’nfunc’

Indicates that the function main calls the function nfunc

.CALLS ’main’,’’,8

The function main  uses 8 bytes on the stack.
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.DB

Syntax

[label] .DB argument[,argument]...

Description

With the .DB directive (Define Byte) the assembler allocates and initializes one byte of memory for each argument.

An argument can be:

• a single or multiple character string constant

• an integer expression

• NULL (indicated by two adjacent commas: ,,)

If you specify label, it gets the value of the location counter at the start of the directive processing.

Multiple arguments are stored in successive address locations. If an argument is NULL, its corresponding address location is
flled with zeros.

Integer arguments are stored as is, but must be byte values (within the range 0−255); floating−point numbers are not allowed. If
the evaluated expression is out of the range [−256, +255] the assembler issues an error. For negative values within that range,
the assembler adds 256 to the specified value (for example, −254 is stored as 2).

In case of single and multiple character strings, each character is stored in consecutive bytes whose lower seven bits represent
the ASCII value of the character. The standard C escape sequences are allowed:

.DB ’R’        ; = 0x52

.DB ’AB’,,’D’  ; = 0x41420043 (second argument is empty)

Example

TABLE:  .DB 14,253,0x62,’ABCD’
CHARS:  .DB ’A’,’B’,,’C’,’D’

Related information

.BS    (Block Storage)

.DS    (Define Storage)

.DH   (Define Half Word)

.DW   (Define Word)

.DD   (Define Double−Word)
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.DD

Syntax

[label] .DD argument[,argument]...

Description

With the .DD directive (Define Double−Word) you allocate and initialize one double−word of memory for each argument.

One double−word is 64 bits.

An argument is:

• a single or multiple character string constant

• an expression

• NULL (indicated by two adjacent commas: ,,)

If you specify label, it gets the value of the location counter at the start of the directive processing.

Multiple arguments are stored in sets of eight bytes. If an argument is NULL, its corresponding address locations are flled with
zeros.

Double−word arguments are stored as is. Floating−point values are not allowed. If the evaluated argument is too large to be
represented in a double−word, the assembler issues a warning and truncates the value.

In case of character strings, each ASCII value of the character is stored in successive locations starting at the least significant
byte of a double−word:

.DD ’AB’,,’D’ => 0x000000000004142
                 0x000000000000000 (second argument is empty) 
                 0x000000000000044

Example

TABLE:  .DD 14,253,0x62,’ABCD’
CHARS:  .DD ’A’,’B’,,’C’,’D’

Related information

.BS    (Block Storage)

.DS    (Define Storage)

.DB    (Define Byte)

.DH   (Define Half Word)

.DW   (Define Word)
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.DEFINE

Syntax

.DEFINE symbol string

Description

With the .DEFINE directive you define a substitution string that you can use on all following source lines. The assembler
searches all succeeding lines for an occurrence of symbol, and replaces it with string. If the symbol occurs in a double quoted
string it is also replaced. Strings between single quotes are not expanded.

This directive is useful for providing better documentation in the source program. A symbol can consist of letters, digits and
underscore characters (_), and the first character cannot be a digit.

The assembler issues a warning if you redefine an existing symbol.

Example

Suppose you defined the symbol LEN with the substitution string "32":

.DEFINE LEN "32"

Then you can use the symbol LEN for example as follows:

.DS LEN

.MESSAGE I "The length is: LEN"

The assembler preprocessor replaces LEN with �32" and assembles the following lines:

.DS 32

.MESSAGE I "The length is: 32"

Related information

.UNDEF (Undefine a .DEFINE symbol or macro)

.MACRO/.ENDM (Define a macro)
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.DH

Syntax

[label] .DH argument[,argument]...

Description

With the .DH directive (Define Half Word) you allocate and initialize a half word of memory for each argument.

A half word is 16 bits.

An argument is:

• a single or multiple character string constant

• an expression

• NULL (indicated by two adjacent commas: ,,)

If you specify label, it gets the value of the location counter at the start of the directive processing.

Multiple arguments are stored in successive half word address locations. If an argument is NULL, its corresponding address
location is filled with zeros.

Half word arguments are stored as is. Floating−point values are not allowed.

If the evaluated argument is too large to be represented in a half word, the assembler issues a warning and truncates the value.

In case of single and multiple character strings, each ASCII value of the character is stored in successive locations starting at
the least significant byte of a half word. The standard C escape sequences are allowed:

.DH ’AB’,,’D’ => 0x4142
                 0x0000 (second argument is empty) 
                 0x0044

Example

TABLE:  .DH 14,253,0x62,’ABCD’
CHARS:  .DH ’A’,’B’,,’C’,’D’

Related information

.BS    (Block Storage)

.DS    (Define Storage)

.DB    (Define Byte)

.DW   (Define Word)

.DD   (Define Double−Word)
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.DS/.DSB/.DSH/.DSW/.DSD

Syntax

[label] .DS expression

[label] .DSB expression

[label] .DSH expression

[label] .DSW expression

[label] .DSD expression

Description

With the .DS directive (Define Storage) the assembler reserves a block of memory. The reserved block of memory is not
initialized to any value.

With the expression you specify the number of minimum addressable units (MAUs) that you want to reserve. The expression
must evaluate to an integer larger than zero and cannot contain references to symbols that are not yet defined in the assembly
source.

If you specify label, it gets the value of the location counter at the start of the directive processing.

You cannot use the .DS directive in sections with attribute init. If you need to reserve initialized space in an init section,
use the .BS directive instead.

The .DSB, .DSH , .DSW and .DSD directives are variants of the .DS directive:

.DSB The expression argument specifies the number of bytes to reserve.

.DSH The expression argument specifies the number of half words to reserve (one half word is16 bits).

.DSW The expression argument specifies the number of words to reserve (one word is 32 bits).

.DSD The expression argument specifies the number of double−words to reserve (one double−word is 64 bits).

Example

RES:  .DS 5+3   ; allocate 8 bytes

Related information

.BS    (Block Storage)

.DB    (Define Byte)

.DH   (Define Half Word)

.DW   (Define Word)

.DD   (Define Double−Word)
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.DW

Syntax

[label] .DW argument[,argument]...

Description

With the .DW directive (Define Word) you allocate and initialize one word of memory for each argument.

One word is 32 bits.

An argument is:

• a single or multiple character string constant

• an expression

• NULL (indicated by two adjacent commas: ,,)

If you specify label, it gets the value of the location counter at the start of the directive processing.

Multiple arguments are stored in sets of four bytes. If an argument is NULL, its corresponding address locations are flled with
zeros.

Word arguments are stored as is. Floating−point values are not allowed. If the evaluated argument is too large to be represented
in a word, the assembler issues a warning and truncates the value.

In case of single and multiple character strings, each ASCII value of the character is stored in successive locations starting at
the least significant byte of a word. The standard C escape sequences are allowed:

.DW ’AB’,,’D’ => 0x0004142
                 0x0000000 (second argument is empty) 
                 0x0000044

Example

TABLE:  .DW 14,253,0x62,’ABCD’
CHARS:  .DW ’A’,’B’,,’C’,’D’

Related information

.BS    (Block Storage)

.DS    (Define Storage)

.DB    (Define Byte)

.DH   (Define Half Word)

.DD   (Define Double−Word)
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.END

Syntax

.END

Description

With the .END directive you tell the assembler that the end of the module is reached. If the assembler finds assembly source
lines beyond the .END directive, it ignores those lines and issues a warning.

Example

.section .text
   ; source lines
.END                  ; End of assembly module
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.EQU

Syntax

symbol  .EQU  expression

Description

With the .EQU directive you assign the value of expression to symbol permanently. Once defined, you cannot redefine the
symbol. With the .GLOBAL directive you can define the symbol global.

Example

To assign the value 0x4000 permanently to the symbol MYSYMBOL:

MYSYMBOL .EQU  0x4000

You cannot redefine the used symbols.

Related information

.SET (Set temporary value to a symbol)
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.EXTERN

Syntax

.EXTERN symbol[,symbol]...

Description

With the .EXTERN directive you define an external symbol. It means that the symbol is referenced in the current module while it
is defined outside the current module.

You must define the symbols either outside any module or declare it as globally accessible within another module with the
.GLOBAL directive.

If you do not use the .EXTERN directive and the symbol is not defined within the current module, the assembler issues a
warning and inserts the .EXTERN directive.

Example

.EXTERN  AA,CC,DD  ; defined elsewhere

Related information

.GLOBAL (Declare global section symbol)
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.FOR/.ENDFOR

Syntax

[label] .FOR var IN expression[,expression]...
....
.ENDFOR

or:

[label] .FOR var IN start TO end [STEP step]
....
.ENDFOR

Description

With the .FOR/.ENDFOR directive you can repeat a sequence of assembly source lines with an iterator. As shown by the
syntax, you can use the .FOR/.ENDFOR in two ways.

1. In the first mehod, the loop is repeated as many times as the number of arguments following IN. If you use the symbol var in
the assembly lines between .FOR and .ENDFOR, for each repetition the symbol var is substituted by a subsequent
expression from the argument list. If the argument is a null, then the loop is repeated with each occurrence of the symbol var
removed.

2. In the second method, the loop is repeated using the symbol var as a counter. The counter passes all integer values from
start to end with a step. If you do not specify step, the counter is increased by one for every repetition.

If you specify label, it gets the value of the location counter at the start of the directive processing.

Example

In the following example the loop is repeated 4 times (there are four arguments). With the .DB directive you allocate and
initialize a byte of memory for each repetition of the loop (a word for the .DW directive). Effectively, the preprocessor duplicates
the .DB and .DW directives four times in the assembly source.

.FOR VAR1 IN 1,2+3,4,12
     .DB VAR1
     .DW (VAR1*VAR1)
.ENDFOR

In the following example the loop is repeated 16 times. With the .DW directive you allocate and initialize four bytes of memory for
each repetition of the loop. Effectively, the preprocessor duplicates the .DW directive16 times in the assembled file, and
substitutes VAR2 with the subsequent numbers.

.FOR VAR2 IN 1 to 0x10
     .DW (VAR1*VAR1)
.ENDFOR

Related information

.REPEAT/.ENDREP (Repeat sequence of source lines)
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.GLOBAL

Syntax

.GLOBAL symbol[,symbol]...

Description

All symbols or labels defined in the current section or module are local to the module by default. You can change this default
behavior with assembler option −ig.

With the .GLOBAL directive you declare one of more symbols as global. It means that the specified symbols are defined within
the current section or module, and that those definitions should be accessible by all modules.

To access a symbol, defined with .GLOBAL, from another module, use the .EXTERN directive.

Only program labels and symbols defined with .EQU can be made global.

Example

LOOPA .EQU 1          ; definition of symbol LOOPA
      .GLOBAL  LOOPA  ; LOOPA will be globally
                      ; accessible by other modules

Related information

.EXTERN (Import global section symbol)
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.IF/.ELIF/.ELSE/.ENDIF

Syntax

.IF  expression
 .
 .
[.ELIF  expression] (the .ELIF directive is optional)
 .
 .
[.ELSE]  (the .ELSE directive is optional)
 .
 .
.ENDIF

Description

With the .IF/.ENDIF directives you can create a part of conditional assembly code. The assembler assembles only the code
that matches a specified condition.

The expression must evaluate to an integer and cannot contain forward references. If expression evaluates to zero, the
IF−condition is considered FALSE, any non−zero result of expression is considered as TRUE.

You can nest .IF directives to any level. The .ELSE and .ELIF directive always refer to the nearest previous .IF directive.

Example

Suppose you have an assemble source file with specific code for a test version, for a demo version and for the final version.
Within the assembly source you define this code conditionally as follows:

.IF   TEST

... ; code for the test version

.ELIF DEMO

... ; code for the demo version

.ELSE

... ; code for the final version

.ENDIF

Before assembling the file you can set the values of the symbols TEST and DEMO in the assembly source before the .IF
directive is reached. For example, to assemble the demo version:

TEST .SET 0
DEMO .SET 1

You can also define the symbols in Altium Designer as preprocessor macros in dialog Project » Project Options » Assembler
» Preprocessing (assembler option −−define).

Related information

Assembler option −−define (Define preprocessor macro) in Section 4.2, Assembler Options, of Chapter Tool Options.
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.INCLUDE

Syntax

.INCLUDE "filename" | <filename>

Description

With the .INCLUDE directive you include another file at the exact location where the .INCLUDE occurs. This happens before
the resulting file is assembled. The .INCLUDE directive works similarly to the #include statement in C. The source from the
include file is assembled as if it followed the point of the .INCLUDE directive. When the end of the included file is reached,
assembly of the original file continues.

The string specifies the filename of the file to be included. The filename must be compatible with the operating system
(forward/backward slashes) and can contain a directory specification. If you omit a filename extension, the assembler assumes
the extension .asm.

If an absolute pathname is specified, the assembler searches for that file. If a relative path is specified or just a filename, the
order in which the assembler searches for include files is:

1. The current directory if you use the "filename" construction.

The current directory is not searched if you use the <filename> syntax.

2. The path that is specified with the assembler option −−include−directory (−I).

3. The path that is specified in the environment variable AStargetINC when the product was installed.

4. The default directory ...\ctarget\include.

Example

Suppose that your assembly source file test.src contains the following line:

.INCLUDE "c:\myincludes\myinc.inc"

The assembler issues an error if it cannot find the file at the specified location.

.INCLUDE "myinc.inc"

The assembler searches the file myinc.inc according to the rules described above.

Related information

Assembler option −−include−directory (Add directory to include file search path) in Section 4.2, Assembler Options, of
Chapter Tool Options.
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.LIST/.NOLIST

Syntax

.NOLIST

.

.  ; assembly source lines

.

.LIST

Description

If you generate a list file (see assembler option −−list−file), you can use the .LIST and .NOLIST directives to specify which
source lines the assembler must write to the list file.

The assembler prints all source lines to the list file, untill it encounters a .NOLIST directive. The assembler does not print the
.NOLIST directive and subsequent source lines. When the assembler encounters the .LIST directive, it resumes printing to the
list file, starting with the .LIST directive itself.

It is possible to nest the .LIST/.NOLIST directives.

Example

Suppose you assemble the following assembly code with the assembler option −−list−file:

.SECTION .text

...  ; source line 1

.NOLIST

...  ; source line 2

.LIST

...  ; source line 3

.END

The assembler generates a list file with the following lines:

.SECTION .text

...  ; source line 1

.LIST

...  ; source line 3

.END

Related information

Assembler option −−list−file (Generate list file) in Section 4.2, Assembler Options, of Chapter Tool Options.
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.MACRO/.ENDM

Syntax

macro_name .MACRO [argument[,argument]...]
...
macro_definition_statements
...
.ENDM

Description

With the .MACRO directive you define a macro. Macros provide a shorthand method for handling a repeated pattern of code or
group of instructions. You can define the pattern as a macro, and then call the macro at the points in the program where the
pattern would repeat.

The definition of a macro consists of three parts:

• Header, which assigns a name to the macro and defines the arguments.

• Body, which contains the code or instructions to be inserted when the macro is called.

• Terminator, which indicates the end of the macro definition (.ENDM directive).

The arguments are symbolic names that the macro processor replaces with the literal arguments when the macro is expanded
(called). Each formal argument must follow the same rules as symbol names: the name can consist of letters, digits and
underscore characters (_). The first character cannot be a digit.  Argument names cannot start with a percent sign (%).

Macro definitions can be nested but the nested macro will not be defined until the primary macro is expanded.

You can use the following operators in macro definition statements:

Operator Name Description

\ Macro argument
concatenation

Concatenates a macro argument with adjacent alphanumeric characters.

? Return decimal
value of symbol

Substitutes the ?symbol sequence with a character string that represents the decimal value
of the symbol.

% Return hex
value of symbol

Substitutes the %symbol sequence with a character string that represents the hexadecimal
value of the symbol.

" Macro string
delimiter

Allows the use of macro arguments as literal strings.

^ Macro local label
override

Prevents name mangling on labels in macros.

Example

The macro definition:

macro_a  .MACRO  arg1,arg2                   ;header
    .db arg1                                 ;body
    .dw (arg1*arg2)
    .ENDM                                    ;terminator

The macro call:

.section  .data
macro_a 2,3

The macro expands as follows:

.db 2

.dw (2*3)
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Related information

.DEFINE (Define a substitution string)
Section 3.9, Macro Operations.
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.MESSAGE

Syntax

.MESSAGE type [{str|exp|symbol}[,{str|exp|symbol}]...]

Description

With the .MESSAGE directive you tell the assembler to print a message to stdout during the assembling process.

With type you can specify the following types of messages:

I Information message. Error and warning counts are not affected and the assembler continues the assembling process.

W Warning message. Increments the warning count and the assembler continues the assembling process.

E Error message. Increments the error count and the assembler continues the assembling process.

F Fatal error message. The assembler immediately aborts the assembling process and generates no object file or list file.

The .MESSAGE directive is for example useful in combination with conditional assembly to indicate which part is assembled.

Example

   .MESSAGE I ’Generating tables’

ID .EQU 4
   .MESSAGE E ’The value of ID is ’,ID

   .DEFINE LONG "SHORT"
   .MESSAGE I ’This is a LONG string’
   .MESSAGE I "This is a LONG string"

Within single quotes, the defined symbol LONG is not expanded. Within double quotes the symbol LONG is expanded so the
actual message is printed as:

This is a LONG string
This is a SHORT string
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.NOPINSERTION/.NONOPINSERTION

Syntax

.NOPINSERTION

.

.  ; assembly source lines

.

.NONOPINSERTION

Description

You can instruct the assembler to automatically fill the delay slots of jump and branch instructions with a NOP instruction (see
assembler option −−nop−insertion). With the .NOPINSERTION and .NONOPINSERTION directives you have more control over
te NOP insertion.

Example

.section .text

.nopinsertion
  jr      $2       ; a nop is added after each instruction
  jalr    $2,$3
.nonopinsertion
  jr      $2       ; no extra nop instruction is added
  jalr    $2,$3

Related information

Assembler option −−nop−insertion in Section 4.2, Assembler Options, of Chapter Tool Options.
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.OFFSET

Syntax

.OFFSET expression

Description

With the .OFFSET directive you tell the assembler to give the location counter a new offset relative to the start of the section.

When the assembler encounters the .OFFSET directive, it moves the location counter forwards to the specified address, relative
to the start of the section, and places the next instruction on that address. If you specify an address equal to or lower than the
current position of the location counter, the assembler issues an error.

Example

.SECTION .text
nop
nop
nop
.OFFSET 0x20   ; the assembler places
nop            ; this instruction at address 0x20
               ; relative to the start of the section.

.SECTION .text
nop
nop
nop
.OFFSET 0x02   ; WRONG: the current position of the
nop            ; location counter is 0x0C.
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.PAGE

Syntax

.PAGE [width,length,blanktop,blankbtm,blankleft]

Description

If you generate a list file (see assembler option −−list−file), you can use the .PAGE directive to format the generated list file.

width Number of characters on a line (1−255). Default is 132.

length Number of lines per page (10−255). Default is 66.

blanktop Number of blank lines at the top of the page. Default = 0.
Specify a value so that blanktop + blankbtm ≤ length − 10.

blankbtm Number of blank lines at the bottom of the page. Default = 0.
Specify a value so that blanktop + blankbtm ≤ length − 10.

blankleft Number of blank columns at the left of the page. Default = 0. Specify a value smaller than width.

If you use the .PAGE directive without arguments, it causes a ’formfeed’: the next source line is printed on the next page in the
list file.

You can omit an argument by using two adjacent commas. If the remaining arguments after an argument are all empty, you can
omit them.

A label is not allowed with this directive.

Example

.PAGE      ; formfeed, the next source line is printed
           ; on the next page in the list file.

.PAGE 96   ; set pagewidth to 96. Note that you can
           ; omit the last four arguments

.PAGE ,,5  ; insert five blank lines at the top. Note
           ; that you can omit the last two arguments.

Related information

.TITLE (Set program title in header of assembler list file)
Assembler option −−list−file (Generate list file) in Section 4.2, Assembler Options, of Chapter Tool Options.
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.REPEAT/.ENDREP

Syntax

[label] .REPEAT expression
....
.ENDREP

Description

With the .REPEAT/.ENDREP directive you can repeat a sequence of assembly source lines. With expression you specify the
number of times the loop is repeated.

If you specify label, it gets the value of the location counter at the start of the directive processing.

Example

In this example the loop is repeated 3 times. Effectively, the preprocessor repeats the source lines (.DB 10) three times, then
the assembler assembles the result:

.REPEAT 3

.DB 10  ; assembly source lines

.ENDREP

Related information

.FOR/.ENDFOR (Repeat sequence of source lines n times)
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.RESUME

Syntax

.RESUME name [, attribute]...

Description

With the .SECTION directive you always start a new section. With the .RESUME directive you can reactivate a previously
defined section. See the .SECTION directive for a list of available section attributes. If you omit the attribute, the previously
defined section with the same name is reactivated (ignoring the attribute(s)). If you specify an attribute you reactivate the section
with that same attribute.

Example

.SECTION .text              ; First .text section
 ...
.SECTION .data              ; First .data section
 ...
.SECTION .text              ; Second .text section
 ...
.SECTION .data, at(0x0)     ; Second .data section
 ...
.RESUME .text               ; Resume in the second .text section
 ...
.RESUME .data               ; Resume in the first .data section
 ...
.RESUME .data, at(0x0)      ; Resume in the second .data section

Related information

.SECTION (Start a new section)
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.SECTION

Syntax

.SECTION name [,at(address)]

....
[.ENDSEC]

Description

With the .SECTION directive you define a new section. Each time you use the .SECTION directive, a new section is created. It
is possible to create multiple sections with exactly the same name.

To resume a previously defined section, use the .RESUME directive.

If you define a section, you must always specify the section name. The names have a special meaning to the locating process
and have to start with a predefined name, optionally extended by a dot ’.’ and a user defined name. The predefined section
name also determines the type of the section (code, data or debug). Optionally, you can specify the at() attribute to locate a
section at a specific address.

You can use the following predefined section names:

Section Name Description Section Type

.text Code sections code

.data Initialized data data

.sdata Initialized data in read−write small data area data

.bss Uninitialized data (cleared) data

.sbss Uninitialized data in read−write small data area (cleared) data

.rodata ROM data (constants) data

.debug Debug sections debug

Table 3−4: Predefined section names

Sections of a specified type are located by the linker in a memory space. The space names are defined in a so−called ’linker
script file’ (files with the extension .lsl) delivered with the product in the directory \Program Files\Altium
Designer\System\Tasking\include.lsl.

You can specify the following section attributes:

Example

.SECTION .data               ; Declare a .data section

.SECTION .data.abs, at(0x0)  ; Declare a .data.abs section at 
                             ; an absolute address

.RESUME (Resume a previously defined section)
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.SET

Syntax

symbol .SET  expression

       .SET  symbol  expression

Description

With the .SET directive you assign the value of expression to symbol temporarily. If a symbol was defined with the .SET
directive, you can redefine that symbol in another part of the assembly source, using the .SET directive again. Symbols that you
define with the .SET directive are always local: you cannot define the symbol global with the .GLOBAL directive.

The .SET directive is useful in establishing temporary or reusable counters within macros. expression must be absolute and
cannot include a symbol that is not yet defined (no forward references are allowed).

Example

COUNT  .SET  0   ; Initialize count. Later on you can
                 ; assign other values to the symbol

Related information

.EQU (Set a permanent value to a symbol)
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.SIZE

Syntax

.SIZE  symbol, expression

Description

With the .SIZE directive you set the size of the specified symbol to the value represented by expression.

The .SIZE directive may occur anywhere in the source file unless the specified symbol is a function. In this case, the .SIZE
directive must occur after the function has been defined.

Example

        .section        .text
        .align  4
        .global main
; Function main
main:   .type   func
         ;
        .SIZE   main,*−main
        .endsec

Related information

.TYPE (Set Symbol Type)
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.SOURCE

Syntax

.SOURCE  string

Description

With the .SOURCE directive you specify the name of the original C source module. This directive is generated by the C compiler.
You do not need this directive in hand−written assembly.

Example

.SOURCE "test.c"

Related information

−
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.TITLE

Syntax

.TITLE [title]

Description

If you generate a list file (see assembler option −−list−file), you can use the .TITLE directive to specify the program title which
is printed at the top of each page in the assembler list file.

If you use the .TITLE directive without the argument, the title becomes empty. This is also the default. The specified title is valid
until the assembler encouters a new .TITLE directive.

Example

.TITLE "The best program"

In the header of each page in the assembler list file, the title of the progam is printed. In this case: The best program

Related information

.PAGE (Format the assembler list file)
Assembler option −−list−file (Generate list file) in Section 4.2, Assembler Options, of Chapter Tool Options.
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.TYPE

Syntax

symbol   .TYPE  typeid

Description

With the .TYPE directive you set a symbol’s type to the specified value in the ELF symbol table. Valid symbol types are:

FUNC  The symbol is associated with a function or other executable code.

OBJECT The symbol is associated with an object such as a variable, an array, or a structure.

FILE  The symbol name represents the filename of the compilation unit.

Labels in code sections have the default type FUNC. Labels in data sections have the default type OBJECT.

Example

Afunc:   .TYPE   FUNC

Related information

.SIZE (Set Symbol Size)
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.UNDEF

Syntax

.UNDEF symbol

Description

With the .UNDEF directive you can undefine a substitution string that was previously defined with the .DEFINE directive. The
substitution string associated with symbol is released, and symbol will no longer represent a valid .DEFINE substitution.

The assembler issues a warning if you redefine an existing symbol.

Example

.UNDEF LEN

Undefines the LEN substitution string that was previously defined with the .DEFINE directive.

Related information

.DEFINE (Define substitution string)
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.WEAK

Syntax

.WEAK symbol[,symbol]...

Description

With the .WEAK directive you mark one or more symbols as ’weak’. The symbol can be defined in the same module with the
.GLOBAL directive or the .EXTERN directive. If the symbol does not already exist, it will be created.

A ’weak’ external reference is resolved by the linker when a global (or weak) definition is found in one of the object files.
However, a weak reference will not cause the extraction of a module from a library to resolve the reference.

You can overrule a weak definition with a .GLOBAL definition in another module. The linker will not complain about the duplicate
definition, and ignore the weak definition.

Only program labels and symbols defined with .EQU can be made weak.

Example

LOOPA .EQU 1          ; definition of symbol LOOPA
      .GLOBAL  LOOPA  ; LOOPA will be globally
                      ; accessible by other modules
      .WEAK LOOPA     ; mark symbol LOOPA as weak

Related information

.EXTERN (Import global section symbol)

.GLOBAL (Declare global section symbol)
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3.9 Macro Operations

Macros provide a shorthand method for inserting a repeated pattern of code or group of instructions. You can define the pattern
as a macro, and then call the macro at the points in the program where the pattern would repeat.

Some patterns contain variable entries which change for each repetition of the pattern. Others are subject to conditional
assembly.

When a macro is called, the assembler executes the macro and replaces the call by the resulting in−line source statements.
’In−line’ means that all replacements act as if they are on the same line as the macro call. The generated statements may
contain substitutable arguments. The statements produced by a macro can be any processor instruction, almost any assembler
directive, or any previously−defined macro. Source statements resulting from a macro call are subject to the same conditions
and restrictions as any other statements.

Macros can be nested. The assembler processes nested macros when the outer macro is expanded.

3.9.1 Defining a Macro

The first step in using a macro is to define it.

The definition of a macro consists of three parts:

• Header, which assigns a name to the macro and defines the arguments.

• Body, which contains the code or instructions to be inserted when the macro is called.

• Terminator, which indicates the end of the macro definition (.ENDM directive).

A macro definition takes the following form:

macro_name .MACRO [arg[,arg]...]   [; comment]
        .
        source statements
        .
        .ENDM

If the macro name is the same as an existing assembler directive or mnemonic opcode, the assembler replaces the directive or
mnemonic opcode with the macro and issues a warning.

The arguments are symbolic names that the macro preprocessor replaces with the literal arguments when the macro is
expanded (called). Each argument must follow the same rules as global symbol names. Argument names cannot start with a
percent sign (%).

Example

Consider the following macro definition:

RESERV  .MACRO  val   ; reserve space

        .DS val

        .ENDM

After the following macro call:

.section .text
RESERV 8

The macro expands to:

.DS 8

3.9.2 Calling a Macro

To invoke a macro, construct a source statement with the following format:

[label] macro_name [arg[,arg...]]          [; comment]

where:

label An optional label that corresponds to the value of the location counter at the start of the macro expansion.
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macro_name The name of the macro. This may not start in the first column.

arg One or more optional, substitutable arguments. Multiple arguments must be separated by commas.

comment An optional comment.

The following applies to macro arguments:

• Each argument must correspond one−to−one with the formal arguments of the macro definition. If the macro call does not
contain the same number of arguments as the macro definition, the assembler issues a warning.

• If an argument has an embedded comma or space, you must surround the argument by single quotes (’).

• You can declare a macro call argument as null in three ways:

− enter delimiting commas in succession with no intervening spaces

macroname ARG1,,ARG3 ; the second argument is a null argument

− terminate the argument list with a comma, the arguments that normally would follow, are now considered null

macroname ARG1,      ; the second and all following arguments are null

− declare the argument as a null string

• No character is substituted in the generated statements that reference a null argument.

3.9.3 Using Operators for Macro Arguments

The assembler recognizes certain text operators within macro definitions which allow text substitution of arguments during
macro expansion. You can use these operators for text concatenation, numeric conversion, and string handling.

Operator Name Description

\ Macro argument
concatenation

Concatenates a macro argument with adjacent alphanumeric characters.

? Return decimal
value of symbol

Substitutes the ?symbol sequence with a character string that represents the decimal value
of the symbol.

% Return hex
value of symbol

Substitutes the %symbol sequence with a character string that represents the hexadecimal
value of the symbol.

" Macro string
delimiter

Allows the use of macro arguments as literal strings.

^ Macro local label
override

Prevents name mangling on labels in macros.

Example: Argument Concatenation Operator − \

Consider the following macro definition:

MAC_A .MACRO reg,val
   li $v\reg,val
   .ENDM

The macro is called as follows:

MAC_A 0,1

The macro expands as follows:

li $v0,1

The macro preprocessor substitutes the character ’0’ for the argument reg, and the character ’1’ for the argument val. The
concatenation operator (\) indicates to the macro preprocessor that the substitution characters for the arguments are to be
concatenated with the characters ’$v’.

Without the ’\’ operator the macro would expand as:

li $vreg,1

which results in an assembler error (invalid operand).
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Example: Decimal Value Operator − ?

Instead of substituting the formal arguments with the actual macro call arguments, you can also use the value of the macro call
arguments.

Consider the following source code that calls the macro MAC_A after the argument AVAL has been set to 1.

AVAL .SET  1
     MAC_A 0,AVAL

If you want to replace the argument val with the value of AVAL rather than with the literal string ’AVAL’, you can use the ?
operator and modify the macro as follows:

MAC_A .MACRO reg,val
   li $v\reg,?val
   .ENDM

Example: Hex Value Operator − %

The percent sign (%) is similar to the standard decimal value operator (?) except that it returns the hexadecimal value of a
symbol.

Consider the following macro definition:

GEN_LAB   .MACRO  LAB,VAL,STMT
LAB\%VAL  STMT
     .ENDM

The macro is called after NUM has been set to 10:

NUM .SET       10
    GEN_LAB   HEX,NUM,NOP

The macro expands as follows:

HEXA NOP

The %VAL argument is replaced by the character ’A’ which represents the hexadecimal value 10 of the argument VAL.

Example: Argument String Operator − "

To generate a literal string, enclosed by single quotes (’), you must use the argument string operator (") in the macro definition.

Consider the following macro definition:

STR_MAC    .MACRO  STRING
    .DB     "STRING"
    .ENDM

The macro is called as follows:

STR_MAC  ABCD

The macro expands as follows:

 .DB     ’ABCD’

Within double quotes .DEFINE directive definitions can be expanded. Take care when using constructions with quotes and
double quotes to avoid inappropriate expansions. Since .DEFINE expansion occurs before macro substitution, any .DEFINE
symbols are replaced first within a macro argument string:

    .DEFINE LONG  ’short’
STR_MAC    .MACRO  STRING
    .MESSAGE I ’This is a LONG STRING’
    .MESSAGE I "This is a LONG STRING"
    .ENDM

If the macro is called as follows:

 STR_MAC  sentence
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it expands as:

.MESSAGE I ’This is a LONG STRING’

.MESSAGE I ’This is a short sentence’

Macro Local Label Override Operator − ^

If you use labels in macros, the assembler normally generates another unique name for the labels (such as
LOCAL__M_L000001).

The macro ^−operator prevents name mangling on macro local labels.

Consider the following macro definition:

INIT  .MACRO  addr
LOCAL:  lw    $v0,@gprel(^addr)($gp)
      .ENDM

The macro is called as follows:

LOCAL:
       INIT LOCAL

The macro expands as:

LOCAL__M_L000001: lw    $v0,@gprel(LOCAL)($gp)

If you would not have used the ^ operator, the macro preprocessor would choose another name for LOCAL because the label
already exists. The macro would expand like:

LOCAL__M_L000001: lw    $v0,@gprel(LOCAL__M_L000001)($gp)

3.9.4 Using the .FOR and .REPEAT Directives as Macros

The .FOR and .REPEAT directives are specialized macro forms to repeat  a block of source statements. You can think of them
as a simultaneous definition and call of an unnamed macro. The source statements between the .FOR and .ENDFOR directives
and .REPEAT and .ENDREP directives follow the same rules as macro definitions.

For a detailed description of these directives, see section 3.8, Assembler Directives.

3.9.5 Conditional Assembly

With the conditional assembly directives you can instruct the macro preprocessor to use a part of the code that matches a
certain condition.

You can specify assembly conditions with arguments in the case of macros, or through definition of symbols via the .DEFINE,
.SET, and .EQU directives.

The built−in functions of the assembler provide a versatile means of testing many conditions of the assembly environment.

You can use conditional directives also within a macro definition to check at expansion time if arguments fall within a range of
allowable values. In this way macros become self−checking and can generate error messages to any desired level of detail.

The conditional assembly directive .IF/.ENDIF has the following form:

.IF  expression
 .
 .
[.ELIF  expression]     ;(the .ELIF directive is optional)
 .
 .
[.ELSE]     ;(the .ELSE directive is optional)
 .
 .
.ENDIF
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A section of a program that is to be conditionally assembled must be bounded by an .IF−.ENDIF directive pair. If the optional
.ELSE and/or .ELIF directives are not present, then the source statements following the .IF directive and up to the next
.ENDIF directive will be included as part of the source file being assembled only if the expression had a non−zero result.

If the expression has a value of zero, the source file will be assembled as if those statements between the .IF and the .ENDIF
directives were never encountered.

If the .ELSE directive is present and expression has a nonzero result, then the statements between the .IF and .ELSE
directives will be assembled, and the statement between the .ELSE and .ENDIF directives will be skipped. Alternatively, if
expression has a value of zero, then the statements between the .IF and .ELSE directives will be skipped, and the statements
between the .ELSE and .ENDIF directives will be assembled.



TSK3000 Embedded Tools Reference

3−50

3.10 Generic Instructions

The assembler supports so−called ’generic instructions’. Generic instructions are pseudo instructions (no instructions from the
instruction set). Depending on the situation in which a generic instruction is used, the assembler replaces the generic instruction
with appropriate real assembly instruction(s).

You can find a complete list of generic instructions for the TSK3000 in the core reference manual CR0121 TSK3000A 32−bit
RISC Processor.
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4 Tool Options

Summary This chapter provides a detailed description of the options for the compiler,
assembler, linker, control program, make program and the librarian.

4.1 C Compiler Options

Altium Designer uses a makefile to build your entire project. This means that in Altium Designer you cannot run the compiler
separately. If you compile a single C source file from within Altium Designer, the file is also assembled. However, you can set
options specific for the compiler.

Options in Altium Designer versus options on the command line

Most command line options have an equivalent option in Altium Designer but some options are only available on the command
line (for example in a Windows Command Prompt). If there is no equivalent option in Altium Designer, you can specify a
command line option in Altium Designer as follows:

1. From the Project menu, select Project Options...

The Project Options dialog box appears.

2. Expand the C Compiler entry and select Miscellaneous.

3. Enter one or more command line options in the Additional C compiler options field.

Invocation syntax on the command line (Windows Command Prompt)

To call the compiler from the command line, use the following syntax:

c3000 [ [option]... [file]... ]...

The input file must be a C source file (.c or .ic).
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 Short and long option names

Options can have both short and long names. Short option names always begin with a single minus (−) character, long option
names always begin with double minus (−−) characters. You can abbreviate long option names as long as the name is unique.
You can mix short and long option names on the command line.

Options can have flags or sub−options. To switch a flag ’on’, use a lowercase letter or a +longflag. To switch a flag off, use an
uppercase letter or a −longflag. Separate longflags with commas. The following two invocations are equivalent:

c3000 −Oac test.c

c3000 −−optimize=+coalesce,+cse test.c

When you do not specify an option, a default value may become active.
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C Compiler: −−align−composites

Menu entry

1. From the Project menu, select Project Options...

The Project Options dialog box appears.

2. Expand the C Compiler entry and select Code Generation.

3. Select the Alignment of composite types: Natural alignment or Optimal alignment

Command line syntax

−−align−composites=alignment

You can specify the following alignments:

n Natural alignment (default)
o Optimal alignment

Description

With this option you can set the alignment for composite types (structs, unions and arrays).

Natural alignment (n) uses the natural alignment of the most−aligned member of the composite type.

Optimal alignment (o) sets the alignment to 8, 16, or 32 bits depending on the size of the composite type.

Related information

−
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C Compiler: −−call (−m)

Menu entry

1. From the Project menu, select Project Options...

The Project Options dialog box appears.

2. Expand the C Compiler entry and select Code Generation.

3. Set the option Select call mode to Use 28−bit PC−region calls (default) or
to Use 32−bit indirect calls.

Command line syntax

−−call={far|near}
−m{f|n}

Description

To address the memory of the TSK3000, you can use two different call modes:

far 32−bit indirect calls. Though you can address the full range of memory, the address is first loaded into a register after
which the call is executed.

near 28−bit PC−region call. The PC−region call is directly coded into the JAL instruction. This way of calling results in higher
execution speed. However, not the full range of memory can be addressed with near calls.

If you compile your C source with near calls but the called address cannot be reached with a near call, the linker will
generate an error.

It is recommended to use the near addressing mode unless your application needs calls to addresses that fall outside a 256 MB
region.

Related information

−
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C Compiler: −−check

Menu entry

1. From the Project menu, select Project Options...

The Project Options dialog box appears.

2. Expand the C Compiler entry and select Miscellaneous.

3. Add the option −−check to the Additional C compiler options field.

Command line syntax

−−check

Description

With this option you can check the source code for syntax errors, without generating code. This saves time in developing your
application because the code will not actually be compiled.

The compiler reports any warnings and/or errors.

Related information

Assembler option −−check (Check syntax)
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C Compiler: −−debug−info (−g)

Menu entry

1. From the Project menu, select Project Options...

The Project Options dialog box appears.

2. Expand the C Compiler entry and select Debug Information.

3. Enable the option Generate symbolic debug information.

4. Enable or disable the suboptions.

Command line syntax

−−debug−info[=suboption]

−g[c|a]

You can set the following suboptions (when you specify −g without suboption, the default is −ga):

call−frame (c) Generate call−frame information only.
all (a) Generate all debug information.

Description

With this option you tell the compiler to add directives to the output file for including symbolic information. This facilitates high
level debugging but increases the size of the resulting assembler file (and thus the size of the object file). For the final
application, compile your C files without debug information.

When you specify a high optimization level, debug comfort may decrease. Therefore, the compiler issues a warning if the
chosen optimizations expect to affect ease of debugging.

call−frame information

With this suboption only call−frame information is generated. This enables you to inspect parameters of nested functions.

all debug information

With this information extra debug information is generated. In extra−ordinary cases you may use this debug information (for
instance, if you use your own debugger which makes use of this information). With this suboption, the resulting
assembler/object file increases significantly.

Related information

−
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C Compiler: −−define (−D)

Menu entry

1. From the Project menu, select Project Options...

The Project Options dialog box appears.

2. Expand the C Compiler entry and select Preprocessing.

3. Select User macro and click on the down arrow in the right pane to expand macro input.

4. Click on an empty Macro field and enter a macro name. (Then click an empty cell to confirm)

5. Optionally, click in the Value field and enter a definition. (Then click an empty cell to confirm)

Command line syntax

−−define=macro_name[=macro_definition]
−Dmacro_name[=macro_definition]

Description

With this option you can define a macro and specify it to the preprocessor. If you only specify a macro name (no macro
definition), the macro expands as ’1’. You can specify as many macros as you like.

On the command line, you can use the option −−define (−D) multiple times. If the command line exceeds the length limit of the
operating system, you can define the macros in an option file which you then must specify to the compiler with the option
−−option−file=file (−f).

Defining macros with this option (instead of in the C source) is, for example, useful to compile conditional C source as shown in
the example below.

Example

Consider the following C program with conditional code to compile a demo program and a real program:

void main( void )
{
#if DEMO == 1
    demo_func();   /* compile for the demo program */
#else
    real_func();   /* compile for the real program */
#endif
}

You can now use a macro definition to set the DEMO flag:

Macro Value

DEMO 1 (or empty)

On the command line, use the option as follows:

c3000 −−define=DEMO test.c
c3000 −−define=DEMO=1 test.c

Note that both invocations have the same effect.

The next example shows how to specify a macro with arguments. Macro definitions follow exactly the same rules as the
#define statement in the C language.

Macro Value

MAX(A,B) ((A) > (B) ? (A) : (B))

On the command line, use the option −D as follows:

c3000 −D"MAX(A,B)=((A) > (B) ? (A) : (B))" test.c
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Note that the macro name and definition are placed between double quotes because otherwise the spaces would indicate a new
option.

Related information

C compiler option −−undefine (Undefine preprocessor macro)
C compiler option −−option−file (Read options from file)
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C Compiler: −−dep−file

Menu entry

1. From the Project menu, select Project Options...

The Project Options dialog box appears.

2. Expand the C Compiler entry and select Miscellaneous.

3. Add the option −−dep−file to the Additional C compiler options field.

Command line syntax

−−dep−file[=file]

Description

With this option you tell the compiler to generate dependency lines that can be used in a Makefile. In contrast to the option
−−preprocess=+make (−Em), the dependency information will be generated in addition to the normal output file.

By default, the information is written to a file with extension .d (one for every input file). When you specify a filename, all
dependencies will be combined in the specified file.

Example

c3000 −−dep−file=test.dep test.c

The compiler compiles the file test.c, which results in the output file test.src, and generates dependency lines in the file
test.dep.

Related information

C compiler option −−preprocess=+make (Generate dependencies for make)
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C Compiler: −−diag

Menu entry

1. From the View menu, select Workspace » Panels » System Messages.

The Message pannel appears.

2. In the Message panel, right−click on the message you want more information on.

A popup menu appears.

3. Select More Info.

A Message Info box appears with additional information.

Command line syntax

−−diag=[format:]{all|nr,...}

Description

With this option you can ask for an extended description of error messages in the format you choose. The output is directed to
stdout (normally your screen) and in the format you specify. You can specify the following formats: html, rtf or text (default).
To create a file with the descriptions, you must redirect the output.

With the suboption all, the descriptions of all error messages are given. If you want the description of one or more selected error
messages, you can specify the error message numbers, separated by commas.

With this option the compiler does not compile any files.

Example

To display an explanation of message number 282, enter:

c3000 −−diag=282

This results in the following message and explanation:

E282: unterminated comment

Make sure that every comment starting with /* has a matching */. Nested comments are not
possible.

To write an explanation of all errors and warnings in HTML format to file cerrors.html, use redirection and enter:

c3000 −−diag=html:all > cerrors.html

Related information

−
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C Compiler: −−error−file

Menu entry

Command line only.

Command line syntax

−−error−file[=file]

Description

With this option the compiler redirects error messages to a file.

If you do not specify a filename, the error file will be named after the input file with extension .err.

Example

To write errors to errors.err instead of stderr, enter:

c3000 −−error−file=errors.err test.c

Related information

−
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C Compiler: −−extern−sdata

Menu entry

1. From the Project menu, select Project Options...

The Project Options dialog box appears.

2. Expand the C Compiler entry and select Code Generation.

3. Enable the option Enable allocation in sdata.

4. Specify a size for Allocation in sdata for objects smaller than threshold (default: 4)

5. Expand the C Compiler entry and select Miscellaneous.

6. Add the option −−extern−sdata to the Additional C compiler options field.

Command line syntax

−−extern−sdata

Description

With this option you tell the compiler to use small data addressing for external data as well as for symbols defined in the current
module.

This option is an addition to the option −−sdata. External data that falls within the threshold of option −−sdata, is not considered
part of sdata. If you want external data to be part of this too, also specify option −−extern−sdata.

If you use option  −−extern−sdata, you must use the option  −−sdata with the same value for all modules in your
application.

Example

To put all global, static and external data objects with a size of 8 bytes or smaller into the sdata section:

c3000 −−sdata=8 −−extern−data test.c

Related information

C compiler option −−sdata=size
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C Compiler: −−help (−?)

Menu entry

Command line only.

Command line syntax

−−help[=item,...]
−?

You can specify the following arguments:

intrinsics (i) Show the list of intrinsic functions
options (o) Show extended option descriptions
pragmas (p) Show the list of supported pragmas
typedefs (t) Show the list of predefined typedefs

Description

Displays an overview of all command line options. With an argument you can specify which extended information is shown.

Example

The following invocations all display a list of the available command line options:

c3000 −?
c3000 −−help
c3000

The following invocation displays a list of the available pragmas:

c3000 −−help=pragmas
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C Compiler: −−include−directory (−I)

Menu entry

1. From the Project menu, select Project Options...

The Project Options dialog box appears.

2. Select Build Options.

3. Add a pathname in the Include files path field.

If you enter multiple paths, separate them with a semicolon (;).

Command line syntax

−−include−directory=path,...
−Ipath,...

Description

With this option you can specify the path where your include files are located. A relative path will be relative to the current
directory.

The order in which the compiler searches for include files is:

1. The pathname in the C source file and the directory of the C source
(only for #include files that are enclosed in "").

2. The path that is specified with this option.

3. The path that is specified in the environment variable C3000INC when the product was installed.

4. The default include directory relative to the installation directory 
(unless you specified option −−no−stdinc).

Example

Suppose that the C source file test.c contains the following lines:

#include <stdio.h>
#include "myinc.h"

You can specify the include directory myinclude to the C compiler:

c3000 −−include−directory=myinclude test.c

First the compiler looks for the file stdio.h in the directory myinclude relative to the current directory. If it was not found, the
compiler searches in the environment variable and then in the default include directory.

The compiler now looks for the file myinc.h, in the directory where test.c is located. If the file is not there the compiler
searches in the directory myinclude. If it was still not found, the compiler searches in the environment variable and then in the
default include directory.

Related information

C compiler option −−include−file (Include file at the start of a compilation)
C compiler option −−no−stdinc (Skip standard include files directory)
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C Compiler: −−include−file (−H)

Menu entry

1. From the Project menu, select Project Options...

The Project Options dialog box appears.

2. Expand the C Compiler entry and select Preprocessing.

3. Enter the name of the file in the Include this file before source field or click ... and select a file.

Command line syntax

−−include−file=file,...
−Hfile,...

Description

With this option (set at project level) you include one extra file at the beginning of each C source file in your project. On a
document level (Project » Document Options), you can overrule this option with another file or no file at all.

The specified include file is included before all other includes. This is the same as specifying #include "file" at the very
beginning of (each of) your C source files.

Example

c3000 −−include−file=stdio.h test1.c test2.c

The file stdio.h is included at the beginning of both test1.c and test2.c.

Related information

C compiler option −−include−directory (Add directory to include file search path)

Section 2.4, How the Compiler Searches Include Files, in chapter Using the Compiler of the user’s manual.
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C Compiler: −−inline

Menu entry

1. From the Project menu, select Project Options...

The Project Options dialog box appears.

2. Expand the C Compiler entry and select Miscellaneous.

3. Add the option −−inline to the Additional C compiler options field.

Command line syntax

−−inline

Description

With this option you instruct the compiler to inline calls to functions without the __noinline function qualifier whenever
possible. This option has the same effect as a #pragma inline at the start of the source file.

This option can be useful to increase the possibilities for code compaction
(compiler option −−optimize=+compact).

Related information

C compiler option −−optimize=+compact (Code compaction)
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C Compiler: −−inline−max−incr / −−inline−max−size

Menu entry

1. From the Project menu, select Project Options...

The Project Options dialog box appears.

2. Expand the C Compiler entry and select Optimization.

3. Set the option Maximum code size increasse caused by to a value (default: 25)

4. Set the option Maximum size for functions to always inline to a value (default: 25)

Command line syntax

−−inline−max−incr=percentage (Default: 25)
−−inline−max−size=threshold (Default: 25)

Description

With these options you can control the function inlining optimization process of the compiler. These options have only effect
when you have enabled the inlining optimization (option −Oi).

Regardless of the optimization process, the compiler always inlines all functions that have the function qualifier inline.

With the option −−inline−max−size you can specify the maximum size of functions that the compiler inlines as part of the
optimization process. The compiler always inlines all functions that are smaller than the specified threshold. The threshold is
measured in compiler internal units and the compiler uses this measure to decide which functions are small enough to inline.
The default threshold is 25.

After the compiler has inlined all functions that have the function qualifier inline and all functions that are smaller than the
specified threshold, the compiler looks whether it can inline more functions without increasing the code size too much. With the
option −−inline−max−incr you can specify how much the code size is allowed to increase. Default, this is 25% which means
that the compiler continues inlining functions until the resulting code size is 25% larger than the original size.

Example

c3000 −−inline−max−incr=40 −−inline−max−size=15 test.c

The compiler first inlines all functions with the function qualifier inline and all functions that are smaller than the specified
threshold of 15. If the code size has still not increased with 40%, the compiler decides which other functions it can inline.

Related information

C compiler option −−optimize (Specify optimization level)

Section 1.7.3, Inlining Functions, in chapter C Language.
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C Compiler: −−iso (−c)

Menu entry

1. From the Project menu, select Project Options...

The Project Options dialog box appears.

2. Expand the C Compiler entry and select Language.

3. Select the ISO C standard C90 or C99.

Command line syntax

−−iso={90|99}
−c{90|99}

Description

With this option you select the ISO C standard. The compiler checks the C source against this standard and may generate
warnings or errors if you use C language that is not defined in the standard.

C90 is also referred to as the "ANSI C standard". C99 refers to the newer ISO/IEC 9899:1999 (E) standard. C99 is the default.

c3000 −−iso=90 test.c

Related information

C compiler option −−language (Language extensions)
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C Compiler: −−keep−output−files (−k)

Menu entry

Altium Designer always removes the .src file when errors occur during compilation.

Command line syntax

−−keep−output−files
−k

Description

If an error occurs during compilation, the resulting .src file may be incomplete or incorrect. With this option you keep the
generated output file (.src) when an error occurs.

By default the compiler removes the generated output file (.src) when an error occurs. This is useful when you use the make
utility. If the erroneous files are not removed, the make utility may process corrupt files on a subsequent invocation.

Use this option when you still want to inspect the generated assembly source. Even if it is incomplete or incorrect.

Related information

−
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C Compiler: −−language (−A)

Menu entry

1. From the Project menu, select Project Options...

The Project Options dialog box appears.

2. Expand the C Compiler entry and select Language.

3. Enable or disable the following options:

• Allow C++ style comments in C source code (only available when ISO C 90 is selected)

• Relax const check for string literals

Command line syntax

−−language=[flags]
−A[flags]

You can set the following flags:

+/−gcc (g/G) Enable a number of gcc extensions
+/−comments (p/P) Allow C++ style comments in C source code
+/−strings (x/X) Relaxed const check for string literals

The option −−language (−A) is the equivalent of −AGPX which disables all language extensions.
The default is −Agpx.

Description

With this option you control the language extensions the compiler accepts. Default the C compiler allows all language
extensions.

With Allow C++ style comments in C source code (−Ap) you tell the compiler to allow C++ style comments (//) in ISO C90
mode (option −c90). In ISO C99 mode this style of comments is always accepted.

With Relax const check for string literals (−Ax) you tell the compiler not to check for assignments of a constant string to a
non−constant string pointer. With this option the following example produces no warning:

char *p;
void main( void ) { p = "hello"; }

With option −−language=+gcc (−Ag, command line only) you tell the compiler to enable the following gcc languages
extensions:

• The identifier __FUNCTION__ expands to the current function name

• Alternative syntax for variadic macros

• Alternative syntax for designated initializers

• Allow zero sized arrays

• Allow empty struct/union

• Allow empty initializer list

• Allow initialization of static objects by compound literals

• The middle operand of a ? : operator may be omitted

• Allow a compound statement inside braces as expression

• Allow arithmetic on void pointers and function pointers

• Allow a range of values after a single case label

• Additional preprocessor directive #warning

• Allow comma operator, conditional operator and cast as lvalue

• An inline function without "static" or "extern" will be global

• An "extern inline" function will not be compiled on its own

• An __attribute__ directly following a struct/union definition relates to that tag instead of to the objects in the declaration.

For an exact description of these gcc extensions, please refer to the gcc info pages (info gcc).
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Example

c3000 −AGPx −c90 test.c
c3000 −−language=−ggc,−comments,+strings −−iso=90 test.c

C compiler option −−iso (ISO C standard)
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C Compiler: −−make−target

Menu entry

1. From the Project menu, select Project Options...

The Project Options dialog box appears.

2. Expand the C Compiler entry and select Miscellaneous.

3. Add the option −−make−target to the Additional C compiler options field.

Command line syntax

−−make−target=name

Description

With this option you can overrule the default target name in the make dependencies generated by the options
−−preprocess=+make (−Em) and −−dep−file. The default target name is the basename of the input file, with extension .obj.

Related information

C compiler option −−preprocess=+make (Generate dependencies for make)
C compiler option −−dep−file (Generate dependencies in a file)
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C Compiler: −−mil / −−mil−split

Menu entry

Command line only.

Command line syntax

−−mil

−−mil−split[=file,...]

Description

With option −−mil the C compiler skips the code generator phase and writes the optimized intermediate representation (MIL) to
a file with the suffix .mil. The C compiler accepts .mil files as input files on the command line.

Option −−mil−split does the same as option −−mil, but in addition, the C compiler splits the MIL representation and writes it to
separate files with suffix .ms. One file is written for each input file or MIL library specified on the command line. The .ms files
are only updated on a change. The C compiler accepts .ms files as input files on the command line.

With option −−mil−split you can perform application−wide optimizations during the frontend phase by specifying all modules at
once, and still invoke the backend phase one module at a time to reduce the total compilation time.

Optionally, you can specify another filename for the .ms file the C compiler generates. Without an argument, the basename of
the C source file is used to create the .ms filename. Note that if you specify a filename, you have to specify one filename for
every input file.

Related information

Control program option −−mil−link / −−mil−split
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C Compiler: −−misrac

Menu entry

1. From the Project menu, select Project Options...

The Project Options dialog box appears.

2. Expand the C Compiler entry and select MISRA−C.

3. Select a MISRA−C Standard.

If you select Custom MISRA−C configuration:

4. In the left pane, expand the MISRA−C entry and select MISRA−C Rules.

5. Enable or disable the individual rules.

Command line syntax

−−misrac={all|number[−number],... }

Description

With this option you specify to the compiler which MISRA−C rules must be checked. With the option −−misrac=all the compiler
checks for all supported MISRA−C rules.

Example

c3000 −−misrac=9−13 test.c

The compiler generates an error for each MISRA−C rule 9, 10, 11, 12 or 13 violation in file test.c.

Related information

C compiler option −−misrac−advisory−warnings
C compiler option −−misrac−required−warnings

Linker option −−misrac−report
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C Compiler: −−misrac−advisory−warnings / −−misrac−required−warnings

Menu entry

1. From the Project menu, select Project Options...

The Project Options dialog box appears.

2. Expand the C Compiler entry and select MISRA−C.

3. Enable one or both options Turn advisory rule violation into warning and Turn required rule violation into warning.

Command line syntax

−−misrac−advisory−warnings

−−misrac−required−warnings

Description

Normally, if an advisory rule or required rule is violated, the compiler generates an error. As a consequence, no output file is
generated. With this option, the compiler generates a warning instead of an error.

Related information

C compiler option −−misrac

Linker option −−misrac−report
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C Compiler: −−misrac−version

Menu entry

1. From the Project menu, select Project Options...

The Project Options dialog appears.

2. Expand the C Compiler entry and select MISRA−C.

3. Select the MISRA−C standard: MISRA−C:1998 or MISRA−C:2004.

Command line syntax

−−misrac−version={1998|2004}

Description

MISRA−C rules exist in two versions: MISRA−C:1998 and MISRA−C:2004. By default, the C source is checked against the
MISRA−C:2004 rules. With this option you can specify to check against the MISRA−C:1998 rules.

Related information

See Chapter 8, MISRA−C Rules, for a list of all supported MISRA−C rules.

C compiler option −−misrac
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C Compiler: −−no−double (−F)

Menu entry

1. From the Project menu, select Project Options...

The Project Options dialog box appears.

2. Expand the C Compiler entry and select Floating−Point.

3. Enable the option Use single precision floating−point only.

Command line syntax

−−no−double

−F

Description

With this option you tell the compiler to treat variables of the type double as float. Because the float type takes less space,
execution speed increases and code size decreases, both at the cost of less precision.

Related information

−
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C Compiler: −−no−stdinc

Menu entry

1. From the Project menu, select Project Options...

The Project Options dialog box appears.

2. Expand the C Compiler entry and select Miscellaneous.

3. Add the option −−no−stdinc to the Additional C compiler options field.

Command line syntax

−−no−stdinc

Description

With this option you tell the compiler not to look in the default include directory relative to the installation directory, when
searching for include files. This way the compiler only searches in the include file search paths you specified.

Related information

C compiler option −−include−directory (Add directory to include file search path)
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C Compiler: −−no−warnings (−w)

Menu entry

1. From the Project menu, select Project Options...

The Project Options dialog box appears.

2. Expand the C Compiler entry and select Diagnostics.

3. In the Warnings field, select one of the following options:

• Report all warnings

• Suppress all warnings

• Suppress specific warningsn

If you select Suppress specific warnings:

4. Enter the numbers, separated by commas, of the warnings you want to suppress.

Command line syntax

−−no−warnings[=number,...]
−w[number,...]

Description

With this option you can suppress all warning messages or specific warning messages.

On the command line this option works as follows:

• If you do not specify this option, all warnings are reported.

• If you specify this option but without numbers, all warnings are suppressed.

• If you specify this option with a number, only the specified warning is suppressed.
You can specify the option −−no−warnings=number multiple times.

Example

To suppress warnings 135 and 136, enter 135,136 in the Specific warnings to suppress field, or enter the following on the
command line:

c3000 test.c −−no−warnings=135,136

Related information

C compiler option −−warnings−as−errors (Treat warnings as errors)
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C Compiler: −−optimize (−O)

Menu entry

1. From the Project menu, select Project Options...

The Project Options dialog box appears.

2. Expand the C Compiler entry and select Optimization.

3. Select an optimization level in the Optimization level box.

4. If you select Custom Optimization, enable or disable the optimizations you want.

5. In addition, in the Size/speed trade−off field, select a level between fully optimize for size or fully optimize for speed.

Command line syntax

−−optimize[=flags]
−O[flags]

Use the following options for predefined sets of flags:

−−optimize=0 (−O0) No optimization
Alias for: −OABCEFGIKLOPRSUY

−−optimize=1 (−O1) Few optimizations
Alias for: −OabcefgIKLOPRSUy

−−optimize=2 (−O2) Medium optimization (default)
Alias for: −OabcefgIkloprsUy

−−optimize=3 (−O3) Full optimization
Alias for: −Oabcefgikloprsuy

You can enable the following individual optimizations:

+/−coalesce (a/A) Coalescer (remove unnecessary moves)
+/−ipro (b/B) Interprocedural Register Optimization
+/−cse (c/C) Common subexpression elimination (CSE)
+/−expression (e/E) Expression simplification
+/−flow (f/F) Control flow simplification (optimization and code reordering)
+/−glo (g/G) Generic assembly code optimizations
+/−inline (i/I) Function inlining
+/−schedule (k/K) Instruction scheduler
+/−loop (l/L) Loop transformations
+/−forward (o/O) Forward store
+/−propagate (p/P) Constant propagation
+/−compact (r/R) Code compaction (reverse inlining)
+/−subscript (s/S) Subscript strength reduction
+/−unroll (u/U) Unroll small loops
+/−peephole (y/Y) Peephole optimizations

For an extensive description of these optimizations, please refer to section 2.6, Compiler Optimizations in chapter Using the
Compiler of the user’s manual.

Description

The TASKING C compilers offer four optimization levels and a custom level, at each level a specific set of optimizations is
enabled.

• No optimization (−O0): No optimizations are performed. The compiler tries to achieve a 1−to−1 resemblance between
source code and produced code. Expressions are evaluated in the order written in the source code, associative and
commutative properties are not used.

• Few optimizations (−O1): Enables optimizations that do not affect the debug−ability of the source code. Use this level when
you encounter problems during debugging your source code with optimization level 2.
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• Medium optimization (−O2): Enables more optimizations to reduce code size and/or execution time. This is the default
optimization level.

• Full optimization (−O3): This is the highest optimization level. Use this level to decrease execution time to meet your
real−time requirements.

• Custom optimization (−Ox/X): you can enable/disable specific optimizations.

With these options you can control the level of optimization. The default optimization level is Medium optimization (option −O2
or −O or −OabcefgIkloprsUy).

You can overrule these settings in your C source file with the pragma pair #pragma optimize flag and #pragma
endoptimize.

In addition to the command line option −−optimize (−O), you can specify the option −−tradeoff (−t). With this option you
specify whether the used optimizations should optimize for more speed (regardless of code size) or for smaller code size
(regardless of speed).

Example

The following invocations are equivalent and result all in the default optimization set:

c3000 test.c
c3000 −O2 test.c
c3000 −−optimize=2 test.c
c3000 −O test.c
c3000 −−optimize test.c
c3000 −OabcefgIkloprsuy test.c
c3000 −−optimize=+coalesce,+ipro,+cse,+expression,+flow,+glo,
  −inline,+schedule,+loop,+forward,+propagate,+compact,+subscript,
  +unroll,+peephole test.c

Related information

Section 2.6, Compiler Optimizations, in chapter Using the Compiler of the user’s manual.

C compiler option −−tradeoff (−t) (Trade off between speed (−t0) and size (−t4))
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C Compiler: −−option−file (−f)

Menu entry

1. From the Project menu, select Project Options...

The Project Options dialog box appears.

2. Expand the C Compiler entry and select Miscellaneous.

3. Add the option −−option−file to the Additional C compiler options field.

Be aware that the options in the option file are added to the C compiler options you have set in the other dialogs. Only in
extraordinary cases you may want to use them in combination. Altium Designer automatically saves the options with your
project.

Command line syntax

−−option−file=file,...
−f file,...

Description

This option is primarily intended for command line use. Instead of typing all options on the command line, you can create an
option file which contains all options and flags you want to specify. With this option you specify the option file to the compiler.

Use an option file when the command line would exceed the limits of the operating system, or just to store options and save
typing.

You can specify the option −−option−file multiple times.

Format of an option file

• Multiple arguments on one line in the option file are allowed.

• To include whitespace in an argument, surround the argument with single or double quotes.

• If you want to use single quotes as part of the argument, surround the argument by double quotes and vise versa:

"This has a single quote ’ embedded"

’This has a double quote " embedded’

’This has a double quote " and a single quote ’"’ embedded"

• When a text line reaches its length limit, use a \ to continue the line. Whitespace between quotes is preserved.

"This is a continuation \
line"

         −> "This is a continuation line"

• It is possible to nest command line files up to 25 levels.

Example

Suppose the file myoptions contains the following lines:

−g
−DDEMO=1
test.c

Specify the option file to the C compiler:

c3000 −−option−file=myoptions

This is equivalent to the following command line:

c3000 −g −DDEMO=1 test.c

Related information

−
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C Compiler: −−output (−o)

Menu entry

Altium Designer names the output file always after the C source file.

Command line syntax

−−output=file
−o file

Description

With this option you can specify another filename for the output file of the compiler. Without this option the basename of the C
source file is used with extension .src.

Example

To create the file output.src instead of test.src, enter:

c3000 −−output=output.src test.c

Related information

−
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C Compiler: −−preprocess (−E)

Menu entry

1. From the Project menu, select Project Options...

The Project Options dialog box appears.

2. Expand the C Compiler entry and select Preprocessing.

3. Enable the option Store the C Compiler preprocess output (<file>.pre).

Command line syntax

−−preprocess[=flags]
−E[flags]

You can set the following flags (when you specify −E without flags, the default is −ECMP):

+/−comments (c/C) Keep comments from the C source in the preprocessed output
+/−make (m/M) Generate dependency lines that can be used for the makefile
+/−noline (p/P) Strip #line source position info (lines starting with #line)

The compiler sends the preprocessed file to stdout. To capture the information in a file, specify an output file with the option
−−output.

Description

When compiling, each file is preprocessed first. With this option you can store the result of preprocessed C files. Altium
Designer stores the preprocessed file in a file called name.pre (where name is the name of the C source file being compiled). C
comments are not preserved (similar to −ECMP)

With −−preprocess=+make the compiler will generate dependency lines that can be used in a Makefile. The preprocessor
output is discarded. The default target name is the basename of the input file, with the extension .obj. With the option
−−make−target you can specify a target name which overrules the default target name.

Related information

C compiler option −−make−target (Specify target name for −Em output)
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C Compiler: −−profile (−p)

Menu entry

1. From the Project menu, select Project Options...

The Project Options dialog box appears.

2. Expand the C Compiler entry and select Debug Information.

3. Enable the option Generate profiling information.

4. Enable one or more of the following suboptions to select which profiles should be obtained:

• Block counters (not in combination with with Call graph or Function timers)

• Call graph

• Function counters

• Function timers

Note that the more detailled information you request, the larger the overhead in terms of execution time, code size and
heap space needed. The option Generate Debug information (−−debug or −g) does not affect profiling, execution time
or code size.

Command line syntax

−−profile[=flags]
−p[flags]

Use the following option for a predefined set of flags:

−−profile=g (−pg) profiling with call graph and function timers
Alias for: −pBcFt

You can set the following flags (when you specify −p without flags, the default is −pBCfST):

+/−block (b/B) block counters
+/−callgraph (c/C) call graph
+/−function (f/F) function counters
+/−static (s/S) static profile generation
+/−time (t/T) function timers

Description

Profiling is the process of collecting statistical data about a running application. With these data you can analyze which functions
are called, how often they are called and what their execution time is.

Several methods of profiling exist. One method is code instrumentation which adds code to your application that takes care of
the profiling process when the application is executed.

For an extensive description of profiling refer to Chapter 3, Profiling, in the user’s manual.

With this option, the compiler adds the extra code to your application that takes care of the profiling process. You can obtain the
following profiling data (see flags above):

Block counters (not in combination with Call graph or Time)

This will instrument the code to perform basic block counting. As the program runs, it counts the number of executions of
each branch in an if statement, each iteration of a for loop, and so on. Note that though you can combine Block counters
with Function counters, this has no effect because Function counters is only a subset of Block counters.

Call graph (not in combination with Block counters)

This will instrument the code to reconstruct the run−time call graph. As the program runs it associates the caller with the
gathered profiling data.
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Function counters

This will instrument the code to perform function call counting. This is a subset of the basic Block counters.

Time (not in combination with Block counters)

This will instrument the code to measure the time spent in a function. This includes the time spent in all sub functions
(callees).

Static profiling

With this option you do not need to run the application to get profiling results. The compiler generates profiling information at
compile time.

If you use the profiling option, you must link the corresponding libraries too! Refer to Section 5.4, Linking with Libraries in
Chapter Using the Linker of the user’s manual, for an overview of the (profiling) libraries. When you use Altium Designer,
automatically the correct libraries are linked.

Example

To generate block count information for the module test.c during execution, compile as follows:

c3000 −−profile=+block test.c

In this case you must link the library pb3000md.lib.

Related information

Chapter 3, Profiling in the user’s manual.
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C Compiler: −−rename−sections (−R)

Menu entry

1. From the Project menu, select Project Options...

The Project Options dialog box appears.

2. Expand the C Compiler entry and select Miscellaneous.

3. Add the option −−rename−sections to the Additional C compiler options field.

Command line syntax

−−rename−sections=[name]={suffix|−f|−m|−fm}
−R[name]={suffix|−f|−m|−fm}

Description

In case a module must be loaded at a fixed address, or a data section needs a special place in memory, you can use this option
to generate different section names. You can then use this unique section name in the linker script file for locating. Because
sections have reserved names, the compiler will not actually change the section name, but will add a suffix to the name.

With the section name you select which sections are renamed. With suffix you specify the suffix part which will be attached to
the existing name. The following name values have special meaning:

With the suboption −f, the compiler uses the function name (only for code).

With the suboption −m, the compiler uses the name of the current module.

With the suboption −fm (or −mf), the compiler uses the name of the current module for data sections and the function name for
code sections.

If you do not specify a section name, all sections will receive the specified suffix.

Example

To change all sections named .data  into .data.NEW:

c3000 −−rename−sections=.data=NEW test.c

To add the name of the current module name as suffix to all data sections, resulting in .data.test):

c3000 −−rename−sections=.data=−m test.c

Related information

Assembler directive .SECTION
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C Compiler: −−runtime (−r)

Menu entry

1. From the Project menu, select Project Options...

The Project Options dialog box appears.

2. Expand the C Compiler entry and select Debug Information.

3. Enable the option Run−time checks.

4. Enable one or more of the following suboptions to select which run−time checks should be performed:

• Bounds checking

• Report unhandled case in a switch

• Malloc consistency checks

Command line syntax

−−runtime[=flags]
−r[flags]

You can set the following flags (when you specify −r without flags, the default is −rbcm):

+/−bounds (b/B) bounds checking
+/−case (c/C) report unhandled case in a switch
+/−malloc (m/M) malloc consistency checks

Description

This option controls a number of run−time checks to detect errors during program execution. Some of these checks require
additional code to be inserted in the original application code, and may therefore slow down the program execution. The
following checks are available:

Bounds checking

Every pointer update and dereference will be checked to detect out−of−bounds accesses, null pointers and uninitialized
automatic pointer variables. This check will increase the code size and slow down the program considerably. In addition, some
heap memory is allocated to store the bounds information. You may enable bounds checking for individual modules or even
parts of modules only (see #pragma runtime).

Report unhandled case in a switch

Report an unhandled case value in a switch without a default part. This check will add one function call to every switch without a
default part, but it will have little impact on the excution speed.

Malloc consistency checks

This option enables the use of wrappers around the functions malloc/realloc/free that will check for common dynamic memory
allocation errors like:

• buffer overflow

• write to freed memory

• multiple calls to free

• passing invalid pointer to free

Enabling this check will extract some additional code from the library, but it will not enlarge your application code. The dynamic
memory usage will increase by a couple of bytes per allocation.

Related information

−
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C Compiler: −−sdata

Menu entry

1. From the Project menu, select Project Options...

The Project Options dialog box appears.

2. Expand the C Compiler entry and select Code Generation.

3. Enable the option Enable allocation in sdata.

4. Specify a size for Allocation in sdata for objects smaller than threshold (default: 4)

Command line syntax

−−sdata=size (Default: 4 bytes)

Description

With this option you tell the compiler to place all global and static data objects smaller than the specified size (bytes) into the
small data section (sdata) or small bss section (sbss). This results in smaller and faster code. In total, 64kB is available for this
kind of addressing.

Without this option, all global and static data objects of 4 bytes and smaller are placed into the small data sections and small bss
sections.

You can still overrule this option with the keywords __sdata and __no_sdata for individiual data objects in your source.

External data that falls within the threshold, is not considered part of sdata. If you want external data to be part of this too, also
specify option −−extern−sdata.

If you use option  −−extern−sdata, you must use the option  −−sdata with the same value for all modules in your
application.

Example

To put all global and static data objects with a size of 8 bytes or smaller into the sdata section:

c3000 −−sdata=8 test.c

Related information

C compiler option −−extern−sdata
Section 1.3, Memory Qualifiers.
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C Compiler: −−signed−bitfields

Menu entry

1. From the Project menu, select Project Options...

The Project Options dialog box appears.

2. Expand the C Compiler entry and select Language.

3. Enable the option Treat ’int’ bit−fields as signed.

Command line syntax

−−signed−bitfields

Description

For bit−fields it depends on the implementation whether a plain int is treated as signed int or unsigned int. By
default an int bit−field is treated as unsigned int. This offers the best performance. With this option you tell the compiler
to treat int bit−fields as signed int. In this case, you can still add the keyword unsigned to treat a particular int
bit−field as unsigned.

Related information

−
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C Compiler: −−source (−s)

Menu entry

1. From the Project menu, select Project Options...

The Project Options dialog box appears.

2. Expand the C Compiler entry and select Miscellaneous.

3. Enable the option Merge C source code with assembly in output file (.src).

Command line syntax

−−source
−s

Description

With this option you tell the compiler to merge C source code with generated assembly code in the output file. The C source
lines are included as comments.

Related information

−
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C Compiler: −−static

Menu entry

1. From the Project menu, select Project Options...

The Project Options dialog box appears.

2. Expand the C Compiler entry and select Miscellaneous.

3. Add the option −−static to the Additional C compiler options field.

Command line syntax

−−static

Description

With this option, the compiler treats external definitions at file scope (except for main) as if they were declared static. As a
result, unused functions will be eliminated, and the alias checking algorithm assumes that objects with static storage cannot be
referenced from functions outside the current module.

On the command line this option only makes sense when you specify all modules of an application on the command line.

Example

c3000 −−static module1.c module2.c module3.c ...

Related information

−



Tool Options − C Compiler

4−43

C Compiler: −−stdout (−n)

Menu entry

Command line only.

Command line syntax

−−stdout
−n

Description

With this option you tell the compiler to send the output to stdout (usually your screen). No files are created. This option is for
example useful to quickly inspect the output or to redirect the output to other tools.

Related information

−
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C Compiler: −−tradeoff (−t)

Menu entry

1. From the Project menu, select Project Options...

The Project Options dialog box appears.

2. Expand the C Compiler entry and select Optimization.

3. In the Size/speed trade−off field, select a level between fully optimize for size or fully optimize for speed.

Command line syntax

−−tradeoff={0|1|2|3|4}
−t{0|1|2|3|4}

Description

If the compiler uses certain optimizations (option −−optimize), you can use this option to specify whether the used optimizations
should optimize for more speed (regardless of code size) or for smaller code size (regardless of speed).

By default the compiler optimizes for more speed (−−tradeoff=0).

If you have not used the option −−optimize, the compiler uses the default optimization. In this case it is still useful to
specify a trade−off level.

Related information

C compiler option −−optimize (Specify optimization level)
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C Compiler: −−uchar (−u)

Menu entry

1. From the Project menu, select Project Options...

The Project Options dialog box appears.

2. Expand the C Compiler entry and select Language.

3. Enable the option Treat ’char’ variables as unsigned.

Command line syntax

−−uchar
−u

Description

By default char is the same as specifying signed char. With this option char is the same as unsigned char.

Related information

−
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C Compiler: −−undefine (−U)

Menu entry

1. From the Project menu, select Project Options...

The Project Options dialog box appears.

2. Expand the C Compiler entry and select Miscellaneous.

3. Add the option −−undefine to the Additional C compiler options field.

Command line syntax

−−undefine=macro_name
−Umacro_name

Description

With this option you can undefine an earlier defined macro as with #undef.

This option is for example useful to undefine predefined macros.

However, the following predefined ISO C standard macros cannot be undefined:

__FILE__ current source filename
__LINE__ current source line number (int type)
__TIME__ hh:mm:ss
__DATE__ mmm dd yyyy
__STDC__ level of ANSI standard

Example

To undefine the predefined macro __TASKING__:

c3000 −−undefine=__TASKING__ test.c

Related information

C compiler option −−define (Define preprocessor macro)
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C Compiler: −−use−hardware

Menu entry

1. From the Project menu, select Project Options...

The Project Options dialog box appears.

2. Expand the Processor entry and select Processor Definition.

3. Enable one or more of the options:

• Multiply/Divide unit present

Command line syntax

−−use−hardware=flag,...

You can set the following flags:

+/−divide (d/D) Divide instructions
+/−multiply (m/M) Multiply instructions

Default: dm

Description

With this option you tell the compiler that the TSK3000 target has a hardware multiply/divide unit. This way the compiler can use
the optional divide and multiply instructions.

Related information

−
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C Compiler: −−version (−V)

Menu entry

Command line only.

Command line syntax

−−version
−V

Description

Displays version information of the compiler. The compiler ignores all other options or input files.

Related information

−
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C Compiler: −−warnings−as−errors

Menu entry

1. From the Project menu, select Project Options...

The Project Options dialog box appears.

2. Expand the C Compiler entry and select Diagnostics.

3. Enable the option Treat warnings as errors.

Command line syntax

−−warnings−as−errors[=number,...]

Description

If the compiler encounters an error, it stops compiling. When you use this option without arguments, you tell the compiler to treat
all warnings as errors. This means that the exit status of the compiler will be non−zero after one or more compiler warnings. As
a consequence, the compiler now also stops after encountering a warning.

You can also limit this option to specific warnings by specifying a comma−separated list of warning numbers.

Related information

C compiler option −−no−warnings (Suppress some or all warnings)
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4.2 Assembler Options

Altium Designer uses a makefile to build your entire project. This means that in Altium Designer you cannot run the assembler
separately. If you want assembly results, you must compile a single C source file from within Altium Designer, the file is then
also assembled. However, you can set options specific for the assembler.

Options in Altium Designer versus options on the command line

Most command line options have an equivalent option in Altium Designer but some options are only available on the command
line (for example in a Windows Command Prompt). If there is no equivalent option in Altium Designer, you can specify a
command line option in Altium Designer as follows:

1. From the Project menu, select Project Options...

The Project Options dialog box appears.

2. Expand the Assembler entry and select Miscellaneous.

3. Enter one or more command line options in the Additional assembler options field.

Invocation syntax on the command line (Windows Command Prompt)

To call the assembler from the command line, use the following syntax:

as3000 [ [option]... [file]... ]...

The input file must be an assembly source file (.asm or .src).

Short and long option names

Options can have both short and long names. Short option names always begin with a single minus (−) character, long option
names always begin with double minus (−−) characters. You can abbreviate long option names as long as the name is unique.
You can mix short and long option names on the command line.

Options can have flags or sub−options. To switch a flag ’on’, use a lowercase letter or a +longflag. To switch a flag off, use an
uppercase letter or a −longflag. Separate longflags with commas. The following two invocations are equivalent:

as3000 −Ogs test.src

as3000 −−optimize=+generics,+instr−size test.src

When you do not specify an option, a default value may become active.
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Assembler: −−case−insensitive (−c)

Menu entry

1. From the Project menu, select Project Options...

The Project Options dialog box appears.

2. Expand the Assembler entry and select Miscellaneous.

3. Disable the option Assemble case sensitive.

Command line syntax

−−case−insensitive
−c

Description

With this option you tell the assembler not to distinguish between upper and lower case characters. By default the assembler
considers upper and lower case characters as different characters.

Disabling the option Assemble case sensitive in Altium Designer is the same as specifying the option
−−case−insensitive on the command line.

Assembly source files that are generated by the compiler must always be assembled case sensitive. When you are writing your
own assembly code, you may want to specify the case insensitive mode.

Example

When assembling case insensitive, the label LabelName is the same label as labelname.

Related information

−
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Assembler: −−check

Menu entry

1. From the Project menu, select Project Options...

The Project Options dialog box appears.

2. Expand the Assembler entry and select Miscellaneous.

3. Add the option −−check to the Additional assembler options field.

Command line syntax

−−check

Description

With this option you can check the source code for syntax errors, without generating code. This saves time in developing your
application.

The assembler reports any warnings and/or errors.

Related information

C compiler option −−check (Check syntax)
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Assembler: −−debug−info (−g)

Menu entry

1. From the Project menu, select Project Options...

The Project Options dialog box appears.

2. Expand the Assembler entry and select Debug Information.

3. Select which debug information to include: Automatic HLL or assembly level debug information, Custom debug
information or No debug information.

If you select Custom debug information:

4. Select which Custom debug information to include: Assembler source line information, Pass HLL debug information, or
None.

5. Enable or disable the option Assembler local symbols information.

Command line syntax

−−debug−info[=flag]
−g[flag]

You can set the following flags:

+/−asm (a/A) Assembly source line information
+/−hll (h/H) Pass high level language debug information (HLL)
+/−local (l/L) Assembler local symbols debug information
+/−smart (s/S) Smart debug information

Description

With this option you tell the assembler which kind of debug information to emit in the object file.

If you do not use this option, the default is −−debug−info=+hll. If you specify −−debug−info without any flags, the default is
−−debug−info=+smart.

You cannot specify −−debug−info=+asm,+hll. Either the assembler generates assembly source line information, or it passes
HLL debug information.

When you specify −−debug−info=+smart, the assembler selects which flags to use. If high level language information is
available in the source file, the assembler passes this information (same as −−debug−info=−asm,+hll,−local). If not, the
assembler generates assembly source line information (same as −−debug−info=+asm,−hll,+local).

With −−debug−info=AHLS the assembler does not generate any debug information.

Related information

−
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Assembler: −−define (−D)

Menu entry

1. From the Project menu, select Project Options...

The Project Options dialog box appears.

2. Expand the Assembler entry and select Preprocessing.

3. Click on User macro, click on the down arrow in the right pane to expand macro input.

4. Click on an empty Macro field and enter a macro name. (Then click outside the cell to confirm)

5. Optionally, click in the Value field and enter a definition. (Then click outside the cell to confirm)

Command line syntax

−−define=macro_name[=macro_definition]
−Dmacro_name[=macro_definition]

Description

With this option you can define a macro and specify it to the assembler preprocessor. If you only specify a macro name (no
macro definition), the macro expands as ’1’.

You can specify as many macros as you like. On the command line you can use the option −−define (−D) multiple times. If the
command line exceeds the limit of the operating system, you can define the macros in an option file which you then must specify
to the assembler with the option −−option−file=file (−f).

Defining macros with this option (instead of in the assembly source) is, for example, useful in combination with conditional
assembly as shown in the example below.

This option has the same effect as defining symbols via the .DEFINE, .SET, and .EQU directives. (similar to #define in
the C language). With the .MACRO directive you can define more complex macros.

Example

Consider the following assembly program with conditional code to assemble a demo program and a real program:

.IF DEMO == 1

...        ; instructions for demo application

.ELSE

...        ; instructions for the real application

.ENDIF

You can now use a macro definition to set the DEMO flag:

Macro Value

DEMO 1 (or empty)

as3000 −−define=DEMO test.src
as3000 −−define=DEMO=1 test.src

Note that both invocations have the same effect.

Related information

Assembler option −−option−file (Read options from file)
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Assembler: −−diag

Menu entry

1. From the View menu, select Workspace Panels » System » Messages.

The Messages panel appears.

2. In the Messages panel, right−click on the message you want more information on.

A popup menu appears.

3. Select More Info.

A Message Info box appears with additional information.

Command line syntax

−−diag=[format:]{all|nr,...}

Description

With this option you can ask for an extended description of error messages in the format you choose. The output is directed to
stdout (normally your screen) and in the format you specify. You can specify the following formats: html, rtf or text (default).
To create a file with the descriptions, you must redirect the output.

With the suboption all, the descriptions of all error messages are given. If you want the description of one or more selected error
messages, you can specify the error message numbers, separated by commas.

With this option the assembler does not assemble any files.

Example

To display an explanation of message number 241, enter:

as3000 −−diag=241

This results in the following message and explanation:

W241: additional input files will be ignored

The assembler supports only a single input file. All other input files are ignored.

To write an explanation of all errors and warnings in HTML format to file aserrors.html, use redirection and enter:

as3000 −−diag=html:all > aserrors.html

Related information

−
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Assembler: −−emit−locals

Menu entry

Command line only.

Command line syntax

−−emit−locals[=flag,...]

You can set the following flags (when you specify no flags, the default is Es)::

+/−equs (e/E) emit local EQU symbols
+/−symbols (s/S) emit local non−EQU symbols

Description

With the option −−emit−locals=+equs the assembler also emits local EQU symbols to the object file. Normally, only global
symbols and non−EQU local symbols are emitted. Having local symbols in the object file can be useful for debugging.

Related information

−
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Assembler: −−error−file

Menu entry

Command line only.

Command line syntax

−−error−file[=file]

Description

With this option the assembler redirects error messages to a file.

If you do not specify a filename, the error file will be named after the input file with extension .ers.

Example

To write errors to errors.err instead of stderr, enter:

as3000 −−error−file=errors.err test.src

Related information

−



TSK3000 Embedded Tools Reference

4−58

Assembler: −−error−limit

Menu entry

1. From the Project menu, select Project Options...

The Project Options dialog box appears.

2. Expand the Assembler entry and select Miscellaneous.

3. Add the option −−error−limit to the Additional assembler options field.

Command line syntax

−−error−limit=number

Description

With this option you tell the assembler to only emit the specified maximum number of errors. Without this option (same as 0) the
assembler emits all errors.

Related information

−
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Assembler: −−gp−relative

Menu entry

1. From the Project menu, select Project Options...

The Project Options dialog box appears.

2. Expand the Assembler entry and select Miscellaneous.

3. Enable the option Automatically generate GP−relative offsets.

Command line syntax

−−gp−relative

Description

When this option is enabled the assembler automatically emits a GP−relative relocation for symbolic offsets in load and store
instructions if the base register is the GP−register ($28).

When this option is disabled (default) you must use the built−in assembly function @GPREL() on the symbolic offset in order to
force the assembler to emit a GP−relative relocation. Assembly code generated by the compiler always uses the @GPREL()
function.

Related information

Assembly function @GPREL()
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Assembler: −−help (−?)

Menu entry

Command line only.

Command line syntax

−−help[=options]
−?

Description

Displays an overview of all command line options. When you specify the argument options you can list detailed option
descriptions.

Example

The following invocations all display a list of the available command line options:

as3000 −?
as3000 −−help
as3000

To see a detailed description of the available options, enter:

as3000 −−help=options
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Assembler: −−include−directory (−I)

Menu entry

1. From the Project menu, select Project Options...

The Project Options dialog box appears.

2. Select Build Options.

3. Add a pathname in the Include Files Path field.

If you enter multiple paths, separate them with a semicolon (;).

Command line syntax

−−include−directory=path,...
−Ipath,...

Description

With this option you can specify the path where your include files are located. A relative path will be relative to the current
directory.

The order in which the assembler searches for include files is:

1. The pathname in the assembly file and the directory of the assembly source.

2. The path that is specified with this option.

3. The path that is specified in the environment variable AS3000INC when the product was installed.

4. The default include directory relative to the installation directory.

Example

Suppose that your assembly source file test.src contains the following line:

.INCLUDE ’myinc.inc’

You can call the assembler as follows:

as3000 −−include−directory=c:\proj\include test.src

First the assembler looks in the directory where test.src is located for the file myinc.inc. If it does not find the file, it looks in
the directory c:\proj\include for the file myinc.inc (this option). If the file is still not found, the assembler searches in the
environment variable and then in the default include directory.

Related information

Assembler option −−include−file (−H) (Include file before source)
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Assembler: −−include−file (−H)

Menu entry

1. From the Project menu, select Project Options...

The Project Options dialog box appears.

2. Expand the Assembler entry and select Preprocessing.

3. Enter the name of the file in the Include this file before source field or click ... and select a file.

Command line syntax

−−include−file=file,...
−Hfile,...

Description

With this option (set at project level) you include one extra file at the beginning of the assembly source file. The specified include
file is included before all other includes. This is the same as specifying .INCLUDE ’file’ at the beginning of your assembly
source.

Example

as3000 −−include−file=myinc.inc test1.src

The file myinc.inc is included at the beginning of test1.src before it is assembled.

Related information

Assembler option −−include−directory (Include files path)

Section 4.4, How the Assembler Searches Include Files, in chapter Using the Assembler of the user’s manual.
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Assembler: −−keep−output−files (−k)

Menu entry

Altium Designer always removes the object file when errors occur during assembling.

Command line syntax

−−keep−output−files
−k

Description

If an error occurs during assembling, the resulting object file (.obj) may be incomplete or incorrect. With this option you keep
the generated object file when an error occurs.

By default the assembler removes the generated object file when an error occurs. This is useful when you use the make utility. If
the erroneous files are not removed, the make utility may process corrupt files on a subsequent invocation.

Use this option when you still want to use the generated object. For example when you know that a particular error does not
result in a corrupt object file.

Related information

−
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Assembler: −−list−file (−l)

Menu entry

1. From the Project menu, select Project Options...

The Project Options dialog box appears.

2. Expand the Assembler entry and select List File.

3. Enable Generate list file.

4. In the List file format section, enable or disable the types of information to be included.

Command line syntax

−−list−file[=file]
−l[file]

Description

With this option you tell the assembler to generate a list file. A list file shows the generated object code and the relative
addresses. Note that the assembler generates a relocatable object file with relative addresses.

With the optional file you can specify an alternative name for the list file. By default, the name of the list file is the basename of
the source file with the extension .lst.

Related information

On the command line you can use the option −−list−format (−L) to specify which types of information should be included
in the list file.
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Assembler: −−list−format (−L)

Menu entry

1. From the Project menu, select Project Options...

The Project Options dialog box appears.

2. Expand the Assembler entry and select List File.

3. Enable Generate list file.

4. In the List file format section, enable or disable the types of information to be included.

Command line syntax

−−list−format=flags
−Lflags

You can set the following flags:

0 Same as −LDEGILMNPQRSVWXYZ (all options disabled)
1 Same as −Ldegilmnpqrsvwxyz (all options enabled)

+/−section (d/D) Section directives (.SECTION)
+/−symbol (e/E) Symbol definition directives
+/−generic−expansion (g/G) Generic instruction expansion
+/−generic (i/I) Generic instructions
+/−line (l/L) C preprocessor #line directives
+/−macro (m/M) Macro/dup definitions (e.g. .MACRO)
+/−empty−line (n/N) Empty source lines (newline)
+/−conditional (p/P) Conditional assembly (.IF, .ELSE, .ENDIF)
+/−equate (q/Q) Assembler .EQU and .SET directives
+/−relocations (r/R) Relocation characters (’r’)
+/−hll (s/S) HLL symbolic debug information (.SYMB)
+/−equate−values (v/V) Assembler .EQU and .SET values
+/−wrap−lines (w/W) Wrapped source lines
+/−macro−expansion (x/X) Macro expansions
+/−cycle−count (y/Y) Cycle counts
+/−macro−expansion (z/Z) Define expansions

Default: −LdEGilMnPqrsVwXyZ

Description

With this option you specify which information you want to include in the list file.

On the command line you must use this option in combination with the option −−list−file (−l).

Related information

Assembler option −−list−file (Generate list file)
Assembler option −−section−info=+list (Display section information in list file)
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Assembler: −−nested−sections (−N)

Menu entry

1. From the Project menu, select Project Options...

The Project Options dialog box appears.

2. Expand the Assembler entry and select Miscellaneous.

3. Add the option −N to the Additional assembler options field.

Command line syntax

−−nested−sections
−N

Description

With this option it is allowed to have nested sections in your assembly source file. When you use this option every .SECTION
directive must have a corresponding .ENDSEC directive.

Example

.SECTION .text
    ; code
    .SECTION .data
        ; a nested section
    .ENDSEC
    ;code
.ENDSEC

Related information

−
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Assembler: −−nop−insertion

Menu entry

1. From the Project menu, select Project Options...

The Project Options dialog box appears.

2. Expand the Assembler entry and select Miscellaneous.

3. Enable the option Insert a NOP after all jumps and branches.

Command line syntax

−−nop−insertion

Description

When this option is enabled the assembler automatically fills the delay slots of jump and branch instructions with a NOP
instruction. NOP insertion can be done with higher granularity by using the .nopinsertion and .nonopinsertion directives
in assembly sources.

Related information

Assembler directive .nopinsertion
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Assembler: −−no−warnings (−w)

Menu entry

1. From the Project menu, select Project Options...

The Project Options dialog box appears.

2. Expand the Assembler entry and select Diagnostics.

3. Enable one of the options:

• Report all warnings

• Suppress all warnings

• Suppress specific warnings

If you select Suppress specific warnings:

4. Enter the numbers, separated by commas, of the warnings you want to suppress.

Command line syntax

−−no−warnings[=number,...]
−w[number,...]

Description

With this option you can suppresses all warning messages or specific warning messages.

• If you do not specify this option, all warnings are reported.

• If you specify this option but without numbers, all warnings are suppressed.

• If you specify this option with a number, only the specified warning is suppressed.
You can specify the option −−no−warnings=number multiple times.

Example

To suppress warnings 135 and 136, enter 135, 136 in the Specific warnings to suppress field, or enter the following on the
command line:

as3000 test.src −−no−warnings=135,136

Related information

Assembler option −−warnings−as−errors (Treat warnings as errors)
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Assembler: −−optimize (−O)

Menu entry

1. From the Project menu, select Project Options...

The Project Options dialog box appears.

2. Expand the Assembler entry and select Optimization.

3. Enable or disable the optimization options:

• Generic instructions

• Jump chains

• Instruction size

Command line syntax

−Oflags
−−optimize=flags

You can set the following flags:

+/−generics (g/G) Allow generic instructions
+/−jumpchains (j/J) Jump chains
+/−instr−size (s/S) Optimize instruction size

Default: −−optimize=gJs

Description

Allow generic instructions

If you use generic instructions in your assembly source, the assembler can optimize them by replacing it with the fastest or
shortest possible variant of that instruction. By default this option is enabled. If you turn off this optimization, the assembler
generates an error on generic instructions. Be aware that the compiler also generates generic instructions!

Jump chains

With this optimization, the assembler replaces chained jumps by a single jump instruction. For example, a jump from a to b
immediately followed by a jump from b to c, is replaced by a jump from a to c.

Optimize instruction size

With this optimization the assembler tries to find the shortest possible operand encoding for instructions.

Related information

Section 4.5, Assembler Optimizations in chapter Using the Assembler of the user’s manual.
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Assembler: −−option−file (−f)

Menu entry

1. From the Project menu, select Project Options...

The Project Options dialog box appears.

2. Expand the Assembler entry and select Miscellaneous.

3. Add the option −−option−file to the Additional assembler options field.

Be aware that the options in the option file are added to the assembler options you have set in the other dialogs. Only in
extraordinary cases you may want to use them in combination.

Command line syntax

−−option−file=file,...
−f file,...

Description

This option is primarily intended for command line use. Instead of typing all options on the command line, you can create an
option file which contains all options and flags you want to specify. With this option you specify the option file to the assembler.

Use an option file when the command line would exceed the limits of the operating system, or just to store options and save
typing.

Option files can also be generated on the fly, for example by the make utility. You can specify the option −−option−file multiple
times.

Format of an option file

• Multiple arguments on one line in the option file are allowed.

• To include whitespace in an argument, surround the argument with single or double quotes.

• If you want to use single quotes as part of the argument, surround the argument by double quotes and vise versa:

"This has a single quote ’ embedded"

’This has a double quote " embedded’

’This has a double quote " and a single quote ’"’ embedded"

• When a text line reaches its length limit, use a ’to continue the line. Whitespace between quotes is preserved.

"This is a continuation \
line"

         −> "This is a continuation line"

• It is possible to nest command line files up to 25 levels.

Example

Suppose the file myoptions contains the following lines:

−gaL
test.src

Specify the option file to the assembler:

as3000 −−option−file=myoptions

This is equivalent to the following command line:

as3000 −gaL test.src

Related information

−
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Assembler: −−output (−o)

Menu entry

Altium Designer names the output file always after the source file.

Command line syntax

−−output=file
−o file

Description

With this option you can specify another filename for the output file of the assembler. Without this option, the basename of the
assembly source file is used with extension .obj.

Example

To create the file relobj.obj instead of asm.obj, enter:

as3000 −−output=relobj.obj asm.src

Related information

−
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Assembler: −−page−length

Menu entry

1. From the Project menu, select Project Options...

The Project Options dialog box appears.

2. Expand the Assembler entry and select Miscellaneous.

3. Add the option −−page−length to the Additional assembler options field.

Command line syntax

−−page−length=number

Default: 72

Description

If you generate a list file with the assembler option −−list−file, (−l), this option sets the number of lines in a page in the list file.
The default is 72, the minimum is 10. As a special case, a page length of 0 turns off page breaks.

Related information

Assembler option −−list−file (Generate list file)
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Assembler: −−page−width

Menu entry

1. From the Project menu, select Project Options...

The Project Options dialog box appears.

2. Expand the Assembler entry and select Miscellaneous.

3. Add the option −−page−width to the Additional assembler options field.

Command line syntax

−−page−width=number

Default: 132

Description

If you generate a list file with the assembler option −−list−file, (−l), this option sets the number of columns per line on a page in
the list file. The default is 132, the minimum is 40.

Related information

Assembler option −−list−file (Generate list file)
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Assembler: −−preprocess (−E)

Menu entry

1. From the Project menu, select Project Options...

The Project Options dialog box appears.

2. Expand the Assembler entry and select Miscellaneous.

3. Add the option −−preprocess to the Additional assembler options field.

Command line syntax

−−preprocess
−E

Description

With this option the assembler will only preprocess the assembly source file. The assembler sends the preprocessed file to
stdout.

Related information

−
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Assembler: −−preprocessor−type (−m)

Menu entry

1. From the Project menu, select Project Options...

The Project Options dialog box appears.

2. Expand the Assembler entry and select Miscellaneous.

3. Add the option −−preprocessor−type to the Additional assembler options field.

Command line syntax

−−preprocessor−type={none|tasking}
−m{n|t} Default: −mt

Description

With this option you select the preprocessor that the assembler will use. By default, the assembler uses the TASKING
preprocessor.

When the assembly source file does not contain any preprocessor symbols, you can specify to the assembler not to use a
preprocessor.

Related information

−
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Assembler: −−section−info (−t)

Menu entry

1. From the Project menu, select Project Options...

The Project Options dialog box appears.

2. Expand the Assembler entry and select List File.

3. Enable Generate list file.

4. Enable the option Display section information.

Command line syntax

−−section−info[=flags]
−t[flags]

You can set the following flags:

+/−console (c/C) Display section information on stdout.
+/−list (l/L) Write section information to the list file.

Description

With this option you tell the assembler to display section information. For each section its memory space, size, total cycle counts
and name is listed on stdout and/or in the list file.

The cycle count consists of two parts: the total accumulated count for the section and the total accumulated count for all
repeated instructions. In the case of nested loops it is possible that the total supersedes the section total.

Without arguments this option is the same as −−section−info=cl.

With −−section−info=l, the assembler writes the section information to the list file. You must specify this option in
combination with the option −−list−file (generate list file).

Example

as3000 −−list−file −−section−info=+console,+list test.src

The assembler generates a list file and writes the section information to this file. The section information is also displayed on
stdout.

Related information

Assembler option −−list−file (generate list file)
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Assembler: −−symbol−scope (−i)

Menu entry

1. From the Project menu, select Project Options...

The Project Options dialog box appears.

2. Expand the Assembler entry and select Miscellaneous.

3. Select the default label mode: Local or Global.

Command line syntax

−−symbol−scope={global|local}
−i{g|l} (Default: −il)

Description

With this option you tell the assembler how to treat symbols that you have not specified explicitly as global or local. By default
the assembler treats all symbols as local symbols unless you have defined them explicitly as global.

Related information

−
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Assembler: −−use−hardware

Menu entry

1. From the Project menu, select Project Options...

The Project Options dialog box appears.

2. Expand the Processor entry and select Processor Definition.

3. Enable one or more of the options:

• Multiply/Divide unit present

Command line syntax

−−use−hardware=flag,...

You can set the following flags:

+/−divide (d/D) Divide instructions
+/−multiply (m/M) Multiply instructions

Default: dm

Description

With this option you tell the assembler that the TSK3000 target has a hardware multiply/divide unit. This way the assembler can
use the optional divide and multiply instructions.

Related information

−
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Assembler: −−version (−V)

Menu entry

Command line only.

Command line syntax

−−version
−V

Description

Displays version information of the assembler. The assembler ignores all other options or input files.

Related information

−
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Assembler: −−verbose (−v)

Menu entry

Command line only.

Command line syntax

−−verbose
−v

Description

With this option you put the assembler in verbose mode. The assembler prints the filenames and the assembly passes while it
processes the files so you can monitor the current status of the assembler.

Related information

−
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Assembler: −−warnings−as−errors

Menu entry

1. From the Project menu, select Project Options...

The Project Options dialog box appears.

2. Expand the Assembler entry and select Diagnostics.

3. Enable the option Treat warnings as errors.

Command line syntax

−−warnings−as−errors[=number,...]

Description

If the assembler encounters an error, it stops assembling. When you use this option without arguments, you tell the assembler to
treat all warnings as errors. This means that the exit status of the assembler will be non−zero after one or more compiler
warnings. As a consequence, the assembler now also stops after encountering a warning.

You can also limit this option to specific warnings by specifying a comma−separated list of warning numbers.

Related information

Assembler option −−no−warnings (Suppress some or all warnings)
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4.3 Linker Options

Altium Designer uses a makefile to build your entire project. This means that you cannot run the linker separately. However, you
can set options specific for the linker.

Options in Altium Designer versus options on the command line

Most command line options have an equivalent option in Altium Designer but some options are only available on the
command line (for example in a Windows Command Prompt). If there is no equivalent option in Altium Designer, you can
specify a command line option in Altium Designer as follows:

1. From the Project menu, select Project Options...

The Project Options dialog box appears.

2. Expand the Linker entry and select Miscellaneous.

3. Enter one or more command line options in the Additional Linker options field.

Invocation syntax on the command line (Windows Command Prompt)

The invocation syntax on the command line is:

lk3000 [ [option]... [file]... ]...

When you are linking multiple files (either relocatable object files (.obj) or libraries (.lib), it is important to specify the files in
the right order.

Short and long option names

Options can have both short and long names. Short option names always begin with a single minus (−) character, long option
names always begin with double minus (−−) characters. You can abbreviate long option names as long as the name is unique.
You can mix short and long option names on the command line.

Options can have flags or sub−options. To switch a flag ’on’, use a lowercase letter or a +longflag. To switch a flag off, use an
uppercase letter or a −longflag. Separate longflags with commas. The following two invocations are equivalent:

lk3000 −mfk test.obj

lk3000 −−map−file−format=+files,+link test.obj

When you do not specify an option, a default value may become active.
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Linker: −−case−insensitive

Menu entry

1. From the Project menu, select Project Options...

The Project Options dialog box appears.

2. Expand the Linker entry and select Miscellaneous.

3. Disable the option Link case sensitive.

Command line syntax

−−case−insensitive

Description

With this option you tell the linker not to distinguish between upper and lower case characters in symbols. By default the linker
considers upper and lower case characters as different characters.

Disabling the option Link case sensitive in Altium Designer is the same as specifying the option −−case−insensitive on
the command line.

Assembly source files that are generated by the compiler must always be assembled and thus linked case sensitive. When you
have written your own assembly code and specified to assemble it case insensitive, you must also link the .obj file case
insensitive.

Related information

−
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Linker: −−chip−output (−c)

Menu entry

1. From the Project menu, select Project Options...

The Project Options dialog box appears.

2. Expand the Linker entry and select Output Format.

3. Enable the options Intel HEX records and/or Motorola S−records.

Command line syntax

−−chip−output=[basename]:format[:addr_size],...
−c[basename]:format[:addr_size],...

You can specify the following formats:

IHEX Intel Hex
SREC Motorola S−records

The addr_size specifies the size of the addresses in bytes (record length). For Intel Hex you can use the values 1, 2 or 4 bytes
(default). For Motorola−S you can specify: 2 (S1 records), 3 (S2 records) or 4 bytes (S3 records, default). In Altium Designer you
cannot specify the address size because Altium Designer always uses the default values.

Description

With this option you specify the Intel Hex or Motorola S−record output format for loading into a PROM−programmer. The linker
generates a file for each ROM memory defined in the LSL file, where sections are located:

memory memname
{  type=rom;  }

The name of the file is the name of the Altium Designer project or, on the command line, the name of the memory  device that
was emitted with extension .hex or .sre. Optionally, you can specify a basename which prepends the generated file name.

The linker always outputs a debugging file in ELF/DWARF format and optionally an absolute object file in Intel
Hex−format and/or Motorola S−record format.

Example

To generate Intel Hex output files for each defined memory, enter the following on the command line:

lk3000 −−chip−output=myfile:IHEX test1.obj

In this case, this generates the file myfile_memname.hex

Related information

Linker option −−output (Output file)

Section 6.2, Motorola S−Record Format,
Section 6.3, Intel Hex Record Format, in Chapter Object File Formats.
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Linker: −−define (−D)

Menu entry

1. From the Project menu, select Project Options...

The Project Options dialog box appears.

2. Expand the Linker entry and select Miscellaneous.

3. Add the option −−define to the Additional linker options field.

Command line syntax

−−define=macro_name[=macro_definition]
−Dmacro_name[=macro_definition]

Description

With this option you can define a macro and specify it to the linker LSL file preprocessor. If you only specify a macro name (no
macro definition), the macro expands as ’1’.

You can specify as many macros as you like; just use the option −−define multiple times. If the command line exceeds the limit
of the operating system, you can define the macros in an option file which you then must specify to the linker with the option
−−option−file=file (−f).

The definition can be tested by the preprocessor with #if, #ifdef and #ifndef, for conditional locating.

Example

To define the stack size and start address which are used in the linker script file 3000.lsl, enter:

lk3000 test.obj −otest.abs −d3000.lsl −D__STACK=32k
       −D__START=0x00000000

or using the long option names:

lk3000 −otest.abs −lsl−file=3000.lsl −−define=__STACK=32k
       −−define=__START=0x00000000

Related information

Linker option −−option−file (Read options from file)
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Linker: −−diag

Menu entry

1. From the View menu, select Workspace Panels » System » Messages.

The Messages panel appears.

2. In the Messages panel, right−click on the message you want more information on.

A popup menu appears.

3. Select More Info.

A Message Info box appears with additional information.

Command line syntax

−−diag=[format:]{all|nr,...]

Description

With this option you can ask for an extended description of error messages in the format you choose. The output is directed to
stdout (normally your screen) and in the format you specify. You can specify the following formats: html, rtf or text (default).
To create a file with the descriptions, you must redirect the output.

With the suboption all, the descriptions of all error messages are given. If you want the description of one or more selected error
messages, you can specify the error message numbers, separated by commas.

With this option the linker does not link/locate any files.

Example

To display an explanation of message number 106, enter:

lk3000 −−diag=106

This results in the following message and explanation:

E106: unresolved external: <message>

The linker could not resolve all external symbols. This is an error when the incremental
linking option is disabled. The <message> indicates the symbol that is unresolved.

To write an explanation of all errors and warnings in HTML format to file lerrors.html, enter:

lk3000 −−diag=html:all > lerrors.html

Related information

−
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Linker: −−error−file

Menu entry

−

Command line syntax

−−error−file[=file]

Description

With this option the linker redirects error messages to a file.

If you do not specify a filename, the error file is lk3000.elk.

Example

To write errors to errors.elk instead of stderr, enter:

lk3000 −−error−file=errors.elk test.obj

Related information

−
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Linker: −−error−limit

Menu entry

−

Command line syntax

−−error−limit=number

Description

With this option you tell the linker to only emit the specified maximum number of errors. When 0 (null) is specified, the linker
emits all errors. Without this option the maximum number of errors is 42.

Related information

−
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Linker: −−extern (−e)

Menu entry

1. From the Project menu, select Project Options...

The Project Options dialog box appears.

2. Expand the Linker entry and select Miscellaneous.

3. Add the option −−extern to the Additional linker options field.

Command line syntax

−−extern=symbol
−e symbol

Description

With this option you force the linker to consider the given symbol as an undefined reference. The linker tries to resolve this
symbol, either the symbol is defined in an object file or the linker extracts the corresponding symbol definition from a library.

This option is, for example, useful if the startup code is part of a library. Because your own application does not refer to the
startup code, you can force the startup code to be extracted by specifying the symbol _START as an unresolved external.

Example

Consider the following invocation:

lk3000 mylib.lib

Nothing is linked and no output file will be produced, because there are no unresolved symbols when the linker searches
through mylib.lib.

lk3000 −−extern=_START mylib.lib

In this case the linker searches for the symbol _START in the library and (if found) extracts the object that contains _START, the
startup code. If this module contains new unresolved symbols, the linker looks again in mylib.lib. This process repeats until
no new unresolved symbols are found.

Related information

Section 5.4, Linking with Libraries, in chapter Using the Linker of the user’s manual.
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Linker: −−first−library first

Menu entry

−

Command line syntax

−−first−library−first

Description

When the linker processes a library it searches for symbols that are referenced by the objects and libraries processed so far. If
the library contains a definition for an unresolved reference the linker extracts the object that contains the definition from the
library.

By default the linker processes object files and libraries in the order in which they appear on the command line. If you specify the
option −−first−library−first the linker always tries to take the symbol definition from the library that appears first on the
command line before scanning subsequent libraries.

This is for example useful when you are working with a newer version of a library that partially overlaps the older version.
Because they do not contain exactly the same functions, you have to link them both. However, when a function is present in
both libraries, you may want the linker to extract the most recent function.

Example

Consider the following example:

lk3000 −−first−library−first a.lib test.obj b.lib

If the file test.obj calls a function which is both present in a.lib and b.lib, normally the function in b.lib would be
extracted. With this option the linker first tries to extract the symbol from the first library a.lib.

Note that routines in b.lib that call other routines that are present in both a.lib and b.lib are now also resolved from
a.lib.

Related information

Linker option −−no−rescan (Rescan libraries to solve unresolved externals)
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Linker: −−help (−?)

Menu entry

−

Command line syntax

−−help[=options]
−?

Description

Displays an overview of all command line options. When you specify the argument options you can list detailed option
descriptions.

Example

The following invocations all display a list of the available command line options:

lk3000 −?
lk3000 −−help
lk3000

To see a detailed description of the available options, enter:

lk3000 −−help=options
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Linker: −−import−object

Menu entry

1. From the Project menu, select Project Options...

The Project Options dialog box appears.

2. Expand the Linker entry and select Miscellaneous.

3. Add the option −−import−object to the Additional linker options field.

Command line syntax

−−import−object=file,...

Description

With this option the linker imports a binary file containing raw data and places it in a section. The section name is derived from
the filename, in which dots are replaced by an underscore. So, when importing a file called my.jpg, a section with the name
my_jpg is created. In your application you can refer to the created section by using linker labels.

Related information

Section 5.7, Importing Binary Files.
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Linker: −−include−directory (−I)

Menu entry

−

Command line syntax

−−include−directory=path,...
−Ipath,...

Description

With this option you can specify the path where your LSL include files are located. A relative path will be relative to the current
directory.

The order in which the linker searches for LSL include files is:

1. The pathname in the LSL file and the directory where the LSL file is located
(only for #include files that are enclosed in "")

2. The path that is specified with this option.

3. The default directory $(PRODDIR)\include.lsl.

Example

Suppose that your linker script file mylsl.lsl contains the following line:

#include "myinc.inc"

You can call the linker as follows:

lk3000 −−include−directory=c:\proj\include −−lsl−file=mylsl.lsl test.obj

First the linker looks in the directory where mylsl.lsl is located for the file myinc.inc. If it does not find the file, it looks in the
directory c:\proj\include for the file myinc.inc (this option). Finally it looks in the directory $(PRODDIR)\include.lsl.

Related information

−
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Linker: −−incremental (−r)

Menu entry

−

Command line syntax

−−incremental
−r

Description

Normally the linker links and locates the specified object files. With this option you tell the linker only to link the specified files.
The linker creates a linker output file .out. You then can link this file again with other object files until you have reached the final
linker output file that is ready for locating.

In the last pass, you call the linker without this option with the final linker output file .out. The linker will now locate the file.

Example

In this example, the files test1.obj, test2.obj and test3.obj are incrementally linked:

1. lk3000 −−incremental test1.obj test2.obj −otest.out

test1.obj and test2.obj are linked

2. lk3000 −−incremental test3.obj test.out

test3.obj and test.out are linked, task1.out is created

3. lk3000 task1.out

task1.out is located

Related information

Section 5.5, Incremental Linking in chapter Using the Linker of the user’s manual.
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Linker: −−keep−output−files (−k)

Menu entry

Altium Designer always removes the output files when errors occurred.

Command line syntax

−−keep−output−files
−k

Description

If an error occurs during linking, the resulting output file may be incomplete or incorrect. With this option you keep the generated
output files when an error occurs.

By default the linker removes the generated output file when an error occurs. This is useful when you use the make utility. If the
erroneous files are not removed, the make utility may process corrupt files on a subsequent invocation.

Use this option when you still want to use the generated file. For example when you know that a particular error does not result
in a corrupt object file, or when you want to inspect the output file, or send it to Altium support.

Related information

−
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Linker: −−library (−l)

Menu entry

1. From the Project menu, select Project Options...

The Project Options dialog box appears.

2. Expand the Linker entry and select Libraries.

3. Enable the option Link default C libraries.

Command line syntax

−−library=name
−lname

Description

With this option you tell the linker to use system library name.lib, where name is a string. The linker first searches for
system libraries in any directories specified with −−library−directory, then in the directories specified with the environment
variable LIBTSK3000, unless you used the option −−ignore−default−library−path.

Example

To search in the system library c3000.lib (C library):

lk3000 test.obj mylib.lib −−library=c3000

The linker links the file test.obj and first looks in mylib.lib (in the current directory only), then in the system library
c3000.lib to resolve unresolved symbols.

Related information

Linker option −−library−directory (Additional search path for system libraries)

Section 5.4, Linking with Libraries, in chapter Using the Linker of the user’s manual.
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Linker: −−library−directory (−L) / −−ignore−default−library−path

Menu entry

1. From the Project menu, select Project Options...

The Project Options dialog box appears.

2. Open the Build Options page.

3. Add a pathname in the Library files path field.

If you enter multiple paths, separate them with a semicolon (;).

Command line syntax

−−library−directory=dir
−Ldir

−−ignore−default−library−path
−L

Description

With this option you can specify the path(s) where your system libraries, specified with the −−library option, are located. If you
want to specify multiple paths, use the option −−library−directory for each separate path.

The default path is $(PRODDIR)\c3000\lib.

If you specify only −L (without a pathname) or the long option −−ignore−default−library−path, the linker will not search the
default path and also not in the paths specified in the environment variable LIBTSK3000. So, the linker ignores steps 2 and 3 as
listed below.

The priority order in which the linker searches for system libraries specified with the −−library option is:

1. The path that is specified with the −−library−directory option.

2. The path that is specified in the environment variable LIBTSK3000.

3. The default directory $(PRODDIR)\c3000\lib (or a processor specific sub−directory).

Example

Suppose you call the linker as follows:

lk3000 test.obj −−library−directory=c:\mylibs −−library=c3000

First the linker looks in the directory c:\mylibs for library c3000.lib (this option).

If it does not find the requested libraries, it looks in the directory that is set with the environment variable LIBTSK3000.

Then the linker looks in the default directory $(PRODDIR)\c3000\lib for libraries.

Related information

Linker option −−library (Link system library)

Section 5.4.1, How the linker searches libraries in chapter Using the Linker of the user’s manual.
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Linker: −−link−only

Menu entry

−

Command line syntax

−−link−only

Description

With this option you suppress the locating phase. The linker stops after linking and informs you about unresolved references.

Related information

Control program option −cl (Stop after linking)
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Linker: −−lsl−check

Menu entry

−

Command line syntax

−−lsl−check

Description

With this option the linker just checks the syntax of the LSL file(s) and exits. No linking or locating is performed. Use the option
−−lsl−file=file to specify the name of the Linker Script File you want to test.

Related information

Linker option −−lsl−file (Linker script file)
Linker option −−lsl−dump (Dump LSL info)

Section 5.9, Controlling the Linker with a Script, in chapter Using the Linker of the user’s manual.
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Linker: −−lsl−dump

Menu entry

1. From the Project menu, select Project Options...

The Project Options dialog box appears.

2. Expand the Linker entry and select Miscellaneous.

3. Enable the option Dump processor and memory info from LSL file.

Command line syntax

−−lsl−dump[=file]

Description

With this option you tell the linker to dump the LSL part of the map file in a separate file, independent of the option −−map−file
(generate map file). If you do not specify a filename, the file lktarget.ldf is used.

Related information

Linker option −−map−file−format (Map file formatting)
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Linker: −−lsl−file (−d)

Menu entry

1. From the Project menu, select Project Options...

The Project Options dialog box appears.

2. Expand the Linker entry and select Miscellaneous.

3. Enable the option Use project specific LSL file.

4. In the LSL file field, type a name or click ... and select an LSL file.

Command line syntax

−−lsl−file=file
−dfile

Description

A linker script file contains vital information about the core for the locating phase of the linker. A linker script file is coded in LSL
and contains the following types of information:

• the architecture definition describes the core’s hardware architecture.

• the memory definition describes the physical memory available in the system.

• the section layout definition describes how to locate sections in memory.

With this option you specify a linker script file to the linker. If you do not specify this option, the linker uses a default script file.
You can specify the existing file 3000.lsl or the name of a manually written linker script file. You can use this option multiple
times. The linker processes the LSL files in the order in which they appear on the command line.

Related information

Linker option −−lsl−check (Check LSL file(s) and exit)

Section 5.9, Controlling the Linker with a Script, in chapter Using the Linker of the user’s manual.
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Linker: −−map−file (−M)

Menu entry

1. From the Project menu, select Project Options...

The Project Options dialog box appears.

2. Expand the Linker entry and select Map File.

3. Enable the option Generate a memory map file (.map).

4. In the Map file format section, enable or disable the information you want to be included in the map file.

Command line syntax

−−map−file[=file]
−M[file]

Description

With this option you tell the linker to generate a linker map file. If you do not specify a filename and you specfied the −o option,
the linker uses the same basename as the output file with the extension .map. If you did not specify the −o option, the linker
uses the file task1.map. Altium Designer names the .map file after the project.

A linker map file is a text file that shows how the linker has mapped the sections and symbols from the various object files
(.obj) to the linked object file. A locate part shows the absolute position of each section. External symbols are listed per space
with their absolute address, both sorted on symbol and sorted on address.

Related information

With the option −−map−file−format (map file formatting) you can specify which parts you want to place in the map file.

Section 5.2, Linker Map File Format, in Chapter List File Formats.
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Linker: −−map−file−format (−m)

Menu entry

1. From the Project menu, select Project Options...

The Project Options dialog box appears.

2. Expand the Linker entry and select Map File.

3. Enable the option Generate a map file (.map).

4. In the Map file format section, enable or disable the information you want to be included in the map file.

Command line syntax

−−map−file−format=flags
−mflags

You can specify the following formats:

0 Same as −mcfikLMNoQrSU  (link information)
1 Same as −mCfiKlMNoQRSU  (locate information)
2 Same as −mcfiklmNoQrSu  (most information)

+/−callgraph (c/C) Call graph information
+/−files (f/F) Processed files information
+/−invocation (i/I) Invocation and tool information
+/−link (k/K) Link result information
+/−locate (l/L) Locate result information
+/−memory (m/M) Memory usage information
+/−nonalloc (n/N) Non alloc information
+/−overlay (o/O) Overlay information
+/−statics (q/Q) Module local symbols
+/−crossref (r/R) Cross references information
+/−lsl (s/S) Processor and memory information
+/−rules (u/U) Locate rules

Description

With this option you specify which information you want to include in the map file. Use this option in combination with the option
−−map−file (−M).

If you do not specify this option, the linker uses the default: −−map−file−format=2.

Related information

Linker option −−map−file (Generate map file)
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Linker: −−misra−c−report

Menu entry

1. From the Project menu, select Project Options...

The Project Options dialog box appears.

2. Expand the C Compiler entry and select MISRA−C.

3. Select a MISRA−C configuration.

4. Enable the option Produce a MISRA−C report.

Command line syntax

−−misra−c−report[=file]

Description

With this option you tell the linker to create a MISRA−C Quality Assurance report. This report lists the various modules in the
project with the respective MISRA−C settings at the time of compilation. If you do not specify a filename, the file name.mcr is
used.

Related information

Compiler option −−misrac
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Linker: −−non−romable

Menu entry

1. From the Project menu, select Project Options...

The Project Options dialog box appears.

2. Expand the Linker entry and select Miscellaneous.

3. Add the option −−non−romable to the Additional linker options field.

Command line syntax

−−non−romable

Description

With this option, the linker will locate all ROM sections in RAM. A copy table is generated and is located in RAM. When the
application is started, that data and BSS sections are re−initialized.

Related information

−
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Linker: −−no−rescan

Menu entry

1. From the Project menu, select Project Options...

The Project Options dialog box appears.

2. Expand the Linker entry and select Libraries.

3. Disable the option Rescan libraries to solve unresolved externals.

Command line syntax

−−no−rescan

Description

When the linker processes a library it searches for symbol definitions that are referenced by the objects and libraries processed
so far. If the library contains a definition for an unresolved reference the linker extracts the object that contains the definition from
the library. The linker processes object files and libraries in the order in which they appear on the command line.

When all objects and libraries are processed the linker checks if there are unresolved symbols left. If so, the default behavior of
the linker is to rescan all libraries in the order given at the command line. The linker stops rescanning the libraries when all
symbols are resolved, or when the linker could not resolve any symbol(s) during the rescan of all libraries. Notice that resolving
one symbol may introduce new unresolved symbols.

With this option, you tell the linker to scan the object files and libraries only once. When the linker has not resolved all symbols
after the first scan, it reports which symbols are still unresolved. This option is useful if you are building your own libraries. The
libraries are most efficiently organized if the linker needs only one pass to resolve all symbols.

Related information

Linker option −−first−library−first (Scan libraries in given order)
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Linker: −−no−rom−copy (−N)

Menu entry

1. From the Project menu, select Project Options...

The Project Options dialog box appears.

2. Expand the Linker entry and select Miscellaneous.

3. Add the option −−no−rom−copy to the Additional linker options field.

Command line syntax

−−no−rom−copy
−N

Description

With this option the linker will not generate a ROM copy for data sections. A copy table is generated and contains entries to
clear BSS section. However, no entries to copy data sections from ROM to RAM are placed in the copy table.

The data sections are initialized when the application is downloaded. The data sections are not re−initialized when the
application is restarted.

Related information

−
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Linker: −−no−warnings (−w)

Menu entry

1. From the Project menu, select Project Options...

The Project Options dialog box appears.

2. Expand the Linker entry and select Diagnostics.

3. Set Error reporting to one of the following values:

• Report all warnings

• Suppress all warnings

• Suppress specific warnings.

If you select Suppress specific warnings:

4. Enter the numbers, separated by commas, of the warnings you want to suppress.

Command line syntax

−−no−warnings[=number,...]
−w[number,...]

Description

With this option you can suppresses all warning messages or specific warning messages.

• If you do not specify this option, all warnings are reported.

• If you specify this option but without numbers, all warnings are suppressed.

• If you specify this option with a number, only the specified warning is suppressed. You can specify the option
−−no−warnings=number multiple times.

Example

To suppress warnings 135 and 136, enter 135, 136 in the Specific warnings to suppress field, or enter the following on the
command line:

lk3000 −−no−warnings=135,136 test.obj

Related information

Linker option −−warnings−as−errors (Treat warnings as errors)
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Linker: −−optimize (−O)

Menu entry

1. From the Project menu, select Project Options...

The Project Options dialog box appears.

2. Expand the Linker entry and select Optimization.

3. Select an optimization level in the Optimization level box.

If you select Custom Optimization:

4. Enable the optimizations you want.

Command line syntax

−−optimize[=flags]
−O[flags]

Use the following options for predefined sets of flags:

−−optimize=0 (−O0) No optimization
Alias for: −OCLTXY

−−optimize=1 (−O1) Default optimization
Alias for: −OcLtXY

−−optimize=2 (−O2) All optimizations
Alias for: −Ocltxy

You can set the following flags:

+/−delete−unreferenced−sections (c/C) Delete unreferenced sections from the output file
+/−first−fit−decreasing (l/L) Use a ’first fit decreasing’ algorithm to locate

unrestricted sections in memory.
+/−copytable−compression (t/T) Emit smart restrictions to reduce copy table size
+/−delete−duplicate−code (x/X) Delete duplicate code sections from the output file
+/−delete−duplicate−data (y/Y) Delete duplicate constant data from the output file

Description

With this option you can control the level of optimization the linker performs. If you do not use this option, −−optimize=1 is the
default.

Related information

Section 5.8, Linker Optimizations, in chapter Using the Linker of the user’s manual.
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Linker: −−option−file (−f)

Menu entry

1. From the Project menu, select Project Options...

The Project Options dialog box appears.

2. Expand the Linker entry and select Miscellaneous.

3. Add the option −−option−file to the Additional linker options field.

Be aware that the options in the option file are added to the linker options you have set in the other dialogs. Only in
extraordinary cases you may want to use them in combination. Altium Designer automatically saves the options with your
project.

Command line syntax

−−option−file=file
−f file

Description

This option is primarily intended for command line use. Instead of typing all options on the command line, you can create an
option file which contains all options and flags you want to specify. With this option you specify the option file to the linker.

Use an option file when the length of the command line would exceed the limits of the operating system, or just to store options
and save typing.

You can specify the option −−option−file multiple times.

Format of an option file

• Multiple arguments on one line in the option file are allowed.

• To include whitespace in an argument, surround the argument with single or double quotes.

• If you want to use single quotes as part of the argument, surround the argument by double quotes and vise versa:

"This has a single quote ’ embedded"

’This has a double quote " embedded’

’This has a double quote " and a single quote ’"’ embedded"

• When a text line reaches its length limit, use a \ to continue the line. Whitespace between quotes is preserved.

"This is a continuation \
line"

         −> "This is a continuation line"

• It is possible to nest command line files up to 25 levels.

Example

Suppose the file myoptions contains the following lines:

−Mmymap       (generate a map file)
test.obj      (input file)
−Lc:\mylibs   (additional search path for system libraries)

Specify the option file to the linker:

lk3000 −−option−file=myoptions

This is equivalent to the following command line:

lk3000 −Mmymap test.obj −Lc:\mylibs

Related information

−
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Linker: −−output (−o)

Menu entry

1. From the Project menu, select Project Options...

The Project Options dialog box appears.

2. Expand the Linker entry and select Output Format.

3. Enable one or more output formats

Command line syntax

−−output=[filename][:format[:addr_size]]...
−o[filename][:format[:addr_size]]...

You can specify the following formats:

ELF ELF/DWARF
IHEX Intel Hex
SREC Motorola S−records

Description

By default, the linker generates an output file in ELF/DWARF format, named after the first input file with extension .abs.

With this option you can specify an alternative filename, and an alternative output format. The default output format is the format
of the first input file.

You can use the −−output option multiple times. This is useful to generate multiple output formats. With the first occurrence of
the −−output option you specify the basename (the filename without extension), which is used for subsequent −−output
options with no filename specified. If you do not specify a filename, or you do not specify the −−output option at all, the linker
uses the default basename taskn.

IHEX and SREC formats

If you specify the Intel Hex format or the Motorola S−records format, you can use the argument addr_size to specify the size of
addresses in bytes (record length). For Intel Hex you can use the values: 1, 2, and 4 (default). For Motorola S−records you can
specify: 2 (S1 records), 3 (S2 records) or 4 bytes (S3 records, default).

The name of the output file will be filename with the extension .hex or .sre and contains the code and data allocated in the
default address space. If they exist, any other address spaces are also emitted whereas their output files are named
filename_spacename.hex (.sre).

Use option −−chip−output (−c) to create Intel Hex or Motorola S−record output files for each chip defined in the LSL file
(suitable for loading into a PROM−programmer).

Example

To create the output file myfile.hex of the default address space:

lk3000 test.obj −−output=myfile.hex:IHEX

Related information

Linker option −−chip−output (Generate an output file for each chip)
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Linker: −−strip−debug (−S)

Menu entry

1. From the Project menu, select Project Options...

The Project Options dialog box appears.

2. Expand the Linker entry and select Miscellaneous.

3. Disable the option Include symbolic debug information.

Command line syntax

−−strip−debug
−S

Description

With this option you specify not to include symbolic debug information in the resulting output file.

Related information

−
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Linker: −−user−provided−initialization−code (−i)

Menu entry

1. From the Project menu, select Project Options...

The Project Options dialog box appears.

2. Expand the Linker entry and select Miscellaneous.

3. Add the option −−user−provided−initialization−code to the Additional linker options field.

Command line syntax

−−user−provided−initialization−code
−i

Description

It is possible to use your own initialization code, for example, to save ROM space. With this option you tell the linker not to
generate a copy table for initialize/clear sections. Use linker labels in your source code to access the positions of the sections
when located.

If the linker detects references to the TASKING initialization code, an error is emitted: it is either the TASKING initialization
routine or your own, not both.

Note that the options −−no−rom−copy and −−non−romable, may vary independently. The ’copytable−compression’
optimization (−−optimize=t) is automatically disabled when you enable this option.

Related information

−
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Linker: −−verbose (−v) / −−extra−verbose (−vv)

Menu entry

1. From the Project menu, select Project Options...

The Project Options dialog box appears.

2. Expand the Linker entry and select Miscellaneous.

3. Add the option −−verbose or−−extra−verbose to the Additional linker options field.

Command line syntax

−−verbose / −−extra−verbose
−v / −vv

Description

With this option you put the linker in verbose mode. The linker prints the link phases while it processes the files. In the extra
verbose mode, the linker also prints the filenames and it shows which objects are extracted from libraries. With this option you
can monitor the current status of the linker.

Related information

−
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Linker: −−version (−V)

Menu entry

−

Command line syntax

−−version
−V

Description

Display version information. The linker ignores all other options or input files.

Related information

−
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Linker: −−warnings−as−errors

Menu entry

1. From the Project menu, select Project Options...

The Project Options dialog box appears.

2. Expand the Linker entry and select Diagnostics.

3. Enable the option Treat warnings as errors.

Command line syntax

−−warnings−as−errors[=number,...]

Description

When the linker detects an error or warning, it tries to continue the link process and reports other errors and warnings. When
you use this option without arguments, you tell the linker to treat all warnings as errors. This means that the exit status of the
linker will be non−zero after the detection of one or more linker warnings. As a consequence, the linker will not produce any
output files.

You can also limit this option to specific warnings by specifying a comma−separated list of warning numbers.

Related information

Linker option −−no−warnings (Suppress some or all warnings)
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4.4 Control Program Options

The control program is a tool to facilitate use of the toolset from the command line. Therefore you can only call the control
program from the command line. The invocation syntax is:

cc3000 [option]... [file]...

Options

The control program processes command line options either by itself, or, when the option is unknown to the control program, it
looks whether it can pass the option to one of the other tools. However, for directly passing an option to the C compiler,
assembler or linker, it is recommended to use the control program options −−pass−c, −−pass−assembler, −−pass−linker.

Short and long option names

Options can have both short and long names. Short option names always begin with a single minus (−) character, long option
names always begin with double minus (−−) characters. You can abbreviate long option names as long as the name is unique.
You can mix short and long option names on the command line.

Options can have flags or sub−options. To switch a flag ’on’, use a lowercase letter or a +longflag. To switch a flag off, use an
uppercase letter or a −longflag. Separate longflags with commas. The following two invocations are equivalent:

cc3000 −Wc−Oac test.c
cc3000 −−pass−c=−−optimize=+coalescer,+cse test.c

When you do not specify an option, a default value may become active.
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Control Program: −−address−size

Command line syntax

−−address−size=addr_size

Description

If you specify IHEX or SREC with the control option −−format, you can additionally specify the record length to be emitted in the
output files.

With this option you can specify the size of addresses in bytes (record length). For Intel Hex you can use the values: 1, 2, and 4
(default). For Motorola S−records you can specify: 2 (S1 records), 3 (S2 records) or 4 bytes (S3 records, default).

If you do not specify addr_size, the default address size is generated.

Example

To create the SREC file test.sre with S1 records, type:

cc3000 −−format=SREC −−address−size=2 test.c

Related information

Control program option −−format (Set linker output format)

Linker option −−output (Specify an output object file)
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Control Program: −−check

Command line syntax

−−check

Description

With this option you can check the source code for syntax errors, without generating code. This saves time in developing your
application.

The compiler/assembler reports any warnings and/or errors.

Related information

C compiler option −−check (Check syntax)

Assembler option −−check (Check syntax)
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Control Program: −−create (−cl/−cm/−co/−cs)

Command line syntax

−−create[=stage]
−c[stage]

You can specify the following stages (if you omit the stage, the default is −−create=object):

relocatable (l) Stop after the files are linked to a linker object file (.out)

mil (m) Stop after C files are compiled to MIL (.mil)

object (o) Stop after the files are assembled to objects (.obj)

assembly (s) Stop after C files are compiled to assembly (.src)

Description

Normally the control program generates an absolute object file of the specified output format from the file you supplied as input.

With this option you tell the control program to stop after a certain number of phases.

Related information

Linker option −−link−only (Link only, no locating)
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Control Program: −−debug−info (−g)

Command line syntax

−−debug−info
−g

Description

With this option you tell the control program to include debug information in the generated object file.

Related information

−
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Control Program: −−define (−D)

Command line syntax

−−define=macro_name[=macro_definition]
−Dmacro_name[=macro_definition]

Description

With this option you can define a macro and specify it to the preprocessor. If you only specify a macro name (no macro
definition), the macro expands as ’1’.

You can specify as many macros as you like. On the command line, use the option −−define multiple times. If the command line
exceeds the length limit of the operating system, you can define the macros in an option file which you then must specify to the
control program with the option −−option−file=file (−f).

Defining macros with this option (instead of in the C source) is, for example, useful to compile or assemble conditional source as
shown in the example below.

The control program passes the option −−define (−D) to the compiler and the assembler.

Example

Consider the following C program with conditional code to compile a demo program and a real program:

void main( void )
{
#if DEMO == 1
    demo_func();   /* compile for the demo program */
#else
    real_func();   /* compile for the real program */
#endif
}

You can now use a macro definition to set the DEMO flag. With the control program this looks as follows:

cc3000 −−define=DEMO test.c
cc3000 −−define=DEMO=1 test.c

Note that both invocations have the same effect.

The next example shows how to define a macro with arguments. Note that the macro name and definition are placed between
double quotes because otherwise the spaces would indicate a new option.

cc3000 −D"MAX(A,B)=((A) > (B) ? (A) : (B))" test.c

Related information

Control Program option −−undefine (Undefine preprocessor macro)
Control Program option −−option−file (Read options from file)
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Control Program: −−diag

Command line syntax

−−diag=[format:]{all|nr,...]

Description

With this option you can ask for an extended description of error messages in the format you choose. The output is directed to
stdout (normally your screen) and in the format you specify. You can specify the following formats: html, rtf or text (default).
To create a file with the descriptions, you must redirect the output.

With the suboption all, the descriptions of all error messages are given. If you want the description of one or more selected error
messages, you can specify the error message numbers, separated by commas.

With this option the control program does not process any files.

Example

To display an explanation of message number 103, enter:

cc3000 −−diag=103

This results in message 103 with explanation.

To write an explanation of all errors and warnings in HTML format to file ccerrors.html, enter:

cc3000 −−diag=html:all > ccerrors.html

Related information

−
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Control Program: −−dry−run (−n)

Command line syntax

−−dry−run
−n

Description

With this option you put the control program verbose mode. The control program prints the invocations of the tools it would use
to process the files without actually performing the steps.

Related information

Control Program option −−verbose (−v) (Verbose output)
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Control Program: −−error−file

Command line syntax

−−error−file

Description

With this option the control program tells the compiler, assembler and linker to redirect error messages to a file.

The error file will be named after the input file with extension .err (for compiler) or .ers (for assembler). For the linker, the
error file is lk3000.elk.

Example

To write errors to error files instead of stderr, enter:

cc3000 −−error−file −t test.c

Related information

Control Program option −−warnings−as−errors (Treat warnings as errors)
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Control Program: −−format

Command line syntax

−−format=format

You can specify the following formats:

IEEE IEEE−695
ELF ELF/DWARF
IHEX Intel Hex
SREC Motorola S−records

Description

With this option you specify the output format for the resulting (absolute) object file. The default output format is ELF/DWARF,
which can directly be used by the debugger.

If you choose IHEX or SREC, you can additionally specify the address size of the chosen format (option −−address−size).

Example

To generate an Motorola S−record output file:

cc3000 −−format=SREC test1.c test2.c −−output=test.sre

Related information

Control program option −−address−size (Set address size for linker IHEX/SREC files)

Linker option −−output (Specify an output object file)
Linker option −−chip−output (Generate hex file for each chip)
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Control Program: −−fp−trap

Command line syntax

−−fp−trap

Description

By default the control program uses the non−trapping floating−point library (fp3000[md].lib). With this option you tell the
control program to use the trapping floating−point library (fp3000[md]t.lib).

If you use the trapping floating−point library, exceptional floating−point cases are intercepted and can be handled separately by
an application defined exception handler. Using this library decreases the execution speed of your application.

Related information
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Control Program: −−help (−?)

Command line syntax

−−help[=options]
−?

Description

Displays an overview of all command line options. When you specify the argument options you can list detailed option
descriptions.

Example

The following invocations all display a list of the available command line options:

cc3000 −?
cc3000 −−help
cc3000

To see a detailed description of the available options, enter:

cc3000 −−help=options
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Control Program: −−include−directory (−I)

Command line syntax

−−include−directory=path,...
−Ipath,...

Description

With this option you can specify the path where your include files are located. A relative path will be relative to the current
directory.

Example

Suppose that the C source file test.c contains the following lines:

#include <stdio.h>
#include "myinc.h"

You can call the control program as follows:

cc3000 −−include−directory=myinclude test.c

First the compiler looks for the file stdio.h in the directory myinclude relative to the current directory. If it was not found, the
compiler searches in the environment variable and then in the default include directory.

The compiler now looks for the file myinc.h, in the directory where test.c is located. If the file is not there the compiler
searches in the directory myinclude. If it was still not found, the compiler searches in the environment variable and then in the
default include directory.

Related information

C compiler option −−include−directory (Add directory to include file search path)
C compiler option −−include−file (Include file at the start of a compilation)

Section 2.4, How the Compiler Searches Include Files, in chapter Using the Compiler of the user’s manual.
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Control Program: −−iso

Command line syntax

−−iso={90|99}

Description

With this option you specify to the control program against which ISO standard it should check your C source. C90 is also
referred to as the "ANSI C standard". C99 refers to the newer ISO/IEC 9899:1999 (E) standard and is the default.

Independant of the chosen ISO standard, the control program always links libraries with C99 support.

Example

To compile the file test.c conform the ISO C90 standard:

cc3000 −−iso=90 test.c

Related information

C compiler option −−iso (ISO C standard)
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Control Program: −−keep−output−files (−k)

Command line syntax

−−keep−output−files
−k

Description

If an error occurs during the compilation, assembling or linking process, the resulting output file may be incomplete or incorrect.
With this option you keep the generated output files when an error occurs.

By default the control program removes generated output files when an error occurs. This is useful when you use the make
utility. If the erroneous files are not removed, the make utility may process corrupt files on a subsequent invocation.

Use this option when you still want to use the generated files. For example when you know that a particular error does not result
in a corrupt file, or when you want to inspect the output file, or send it to Altium support.

Related information

−



TSK3000 Embedded Tools Reference

4−132

Control Program: −−keep−temporary−files (−t)

Menu Entry

1. From the Project menu, select Project Options...

The Project Options dialog box appears.

2. Select Build Options.

3. Enable the option Keep temporary files that are generated during a compile.

Command line syntax

−−keep−temporary−files
−t

Description

By default, the control program removes intermediate files like the .src file (result of the compiler phase) and the .obj file
(result of the assembler phase).

With this option you tell the control program to keep temporary files it generates during the creation of the absolute object file.

Related information

−



Tool Options − Control Program

4−133

Control Program: −−library (−l)

Command line syntax

−−library=name
−lname

Description

With this option you tell the linker via the control program to use system library name.lib, where name is a string. The
linker first searches for system libraries in any directories specified with −−library−directory, then in the directories specified
with the environment variable LIBTSK3000, unless you used the option −−ignore−default−library−path.

Example

To search in the system library c3000.lib (C library):

cc3000 test.obj mylib.lib −−library=c3000

The linker links the file test.obj and first looks in mylib.lib (in the current directory only), then in the system library
c3000.lib to resolve unresolved symbols.

Related information

Linker option −−library−directory (Additional search path for system libraries)

Section 5.4, Linking with Libraries, in chapter Using the Linker of the user’s manual.
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Control Program:−−library−directory (−L) / −−ignore−default−library−path

Command line syntax

−−library−directory=dir
−Ldir

−−ignore−default−library−path
−L

Description

With this option you can specify the path(s) where your system libraries, specified with the −−library option, are located. If you
want to specify multiple paths, use the option −−library−directory for each separate path.

By default path this is $(PRODDIR)\c3000\lib directory.

If you specify only −L (without a pathname) or the long option −−ignore−default−library−path, the linker will not search the
default path and also not in the paths specified in the environment variable LIBTSK3000. So, the linker ignores steps 2 and 3 as
listed below.

The priority order in which the linker searches for system libraries specified with the −−library option is:

1. The path that is specified with the −−library−directory option.

2. The path that is specified in the environment variable LIBTSK3000.

3. The default directory $(PRODDIR)\c3000\lib (or a processor specific sub−directory).

Example

Suppose you call the control program as follows:

cc3000 test.c −−library−directory=c:\mylibs −−library=c3000

First the linker looks in the directory c:\mylibs for library c3000.lib (this option).

If it does not find the requested libraries, it looks in the directory that is set with the environment variable LIBTSK3000.

Then the linker looks in the default directory $(PRODDIR)\c3000\lib for libraries.

Related information

Linker option −−library (Link system library)
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Control Program: −−list−files

Command line syntax

−−list−files[=name]

Description

With this option you tell the assembler via the control programma to generate a list file for each specified input file. A list file
shows the generated object code and the relative addresses. Note that the assembler generates a relocatable object file with
relative addresses.

With name you can specify a name for the list file. This is only possible if you specify only one input file to the control
program. If you do not specify name, or you specify more than one input files, the control program names the generated list
file(s) after the specified input file(s) with extension .lst.

Example

This example generates the list files 1.lst and 2.lst for 1.c and 2.c. If in this example also a name had been specified, it
would be ignored because two input files are specified.

cc3000 1.c 2.c −−list−files

Related information

Assembler option −−list−file (Generate list file)

Assembler option −−list−format (List file formatting options)
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Control Program: −−lsl−file (−d)

Command line syntax

−−lsl−file=file
−dfile

Description

A linker script file contains vital information about the core for the locating phase of the linker. A linker script file is coded in LSL
and contains the following types of information:

• the architecture and derivative definition describe the core’s hardware architecture and its internal memory.

• the board specification describes the physical memory available in the system.

• the section layout definition describes how to locate sections in memory.

With this option you specify a linker script file via the control program to the linker. If you do not specify this option, the linker
does not use a script file. You can specify the existing file 3000.lsl or the name of a manually written linker script file. You can
use this option multiple times. The linker processes the LSL files in the order in which they appear on the command line.

Related information

Section 5.9, Controlling the Linker with a Script, in chapter Using the Linker of the user’s manual.
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Control Program: −−mil−link / −−mil−split

Command line syntax

−−mil−link

−−mil−split

Description

With option −−mil−link the C compiler links the optimized intermediate representation (MIL) of all input files and MIL libraries
specified on the command line in the compiler. The result is one single module that is optimized another time.

Option −−mil−split does the same as option −−mil−link, but in addition, the resulting MIL representation is written to a file with
the suffix .mil and the C compiler also splits the MIL representation and writes it to separate files with suffix .ms. One file is
written for each input file or MIL library specified on the command line. The .ms files are only updated on a change.

With option −−mil−split you can perform application−wide optimizations during the frontend phase by specifying all modules at
once, and still invoke the backend phase one module at a time to reduce the total compilation time.

Related information

C compiler option −−mil / −−mil−split
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Control Program: −−no−default−libraries

Command line syntax

−−no−default−libraries

Description

By default the control program specifies the standard C libraries (C99) and run−time library to the linker. With this option you tell
the control program not to specify the standard C libraries and run−time library to the linker.

In this case you must specify the libraries you want to link to the linker with the option −llibrary_name. The control program
recognizes the option −l as an option for the linker and passes it as such.

Example

cc3000 −−no−default−libraries test.c

The control program does not specify any libraries to the linker. In normal cases this would result in unresoved externals.

To specify your own libraries (libmy.a) and avoid unresolved externals:

cc3000 −−no−default−libraries −lmy test.c

Related information

Linker option −−library (−l) (Add library)



Tool Options − Control Program

4−139

Control Program: −−no−double (−F)

Command line syntax

−−no−double

−F

Description

With this option you tell the compiler to treat variables of the type double as float. Because the float type takes less space,
execution speed increases and code size decreases, both at the cost of less precision.

Related information

−
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Control Program: −−no−map−file

Command line syntax

−−no−map−file

Description

By default the control program tells the linker to generate a linker map file.

A linker map file is a text file that shows how the linker has mapped the sections and symbols from the various object files
(.obj) to the linked object file. A locate part shows the absolute position of each section. External symbols are listed per space
with their absolute address, both sorted on symbol and sorted on address.

With this option you prevent the generation of a map file.

Related information

−
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Control Program: −−no−preprocessing−only

Command line syntax

−−no−preprocessing−only

Description

On the command line, the control program stops after preprocessing. If you also want to compile the C source you can specify
the option −−no−preprocessing−only. In this case the control program calls the compiler twice, once with option
−−preprocess and once for a regular compilation.

Related information

Control program option −−preprocess / −E
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Control Program: −−no−warnings (−w)

Command line syntax

−−no−warnings[=number,...]
−w[number,...]

Description

With this option you can suppress all warning messages or specific C compiler warning messages:

• If you do not specify this option, all warnings are reported.

• If you specify this option but without numbers, all warnings are suppressed.

• If you specify this option with a number, only the specified C compiler warning is suppressed.
You can specify the option −−no−warnings=number multiple times.

Related information

−
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Control Program: −−option−file (−f)

Command line syntax

−−option−file=file
−f file

Description

Instead of typing all options on the command line, you can create an option file which contains all options and flags you want to
specify. With this option you specify the option file to the control program.

Use an option file when the command line would exceed the limits of the operating system, or just to store options and save
typing.

You can specify the option −−option−file multiple times.

Format of an option file

• Multiple arguments on one line in the option file are allowed.

• To include whitespace in an argument, surround the argument with single or double quotes.

• If you want to use single quotes as part of the argument, surround the argument by double quotes and vise versa:

"This has a single quote ’ embedded"

’This has a double quote " embedded’

’This has a double quote " and a single quote ’"’ embedded"

• When a text line reaches its length limit, use a ’to continue the line. Whitespace between quotes is preserved.

"This is a continuation \
line"

         −> "This is a continuation line"

• It is possible to nest command line files up to 25 levels.

Example

Suppose the file myoptions contains the following lines:

−DDEMO=1
test.c

Specify the option file to the control program:

cc3000 −−option−file=myoptions

This is equivalent to the following command line:

cc3000 −DDEMO=1 test.c

Related information

−
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Control Program: −−output (−o)

Command line syntax

−−output=file
−o file

Description

Default, the control program generates a file with the same basename as the first specified input file. With this option you specify
another name for the resulting absolute object file.

Example

cc3000 test.c prog.c

The control program generates an ELF/DWARF object file (default) with the name test.abs.

To generate the file result.abs:

cc3000 −−output=result.abs test.c prog.c

Related information

−
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Control Program: −−pass (−W)

Command line syntax

−−pass−assembler=option (−Waoption) Pass option directly to the assembler

−−pass−c=option (−Wcoption) Pass option directly to the C compiler

−−pass−linker=option (−Wloption) Pass option directly to the linker

Description

With this option you tell the control program to call a tool with the specified option. The control program does not use or interpret
the option itself, but specifies it directly to the tool which it calls.

Related information

−



TSK3000 Embedded Tools Reference

4−146

Control Program: −−preprocess (−E)

Command line syntax

−−preprocess[=flags]
−E[flags]

You can set the following flags (when you specify −E without flags, the default is −ECMP):

+/−comments (c/C) Keep comments from the C source in the preprocessed output
+/−make (m/M) Generate dependency lines that can be used for the makefile
+/−noline (p/P) Strip #line source position info (lines starting with #line)

Description

With this option you tell the control program to preprocess the C source.

The C compiler sends the preprocessed output to the file name.pre (where name is the name of the C source file being
compiled). Altium Designer also compiles the C source.

On the command line, the control program stops after preprocessing. If you also want to compile the C source you can specify
the option −−no−preprocessing−only. In this case the control program calls the compiler twice, once with option
−−preprocess and once for a regular compilation.

Example

cc3000 −−preprocess=+comments,−make,−noline −−no−preprocessing−only test.c

The compiler preprocesses the file test.c and sends the output to the file test.pre. Comments are included but no
dependencies are generated and the line source position information is not stripped from the output file. Next, the control
program calls the compiler, assembler and linker to create the final object file test.abs.

Related information

Control program option −−no−preprocessing−only
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Control Program: −−profile (−p)

Command line syntax

−−profile[=flags]
−p[flags]

Use the following option for a predefined set of flags:

−−profile=g (−pg) profiling with call graph and function timers
Alias for: −pBcFt

You can set the following flags (when you specify −p without flags, the default is −pBCfST):

+/−block (b/B) block counters
+/−callgraph (c/C) call graph
+/−function (f/F) function counters
+/−static (s/S) static profile generation
+/−time (t/T) function timers

Description

Profiling is the process of collecting statistical data about a running application. With these data you can analyze which functions
are called, how often they are called and what their execution time is.

Several methods of profiling exist. One method is code instrumentation which adds code to your application that takes care of
the profiling process when the application is executed.

For an extensive description of profiling refer to Chapter 3, Profiling in the user’s manual.

With this option, the compiler adds the extra code to your application that takes care of the profiling process. You can obtain the
following profiling data (see flags above):

Block counters (not in combination with Call graph or Time)

This will instrument the code to perform basic block counting. As the program runs, it counts the number of executions of
each branch in an if statement, each iteration of a for loop, and so on. Note that though you can combine Block counters
with Function counters, this has no effect because Function counters is only a subset of Block counters.

Call graph (not in combination with Block counters)

This will instrument the code to reconstruct the run−time call graph. As the program runs it associates the caller with the
gathered profiling data.

Function counters

This will instrument the code to perform function call counting. This is a subset of the basic Block counters.

Time (not in combination with Block counters)

This will instrument the code to measure the time spent in a function. This includes the time spent in all sub functions
(callees).

Note that the more detailled information you request, the larger the overhead in terms of execution time, code size and
heap space needed. The option Generate Debug information (−g or −−debug) does not affect profiling, execution time
or code size.

The control program automatically specifies the corresponding profiling libraries to the linker.

Example

To generate block count information for the module test.c during execution, compile as follows:

cc3000 −−profile=+block test.c

In this case the library pb3000md.lib is linked.
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Related information

Chapter 3, Profiling in the user’s manual.
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Control Program: −−static

Command line syntax

−−static

Description

This option is directly passed to the compiler.

With this option, the compiler treats external definitions at file scope (except for main) as if they were declared static. As a
result, unused functions will be eliminated, and the alias checking algorithm assumes that objects with static storage cannot be
referenced from functions outside the current module.

This option only makes sense when you specify all modules of an application on the command line.

Example

cc3000 −−static module1.c module2.c module3.c

Related information

−
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Control Program: −−undefine (−U)

Command line syntax

−−undefine=macro_name
−Umacro_name

Description

With this option you can undefine an earlier defined macro as with #undef.

This option is for example useful to undefine predefined macros. However, you cannot undefine predefined ISO C standard
macros.

The control program passes the option −−undefine (−U) to the compiler.

Example

To undefine the predefined macro __TASKING__:

cc3000 −−undefine=__TASKING__ test.c

Related information

Control Pogram option −−define (Define preprocessor macro)
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Control Program: −−verbose (−v)

Command line syntax

−−verbose
−v

Description

With this option you put the control program in verbose mode. With the option −v the control program performs it tasks while it
prints the steps it performs to stdout.

Related information

Control Program option −n (−−dry−run) (Verbose output and suppress execution)
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Control Program: −−version (−V)

Command line syntax

−−version
−V

Description

Display version information. The control program ignores all other options or input files.

Related information

−
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Control Program: −−warnings−as−errors

Command line syntax

−−warnings−as−errors[=number,...]

Description

If one of the tools encounters an error, it stops processing the file(s). With this option you tell the tools to treat warnings as errors
or treat specific C compiler warning messages as errors:

• If you specify this option but without numbers, all warnings are treated as errors.

• If you specify this option with a number, only the specified C compiler warning is treated as an error.
You can specify the option −−warnings−as−errors=number multiple times.

Related information

Control Program option −−no−warnings (Suppress all warnings)
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4.5 Make Utility Options

When you build a project in Altium Designer, Altium Designer generates a makefile and uses the make utility tmk to build all
your files. However, you can also use the make utility directly from the command line to build your project.

The invocation syntax is:

tmk [option...] [target...] [macro=def]

This section describes all options for the make utility. The make utility is a command line tool so there are no equivalent options
in Altium Designer.
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Defining Macros

Command line syntax

macro=definition

Description

With this argument you can define a macro and specify it to the make utility.

A macro definition remains in existence during the execution of the makefile, even when the makefile recursively calls the make
utility again. In the recursive call, the macro acts as an environment variable. This means that it is overruled by definitions in the
recursive call. Use the option −e to prevent this.

You can specify as many macros as you like. If the command line exceeds the limit of the operating system, you can define the
macros in an option file which you then must specify to the make utility with the option −m file.

Defining macros on the command line is, for example, useful in combination with conditional processing as shown in the
example below.

Example

Consider the following makefile with conditional rules to build a demo program and a real program:

ifdef DEMO     # the value of DEMO is of no importance
  real.abs : demo.obj main.obj
             lk3000 demo.obj main.obj −d3000.lsl −lc3000 −lfp3000
else
  real.abs : real.obj main.obj
             lk3000 real.obj main.obj −d3000.lsl −lc3000 −lfp3000
endif

You can now use a macro definition to set the DEMO flag:

tmk real.abs DEMO=1

In both cases the absolute object file real.abs is created but depending on the DEMO flag it is linked with demo.obj or with
real.obj.

Related information

Make utility option −e (Environment variables override macro definitions)
Make utility option −m (Name of invocation file)
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Make Utility: −?

Command line syntax

−?

Description

Displays an overview of all command line options.

Example

The following invocation displays a list of the available command line options:

tmk −?

Related information

−
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Make Utility: −a

Command line syntax

−a

Description

Normally the make utility rebuilds only those files that are out of date. With this option you tell the make utility to rebuild all files,
without checking whether they are out of date.

Example

tmk −a

Rebuilds all your files, regardless of whether they are out of date or not.

Related information

−
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Make Utility: −c

Command line syntax

−c

Description

Altium Designer uses this option for the graphical version of the make utility when you create sub−projects. In this case the
make utility calls another instance of the make utility for the sub−project. With the option −c, the make utility runs as a child
process of the current make.

The option −c overrules the option −err.

Example

tmk −c

 The make utility runs its commands as a child processes.

Related information

−
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Make Utility: −D/−DD

Command line syntax

−D
−DD

Description

With the option −D the make utility prints every line of the makefile to standard output as it is read by tmk.

With the option −DD not only the lines of the makefile are printed but also the lines of the tmk.mk file (implicit rules).

Example

tmk −D

Each line of the makefile that is read by the make utility is printed to standard output (usually your screen).

Related information

−
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Make Utility: −d/−dd

Command line syntax

−d
−dd

Description

With the option −d the make utility shows which files are out of date and thus need to be rebuild. The option −dd gives more
detail than the option −d.

Example

tmk −d

Shows which files are out of date and rebuilds them.

Related information

−
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Make Utility: −e

Command line syntax

−e

Description

If you use macro definitions, they may overrule the settings of the environment variables.

With the option −e, the settings of the environment variables are used even if macros define otherwise.

Example

tmk −e

The make utility uses the settings of the environment variables regardless of macro definitions.

Related information

−
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Make Utility: −err

Command line syntax

−err file

Description

With this option the make utility redirects error messages and verbose messages to a specified file.

With the option −s the make utility only displays error messages.

Example

tmk −err error.txt

The make utility writes messages to the file error.txt.

Related information

Make utility option −s (Do not print commands before execution)



Tool Options − Make Utility

4−163

Make Utility: −f

Command line syntax

−f my_makefile

Description

Default the make utility uses the file makefile to build your files.

With this option you tell the make utility to use the specified file instead of the file makefile. Multiple −f options act as if all the
makefiles were concatenated in a left−to−right order.

Example

tmk −f mymake

The make utility uses the file mymake to build your files.

Related information

−
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Make Utility: −G

Command line syntax

−G path

Description

Normally you must call the make utility tmk from the directory where your makefile and other files are stored.

With the option −G you can call the make utility from within another directory. The path is the path to the directory where your
makefile and other files are stored and can be absolute or relative to your current directory.

Example

Suppose your makefile and other files are stored in the directory ..\myfiles. You can call the make utility, for example, as
follows:

tmk −G ..\myfiles

Related information

−
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Make Utility: −i

Command line syntax

−i

Description

When an error occurs during the make process, the make utility exits with a certain exit code.

With the option −i, the make utility exits without an error code, even when errors occurred.

Example

tmk −i

The make utility exits without an error code, even when an error occurs.

Related information

−
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Make Utility: −K

Command line syntax

−K

Description

With this option the make utility keeps temporary files it creates during the make process. The make utility stores temporary files
in the directory that you have specified with the environment variable TMPDIR or in the default ’temp’ directory of your system
when the TMPDIR environment variable is not specified.

Example

tmk −K

The make utility preserves all temporary files.

Related information

−
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Make Utility: −k

Command line syntax

−k

Description

When during the make process the make utility encounters an error, it stops rebuilding your files.

With the option −k, the make utility only stops building the target that produced the error. All other targets defined in the makefile
are built.

Example

tmk −k

If the make utility encounters an error, it stops building the current target but proceeds with the other targets that are defined in
the makefile.

Related information

Make utility option −S (Undo the effect of −k)
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Make Utility: −m

Command line syntax

−m file

Description

Instead of typing all options on the command line, you can create an option file which contains all options and flags you want to
specify. With this option you specify the option file to the make utility.

Use an option file when the command line would exceed the limits of the operating system, or just to store options and save
typing.

You can specify the option −m multiple times.

Format of an option file

• Multiple arguments on one line in the option file are allowed.

• To include whitespace in an argument, surround the argument with single or double quotes.

• If you want to use single quotes as part of the argument, surround the argument by double quotes and vise versa:

"This has a single quote ’ embedded"

’This has a double quote " embedded’

’This has a double quote " and a single quote ’"’ embedded"

• When a text line reaches its length limit, use a ’\’ to continue the line. Whitespace between quotes is preserved.

"This is a continuation \
line"
     −> "This is a continuation line"

• It is possible to nest command line files up to 25 levels.

Example

Suppose the file myoptions contains the following lines:

−k
−err errors.txt
test.abs

Specify the option file to the make utility:

tmk −m myoptions

This is equivalent to the following command line:

tmk −k −err errors.txt test.abs

Related information

−
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Make Utility: −n

Command line syntax

−n

Description

With this option you tell the make utility to perform a dry run. The make utility shows what it would do but does not actually
perform these tasks.

This option is for example useful to quickly inspect what would happen if you call the make utility.

Example

tmk −n

The make utility does not perform any tasks but displays what it would do if called without the option −n.

Related information

Make utility option −s (Do not print commands before execution)
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Make Utility: −p

Command line syntax

−p

Description

Normally, if a command in a target rule in a makefile returns an error or when the target construction is interrupted, the make
utility removes that target file. With this option you tell the make utility to make all target files precious. This means that
dependency files are never removed.

Example

tmk −p

The make utility never removes target dependency files.

Related information

−
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Make Utility: −q

Command line syntax

−q

Description

With this option the make utility does not perform any tasks but only returns an exit code. A zero status indicates that all target
files are up to date, a non−zero status indicates that some or all target files are out of date.

Example

tmk −q

The make utility only returns an exit code that indicates whether all target files are up to date or not. It does not rebuild any files.

Related information

−
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Make Utility: −r

Command line syntax

−r

Description

When you call the make utility, it first reads the implicit rules from the file tmk.mk, then it reads the makefile with the rules to
build your files. (The file tmk.mk is located in the \etc directory of the toolset.)

With this option you tell the make utility not to read tmk.mk and to rely fully on the make rules in the makefile.

Example

tmk −r

The make utility does not read the implicit make rules in tmk.mk.

Related information

−
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Make Utility: −S

Command line syntax

−S

Description

With this option you cancel the effect of the option −k. This is only necessary in a recursive make where the option −k might be
inherited from the top−level make via MAKEFLAGS or if you set the option −k in the environment variable MAKEFLAGS.

Example

tmk −S

The effect of the option −k is cancelled so the make utility stops with the make process after it encounters an error.

The option −k in this example may have been set with the environment variable MAKEFLAGS or in a recursive call to tmk in the
makefile.

Related information

Make utility option −k (On error, abandon the work for the current target only)
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Make Utility: −s

Command line syntax

−s

Description

With this option you tell the make utility to perform its tasks without printing the commands it executes. Error messages are
normally printed.

Example

tmk −s

The make utility rebuilds your files but does not print the commands it executes during the make process.

Related information

Make utility option −n (Perform a dry run)
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Make Utility: −t

Command line syntax

−t

Description

With this option you tell the make utility to touch the target files, bringing them up to date, rather than performing the rules to
rebuild them.

Example

tmk −t

The make utility updates out−of−date files by giving them a new date and time stamp. The files are not actually rebuild.

Related information

−
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Make Utility: −time

Command line syntax

−time

Description

With this option you tell the make utility to display the current date and time on standard output.

Example

tmk −time

The make utility displays the current date and time and updates out−of−date files.

Related information

−
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Make Utility: −V

Command line syntax

−V

Description

Display version information. The make utility ignores all other options or input files.

Example

tmk −V

The make utility displays the version information but does not perform any tasks.

Related information

−
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Make Utility: −W

Command line syntax

−W target

Description

With this option the make utility considers the specified target file always as up to date and will not rebuild it.

Example

tmk −W test.abs

The make utility rebuilds out of date targets in the makefile except the file test.abs which is considered now as up to date.

Related information

−
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Make Utility: −x

Command line syntax

−x

Description

With this option the make utility shows extended error messages. Extended error messages give more detailed information
about the exit status of the make utility after errors. Altium Designer uses this option for the graphical version of make.

Example

tmk −x

If errors occur, the make utility gives extended information.

Related information

−
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4.6 Librarian Options

The librarian tlb is a tool to build library files and it offers the possibility to replace, extract and remove modules from an existing
library.

You can only call the librarian from the command line. The invocation syntax is:

tlb key_option  [sub_option...]  library  [object_file]

This section describes all options for the make utility. Suboptions can only be used in combination with certain key options.
Keyoptions and their suboptions are therefor described together. The miscellaneous options can always be used and are also
described separately.

The librarian is a command line tool so there are no equivalent options in Altium Designer.

Description Option Suboption

Main functions (key options)

Replace or add an object module −r −a −b −c −u −v

Extract an object module from the library −x −o −v

Delete object module from library −d −v

Move object module to another position −m −a −b −v

Print a table of contents of the library −t −s0 −s1

Print object module to standard output −p

Suboptions

Append or move new modules after existing module name −a name

Append or move new modules before existing module name −b name

Create library without notification if library does not exist −c

Preserve last−modified date from the library −o

Print symbols in library modules −s{0|1}

Replace only newer modules −u

Verbose −v

Miscellaneous

Display options −?

Display version header −V

Read options from file −f file

Suppress warnings above level n −wn

Table 4−1: Overview of librarian options and suboptions
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Librarian: −?

Command line syntax

−?

Description

Displays an overview of all command line options.

Example

The following invocations display a list of the available command line options:

tlb −?
tlb

Related information

−
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Librarian: −d

Command line syntax

−d [−v]

Description

Delete the specified object modules from a library. With the suboption −v the librarian shows which files are removed.

−v Verbose: the librarian shows which files are removed.

Example

tlb −d mylib.lib obj1.obj obj2.obj

The librarian deletes obj1.obj and obj2.obj from the library mylib.lib.

tlb −d −v mylib.lib obj1.obj obj2.obj

The librarian deletes obj1.obj and obj2.obj from the library mylib.lib and displays which files are removed.

Related information

−
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Librarian: −f

Command line syntax

−f file

Description

Instead of typing all options on the command line, you can create an option file which contains all options and flags you want to
specify. With this option you specify the option file to the librarian tlb.

Use an option file when the command line would exceed the limits of the operating system, or just to store options and save
typing.

Option files can also be generated on the fly, for example by the make utility. You can specify the option −f multiple times.

Format of an option file

• Multiple arguments on one line in the option file are allowed.

• To include whitespace in an argument, surround the argument with single or double quotes.

• If you want to use single quotes as part of the argument, surround the argument by double quotes and vise versa:

"This has a single quote ’ embedded"

’This has a double quote " embedded’

’This has a double quote " and a single quote ’"’ embedded"

• When a text line reaches its length limit, use a ’to continue the line. Whitespace between quotes is preserved.

"This is a continuation \
line"
     −> "This is a continuation line"

• It is possible to nest command line files up to 25 levels.

Example

Suppose the file myoptions contains the following lines:

−x mylib.lib obj1.obj
−w5

Specify the option file to the librarian:

tlb −f myoptions

This is equivalent to the following command line:

tlb −x mylib.lib obj1.obj −w5
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Librarian: −m

Command line syntax

−m [−a posname] [−b posname]

Description

Move the specified object modules to another position in the library.

The ordering of members in a library can make a difference in how programs are linked if a symbol is defined in more than one
member.

Default, the specified members are moved to the end of the archive. Use the suboptions −a or −b  to move them to a specified
place instead.

−a posname Move the specified object module(s) after the existing module posname.

−b posname Move the specified object module(s) before the existing module posname.

Example

Suppose the library mylib.lib contains the following objects (see option −t):

obj1.obj
obj2.obj
obj3.obj

To move obj1.obj to the end of mylib.lib:

tlb −m mylib.lib obj1.obj

To move obj3.obj just before obj2.obj:

tlb −m −b obj3.obj mylib.lib obj2.obj

The library mylib.lib after these two invocations now looks like:

obj3.obj
obj2.obj
obj1.obj

Related information

Librarian option −t (Print library contents)
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Librarian: −p

Command line syntax

−p

Description

Print the specified object module(s) in the library to standard output.

This option is only useful when you redirect or pipe the output to other files or tools that serve your own purposes. Normally you
do not need this option.

Example

tlb −p mylib.lib obj1.obj > file.obj

The librarian prints the file obj1.obj to standard output where it is redirected to the file file.obj. The effect of this example
is very similar to extracting a file from the library but in this case the ’extracted’ file gets another name.

Related information

−
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Librarian: −r

Command line syntax

−r [−a posname] [−b posname] [−c] [−u] [−v]

Description

You can use the option −r for several purposes:

• Adding new objects to the library

• Replacing objects in the library with the same object of a newer date

• Creating a new library

The option −r normally adds a new module to the library. However, if the library already contains a module with the specified
name, the existing module is replaced. If you specify a library that does not exist, the librarian creates a new library with the
specified name.

If you add a module to the library without specifying the suboption −a or −b, the specified module is added at the end of the
archive. Use the suboptions −a or −b  to insert them to a specified place instead.

−a posname Add the specified object module(s) after the existing module posname.

−b posname Add the specified object module(s) before the existing module posname.

−c Create a new library without checking whether it already exists. If the library already exists, it is overwritten.

−u Insert the specified object module only if it is newer than the module in the library.

−v Verbose: the librarian shows which files are removed.

The suboptions −a or −b have no effect when an object is added to the library.

Examples

Suppose the library mylib.lib contains the following objects (see option −t):

obj1.obj

To add obj2.obj to the end of mylib.lib:

tlb −r mylib.lib obj2.obj

To insert obj3.obj just before obj2.obj:

tlb −r −b obj2.obj mylib.lib obj3.obj

The library mylib.lib after these two invocations now looks like:

obj1.obj
obj3.obj
obj2.obj

Creating a new library

To create a new library file, add an object file and specify a library that does not yet exist:

tlb −r obj1.obj newlib.lib

The librarian creates the library newlib.lib and adds the object obj1.obj to it.

To create a new library file and overwrite an existing library, add an object file and specify an existing library with the supoption
−c:

tlb −r −c obj1.obj mylib.lib
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The librarian overwrites the library mylib.lib and adds the object obj1.obj to it. The new library mylib.lib only contains
obj1.obj.

Related information

Librarian option −t (Print library contents)
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Librarian: −t

Command line syntax

−t [−s0|−s1]

Description

Print a table of contents of the library to standard out. With the suboption −s the librarian displays all symbols per object file.

−s0 Displays per object the library in which it resides, the name of the object itself and all symbols in the object.

−s1 Displays only the symbols of all object files in the library.

Example

tlb −t mylib.lib

The librarian prints a list of all object modules in the libary mylib.lib.

tlb −t −s0 mylib.lib

The librarian prints per object all symbols in the library. This looks like:

prolog.obj
   symbols:
mylib.lib:prolog.obj:___Qabi_callee_save
mylib.lib:prolog.obj:___Qabi_callee_restore
div16.obj
   symbols:
mylib.lib:div16.obj:___udiv16
mylib.lib:div16.obj:___div16
mylib.lib:div16.obj:___urem16
mylib.lib:div16.obj:___rem16

Related information

−
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Librarian: −V

Command line syntax

−V

Description

Display version information. The librarian ignores all other options or input files.

Example

tlb −V

The librarian displays version information but does not perform any tasks.

Related information

−
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Librarian: −w

Command line syntax

−wlevel

Description

With this suboption you tell the librarian to suppress all warnings above the specified level. The level is a number between 0 − 9.

The level of a message is printed between parentheses after the warning number. If you do not use the −w option, the default
warning level is 8.

Example

To suppresses warnings above level 5:

tlb −x −w5 mylib.lib obj1.obj

Related information

−
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Librarian: −x

Command line syntax

−x [−o] [−v]

Description

Extract an existing module from the library.

−o Give the extracted object module the same date as the last−modified date that was recorded in the library.

Without this suboption it receives the last−modified date of the moment it is extracted.

−v Verbose: the librarian shows which files are extracted.

Examples

To extract the file obj1.obj from the library mylib.lib:

tlb −x mylib.lib obj1.obj

If you do not specify an object module, all object modules are extracted:

tlb −x mylib.lib

Related information

−
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5 List File Formats

Summary This chapter describes the format of the assembler list file and the linker map file.

5.1 Assembler List File Format

The assembler list file is an additional output file of the assembler that contains information about the generated code.

The list file consists of a page header and a source listing.

Page header

The page header is repeated on every page:

TASKING target Assembler vx.yrz Build nnn SN 00000000
Title                                                     Page 1

ADDR CODE      CYCLES  LINE SOURCE LINE

The first line contains version information.

The second line can contain a title which you can specify with the assembler directive .TITLE and always contains a page
number. With the assembler directives .LIST/.NOLIST and .PAGE, and with the assembler option −Lflag (−−list−format) you
can format the list file.

See Section 3.8.2, Assembler Directives in Chapter Assembly Language and Section 4.2, Assembler Options in Chapter
Tools Options.

The fourth line contains the headings of the columns for the source listing.

Source listing

The following is a sample part of a listing. An explanation of the different columns follows below.

ADDR CODE      CYCLES  LINE SOURCE LINE
                          1         ; Module start
                          .
                          .
0000 3C02rrrr  1    1    14         lui     $v0,@hi(_2_str)
0004 2444rrrr  1    2    15         addiu   $a0,$v0,@lo(_2_str)
0008 0rrrrrrr  1    3    16         j       printf
000C 8F85rrrr  1    4    17         lw      $a1,@gprel(world)($gp)
                          .
                          .
0000                     38         .ds     2
  |  RESERVED
0001

The meaning of the different columns is:

ADDR This column contains the memory address. The address is a hexadecimal number that represents the
offset from the beginning of a relocatable section or the absolute address for an absolute section. The
address only appears on lines that generate object code.
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CODE This is the object code generated by the assembler for this source line, displayed in hexadecimal format.
The displayed code need not be the same as the generated code that is entered in the object module. The
code can also be relocatable code. In this case the letter ’r’ is printed for the relocatable code part in the
listing. For lines that allocate space, the code field contains the text "RESERVED". For lines that initialize a
buffer, the code field lists one value followed by the word "REPEATS".

CYCLES The first number in this column is the number of instruction cycles needed to execute the instruction(s) as
generated in the CODE field. The second number is the accumulated cycle count of this section.

LINE This column contains the line number. This is a decimal number indicating each input line, starting from 1
and incrementing with each source line.

SOURCE LINE This column contains the source text. This is a copy of the source line from the assembly source file.

For the .SET and .EQU directives the ADDR and CODE columns do not apply. The symbol value is listed instead.

Related information

See section 4.6, Generating a List File, in Chapter Using the Assembler of the user’s manual for more information on
how to generate a list file and specify the amount of list file information.
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5.2 Linker Map File Format

The linker map file is an additional output file of the linker that shows how the linker has mapped the sections and symbols from
the various object files (.obj) to output sections. The locate part shows the absolute position of each section. External symbols
are listed per space with their absolute address, both sorted on symbol and sorted on address.

With the linker option −−map−file−format (map file formatting) you can specify which parts of the map file you want to see.

Example (part of) linker map file

**********************************************************  Tool and Invocation  ***********************************************************

+−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−+

| tool      | TASKING TSK3000 object linker vx.yrz Build 016                   |

| path      | <installation dir>\System\Tasking\c3000\bin\lk3000.exe           |

| arguments | hello.obj −o hello.abs −d3000.lsl −M −mnqs −lc3000md −lfp3000md  |

| task      | task1                                                            |

+−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−+

*************************************************************  Used Resources  *************************************************************

* Memory usage in bytes

========================

+−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−+

| Memory      | Code    | Data    | Reserved | Free    | Total   |

|================================================================|

| system:xram |     0x0 | 0x00280 |  0x08001 | 0x77d7f | 0x80000 |

| system:xrom | 0x015a4 | 0x00146 |      0x0 | 0x0e916 | 0x10000 |

|−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−|

| Total       | 0x015a4 | 0x003c6 |  0x08001 | 0x86695 | 0x90000 |

+−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−+

* Space usage in bytes

=======================

+−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−+

| Space          | Native used Rom | Native used Ram | Foreign used |  Reserved | Free Rom |  Free Ram | Total   |

|================================================================================================================|

| system:sw:main |         0x016ea |         0x00280 |          0x0 |   0x08001 |  0x0e916 |   0x77d7f | 0x90000 |

|−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−|

| Total          |         0x016ea |         0x00280 |            − |         − |        − |         − |       − |

| Largest gap    |               − |               − |            − |         − |  0x0e914 |   0x77d7c |       − |

+−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−+

Note:

When spaces share memory with each other, some space can be consumed by sections

located in other spaces. In the table above we call this foreign used space as

opposed to native used space.

* Estimated stack usage

========================

+−−−−−−−−−−−−−−−−−−−−−−−−−+

| Stack Name | Used       |

|=========================|

| stack   0  | 0x000001cc |

|−−−−−−−−−−−−−−−−−−−−−−−−−|

| recursive  | no         |

+−−−−−−−−−−−−−−−−−−−−−−−−−+

************************************************************  Processed Files  *************************************************************

+−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−+

| File       | From archive | Symbol causing the extraction |

|===========================================================|

| cstart.obj | c3000md.lib  | _START                        |

| hello.obj  |              |                               |

| printf.obj | c3000md.lib  | printf                        |

+−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−+
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**************************************************************  Link Result  ***************************************************************

+−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−+

| [in] File  | [in] Section       | [in] Size (MAU) | [out] Offset | [out] Section      | [out] Size (MAU) |

|==========================================================================================================|

| hello.obj  | .text (2)          | 0x00000020      | 0x00000000   | .text (2)          | 0x00000020       |

|−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−|

| cstart.obj | .text.cstart (245) | 0x000000a8      | 0x00000000   | .text.cstart (245) | 0x000000a8       |

|−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−|

| printf.obj | .text.libc (57)    | 0x00000058      | 0x00000000   | .text.libc (57)    | 0x00000058       |

+−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−+

**********************************************************  Module Local Symbols  **********************************************************

* Scope "hello.c"

==================

+−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−+

| Name    | Space addr | Space          |

|=======================================|

| hello.c | 0x0        | −              |

|−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−|

| .rodata | 0x00000170 | system:sw:main |

| .sbss   | 0x01000004 |                |

| .sdata  | 0x01000000 |                |

| .text   | 0x0000018c |                |

+−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−+

************************************************************  Cross References  ************************************************************

+−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−+

| Definition file | Definition section  | Symbol     | Referenced in           |

|==============================================================================|

| cstart.obj      | .text.cstart (245)  | _START     | hello.obj               |

| hello.obj       | .text (2)           | main       | cstart.obj              |

+−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−+

* Undefined symbols

====================

+−−−−−−−−−−−−−−−−−−−−−−−−+

| Symbol | Referenced in |

|========================|

| _init | hello.obj      |

+−−−−−−−−−−−−−−−−−−−−−−−−+

***************************************************************  Call Graph  ***************************************************************

main

|

+−− printloop

|   |

|   +−− printf *

|

+−− printf *

printf

|

+−− _doprint

    |

    +−− _doprint_int.c:_emitchar *

    |

    +−− _doprint_int.c:_putnumber

    |   |

    |   +−− _doprint_int.c:_emitchar *

    |   |

    |   +−− _doprint_int.c:_putstring *

    |   |

    |   +−− strlen *

    |   |

    |   +−− _doprint_int.c:_ltoa

    |

    +−− _doprint_int.c:_putstring *

    |

    +−− _doflt
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*************************************************************  Locate Result  **************************************************************

* Task entry address

=====================

+−−−−−−−−−−−−−−−−−−−−−−−−−−−+

| symbol           | _START |

| absolute address | 0x0    |

+−−−−−−−−−−−−−−−−−−−−−−−−−−−+

* Sections

===========

+ Space system:sw:main (MAU = 8bit)

+−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−+

| Chip        | Group | Section                     | Size (MAU) | Space addr | Chip addr  |

|==========================================================================================|

| system:xrom |       | .text.cstart (245)          | 0x000000a8 | 0x0        | 0x0        |

| system:xrom |       | [.data.libc] (256)          | 0x000000c8 | 0x000000a8 | 0x000000a8 |

| system:xrom |       | .rodata (4)                 | 0x0000000e | 0x00000170 | 0x00000170 |

| system:xrom |       | .rodata.libc (181)          | 0x0000000c | 0x00000180 | 0x00000180 |

| system:xrom |       | .text (2)                   | 0x00000020 | 0x0000018c | 0x0000018c |

| system:xrom |       | [.sdata] (255)              | 0x00000004 | 0x00001688 | 0x00001688 |

| system:xrom |       | table (254)                 | 0x00000060 | 0x0000168c | 0x0000168c |

| system:xram | sda   | .sdata (3)                  | 0x00000004 | 0x01000000 | 0x0        |

| system:xram |       | stack (252)                 | 0x00008000 | 0x01000284 | 0x00000284 |

+−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−+

* Symbols (sorted on name)

===========================

+−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−+

| Name             | Space addr | Space          |

|================================================|

| _EXCEPTION_BASE_ | 0x00000100 | system:sw:main |

| _Exit            | 0x000001f4 |                |

| _START           | 0x0        |                |

| main             | 0x0000018c |                |

+−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−+

* Symbols (sorted on address)

==============================

+−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−+

| Space addr | Name             | Space          |

|================================================|

| 0x0        | _START           | system:sw:main |

| 0x000001f4 | _Exit            |                |

| 0x00000100 | _EXCEPTION_BASE_ |                |

| 0x0000018c | main             |                |

+−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−+

**********************************************************  Processor and Memory  **********************************************************

**************************************************************  Locate Rules  **************************************************************

+−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−+

| Address space  | Type         | Properties | Sections                                                 |

|=======================================================================================================|

| system:sw:main | absolute     | 0x00000000 | .text.cstart (245)                                       |

| system:sw:main | contiguous   |            | .sdata (3) | .sbss (5)                                   |

| system:sw:main | clustered    |            | [.data.libc] (256)                                       |

| system:sw:main | unrestricted |            | .rodata (4) , .rodata.libc (181) , .text (2) , .text (1) |

| system:sw:main | unrestricted |            | stack (252)                                              |

| system:sw:main | unrestricted |            | .alignment_protection (257)                              |

+−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−+

The meaning of the different parts is:

Tool and Invocation

This part of the map file contains information about the linker, its version header information, binary location and which options
are used to call it.

Used Resources

This part of the map file shows the memory usage at memory level and space level. The largest free block of memory (Largest
gap) is also shown. This part also contains an estimation of the stack usage.
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Memory  The names of the memory as defined in the linker script file (*.lsl).

Code  The size of all executable sections.

Data  The size of all non−executable sections (not including stacks, heaps, debug sections in non−alloc
space).

Reserved  The total size of reserved memories, reserved ranges, reserved special sections, stacks, heaps,
alignment protections, sections located in non−alloc space (debug sections). In fact, this size is the
same as the size in the Total column minus the size of all other columns.

Free  The free memory area addressable by this core. This area is accessible for unrestricted items.

Total  The total memory area addressable by this core.

Space  The names of the address spaces as defined in the linker script file (*.lsl). The names are
constructed of the derivative name followed by a colon ’:’, the core name, another colon ’:’ and the
space name.

Native used ...  The size of sections located in this space.

Foreign used  The size of all sections destined for/located in other spaces, but because of overlap in spaces
consume memory in this space.

Stack Name  The name(s) of the stack(s) as defined in the linker script file (*.lsl).

Used  An estimation of the stack usage. The linker calculates the required stack size by using information
(.CALLS directives) generated by the compiler. If for example recursion is detected, the calculated
stack size is inaccurate, therefore this is an estimation only. The calculated stack size is supposed
to be smaller than the actual allocated stack size. If that is not the case, then a warning is given.

Processed Files

This part of the map file shows all processed files. This also includes object files that are extracted from a library, with the
symbol that led to the extraction.

Link Result

This part of the map file shows per object file how the link phase has mapped the sections from the various object files (.obj) to
output sections.

[in] File  The name of an input object file.

[in] Section  A section name and id from the input object file. The number between ’( )’ uniquely identifies the section.

[in] Size  The size of the input section.

[out] Offset  The offset relative to the start of the output section.

[out] Section  The resulting output section name and id.

[out] Size  The size of the output section.

Module Local Symbols

This part of the map file shows a table for each local scope within an object file. Each table has three columns, 1 the symbol
name, 2 the address of the symbol and 3 the space where the symbol resides in. The table is sorted on symbol name within
each space.

By default this part is not shown in the map file. You have to turn this part on manually with linker option
−−map−file−format=+statics (module local symbols).

Cross References

This part of the map file lists all symbols defined in the object modules and for each symbol the object modules that contain a
reference to the symbol are shown. Also, symbols that remain undefined are shown.

Call Graph

This part of the map file contains a schematic overview that shows how (library) functions call each other.
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Locate Result: Sections

This part of the map file shows the absolute position of each section in the absolute object file. It is organized per address
space, memory chip and group and sorted on space address.

+ Space  The names of the address spaces as defined in the linker script file (*.lsl). The names are constructed
of the derivative name followed by a colon ’:’, the core name, another colon ’:’ and the space name.

Chip  The names of the memory chips as defined in the linker script file (*.lsl) in the memory definitions.

Group  Sections can be ordered in groups. These are the names of the groups as defined in the linker script file
(*.lsl) with the keyword group in the section_layout definition. The name that is displayed is the
name of the deepest nested group.

Section  The name and id of the section. The number between ’( )’ uniquely identifies the section. Names within
square brackets [ ] will be copied during initialization from ROM to the corresponding section name in
RAM.

Size (MAU)  The size of the section in minimum addressable units.

Space addr  The absolute address of the section in the address space.

Chip addr  The absolute offset of the section from the start of a memory chip.

Locate Result: Symbols

This part of the map file lists all external symbols per address space name, both sorted on address and sorted on symbol name.

Name  The name of the symbol.

Space addr  The absolute address of the section in the address space.

Space  The names of the address spaces as defined in the linker script file (*.lsl). The names are constructed
of the derivative name followed by a colon ’:’, the core name, another colon ’:’ and the space name.

Processor and Memory

This part of the map file shows the processor and memory information of the linker script file.

By default this part is not shown in the map file. You have to turn this part on manually with linker option
−−map−file−format=+lsl (processor and memory info). You can print this information to a separate file with linker option
−−lsl−dump.

Locate Rules

This part of the map file shows the rules the linker uses to locate sections.

Address space  The names of the address spaces as defined in the linker script file (*.lsl). The names are constructed
of the derivative name followed by a colon ’:’, the core name, another colon ’:’ and the space name.

Type  The rule type:

  ordered/contiguous/clustered/unrestricted   
Specifies how sections are grouped. By default, a group is ’unrestricted’ which means that the linker
has total freedom to place the sections of the group in the address space.

  absolute   The section must be located at the address shown in the Properties column.

  address range  The section must be located in the union of the address ranges shown in the Properties column;
end addresses are not included in the range.

  address range size  The sections must be located in some address range with size not larger than shown in the
Properties column; the second number in that field is the alignment requirement for the address
range.

  ballooned   After locating all sections, the largest remaining gap in the space is used completely for the stack
and/or heap.

Properties  The contents depends on the Type column.



TSK3000 Embedded Tools Reference

5−8

Sections  The sections to which the rule applies;
restrictions between sections are shown in this column:
     < ordered
     | contiguous
     + clustered
For contiguous sections, the linker uses the section order as shown here. Clustered sections can be
located in any relative order.

Related information

Section 5.11, Generating a Map File, in Chapter Using the Linker of the user’s manual.
Linker option −−map−file (Generate map file)
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6 Object File Formats

Summary This chapter describes the formats of several object files.

6.1 ELF/DWARF Object Format

The TASKING TSK3000 toolset by default produces objects in the ELF/DWARF 2 format.

The ELF/DWARF 2 Object Format for the TSK3000 toolset follows the convention as described in the System V Application
Binary Interface, MIPS RISC Processor Supplement 3rd Edition [1990−1996, The Santa Cruz Operation, Inc.]

For a complete description of the ELF and DWARF formats, please refer to the Tool Interface Standard (TIS).
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6.2 Motorola S−Record Format

With the linker option −ofilename:SREC option the linker produces output in Motorola S−record format with three types of
S−records: S0, S3 and S7. With the options −ofilename:SREC:2 or −ofilename:SREC:3 option you can force other types of
S−records. They have the following layout:

S0 − record

’S’ ’0’ <length_byte> <2 bytes 0> <comment> <checksum_byte>

A linker generated S−record file starts with a S0 record with the following contents:

length_byte : $09
comment : lk3000
checksum : $5C

        l k 3 0 0 0
S00900006C6B333030305C

The S0 record is a comment record and does not contain relevant information for program execution.

The length_byte represents the number of bytes in the record, not including the record type and length byte.

The checksum is calculated by first adding the binary representation of the bytes following the record type (starting with the
length_byte) to just before the checksum. Then the one’s complement is calculated of this sum. The least significant byte of the
result is the checksum. The sum of all bytes following the record type is 0FFH.

S1 − record

With the linker option −ofilename:SREC:2, the actual program code and data is supplied with S1 records, with the following
layout:

’S’ ’1’ <length_byte> <address> <code bytes> <checksum_byte>

This record is used for 2−byte addresses.

Example:

S1130250F03EF04DF0ACE8A408A2A013EDFCDB00E6
  | |   |                               |_ checksum
  | |   |_ code
  | |_ address
  |_ length

The linker has an option that controls the length of the output buffer for generating S1 records. The default buffer length is 32
code bytes.

The checksum calculation of S1 records is identical to S0.

S2 − record

With the linker option −ofilename:SREC:3, the actual program code and data is supplied with S2 records, with the following
layout:

’S’ ’2’ <length_byte> <address> <code bytes> <checksum_byte>

This record is used for 3−byte addresses.

Example:

S213FF002000232222754E00754F04AF4FAE4E22BF
  | |     |                             |_ checksum
  | |     |_ code
  | |_ address
  |_ length

The linker has an option that controls the length of the output buffer for generating S2 records. The default buffer length is 32
code bytes.
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The checksum calculation of S2 records is identical to S0.

S3 − record

With the linker option −ofilename:SREC:4, which is the default, the actual program code and data is supplied with S3 records,
with the following layout:

’S’ ’3’ <length_byte> <address> <code bytes> <checksum_byte>

The linker generates 4−byte addresses by default.

Example:

S3070000FFFE6E6825
  | |       |   |_ checksum
  | |       |_ code
  | |_ address
  |_ length

The linker has an option that controls the length of the output buffer for generating S3 records.

The checksum calculation of S3 records is identical to S0.

S7 − record

With the linker option −ofilename:SREC:4, which is the default, at the end of an S−record file, the linker generates an S7 record,
which contains the program start address. S7 is the corresponding termination record for S3 records.

Layout:

’S’ ’7’ <length_byte> <address> <checksum_byte>

Example:

S70500000000FA
  | |       |_checksum
  | |_ address
  |_ length

The checksum calculation of S7 records is identical to S0.

S8 − record

With the linker option −ofilename:SREC:3, at the end of an S−record file, the linker generates an S8 record, which contains the
program start address.

Layout:

’S’ ’8’ <length_byte> <address> <checksum_byte>

Example:

S804FF0003F9
  | |     |_checksum
  | |_ address
  |_ length

The checksum calculation of S8 records is identical to S0.

S9 − record

With the linker option −ofilename:SREC:2, at the end of an S−record file, the linker generates an S9 record, which contains the
program start address. S9 is the corresponding termination record for S1 records.

Layout:

’S’ ’9’ <length_byte> <address> <checksum_byte>
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Example:

S9030210EA
  | |   |_checksum
  | |_ address
  |_ length

The checksum calculation of S9 records is identical to S0.
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6.3 Intel Hex Record Format

Intel Hex records describe the hexadecimal object file format for 8−bit, 16−bit and 32−bit microprocessors. The hexadecimal
object file is an ASCII representation of an absolute binary object file. There are six different types of records:

• Data Record (8−, 16, or 32−bit formats)

• End of File Record (8−, 16, or 32−bit formats)

• Extended Segment Address Record (16, or 32−bit formats)

• Start Segment Address Record (16, or 32−bit formats)

• Extended Linear Address Record (32−bit format only)

• Start Linear Address Record (32−bit format only)

By default the linker generates records in the 32−bit format (4−byte addresses).

General Record Format

In the output file, the record format is:

ÁÁÁ
ÁÁÁ
ÁÁÁ
ÁÁÁ

:

ÁÁÁÁ
ÁÁÁÁ
ÁÁÁÁ
ÁÁÁÁ

length

ÁÁÁÁ
ÁÁÁÁ
ÁÁÁÁ
ÁÁÁÁ

offset

ÁÁÁÁ
ÁÁÁÁ
ÁÁÁÁ
ÁÁÁÁ

type

ÁÁÁÁ
ÁÁÁÁ
ÁÁÁÁ
ÁÁÁÁ

content

ÁÁÁÁÁ
ÁÁÁÁÁ
ÁÁÁÁÁ
ÁÁÁÁÁ

checksum

Where:

: is the record header.

length is the record length which specifies the number of bytes of the content field. This value occupies one byte (two
hexadecimal digits). The linker outputs records of 255 bytes (32 hexadecimal digits) or less; that is, length is
never greater than FFH.

offset is the starting load offset specifying an absolute address in memory where the data is to be located when loaded
by a tool. This field is two bytes long. This field is only used for Data Records. In other records this field is coded
as four ASCII zero characters (’0000’).

type is the record type. This value occupies one byte (two hexadecimal digits). The record types are:

Byte Type Record type

00 Data

01 End of File

02 Extended segment address (not used)

03 Start segment address (not used)

04 Extended linear address (32−bit)

05 Start linear address (32−bit)

content is the information contained in the record. This depends on the record type.

checksum is the record checksum. The linker computes the checksum by first adding the binary representation of the
previous bytes (from length to content). The linker then computes the result of sum modulo 256 and subtracts the
remainder from 256 (two’s complement). Therefore, the sum of all bytes following the header is zero.

Extended Linear Address Record

The Extended Linear Address Record specifies the two most significant bytes (bits 16−31) of the absolute address of the first
data byte in a subsequent Data Record:

ÁÁÁ
ÁÁÁ
ÁÁÁ

:

ÁÁÁ
ÁÁÁ
ÁÁÁ

02

ÁÁÁÁ
ÁÁÁÁ
ÁÁÁÁ

0000

ÁÁÁÁ
ÁÁÁÁ
ÁÁÁÁ

04

ÁÁÁÁÁÁ
ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

upper_address

ÁÁÁÁÁ
ÁÁÁÁÁ
ÁÁÁÁÁ

checksum
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The 32−bit absolute address of a byte in a Data Record is calculated as:

( address + offset + index ) modulo 4G

where:

address is the base address, where the two most significant bytes are the upper_address and the two least significant
bytes are zero.

offset is the 16−bit offset from the Data Record.

index is the index of the data byte within the Data Record (0 for the first byte).

Example:

:0200000400FFFB
 | |   | |   |_ checksum
 | |   | |_ upper_address
 | |   |_ type
 | |_ offset
 |_ length

Data Record

The Data Record specifies the actual program code and data.

ÁÁÁ
ÁÁÁ
ÁÁÁ

:
ÁÁÁÁ
ÁÁÁÁ
ÁÁÁÁ

length
ÁÁÁÁ
ÁÁÁÁ
ÁÁÁÁ

offset
ÁÁÁ
ÁÁÁ
ÁÁÁ

00
ÁÁÁÁÁ
ÁÁÁÁÁ
ÁÁÁÁÁ

data
ÁÁÁÁ
ÁÁÁÁ
ÁÁÁÁ

checksum

The length byte specifies the number of data bytes. The linker has an option that controls the length of the output buffer for
generating Data records. The default buffer length is 32 bytes.

The offset is the 16−bit starting load offset. Together with the address specified in the Extended Address Record it specifies an
absolute address in memory where the data is to be located when loaded by a tool.

Example:

:0F00200000232222754E00754F04AF4FAE4E22C3
 | |   | |                             |_ checksum
 | |   | |_ data
 | |   |_ type
 | |_ offset
 |_ length

Start Linear Address Record

The Start Linear Address Record contains the 32−bit program execution start address.

Layout:

ÁÁÁ
ÁÁÁ
ÁÁÁ

:

ÁÁÁ
ÁÁÁ
ÁÁÁ

04

ÁÁÁÁ
ÁÁÁÁ
ÁÁÁÁ

0000

ÁÁÁÁ
ÁÁÁÁ
ÁÁÁÁ

05

ÁÁÁÁ
ÁÁÁÁ
ÁÁÁÁ

address

ÁÁÁÁÁ
ÁÁÁÁÁ
ÁÁÁÁÁ

checksum

Example:

:0400000500FF0003F5
 | |   | |       |_ checksum
 | |   | |_ address
 | |   |_ type
 | |_ offset
 |_ length
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End of File Record

The hexadecimal file always ends with the following end−of−file record:

:00000001FF
 | |   | |_ checksum
 | |   |_ type
 | |_ offset
 |_ length
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7 Linker Script Language

Summary This chapter describes the syntax of the linker script language (LSL)

7.1 Introduction

To make full use of the linker, you can write a script with information about the architecture of the target processor and locating
information. The language for the script is called the Linker Script Language (LSL). This chapter first describes the structure of
an LSL file. The next section contains a summary of the LSL syntax. Finally, in the remaining sections, the semantics of the
Linker Script Language is explained.

The TASKING linker is a target independent linker/locator that can simultaneously link and locate all programs for all cores
available on a target board. The target board may be of arbitrary complexity. A simple target board may contain one standard
processor with some external memory that executes one task. A complex target board may contain multiple standard
processors and DSPs combined with configurable IP−cores loaded in an FPGA. Each core may execute a different program,
and external memory may be shared by multiple cores.

LSL serves two purposes. First it enables you to specify the characteristics (that are of interest to the linker) of your specific
target board and of the cores installed on the board. Second it enables you to specify how sections should be located in
memory.

7.2 Structure of a Linker Script File

 A script file consists of several definitions. The definitions can appear in any order.

The architecture definition (required)

In essence an architecture definition describes how the linker should convert logical addresses into physical addresses for a
given type of core. If the core supports multiple address spaces, then for each space the linker must know how to perform this
conversion. In this context a physical address is an offset on a given internal or external bus. Additionally the architecture
definition contains information about items such as the (hardware) stack and the vector table.

This specification is normally written by Altium. The architecture definition of the LSL file should not be changed by you unless
you also modify the core’s hardware architecture. If the LSL file describes a multi−core system an architecture definition must be
available for each different type of core.

See section 7.5, Semantics of the Architecture Definition for detailed descriptions of LSL in the architecture definition.

The derivative definition

The derivative definition describes the configuration of the internal (on−chip) bus and memory system. Basically it tells the linker
how to convert offsets on the buses specified in the architecture definition into offsets in internal memory. A derivative definition
must be present in an LSL file. Microcontrollers and DSPs often have internal memory and I/O sub−systems apart from one or
more cores. The design of such a chip is called a derivative.

When you design an FPGA together with a PCB, the components on the FPGA become part of the board design and there is no
need to distinguish between internal and external memory. For this reason you probably do not need to work with derivative
definitions at all. There are, however, two situations where derivative definitions are useful:

1. When you re−use an FPGA design for several board designs it may be practical to write a derivative definition for the FPGA
design and include it in the project LSL file.

2. When you want to use multiple cores of the same type, you must instantiate the cores in a derivative definition, since the
linker automatically instantiates only a single core for an unused architecture.
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See section 7.6, Semantics of the Derivative Definition for a detailed description of LSL in the derivative definition.

The processor definition

The processor definition describes an instance of a derivative. Typically the processor definition instantiates one derivative only
(single−core processor). A processor that contains multiple cores having the same (homogeneous) or different (heterogeneous)
architecture can also be described by instantiating multiple derivatives of the same or different types in separate processor
definitions.

If for a derivative ’A’ no processor is defined in the LSL file, the linker automatically creates a processor named ’A’ of derivative
’A’. This is why for single−processor applications it is enough to specify the derivative in the LSL file.

See section 7.7, Semantics of the Board Specification for a detailed description of LSL in the processor definition.

The memory and bus definitions (optional)

Memory and bus definition are used within the context of a derivative definition to specify internal memory and on−chip buses. In
the context of a board specification the memory and bus definitions are used to define external (off−chip) memory and buses.
Given the above definitions the linker can convert a logical address into an offset into an on−chip or off−chip memory device.

See section 7.7.3, Defining External Memory and Buses, for more information on how to specify the external physical
memory layout. Internal memory for a processor should be defined in the derivative definition for that processor.

The board specification

The processor definition and memory and bus definitions together form a board specification. LSL provides language constructs
to easily describe single−core and heterogeneous or homogeneous multi−core systems. The board specification describes all
characteristics of your target board’s system buses, memory devices, I/O sub−systems, and cores that are of interest to the
linker. Based on the information provided in the board specification the linker can for each core:

• convert a logical address to an offset within a memory device

• locate sections in physical memory

• maintain an overall view of the used and free physical memory within the whole system while locating

The section layout definition (optional)

The optional section layout definition enables you to exactly control where input sections are located.  Features are provided
such as: the ability to place sections at a given load−address or run−time address, to place sections in a given order, and to
overlay code and/or data sections.

Which object files (sections) constitute the task that will run on a given core is specified on the command line when you invoke
the linker. The linker will link and locate all sections of all tasks simultaneously. From the section layout definition the linker can
deduce where a given section may be located in memory, form the board specification the linker can deduce which physical
memory is (still) available while locating the section.

See section 7.9, Semantics of the Section Layout Definition, for more information on how to locate a section at a specific
place in memory.

Skeleton of a Linker Script File

The skeleton of a linker script file now looks as follows:

architecture architecture_name
{
    architecture definition
}

derivative derivative_name
{
    derivative definition
}
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processor processor_name
{
    processor definition
}

memory definitions and/or bus definitions

section_layout space_name
{
    section placement statements
}

7.3 Syntax of the Linker Script Language

7.3.1 Preprocessing

When the linker loads an LSL file, the linker processes it with a C−style prepocessor. As such, it strips C and C++ comments.
You can use the standard ISO C preprocessor directives, such as #include, #define, #if/#else/#endif.

For example:

#include "arch.lsl"

Preprocess and include the file arch.lsl at this point in the LSL file.

7.3.2 Lexical Syntax

The following lexicon is used to describe the syntax of the Linker Script Language:

A ::= B     = A is defined as B
A ::= B C   = A is defined as B and C; B is followed by C
A ::= B | C = A is defined as B or C
<B>0|1      = zero or one occurrence of B
<B>>=0      = zero of more occurrences of B
<B>>=1      = one of more occurrences of B

IDENTIFIER = a character sequence starting with ’a’−’z’, ’A’−’Z’ or ’_’. 
             Following characters may also be digits and dots ’.’ 
STRING     = sequence of characters not starting with \n, \r or \t
DQSTRING   = " STRING "           (double quoted string)
OCT_NUM    = octal number, starting with a zero (06, 045)
DEC_NUM    = decimal number, not starting with a zero (14, 1024)
HEX_NUM    = hexadecimal number, starting with ’0x’ (0x0023, 0xFF00)

OCT_NUM, DEC_NUM and HEX_NUM can be followed by a k (kilo), M (mega), or G (giga).

Characters in bold are characters that occur literally. Words in italics are higher order terms that are defined in the same or in
one of the other sections.

To write comments in LSL file, you can use the C style ’/*  */’ or C++ style ’//’.
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7.3.3 Identifiers

arch_name         ::= IDENTIFIER
bus_name          ::= IDENTIFIER
core_name         ::= IDENTIFIER
derivative_name   ::= IDENTIFIER
file_name         ::= DQSTRING
group_name        ::= IDENTIFIER
mem_name          ::= IDENTIFIER
proc_name         ::= IDENTIFIER
section_name      ::= DQSTRING
space_name        ::= IDENTIFIER
stack_name        ::= section_name
symbol_name       ::= DQSTRING

7.3.4 Expressions

The expressions and operators in this section work the same as in ISO C.

number            ::= OCT_NUM
                    | DEC_NUM
                    | HEX_NUM

expr              ::= number
                    | symbol_name
                    | unary_op expr
                    | expr binary_op expr
                    | expr ? expr : expr
                    | ( expr )
                    | function_call

unary_op          ::= !    // logical NOT
                    | ~    // bitwise complement
                    | −    // negative value

binary_op         ::= ^    // exclusive OR
                    | *    // multiplication
                    | /    // division
                    | %    // modulus
                    | +    // addition
                    | −    // subtraction
                    | >>   // right shift
                    | <<   // left shift
                    | ==   // equal to
                    | !=   // not equal to
                    | >    // greater than
                    | <    // less than
                    | >=   // greater than or equal to
                    | <=   // less than or equal to
                    | &    // bitwise AND
                    | |    // bitwise OR
                    | &&   // logical AND
                    | ||   // logical OR
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7.3.5 Built−in Functions

function_call     ::= absolute ( expr )
                    | addressof ( addr_id )
                    | exists ( section_name )
                    | max ( expr , expr )
                    | min ( expr , expr )
                    | sizeof ( size_id )

addr_id           ::= sect : section_name
                    | group : group_name

size_id           ::= sect : section_name
                    | group : group_name
                    | mem : mem_name

• Every space, bus, memory, section or group your refer to, must be defined in the LSL file.

• The addressof() and sizeof() functions with the group or sect argument can only be used in the right hand side of an
assignment. The sizeof() function with the mem argument can be used anywhere in section layouts.

You can use the following built−in functions in expressions. All functions return a numerical value. This value is a 64−bit signed
integer.

absolute()

int absolute( expr )

Converts the value of expr to a positive integer.

absolute( "labelA"−"labelB" )

addressof()

int addressof( addr_id )

Returns the address of addr_id, which is a named section or group. To get the offset of the section with the name asect:

addressof( sect: "asect")

This function only works in assignments.

exists()

int exists( section_name )

The function returns 1 if the section section_name exists in one or more object file, 0 otherwise. If the section is not present in
input object files, but generated from LSL, the result of this function is undefined.

To check whether the section mysection exists in one of the object files that is specified to the linker:

exists( "mysection" )

max()

int max( expr, expr )

Returns the value of the expression that has the largest value. To get the highest value of two symbols:

max( "sym1" , "sym2")
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min()

int min( expr, expr )

Returns the value of the expression hat has the smallest value. To get the lowest value of two symbols:

min( "sym1" , "sym2")

sizeof()

int sizeof( size_id )

Returns the size of the object (group, section or memory) the identifier refers to. To get the size of the section "asection":

sizeof( sect: "asection" )

The group and sect arguments only works in assignments. The mem argument can be used anywhere in section
layouts.

7.3.6 LSL Definitions in the Linker Script File

description       ::= <definition>>=1

definition         ::= architecture_definition
                    | derivative_definition
                    | board_spec
                    | section_definition
                    | section_setup

• At least one architecture_definition must be present in the LSL file.

7.3.7 Memory and Bus Definitions

mem_def           ::= memory mem_name { <mem_descr ;>>=0 }

• A mem_def defines a memory with the mem_name as a unique name.

mem_descr         ::= type = <reserved>0|1 mem_type
                    | mau = expr
                    | size = expr
                    | speed = number
                    | mapping

• A mem_def contains exactly one type statement.

• A mem_def contains exactly one mau statement (non−zero size).

• A mem_def contains exactly one size statement.

• A mem_def contains zero or one speed statement (default value is 1).

• A mem_def contains at least one mapping.

mem_type          ::= rom        // attrs = rx
                    | ram        // attrs = rw
                    | nvram      // attrs = rwx

bus_def           ::= bus bus_name { <bus_descr ;>>=0 }

• A bus_def statement defines a bus with the given bus_name as a unique name within a core architecture.

bus_descr         ::= mau = expr
                    | width = expr  // bus width, nr
                    |               // of data bits 
                    | mapping       // legal destination
                                    // ’bus’ only

• The mau and width statements appear exactly once in a bus_descr. The default value for width is the mau size.

• The bus width must be an integer times the bus MAU size.
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• The MAU size must be non−zero.

• A bus can only have a mapping on a destination bus  (through dest = bus: ).

mapping           ::= map ( map_descr <, map_descr>>=0 )

map_descr         ::= dest = destination
                    | dest_dbits = range
                    | dest_offset = expr
                    | size = expr
                    | src_dbits = range
                    | src_offset = expr

• A mapping requires at least the size and dest statements.

• Each map_descr can occur only once.

• You can define multiple mappings from a single source.

• Overlap between source ranges or destination ranges is not allowed.

• If the src_dbits or dest_dbits statement is not present, its value defaults to the width value if the source/destination is
a bus, and to the mau size otherwise.

destination       ::= space : space_name
                    | bus : <proc_name |
                             core_name :>0|1 bus_name

• A space_name refers to a defined address space.

• A proc_name refers to a defined processor.

• A core_name refers to a defined core.

• A bus_name refers to a defined bus.

• The following mappings are allowed (source to destination)

− space => space

− space => bus

− bus => bus

− memory => bus

range             ::= expr .. expr

7.3.8 Architecture Definition

architecture_definition
                  ::= architecture arch_name
                      <( parameter_list )>0|1 
                      <extends arch_name 
                              <( argument_list )>0|1 >0|1 
                      { arch_spec>=0 }

• An architecture_definition defines a core architecture with the given arch_name as a unique name.

• At least one space_def and at least one bus_def have to be present in an architecture_definition.

• An architecture_definition that uses the extends construct defines an architecture that inherits all elements of the
architecture defined by the second arch_name. The parent architecture must be defined in the LSL file as well.

parameter_list    ::= parameter <, parameter>>=0

parameter         ::= IDENTIFIER <= expr>0|1

argument_list     ::= expr <, expr>>=0

arch_spec         ::= bus_def
                    | space_def
                    | endianness_def

space_def         ::= space space_name { <space_descr;>>=0 }

• A space_def defines an address space with the given space_name as a unique name within an architecture.
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space_descr       ::= space_property ; 
                    | section_definition  //no space ref
                    | vector_table_statement
                    | reserved_range

space_property    ::= id = number // as used in object
                    | mau = expr
                    | align = expr
                    | page_size = expr <[ range ] <| [ range ]>>=0 >0|1

                    | page
                    | direction = direction
                    | stack_def
                    | heap_def
                    | copy_table_def
                    | start_address
                    | mapping

• A space_def contains exactly one id and one mau statement.

• A space_def contains at most one align statement.

• A space_def contains at most one page_size statement.

• A space_def contains at least one mapping.

stack_def         ::= stack stack_name ( stack_heap_descr
                                         <, stack_heap_descr >>=0 )

• A stack_def defines a stack with the stack_name as a unique name.

heap_def          ::= heap heap_name ( stack_heap_descr
                                       <, stack_heap_descr >>=0 )

• A heap_def defines a heap with the heap_name as a unique name.

stack_heap_descr  ::= min_size = expr
                    | grows = direction
                    | align = expr
                    | fixed
                    | id = expr

• The min_size statement must be present.

• You can specify at most one align statement and one grows statement.

• Each stack definition has its own unique id, the number specified corresponds to the index in the .CALLS directive as
generated by the compiler. If the id is omitted, the id is 0 (zero).

direction         ::= low_to_high
                    | high_to_low

• If you do not specify the grows statement, the stack and grow low−to−high.

copy_table_def    ::= copytable <( copy_table_descr 
                                  <, copy_table_descr>>=0 )>0|1

• A space_def contains at most one copytable statement.

• If the architecture definition contains more than one address space, exactly one copy table must be defined in one of the
spaces. If the architecture definition contains only one address space, a copy table definition is optional (it will be generated
in the space).

copy_table_descr  ::= align = expr
                    | copy_unit = expr
                    | dest <space_name>0|1 = space_name
                    | page

• The copy_unit is defined by the size in MAUs in which the startup code moves data.

• The dest statement is only required when the startup code initializes memory used by another processor that has no
access to ROM.

• A space_name refers to a defined address space.
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start_addr        ::= start_address ( start_addr_descr
                               <, start_addr_descr>>=0 )

start_addr_descr  ::= run_addr = expr
                    | symbol = symbol_name

• A symbol_name refers to the section that contains the startup code.

vector_table_statement 
                  ::= vector_table section_name
                      ( vecttab_spec <, vecttab_spec>>=0 )
                       { <vector_def>>=0 }

vecttab_spec      ::= vector_size = expr
                    | size = expr
                    | id_symbol_prefix = symbol_name
                    | run_addr = addr_absolute
                    | template = section_name
                    | template_symbol = symbol_name
                    | vector_prefix = section_name
                    | fill = vector_value
                    | no_inline
                    | copy

vector_def        ::= vector ( vector_spec <, vector_spec>>=0 )

vector_spec       ::= id = vector_id_spec
                    | fill = vector_value

vector_id_spec    ::= number
                    | [ range ] <, [ range ]>>=0

vector_value      ::= symbol_name
                    | [ number <, number>>=0 ]
                    | loop <[ expr ]>0|1

reserved_range    ::= reserved expr .. expr ;

endianness_def    ::= endianness { <endianness_type;>>=1 }

endianness_type   ::= big
                    | little

7.3.9 Derivative Definition

derivative_definition
                  ::= derivative derivative_name
                      <( parameter_list )>0|1 
                      <extends derivative_name 
                              <( argument_list )>0|1 >0|1 
                      { <derivative_spec>>=0 }

• A derivative_definition defines a derivative with the given derivative_name as a unique name.

derivative_spec   ::= core_def
                    | bus_def
                    | mem_def
                    | section_definition // no processor name
                    | section_setup

core_def          ::= core core_name { <core_descr ;>>=0 }

• A core_def defines a core with the given core_name as a unique name.

• At least one core_def must be present in a derivative_definition.
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core_descr        ::= architecture = arch_name 
                      <( argument_list )>0|1 
                    | endianness = ( endianness_type
                               <, endianness_type>>=0 )

• An arch_name refers to a defined core architecture.

• Exactly one architecture statement must be present in a core_def.

7.3.10 Processor Definition and Board Specification

board_spec        ::= proc_def
                    | bus_def
                    | mem_def

proc_def          ::= processor proc_name 
                      { proc_descr ; }

proc_descr        ::= derivative = derivative_name
                      <( argument_list )>0|1

• A proc_def defines a processor with the proc_name as a unique name.

• If you do not explicitly define a processor for a derivative in an LSL file, the linker defines a processor with the same name as
that derivative.

• A derivative_name refers to a defined derivative.

• A proc_def contains exactly one derivative statement.

7.3.11 Section Layout Definition and Section Setup

section_definition ::= section_layout <space_ref>0|1 
                       <( locate_direction )>0|1 
                       { <section_statement>>=0 }

• A section definition inside a space definition does not have a space_ref.

• All global section definitions have a space_ref.

space_ref         ::= <proc_name>0|1 : <core_name>0|1

                             : space_name

• If more than one processor is present, the proc_name must be given for a global section layout.

• If the section layout refers to a processor that has more than one core, the core_name must be given in the space_ref.

• A proc_name refers to a defined processor.

• A core_name refers to a defined core.

• A space_name refers to a defined address space.

locate_direction  ::= direction = direction

direction         ::= low_to_high
                    | high_to_low

• A section layout contains at most one direction statement.

• If you do not specify the direction statement, the locate direction of the section layout is low−to−high.

section_statement
                  ::= simple_section_statement ;
                    | aggregate_section_statement

simple_section_statement
                  ::= assignment
                    | select_section_statement
                    | special_section_statement

assignment        ::= symbol_name assign_op expr

assign_op         ::= =
                    | :=
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select_section_statement
                  ::= select <ref_tree>0|1 <section_name>0|1 
                      <section_selections>0|1

• Either a section_name or at least one section_selection must be defined.

section_selections
                  ::= ( section_selection 
                        <, section_selection>>=0 )

section_selection
                  ::= attributes = < <+|−> attribute>>0

• +attribute means: select all sections that have this attribute.

• −attribute means: select all sections that do not have this attribute.

special_section_statement
                  ::= heap stack_name <size_spec>0|1

                    | stack stack_name <size_spec>0|1

                    | copytable
                    | reserved section_name <reserved_specs>0|1

• Special sections cannot be selected in load−time groups.

size_spec         ::= ( size = expr )

reserved_specs    ::= ( reserved_spec <, reserved_spec>>=0 )

reserved_spec     ::= attributes
                    | fill_spec
                    | size = expr
                    | alloc_allowed = absolute

• If a reserved section has attributes r, rw, x, rx or rwx, and no fill pattern is defined, the section is filled with zeros. If no
attributes are set, the section is created as a scratch section (attributes ws, no image).

fill_spec         ::= fill = fill_values

fill_values       ::= expr 
                    | [ expr <, expr>>=0 ]

aggregate_section_statement
                  ::= { <section_statement>>=0 }
                    | group_descr
                    | if_statement
                    | section_creation_statement

group_descr       ::= group <group_name>0|1 <( group_specs )>0|1

                             section_statement

• No two groups for an address space can have the same group_name.

group_specs       ::= group_spec <, group_spec >>=0

group_spec        ::= group_alignment
                    | attributes
                    | copy
                    | nocopy
                    | group_load_address
                    | fill <= fill_values>0|1

                    | group_page
                    | group_run_address
                    | group_type
                    | allow_cross_references
                    | priority = number

• The allow−cross−references property is only allowed for overlay groups.

• Sub groups inherit all properties from a parent group.
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group_alignment   ::= align = expr

attributes        ::= attributes = <attribute>>=1

attribute         ::= r    // readable sections
                    | w    // writable sections
                    | x    // executable code sections
                    | i    // initialized sections
                    | s    // scratch sections
                    | b    // blanked (cleared) sections

group_load_address
                  ::= load_addr <= load_or_run_addr>0|1

group_page        ::= page <= expr>0|1

                    | page_size = expr <[ range ] <| [ range ]>>=0 >0|1

group_run_address ::= run_addr <= load_or_run_addr>0|1

group_type        ::= clustered
                    | contiguous
                    | ordered
                    | overlay

• For non−contiguous groups, you can only specify group_alignment and attributes.

• The overlay keyword also sets the contiguous property.

• The clustered property cannot be set together with contiguous or ordered on a single group.

load_or_run_addr  ::= addr_absolute 
                    | addr_range <| addr_range>>=0

addr_absolute     ::= expr 
                    | memory_reference [ expr ]

• An absolute address can only be set on ordered groups.

addr_range        ::= [ expr .. expr ] 
                    | memory_reference 
                    | memory_reference [ expr .. expr ]

• The parent of a group with an addr_range or page restriction cannot be ordered, contiguous or clustered.

memory_reference  ::= mem : <proc_name :>0|1 <core_name :>0|1 mem_name

• A proc_name refers to a defined processor.

• A core_name refers to a defined core.

• A mem_name refers to a defined memory.

if_statement      ::= if ( expr ) section_statement
                      <else section_statement>0|1

section_creation_statement
                  ::= section section_name ( section_specs )
                      { <section_statement2>>=0 }

section_specs     ::= section_spec <, section_spec >>=0

section_spec      ::= attributes
                    | fill_spec
                    | size = expr
                    | blocksize = expr
                    | overflow = section_name

section_statement2
                  ::= select_section_statement ;
                    | group_descr2
                    | { <section_statement2>>=0 }
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group_descr2      ::= group <group_name>0|1 
                            ( group_specs2 )
                             section_statement2

group_specs2      ::= group_spec2 <, group_spec2 >>=0

group_spec2       ::= group_alignment
                    | attributes
                    | load_addr

section_setup     ::= section_setup space_ref
                      { <section_setup_item>>=0 }

section_setup_item
                  ::= vector_table_statement
                    | reserved_range
                    | stack_def ;
                    | heap_def ;

7.4 Expression Evaluation

Only constant expressions are allowed, including sizes, but not addresses, of sections in object files.

All expressions are evaluated with 64−bit precision integer arithmetic. The result of an expression can be absolute or
relocatable. A symbol you assign is created as an absolute symbol.
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7.5 Semantics of the Architecture Definition

Keywords in the architecture definition

architecture
   extends
endianness          big  little
bus
   mau
   width
   map
space
   id
   mau
   align
   page_size
   page
   direction        low_to_high  high_to_low
   stack
      min_size
      grows         low_to_high  high_to_low
      align
      fixed
      id
   heap
      min_size
      grows         low_to_high  high_to_low
      align
      fixed
      id
   copytable
      align
      copy_unit
      dest
      page
   vector_table
      vector_size
      size
      id_symbol_prefix
      run_addr
      template
      template_symbol
      vector_prefix
      fill
      no_inline
      copy
      vector
         id
         fill       loop
   reserved
   start_address
      run_addr
      symbol
   map
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   map
      dest          bus  space
      dest_dbits
      dest_offset
      size
      src_dbits
      src_offset

7.5.1 Defining an Architecture

With the keyword architecture you define an architecture and assign a unique name to it. The name is used to refer to it at
other places in the LSL file:

architecture name
{
     definitions
}

If you are defining multiple core architectures that show great resemblance, you can define the common features in a parent
core architecture and extend this with a child core architecture that contains specific features. The child inherits all features of
the parent. With the keyword extends you create a child core architecture:

architecture name_child_arch extends name_parent_arch
{
     definitions
}

A core architecture can have any number of parameters. These are identifiers which get values assigned on instantiation or
extension of the architecture. You can use them in any expression within the core architecture. Parameters can have default
values, which are used when the core architecture is instantiated with less arguments than there are parameters defined for it.
When you extend a core architecture you can pass arguments to the parent architecture. Arguments are expressions that set
the value of the parameters of the sub−architecture.

architecture name_child_arch (parm1,parm2=1)
             extends name_parent_arch (arguments)
{
     definitions
}

7.5.2 Defining Internal Buses

With the bus keyword you define a bus (the combination of data and corresponding address bus). The bus name is used to
identify a bus and does not conflict with other identifiers. Bus descriptions in an architecture definition or derivative definition
define internal buses. Some internal buses are used to communicate with the components outside the core or processor. Such
buses on a processor have physical pins reserved for the number of bits specified with the width statements.

• The mau field specifies the MAU size (Minimum Addressable Unit) of the data bus. This field is required.

• The width field specifies the width (number of address lines) of the data bus. The default value is the MAU size.

• The map keyword specifies how this bus maps onto another bus (if so). Mappings are described in section 7.5.4, Mappings.

bus bus_name
{
     mau = 8;
     width = 8;
     map ( map_description );
}

7.5.3 Defining Address Spaces

With the space keyword you define a logical address space. The space name is used to identify the address space and does
not conflict with other identifiers.
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• The id field defines how the addressing space is identified in object files. In general, each address space has a unique ID.
The linker locates sections with a certain ID in the address space with the same ID. This field is required. In IEEE this ID is
specified explicitly for sections and symbols, ELF sections map by default to the address space with ID 1. Sections with one
of the special names defined in the ABI (Application Binary Interface) may map to different address spaces.

• The mau field specifies the MAU size (Minimum Addressable Unit) of the space. This field is required.

• The align value must be a power of two. The linker uses this value to compute the start addresses when sections are
concatenated. An align value of n means that objects in the address space have to be aligned on n MAUs.

• The page_size field sets the page alignment and page size in MAUs for the address space. It must be a power of 2. The
default value is 1. If one or more page ranges are supplied the supplied value only sets the page alignment. The ranges
specify the available space in each page, as offsets to the page start, which is aligned at the page alignment.

See also the page keyword in subsection Locating a group in section 7.9.2, Creating and Locating Groups of Sections.

• With the optional direction field you can specify how all sections in this space should be located. This can be either from
low_to_high addresses (this is the default) or from high_to_low addresses.

• The map keyword specifies how this address space maps onto an internal bus or onto another address space. Mappings are
described in section 7.5.4, Mappings.

Stacks and heaps

• The stack keyword defines a stack in the address space and assigns a name to it. The architecture definition must contain
at least one stack definition. Each stack of a core architecture must have a unique name. See also the stack keyword in
section 7.9.3, Creating or Modifying Special Sections.

The stack is described in terms of a minimum size (min_size) and the direction in which the stack grows (grows).  This
can be either from low_to_high addresses (stack grows upwards, this is the default) or from high_to_low addresses
(stack grows downwards). The min_size is required.

By default, the linker tries to maximize the size of the stacks and heaps. After locating all sections, the largest remaining gap
in the space is used completely for the stacks and heaps. If you specify the keyword fixed, you can disable this so−called
’balloon behavior’. The size is also fixed if you used a stack or heap in the software layout definition in a restricted way. For
example when you override a stack with another size or select a stack in an ordered group with other sections.

The id keyword matches stack information generated by the compiler with a stack name specified in LSL. This value
assigned to this keyword is strongly related to the compiler’s output, so users are not supposed to change this configuration.

Optionally you can specify an alignment for the stack with the argument align. This alignment must be equal or larger than
the alignment that you specify for the address space itself.

• The heap keyword defines a heap in the address space and assigns a name to it. The definition of a heap is similar to the
definition of a stack. See also the heap keyword in section 7.9.3, Creating or Modifying Special Sections.

See section 7.9, Semantics of the Section Layout Definition, for information on creating and placing stack sections.

Copy tables

• The copytable keyword defines a copy table in the address space. The content of the copy table is created by the linker
and contains the start address and size of all sections that should be initialized by the startup code. You must define exactly
one copy table in one of the address spaces (for a core).

Optionally you can specify an alignment for the copy table with the argument align. This alignment must be equal or larger
than the alignment that you specify for the address space itself. If smaller, the alignment for the address space is used.

The copy_unit argument specifies the size in MAUs of information chunks that are copied. If you do not specify the copy
unit, the MAU size of the address space itself is used.

The dest argument specifies the destination address space that the code uses for the copy table. The linker uses this
information to generate the correct addresses in the copy table. The memory into where the sections must be copied at
run−time, must be accessible from this destination space.

Sections generated for the copy table may get a page restriction with the address space’s page size, by adding the page
argument.
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Vector table

• The vector_table keyword defines a vector table with n vectors of size m (This is an internal LSL object similar to an LSL
group.) The run_addr argument specifies the location of the first vector (id=0). This can be a simple address or an offset in
memory (see the description of the run−time address in subsection Locating a group in section 7.9.2, Creating and Locating
Groups of Sections). A vector table defines symbols _lc_ub_foo and _lc_ue_foo pointing to start and end of the table.

vector_table "vtable" (vector_size=m, size=n, run_addr=x, ...)

See the following example of a vector table definition:

vector_table "vtable" (vector_size = 4, size = 256, run_addr=0,
                    template=".text.vector_template",
                    template_symbol="_lc_vector_target",
                    vector_prefix="_vector_",
                    id_symbol_prefix="foo",
                    no_inline,
                    /* default: empty, or */
                    fill="foo", /* or */
                    fill=[1,2,3,4], /* or */
                    fill=loop)
{
    vector (id=0, fill="_START");
    vector (id=12, fill=[0xab, 0x21, 0x32, 0x43]);
    vector (id=[1..11], fill=[0]);
    vector (id=[18..23], fill=loop);
}

The template argument defines the name of the section that holds the code to jump to a handler function from the vector
table. This template section does not get located and is removed when the locate phase is completed. This argument is
required.

The template_symbol argument is the symbol reference in the template section that must be replaced by the address of
the handler function. This symbol name should start with the linker prefix for the symbol to be ignored in the link phase. This
argument is required.

The vector_prefix argument defines the names of vector sections: the section for a vector with id vector_id is
$(vector_prefix)$(vector_id). Vectors defined in C or assembly source files that should be included in the vector table must
have the correct symbol name. The compiler uses the prefix that is defined in the default LSL file(s); if this attribute is
changed, the vectors declared in C source files are not included in the vector table. When a vector supplied in an object file
has exactly one relocation, the linker will assume it is a branch to a handler function, and can be removed when the handler
is inlined in the vector table. Otherwise, no inlining is done. This argument is required.

With the optional no_inline argument the vectors handlers are not inlined in the vector table.

With the optional copy argument a ROM copy of the vector table is made and the vector table is copied to RAM at startup.

With the optional id_symbol_prefix argument you can set an internal string representing a symbol name prefix that may
be found on symbols in vector handler code. When the linker detects such a symbol in a handler, the symbol is assigned the
vector number. If the symbol was already assigned a vector number, a warning is issued.

The fill argument sets the default contents of vectors. If nothing is specified for a vector, this setting is used. See below.
When no default is provided, empty vectors may be used to locate large vector handlers and other sections. Only one fill
argument is allowed.

The vector field defines the content of vector with the number specified by id. If a range is specified for id ([p..q,s..t]) all
vectors in the ranges (inclusive) are defined the same way.

With fill=symbol_name, the vector must jump to this symbol. If the section in which the symbol is defined fits in the vector
table (size may be >m), locate the section at the location of the vector. Otherwise, insert code to jump to the symbol’s value.
A template handler section name + symbol name for the target code must be supplied in the LSL file.

fill=[value(s)], fills the vector with the specified MAU values.

With fill=loop the vector jumps to itself. With the optional [offset] you can specify an offset from the vector table entry.
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Reserved address ranges

• The reserved keyword specifies to reserve a part of an address space even if not all of the range is covered by memory.
See also the reserved keyword in section 7.9.3, Creating or Modifying Special Sections.

Start address

• The start_address keyword specifies the start address for the position where the C startup code is located. When a
processor is reset, it initializes its program counter to a certain start address, sometimes called the reset vector. In the
architecture definition, you must specify this start address in the correct address space in combination with the name of the
label in the application code which must be located here.

The run_addr argument specifies the start address (reset vector). If the core starts executing using an entry from a vector
table, and directly jumps to the start label, you should omit this argument.

The symbol argument specifies the name of the label in the application code that should be located at the specified start
address. The symbol argument is required. The linker will resolve the start symbol and use its value after locating for the
start address field in IEEE−695 files and Intel Hex files. If you also specified the run_addr argument, the start symbol
(label) must point to a section. The linker locates this section such that the start symbol ends up on the start address.

space space_name
{
     id = 1;
     mau = 8;
     align = 8;
     page_size = 1;
     stack name (min_size = 1k, grows = low_to_high);
     reserved start_address .. end_address;
     start_address ( run_addr = 0x0000,
                     symbol = "start_label" )
     map ( map_description );
}

7.5.4 Mappings

You can use a mapping when you define a space, bus or memory. With the map field you specify how addresses from the
source (space, bus or memory) are translated to addresses of a destination (space, bus). The following mappings are possible:

• space => space

• space => bus

• bus => bus

• memory => bus

With a mapping you specify a range of source addresses you want to map (specified by a source offset and a size), the
destination to which you want to map them (a bus or another address space), and the offset address in the destination.

• The dest argument specifies the destination. This can be a bus or another address space (only for a space to space
mapping). This argument is required.

• The src_offset argument specifies the offset of the source addresses. In combination with size, this specifies the range of
address that are mapped. By default the source offset is 0x0000.

• The size argument specifies the number of addresses that are mapped. This argument is required.

• The dest_offset argument specifies the position in the destination to which the specified range of addresses is mapped.
By default the destination offset is 0x0000.

If you are mapping a bus to another bus, the number of data lines of each bus may differ. In this case you have to specify a
range of source data lines you want to map (src_dbits = begin..end) and the range of destination data lines you want to
map them to (dest_dbits = first..last).

• The src_dbits argument specifies a range of data lines of the source bus. By default all data lines are mapped.

• The dest_dbits argument specifies a range of data lines of the destination bus. By default, all data lines from the source
bus are mapped on the data lines of the destination bus (starting with line 0).
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From space to space

If you map an address space to another address space (nesting), you can do this by mapping the subspace to the containing
larger space. In this example a small space of 64k is mapped on a large space of 16M.

space small
{
   id = 2;
   mau = 4;
   map (src_offset = 0, dest_offset = 0,
        dest = space : large, size = 64k);
}

From space to bus

All spaces that are not mapped to another space must map to a bus in the architecture:

space large
{
   id = 1;
   mau = 4;
   map (src_offset = 0, dest_offset = 0,
        dest = bus:bus_name, size = 16M );
}

From bus to bus

The next example maps an external bus called e_bus to an internal bus called i_bus. This internal bus resides on a core
called mycore. The source bus has 16 data lines whereas the destination bus has only 8 data lines. Therefore, the keywords
src_dbits and dest_dbits specify which source data lines are mapped on which destination data lines.

architecture mycore
{
    bus i_bus
    {
       mau = 4;
    }

    space i_space
    {
       map (dest=bus:i_bus, size=256);
    }
}

bus e_bus
{
   mau = 16;
   width = 16;
   map (dest = bus:mycore:i_bus, src_dbits = 0..7, dest_dbits = 0..7 )
}

It is not possible to map an internal bus to an external bus.
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7.6 Semantics of the Derivative Definition

Keywords in the derivative definition

derivative
   extends
core
   architecture
bus
   mau
   width
   map
memory
   type             reserved  rom  ram  nvram
   mau
   size
   speed
   map
section_layout
section_setup

   map
      dest          bus  space
      dest_dbits
      dest_offset
      size
      src_dbits
      src_offset

7.6.1 Defining a Derivative

With the keyword derivative you define a derivative and assign a unique name to it. The name is used to refer to it at other
places in the LSL file:

derivative name
{
     definitions
}

If you are defining multiple derivatives that show great resemblance, you can define the common features in a parent derivative
and extend this with a child derivative that contains specific features. The child inherits all features of the parent (cores and
memories). With the keyword extends you create a child derivative:

derivative name_child_deriv extends name_parent_deriv
{
     definitions
}

As with a core architecture, a derivative can have any number of parameters. These are identifiers which get values assigned
on instantiation or extension of the derivative. You can use them in any expression within the derivative definition.

derivative name_child_deriv (parm1,parm2=1)
           extends name_parent_derivh (arguments)
{
     definitions
}

7.6.2 Instantiating Core Architectures

With the keyword core you instantiate a core architecture in a derivative.
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• With the keyword architecture you tell the linker that the given core has a certain architecture. The architecture name
refers to an existing architecture definition in the same LSL file.

For example, if you have two cores (called mycore_1 and mycore_2) that have the same architecture (called
mycorearch), you must instantiate both cores as follows:

core mycore_1
{
     architecture = mycorearch;
}

core mycore_2
{
     architecture = mycorearch;
}

If the architecture definition has parameters you must specify the arguments that correspond with the parameters. For
example mycorearch1 expects two parameters which are used in the architecture definition:

core mycore
{
     architecture = mycorearch1 (1,2);
}

7.6.3 Defining Internal Memory and Buses

With the memory keyword you define physical memory that is present on the target board. The memory name is used to identify
the memory and does not conflict with other identifiers. It is common to define internal memory (on−chip) in the derivative
definition. External memory (off−chip memory) is usually defined in the board specification (See section 7.7.3, Defining External
Memory and Buses).

• The type field specifies a memory type:

− rom: read only memory − it can only be written at load−time

− ram: random access volatile writable memory − writing at run−time is possible 
while writing at load−time has no use since the data is not retained after 
a power−down

− nvram: non volatile ram − writing is possible both at load−time and run−time

The optional reserved qualifier before the memory type, tells the linker not to locate any section in the memory by default.
You can locate sections in such memories using an absolute address or range restriction (see subsection Locating a group
in section 7.9.2, Creating and Locating Groups of Sections).

• The mau field specifies the MAU size (Minimum Addressable Unit) of the memory. This field is required.

• The size field specifies the size in MAU of the memory. This field is required.

• The speed field specifies a symbolic speed for the memory (1..4): 1 is the fastest, 4 the slowest. The linker uses the relative
speed of the memories in such a way, that optimal speed is achieved. The default speed is 1.

• The map field specifies how this memory maps onto an (internal) bus. Mappings are described in section 7.5.4, Mappings.

memory mem_name
{
   type = rom;
   mau = 8;
   size = 64k;
   speed = 2;
   map ( map_description );
}

With the bus keyword you define a bus in a derivative definition. Buses are described in section 7.5.2, Defining Internal Buses.
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7.7 Semantics of the Board Specification

Keywords in the board specification

processor
   derivative
bus
   mau
   width
   map
memory
   type             reserved  rom  ram  nvram
   mau
   size
   speed
   map

   map
      dest          bus  space
      dest_dbits
      dest_offset
      size
      src_dbits
      src_offset

7.7.1 Defining a Processor

If you have a target board with multiple processors that have the same derivative, you need to instantiate each individual
processor in a processor definition. This information tells the linker which processor has which derivative and enables the linker
to distinguish between the present processors.

If you use processors that all have a unique derivative, you may omit the processor definitions. In this case the linker
assumes that for each derivative definition in the LSL file there is one processor. The linker uses the derivative name also
for the processor.

With the keyword processor you define a processor. You can freely choose the processor name. The name is used to refer to
it at other places in the LSL file:

processor proc_name
{
   processor definition
}

7.7.2 Instantiating Derivatives

With the keyword derivative you tell the linker that the given processor has a certain derivative. The derivative name refers
to an existing derivative definition in the same LSL file.

For examples, if you have two processors on your target board (called myproc_1 and myproc_2) that have the same derivative
(called myderiv), you must instantiate both processors as follows:

processor myproc_1
{
     derivative = myderiv;
}

processor myproc_2
{
     derivative = myderiv;
}
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If the derivative definition has parameters you must specify the arguments that correspond with the parameters. For example
myderiv1 expects two parameters which are used in the derivative definition:

processor myproc
{
     derivative = myderiv1 (2,4);
}

7.7.3 Defining External Memory and Buses

It is common to define external memory (off−chip) and external buses at the global scope (outside any enclosing definition).
Internal memory (on−chip memory) is usually defined in the scope of a derivative definition.

With the keyword memory you define physical memory that is present on the target board. The memory name is used to identify
the memory and does not conflict with other identifiers. If you define memory parts in the LSL file, only the memory defined in
these parts is used for placing sections.

If no external memory is defined in the LSL file and if the linker option to allocate memory on demand is set then the linker will
assume that all virtual addresses are mapped on physical memory. You can override this behavior by specifying one or more
memory definitions.

memory mem_name
{
   type = rom;
   mau = 8;
   size = 64k;
   speed = 2;
   map ( map_description );
}

For a description of the keywords, see section 7.6.3, Defining Internal Memory and Buses.

With the keyword bus you define a bus (the combination of data and corresponding address bus). The bus name is used to
identify a bus and does not conflict with other identifiers. Bus descriptions at the global scope (outside any definition) define
external buses. These are buses that are present on the target board.

bus bus_name
{
     mau = 8;
     width = 8;
     map ( map_description );
}

For a description of the keywords, see section 7.5.2, Defining Internal Buses.

You can connect off−chip memory to any derivative: you need to map the off−chip memory to a bus and map that bus on the
internal bus of the derivative you want to connect it to.



TSK3000 Embedded Tools Reference

7−24

7.8 Semantics of the Section Setup Definition

Keywords in the section setup definition

section_setup
   stack
      min_size
      grows         low_to_high  high_to_low
      align
      fixed
      id
   heap
      min_size
      grows         low_to_high  high_to_low
      align
      fixed
      id
   vector_table
      vector_size
      size
      id_symbol_prefix
      run_addr
      template
      template_symbol
      vector_prefix
      fill
      no_inline
      copy
      vector
         id
         fill       loop
   reserved

7.8.1 Setting up a Section

With the keyword section_setup you can define stacks, heaps, vector tables, and/or reserved address ranges outside their
address space definition.

section_setup ::my_space
{
   vector table statements
   reserved address range
   stack definition
   heap definition
}

See the subsections Stacks and heaps, Vector table and Reserved address ranges in section 7.5.3, Defining Address
Spaces, for details on the keywords stack, heap, vector_table and reserved.



Linker Script Language

7−25

7.9 Semantics of the Section Layout Definition

Keywords in the section layout definition

section_layout
   direction     low_to_high  high_to_low
group
   align
   attributes    + −  r w x b i s
   copy
   nocopy
   fill
   ordered
   contiguous
   clustered
   overlay
   allow_cross_references
   load_addr
      mem
   run_addr
      mem
   page
   page_size
   priority
select
stack
   size
heap
   size
reserved
   size
   attributes    r w x
   fill
   alloc_allowed absolute
copytable
section
   size
   blocksize
   attributes    r w x
   fill
   overflow

if
else

7.9.1 Defining a Section Layout

With the keyword section_layout you define a section layout for exactly one address space. In the section layout you can
specify how input sections are placed in the address space, relative to each other, and what the absolute run and load
addresses of each section will be.

You can define one or more section definitions. Each section definition arranges the sections in one address space. You can
precede the address space name with a processor name and/or core name, separated by colons. You can omit the processor
name and/or the core name if only one processor is defined and/or only one core is present in the processor. A reference to a
space in the only core of the only processor in the system would look like "::my_space". A reference to a space of the only
core on a specific processor in the system could be "my_chip::my_space". The next example shows a section definition for
sections in the my_space address space of the processor called my_chip:
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section_layout my_chip::my_space ( locate_direction )
{
   section statements
}

With the optional keyword direction you specify whether the linker starts locating sections from low_to_high (default) or
from high_to_low. In the second case the linker starts locating sections at the highest addresses in the address space but
preserves the order of sections when necessary (one processor and core in this example).

section_layout ::my_space ( direction = high_to_low )
{
   section statements
}

If you do not explicitly tell the linker how to locate a section, the linker decides on the basis of the section attributes in the
object file and the information in the architecture definition and memory parts where to locate the section.

7.9.2 Creating and Locating Groups of Sections

Sections are located per group. A group can contain one or more (sets of)  input sections as well as other groups. Per group you
can assign a mutual order to the sets of sections and locate them into a specific memory part.

group ( group_specifications )
{
   section_statements
}

With the section_statements you generally select sets of sections to form the group. This is described in subsection Selecting
sections for a group.

Instead of selecting sections, you can also modify special sections like stack and heap or create a reserved section. This is
described in  section 7.9.3, Creating or Modifying Special Sections.

With the group_specifications you actually locate the sections in the group. This is described in subsection Locating a group.

Selecting sections for a group

With the select keyword you can select one or more sections for the group. You can select a section by name or by attributes.
If you select a section by name, you can use a wildcard pattern:

"*" matches with all section names
"?" matches with a single character in the section name
"\" takes the next character literally
"[abc]" matches with a single ’a’, ’b’ or ’c’ character
"[a−z]" matches with any single character in the range ’a’ to ’z’

group ( ... )
{
   select "mysection";
   select "*";
}

The first select statement selects the section with the name "mysection". The second select statement selects all sections
that were not selected yet.

A section is selected by the first select statement that matches, in the union of all section layouts for the address space.
Global section layouts are processed in the order in which they appear in the LSL file. Internal core architecture section layouts
always take precedence over global section layouts.

• The attributes field selects all sections that carry (or do not carry) the given attribute. With +attribute you select sections
that have the specified attribute set. With −attribute you select sections that do not have the specified attribute set. You can
specify one or more of the following attributes:

− r readable sections

− w writable sections
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− x executable sections

− i initialized sections

− b sections that should be cleared at program startup

− s scratch sections (not cleared and not initialized)

To select all read−only sections:

group ( ... )
{
   select (attributes = +r−w);
}

Keep in mind that all section selections are restricted to the address space of the section layout in which this group
definition occurs.

• With the ref_tree field you can select a group of related sections. The relation between sections is often expressed by
means of references. By selecting just the ’root’ of tree, the complete tree is selected. This is for example useful to locate a
group of related sections in special memory (e.g. fast memory).  The (referenced) sections must meet the following
conditions in order to be selected:

1. The sections are within the section layout’s address space

2. The sections match the specified attributes

3. The sections have no absolute restriction (as is the case for all wildcard selections)

For example, to select the code sections referenced from foo1:

group refgrp (ordered, contiguous, run_addr=mem:ext_c)
{
    select ref_tree "foo1" (attributes=+x);
}

If section foo1 references foo2 and foo2 references foo3, then all these sections are selected by the selection shown
above.

Locating a group

group group_name ( group_specifications )
{
   section_statements
}

With the group_specifications you actually define how the linker must locate the group. You can roughly define three things: 1)
assign properties to the group like alignment and read/write attributes, 2) define the mutual order in the address space for
sections in the group and 3) restrict the possible addresses for the sections in a group.

The linker creates labels that allow you to refer to the begin and end address of a group from within the application software.
Labels _lc_gb_group_name and _lc_ge_group_name mark the begin and end of the group respectively, where the begin is
the lowest address used within this group and the end is the highest address used. Notice that a group not necessarily occupies
all memory between begin and end address. The given label refers to where the section is located at run−time (versus
load−time).

1. Assign properties to the group like alignment and read/write attributes. 
These properties are assigned to all sections in the group (and subgroups) and override the attributes of the input sections.

• The align field tells the linker to align all sections in the group and the group as a whole according to the align value. By
default the linker uses the largest alignment constraint of either the input sections or the alignment of the address space.

• The attributes field tells the linker to assign one or more attributes to all sections in the group. This overrules the
default attributes. By default the linker uses the attributes of the input sections. You can set the r, w or rw attributes and
you can switch between the b and s attributes.

• The copy field tells the linker to locate a read−only section in RAM and generate a ROM copy and a copy action in the
copy table. This property makes the sections in the group writable which causes the linker to generate ROM copies for
the sections.
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• The effect of the nocopy field is the opposite of the copy field. It prevents the linker from generating ROM copies of the
selected sections.

2. Define the mutual order of the sections in the group.
By default, a group is unrestricted which means that the linker has total freedom to place the sections of the group in the
address space.

• The ordered keyword tells the linker to locate the sections in the same order in the address space as they appear in the
group (but not necessarily adjacent).

Suppose you have an ordered group that contains the sections ’A’, ’B’  and ’C’. By default the linker places the sections
in the address space like ’A’ − ’B’ − ’C’, where section ’A’ gets the lowest possible address. With
direction=high_to_low in the section_layout space properties, the linker places the sections in the address
space like ’C’ − ’B’ − ’A’, where section ’A’ gets the highest possible address.

• The contiguous keyword tells the linker to locate the sections in the group in a single address range. Within a
contiguous group the input sections are located in arbitrary order, however the group occupies one contigous range of
memory. Due to alignment of sections there can be ’alignment gaps’ between the sections.

When you define a group that is both ordered and contiguous, this is called a sequential group. In a sequential group
the linker places sections in the same order in the address space as they appear in the group and it occupies a
contiguous range of memory.

• The clustered keyword tells the linker to locate the sections in the group in a number of contiguous blocks. It tries to
keep the number of these blocks to a minimum. If enough memory is available, the group will be located as if it was
specified as contiguous. Otherwise, it gets split into two or more blocks.

If a contiguous or clustered group contains alignment gaps, the linker can locate sections that are not part of the group in
these gaps. To prevent this, you can use the fill keyword. If the group is located in RAM, the gaps are treated as
reserved (scratch) space. If the group is located in ROM, the alignment gaps are filled with zeros by default. You can
however change the fill pattern by specifying a bit pattern. The result of the expression, or list of expressions, is used as
values to write to memory, each in MAU.

• The overlay keyword tells the linker to overlay the sections in the group. The linker places all sections in the address
space using a contiguous range of addresses. (Thus an overlay group is automatically also a contiguous group.) To
overlay the sections, all sections in the overlay group share the same run−time address.

For each input section within the overlay the linker automatically defines two symbols. The symbol
_lc_cb_section_name is defined as the load−time start address of the section. The symbol _lc_ce_section_name
is defined as the load−time end address of the section. C (or assembly) code may be used to copy the overlaid sections.

If sections in the overlay group contain references between groups, the linker reports an error. The keyword
allow_cross_references tells the linker to accept cross−references. Normally, it does not make sense to have
references between sections that are overlaid.

group ovl (overlay)
{
    group a
    {
        select "my_ovl_p1";
        select "my_ovl_p2";
    }
    group b
    {
        select "my_ovl_q1";
    }
}

It may be possible that one of the sections in the overlay group already has been defined in another group where it
received a load−time address. In this case the linker does not overrule this load−time address and excludes the section
from the overlay group.
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3. Restrict the possible addresses for the sections in a group.
The load−time address specifies where the group’s elements are loaded in memory at download time. The run−time address
specifies where sections are located at run−time, that is when the program is executing. If you do not explicitly restrict the
address in the LSL file, the linker assigns addresses to the sections based on the restrictions relative to other sections in the
LSL file and section alignments. The program is responsible for copying overlay sections at appropriate moment from its
load−time location to its run−time location (this is typically done by the startup code).

• The run_addr keyword defines the run−time address. If the run−time location of a group is set explicitly, the given order
between groups specify whether the run−time address propagates to the parent group or not. The location of the sections
a group can be restricted either to a single absolute address, or to a number of address ranges. With an expression you
can specify that the group should be located at the absolute address specified by the expression:

group (run_addr = 0xa00f0000)

You can use the ’[offset]’ variant to locate the group at the given absolute offset in memory:

group (run_addr = mem:A[0x1000])

A range can be an absolute space address range, written as [ expr .. expr ], a complete memory device, written
as mem:mem_name, or a memory address range,
mem:mem_name[expr .. expr]

group (run_addr = mem:my_dram)

You can use the ’|’ to specify an address range of more than one physical memory device:

group (run_addr = mem:A | mem:B)

• The load_addr keyword changes the meaning of the section selection in the group: the linker selects the load−time
ROM copy of the named section(s) instead of the regular sections. Just like run_addr you can specify an absolute
address or an address range.

The load_addr keyword itself (without an assignment) specifies that the group’s position in the LSL file defines its
load−time address.

group (load_addr)
      select "mydata";  // select ROM copy of mydata: "[mydata]"

The load−time and run−time addresses of a group cannot be set at the same time. If the load−time property is set for a
group, the group (only) restricts the positioning at load−time of the group’s sections. It is not possible to set the address of a
group that has a not−unrestricted parent group.

The properties of the load−time and run−time start address are:

• At run−time, before using an element in an overlay group, the application copies the sections from their load location to
their run−time location, but only if these two addresses are different. For non−overlay sections this happens at program
start−up.

• The start addresses cannot be set to absolute values for unrestricted groups.

• For non−overlay groups that do not have an overlay parent, the load−time start address equals the run−time start
address.

• For any group, if the run−time start address is not set, the linker selects an appropriate address.

• If an ordered group or sequential group has an absolute address and contains sections that have separate page
restrictions (not defined in LSL), all those sections are located in a single page. In other cases, for example when an
unrestricted group has an address range assigned to it, the paged sections may be located in different pages.

For overlays, the linker reserves memory at the run−time start address as large as the largest element in the overlay group.

• The page keyword tells the linker to place the group in one page. Instead of specifying a run−time address, you can
specify a page and optional a page number. Page numbers start from zero. If you omit the page number, the linker
chooses a page.

The page keyword refers to pages in the address space as defined in the architecture definition.

• With the page_size keyword you can override the page alignment and size set on the address space. When you set the
page size to zero, the linker removes simple (auto generated) page restrictions from the selected sections. See also the
page_size keyword in section 7.5.3, Defining Address Spaces.

group (page, ... )
group (page = 3, ...)
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• With the priority keyword you can change the order in which sections are located. This is useful when some sections
are considered important for good performance of the application and a small amount of fast memory is available. The
value is a number for which the default is 1, so higher priorities start at 2. Sections with a higher priority are located
before sections with a lower priority, unless their relative locate priority is already determined by other restrictions like
run_addr and page.

group (priority=2)
{
  select "importantcode1";
  select "importantcode2";
}

7.9.3 Creating or Modifying Special Sections

Instead of selecting sections, you can also create a reserved section or an output section or modify special sections like a stack
or a heap. Because you cannot define these sections in the input files, you must use the linker to create them.

Stack

• The keyword stack tells the linker to reserve memory for the stack. The name for the stack section refers to the stack as
defined in the architecture definition. If no name was specified in the architecture definition, the default name is stack.

With the keyword size you can specify the size for the stack. If the size is not specified, the linker uses the size given by
the min_size argument as defined for the stack in the architecture definition. Normally the linker automatically tries to
maximize the size, unless you specified the keyword fixed.

group ( ... )
{
   stack "mystack" ( size = 2k );
}

The linker creates two labels to mark the begin and end of the stack, _lc_ub_stack_name  for the begin of the stack and
_lc_ue_stack_name for the end of the stack. The linker allocates space for the stack when there is a reference to either of
the labels.

See also the stack keyword in section 7.5.3, Defining Address Spaces.

Heap

• The keyword heap tells the linker to reserve a dynamic memory range for the malloc() function. Optionally you can assign
a name to the heap section. With the keyword size you can change the size for the heap. If the size is not specified, the
linker uses the size given by the min_size argument as defined for the heap in the architecture definition. Normally the
linker automatically tries to maximize the size, unless you specified the keyword fixed.

group ( ... )
{
   heap "myheap" ( size = 2k );
}

The linker creates two labels to mark the begin and end of the heap, _lc_ub_heap_name  for the begin of the heap and
_lc_ue_heap_name for the end of the heap. The linker allocates space for the heap when a reference to either of the
section labels exists in one of the input object files.

Reserved section

• The keyword reserved tells the linker to create an area or section of a given size. The linker will not locate any other
sections in the memory occupied by a reserved section, with some exceptions. Optionally you can assign a name to a
reserved section. With the keyword size you can specify a size for a given reserved area or section.

group ( ... )
{
   reserved "myreserved" ( size = 2k );
}
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The optional fill field contains a bit pattern that the linker writes to all memory addresses that remain unoccupied during
the locate process. The result of the expression, or list of expressions, is used as values to write to memory, each in MAU.
The first MAU of the fill pattern is always the first MAU in the section.

By default, no sections can overlap with a reserved section. With alloc_allowed=absolute sections that are located at
an absolute address due to an absolute group restriction can overlap a reserved section.

With the attributes field you can set the access type of the reserved section. The linker locates the reserved section in its
space with the restrictions that follow from the used attributes, r, w or x or a valid combination of them. The allowed
attributes are shown in the following table. A value between < and > in the table means this value is set automatically by the
linker.

Properties set in LSL Resulting section properties

attributes filled access memory content

x yes <rom> executable

r yes r <rom> data

r no r <rom> scratch

rx yes r <rom> executable

rw yes rw <ram> data

rw no rw <ram> scratch

rwx yes rw <ram> executable

group ( ... )
{
   reserved "myreserved" ( size = 2k, 
               attributes = rw, fill = 0xaa );
}

If you do not specify any attributes, the linker will reserve the given number of maus, no matter what type of memory lies
beneath. If you do not specify a fill pattern, no section is generated.

The linker creates two labels to mark the begin and end of the section, _lc_ub_name  for the start, and _lc_ue_name for
the end of the reserved section.

Output sections

• The keyword section tells the linker to accumulate sections obtained from object files ("input sections") into an output
section of a fixed size in the locate phase. You can select the input sections with select statements. You can use groups
inside output sections, but you can only set the align, attributes and load_addr attributes.

The fill field contains a bit pattern that the linker writes to all unused space in the output section. When all input sections
have an image (code/data) you must specify a fill pattern. If you do not specify a fill pattern, all input sections must be
scratch sections. The fill pattern is aligned at the start of the output section.

As with a reserved section you can use the attributes field to set the access type of the output section.

group ( ... )
{
   section "myoutput" ( size = 4k, attributes = rw, fill = 0xaa )
   {
      select "myinput1";
      select "myinput2";
   }
}

The available room for input sections is determined by the size, blocksize and overflow fields. With the keyword size
you specify the fixed size of the output section. Input sections are placed from output section start towards higher addresses
(offsets). When the end of the output section is reached and one or more input sections are not yet placed, an error is
emitted. If however, the overflow field is set to another output section, remaining sections are located as if they were
selected for the overflow output section.
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group ( ... )
{
  section "tsk1_data" (size=4k, attributes=rw, fill=0,
                       overflow = "overflow_data")
  {
          select ".data.tsk1.*"
  }
  section "tsk2_data" (size=4k, attributes=rw, fill=0,
                       overflow = "overflow_data")
  {
          select ".data.tsk2.*"
  }
  section "overflow_data" (size=4k, attributes=rx,
                           fill=0)
  {
  }
}

With the keyword blocksize , the size of the output section will adapt to the size of its content. For example:

group flash_area (run_addr = 0x10000)
{
   section "flash_code" (blocksize=4k, attributes=rx,
                         fill=0)
   {
     select "*.flash";
   }
}

If the content of the section is 1 mau, the size will be 4k, if the content is 11k, the section will be 12k, etc. If you use size in
combination with blocksize, the size value is used as default (minimal) size for this section. If it is omitted, the default
size will be of blocksize. It is not allowed to omit both size and blocksize from the section definition.

The linker creates two labels to mark the begin and end of the section, _lc_ub_name  for the start, and _lc_ue_name for
the end of the output section.

Copy table

• The keyword copytable tells the linker to select a section that is used as copy table. The content of the copy table is
created by the linker. It contains the start address and length of all sections that should be initialized by the startup code.

The linker creates two labels to mark the begin and end of the section, _lc_ub_table  for the start, and _lc_ue_table
for the end of the copy table. The linker generates a copy table when a reference to either of the section labels exists in one
of the input object files.

7.9.4 Creating Symbols

You can tell the linker to create symbols before locating by putting assignments in the section layout definition. Symbol names
are represented by double−quoted strings. Any string is allowed, but object files may not support all characters for symbol
names. You can use two different assignment operators. With the simple assignment operator ’=’, the symbol is created
unconditionally. With the ’:=’ operator, the symbol is only created if it already exists as an undefined reference in an object file.

The expression that represents the value to assign to the symbol may contain references to other symbols. If such a referred
symbol is a special section symbol, creation of the symbol in the left hand side of the assignment will cause creation of the
special section.

section_layout 
{
   "_lc_bs" := "_lc_ub_stack";
    // when the symbol _lc_bs occurs as an undefined reference 
    // in an object file, the linker allocates space for the stack
}
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7.9.5 Conditional Group Statements

Within a group, you can conditionally select sections or create special sections.

• With the if keyword you can specify a condition. The succeeding section statement is executed if the condition evaluates to
TRUE (1).

• The optional else keyword is followed by a section statement which is executed in case the if−condition evaluates to FALSE
(0).

group ( ... )
{
   if ( exists ( "mysection" ) )
      select "mysection";
   else
      reserved "myreserved" ( size=2k );
}
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8 MISRA−C Rules

Summary This chapter contains an overview of the supported and unsupported MISRA−C
rules.

8.1 MISRA−C:1998

This section lists all supported and unsupported MISRA−C:1998 rules.

See also section 2.7, C Code Checking: MISRA−C, in Chapter Using the Compiler of the User’s Manual.

A number of MISRA−C rules leave room for interpretation. Other rules can only be checked in a limited way. In such
cases the implementation decisions and possible restrictions for these rules are listed.

x  means that the rule is not supported by the TASKING C compiler.
(R) is a required rule, (A) is an advisory rule.

1. (R) The code shall conform to standard C, without language extensions

x 2. (A) Other languages should only be used with an interface standard

3. (A) Inline assembly is only allowed in dedicated C functions

x 4. (A) Provision should be made for appropriate run−time checking

5. (R) Only use characters and escape sequences defined by ISO C

x 6. (R) Character values shall be restricted to a subset of ISO 106460−1

7. (R) Trigraphs shall not be used

8. (R) Multibyte characters and wide string literals shall not be used

9. (R) Comments shall not be nested

10. (A) Sections of code should not be "commented out"

In general, it is not possible to decide whether a piece of comment is C code that is commented out, or just
some pseudo code. Instead, the following heuristics are used to detect possible C code inside a comment:

− a line ends with ’;’, or

− a line starts with ’}’, possibly preceded by white space

11. (R) Identifiers shall not rely on significance of more than 31 characters

12. (A) The same identifier shall not be used in multiple name spaces

13. (A) Specific−length typedefs should be used instead of the basic types

14. (R) Use ’unsigned char’ or ’signed char’ instead of plain ’char’

x 15. (A) Floating−point implementations should comply with a standard

16. (R) The bit representation of floating−point numbers shall not be used

A violation is reported when a pointer to a floating−point type is converted to a pointer to an integer type.

17. (R) "typedef" names shall not be reused

18. (A) Numeric constants should be suffixed to indicate type

A violation is reported when the value of the constant is outside the range indicated by the suffixes, if any.

19. (R) Octal constants (other than zero) shall not be used

20. (R) All object and function identifiers shall be declared before use

21. (R) Identifiers shall not hide identifiers in an outer scope

22. (A) Declarations should be at function scope where possible
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x 23. (A) All declarations at file scope should be static where possible

24. (R) Identifiers shall not have both internal and external linkage

x 25. (R) Identifiers with external linkage shall have exactly one definition

26. (R) Multiple declarations for objects or functions shall be compatible

x 27. (A) External objects should not be declared in more than one file

28. (A) The "register" storage class specifier should not be used

29. (R) The use of a tag shall agree with its declaration

30. (R) All automatics shall be initialized before being used

This rule is checked using worst−case assumptions. This means that violations are reported not only for
variables that are guaranteed to be uninitialized, but also for variables that are uninitialized on some
execution paths.

31. (R) Braces shall be used in the initialization of arrays and structures

32. (R) Only the first, or all enumeration constants may be initialized

33. (R) The right hand operand of && or || shall not contain side effects

34. (R) The operands of a logical && or || shall be primary expressions

35. (R) Assignment operators shall not be used in Boolean expressions

36. (A) Logical operators should not be confused with bitwise operators

37. (R) Bitwise operations shall not be performed on signed integers

38. (R) A shift count shall be between 0 and the operand width minus 1

This violation will only be checked when the shift count evaluates to a constant value at compile time.

39. (R) The unary minus shall not be applied to an unsigned expression

40. (A) "sizeof" should not be used on expressions with side effects

x 41. (A) The implementation of integer division should be documented

42. (R) The comma operator shall only be used in a "for" condition

43. (R) Don’t use implicit conversions which may result in information loss

44. (A) Redundant explicit casts should not be used

45. (R) Type casting from any type to or from pointers shall not be used

46. (R) The value of an expression shall be evaluation order independent

This rule is checked using worst−case assumptions. This means that a violation will be reported when a
possible alias may cause the result of an expression to be evaluation order dependent.

47. (A) No dependence should be placed on operator precedence rules

48. (A) Mixed arithmetic should use explicit casting

49. (A) Tests of a (non−Boolean) value against 0 should be made explicit

50. (R) F.P. variables shall not be tested for exact equality or inequality

51. (A) Constant unsigned integer expressions should not wrap−around

52. (R) There shall be no unreachable code

53. (R) All non−null statements shall have a side−effect

54. (R) A null statement shall only occur on a line by itself

55. (A) Labels should not be used

56. (R) The "goto" statement shall not be used

57. (R) The "continue" statement shall not be used

58. (R) The "break" statement shall not be used (except in a "switch")

59. (R) An "if" or loop body shall always be enclosed in braces

60. (A) All "if", "else if" constructs should contain a final "else"

61. (R) Every non−empty "case" clause shall be terminated with a "break"

62. (R) All "switch" statements should contain a final "default" case
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63. (A) A "switch" expression should not represent a Boolean case

64. (R) Every "switch" shall have at least one "case"

65. (R) Floating−point variables shall not be used as loop counters

66. (A) A "for" should only contain expressions concerning loop control

A violation is reported when the loop initialization or loop update expression modifies an object that is not
referenced in the loop test.

67. (A) Iterator variables should not be modified in a "for" loop

68. (R) Functions shall always be declared at file scope

69. (R) Functions with variable number of arguments shall not be used

70. (R) Functions shall not call themselves, either directly or indirectly

A violation will be reported for direct or indirect recursive function calls in the source file being checked.
Recursion via functions in other source files, or recursion via function pointers is not detected.

71. (R) Function prototypes shall be visible at the definition and call

72. (R) The function prototype of the declaration shall match the definition

73. (R) Identifiers shall be given for all prototype parameters or for none

74. (R) Parameter identifiers shall be identical for declaration/definition

75. (R) Every function shall have an explicit return type

76. (R) Functions with no parameters shall have a "void" parameter list

77. (R) An actual parameter type shall be compatible with the prototype

78. (R) The number of actual parameters shall match the prototype

79. (R) The values returned by "void" functions shall not be used

80. (R) Void expressions shall not be passed as function parameters

81. (A) "const" should be used for reference parameters not modified

82. (A) A function should have a single point of exit

83. (R) Every exit point shall have a "return" of the declared return type

84. (R) For "void" functions, "return" shall not have an expression

85. (A) Function calls with no parameters should have empty parentheses

86. (A) If a function returns error information, it should be tested

A violation is reported when the return value of a function is ignored.

87. (R) #include shall only be preceded by other directives or comments

88. (R) Non−standard characters shall not occur in #include directives

89. (R) #include shall be followed by either <filename> or "filename"

90. (R) Plain macros shall only be used for constants/qualifiers/specifiers

91. (R) Macros shall not be #define’d and #undef’d within a block

92. (A) #undef should not be used

93. (A) A function should be used in preference to a function−like macro

94. (R) A function−like macro shall not be used without all arguments

95. (R) Macro arguments shall not contain pre−preprocessing directives

A violation is reported when the first token of an actual macro argument is ’#’.

96. (R) Macro definitions/parameters should be enclosed in parentheses

97. (A) Don’t use undefined identifiers in pre−processing directives

98. (R) A macro definition shall contain at most one # or ## operator

99. (R) All uses of the #pragma directive shall be documented

This rule is really a documentation issue. The compiler will flag all #pragma directives as violations.

100. (R) "defined" shall only be used in one of the two standard forms

101. (A) Pointer arithmetic should not be used
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102. (A) No more than 2 levels of pointer indirection should be used

A violation is reported when a pointer with three or more levels of indirection is declared.

103. (R) No relational operators between pointers to different objects

In general, checking whether two pointers point to the same object is impossible. The compiler will only
report a violation for a relational operation with incompatible pointer types.

104. (R) Non−constant pointers to functions shall not be used

105. (R) Functions assigned to the same pointer shall be of identical type

106. (R) Automatic address may not be assigned to a longer lived object

107. (R) The null pointer shall not be de−referenced

A violation is reported for every pointer dereference that is not guarded by a NULL pointer test.

108. (R) All struct/union members shall be fully specified

109. (R) Overlapping variable storage shall not be used

A violation is reported for every ’union’ declaration.

110. (R) Unions shall not be used to access the sub−parts of larger types

A violation is reported for a ’union’ containing a ’struct’ member.

111. (R) bit−fields shall have type "unsigned int" or "signed int"

112. (R) bit−fields of type "signed int" shall be at least 2 bits long

113. (R) All struct/union members shall be named

114. (R) Reserved and standard library names shall not be redefined

115. (R) Standard library function names shall not be reused

x 116. (R) Production libraries shall comply with the MISRA−C restrictions

x 117. (R) The validity of library function parameters shall be checked

118. (R) Dynamic heap memory allocation shall not be used

119. (R) The error indicator "errno" shall not be used

120. (R) The macro "offsetof" shall not be used

121. (R) <locale.h> and the "setlocale" function shall not be used

122. (R) The "setjmp" and "longjmp" functions shall not be used

123. (R) The signal handling facilities of <signal.h> shall not be used

124. (R) The <stdio.h> library shall not be used in production code

125. (R) The functions atof/atoi/atol shall not be used

126. (R) The functions abort/exit/getenv/system shall not be used

127. (R) The time handling functions of library <time.h> shall not be used

See also section 2.7, C Code Checking: MISRA−C, in Chapter Using the Compiler of the User’s manual.
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8.2 MISRA−C:2004

This section lists all supported and unsupported MISRA−C:2004 rules.

See also section 2.7, C Code Checking: MISRA−C, in Chapter Using the Compiler of the User’s Manual.

A number of MISRA−C rules leave room for interpretation. Other rules can only be checked in a limited way. In such
cases the implementation decisions and possible restrictions for these rules are listed.

x  means that the rule is not supported by the TASKING C compiler.
(R) is a required rule, (A) is an advisory rule.

Environment

1.1 (R) All code shall conform to ISO 9899:1990 "Programming languages − C", amended and corrected by
ISO/IEC 9899/COR1:1995, ISO/IEC 9899/AMD1:1995, and ISO/IEC 9899/COR2:1996.

1.2 (R) No reliance shall be placed on undefined or unspecified behavior.

x 1.3 (R) Multiple compilers and/or languages shall only be used if there is a common defined interface standard
for object code to which the languages/compilers/assemblers conform.

x 1.4 (R) The compiler/linker shall be checked to ensure that 31 character significance and case sensitivity are
supported for external identifiers.

x 1.5 (A) Floating−point implementations should comply with a defined floating−point standard.

Language extensions

2.1 (R) Assembly language shall be encapsulated and isolated.

2.2 (R) Source code shall only use /* ... */ style comments.

2.3 (R) The character sequence /* shall not be used within a comment.

2.4 (A) Sections of code should not be "commented out".

In general, it is not possible to decide whether a piece of comment is C code that is commented out, or
just some pseudo code. Instead, the following heuristics are used to detect possible C code inside a
comment:

− a line ends with ’;’, or

− a line starts with ’}’, possibly preceded by white space

Documentation

x 3.1 (R) All usage of implementation−defined behavior shall be documented.

x 3.2 (R) The character set and the corresponding encoding shall be documented.

x 3.3 (A) The implementation of integer division in the chosen compiler should be determined, documented and
taken into account.

3.4 (R) All uses of the #pragma directive shall be documented and explained.

This rule is really a documentation issue. The compiler will flag all #pragma
directives as violations.

3.5 (R) The implementation−defined behavior and packing of bit−fields shall be documented if being relied upon.

x 3.6 (R) All libraries used in production code shall be written to comply with the provisions of this document, and
shall have been subject to appropriate validation.

Character sets

4.1 (R) Only those escape sequences that are defined in the ISO C standard shall be used.

4.2 (R) Trigraphs shall not be used.
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Identifiers

5.1 (R) Identifiers (internal and external) shall not rely on the significance of more than 31 characters.

5.2 (R) Identifiers in an inner scope shall not use the same name as an identifier in an outer scope, and therefore
hide that identifier.

5.3 (R) A typedef name shall be a unique identifier.

5.4 (R) A tag name shall be a unique identifier.

x 5.5 (A) No object or function identifier with static storage duration should be reused.

5.6 (A) No identifier in one name space should have the same spelling as an identifier in another name space,
with the exception of structure and union member names.

x 5.7 (A) No identifier name should be reused.

Types

6.1 (R) The plain char type shall be used only for storage and use of character values.

x 6.2 (R) signed and unsigned char type shall be used only for the storage and use of numeric values.

6.3 (A) typedefs that indicate size and signedness should be used in place of the basic types.

6.4 (R) bit−fields shall only be defined to be of type unsigned int or signed int.

6.5 (R) bit−fields of type signed int shall be at least 2 bits long.

Constants

7.1 (R) Octal constants (other than zero) and octal escape sequences shall not be used.

Declarations and definitions

8.1 (R) Functions shall have prototype declarations and the prototype shall be visible at both the function
definition and call.

8.2 (R) Whenever an object or function is declared or defined, its type shall be explicitly stated.

8.3 (R) For each function parameter the type given in the declaration and definition shall be identical, and the
return types shall also be identical.

8.4 (R) If objects or functions are declared more than once their types shall be compatible.

8.5 (R) There shall be no definitions of objects or functions in a header file.

8.6 (R) Functions shall be declared at file scope.

8.7 (R) Objects shall be defined at block scope if they are only accessed from within a single function.

x 8.8 (R) An external object or function shall be declared in one and only one file.

x 8.9 (R) An identifier with external linkage shall have exactly one external definition.

x 8.10 (R) All declarations and definitions of objects or functions at file scope shall have internal linkage unless
external linkage is required.

8.11 (R) The static storage class specifier shall be used in definitions and declarations of objects and functions
that have internal linkage.

8.12 (R) When an array is declared with external linkage, its size shall be stated explicitly or defined implicitly by
initialization.
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Initialization

9.1 (R) All automatic variables shall have been assigned a value before being used.

This rule is checked using worst−case assumptions. This means that violations are reported not only for
variables that are guaranteed to be uninitialized, but also for variables that are uninitialized on some
execution paths.

9.2 (R) Braces shall be used to indicate and match the structure in the non−zero initialization of arrays and
structures.

9.3 (R) In an enumerator list, the "=" construct shall not be used to explicitly initialize members other than the
first, unless all items are explicitly initialized.

Arithmetic type conversions

10.1 (R) The value of an expression of integer type shall not be implicitly converted to a different underlying type if:
a) it is not a conversion to a wider integer type of the same signedness, or
b) the expression is complex, or
c) the expression is not constant and is a function argument, or
d) the expression is not constant and is a return expression.

10.2 (R) The value of an expression of floating type shall not be implicitly converted to a different type if:
a) it is not a conversion to a wider floating type, or
b) the expression is complex, or
c) the expression is a function argument, or
d) the expression is a return expression.

10.3 (R) The value of a complex expression of integer type may only be cast to a type that is narrower and of the
same signedness as the underlying type of the expression.

10.4 (R) The value of a complex expression of floating type may only be cast to a narrower floating type.

10.5 (R) If the bitwise operators ~ and << are applied to an operand of underlying type unsigned char or
unsigned short, the result shall be immediately cast to the underlying type of the operand.

10.6 (R) A "U" suffix shall be applied to all constants of unsigned type.

Pointer type conversions

11.1 (R) Conversions shall not be performed between a pointer to a function and any type other than an integral
type.

11.2 (R) Conversions shall not be performed between a pointer to object and any type other than an integral type,
another pointer to object type or a pointer to void.

11.3 (A) A cast should not be performed between a pointer type and an integral type.

11.4 (A) A cast should not be performed between a pointer to object type and a different pointer to object type.

11.5 (R) A cast shall not be performed that removes any const or volatile qualification from the type
addressed by a pointer.

Expressions

12.1 (A) Limited dependence should be placed on C’s operator precedence rules in expressions.

12.2 (R) The value of an expression shall be the same under any order of evaluation that the standard permits.

This rule is checked using worst−case assumptions. This means that a violation will be reported when a
possible alias may cause the result of an expression to be evaluation order dependent.

12.3 (R) The sizeof operator shall not be used on expressions that contain side effects.

12.4 (R) The right−hand operand of a logical && or || operator shall not contain side effects.

12.5 (R) The operands of a logical && or || shall be primary−expressions.

12.6 (A) The operands of logical operators (&&, || and !) should be effectively Boolean. Expressions that are
effectively Boolean should not be used as operands to operators other than (&&, || and !).

12.7 (R) Bitwise operators shall not be applied to operands whose underlying type is signed.
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12.8 (R) The right−hand operand of a shift operator shall lie between zero and one less than the width in bits of
the underlying type of the left−hand operand.

This violation will only be checked when the shift count evaluates to a constant value at compile
time.

12.9 (R) The unary minus operator shall not be applied to an expression whose underlying type is unsigned.

12.10 (R) The comma operator shall not be used.

12.11 (A) Evaluation of constant unsigned integer expressions should not lead to wrap−around.

12.12 (R) The underlying bit representations of floating−point values shall not be used.

A violation is reported when a pointer to a floating−point type is converted to a pointer to an integer type.

12.13 (A) The increment (++) and decrement (−−) operators should not be mixed with other operators in an
expression.

Control statement expressions

13.1 (R) Assignment operators shall not be used in expressions that yield a Boolean value.

13.2 (A) Tests of a value against zero should be made explicit, unless the operand is effectively Boolean.

13.3 (R) Floating−point expressions shall not be tested for equality or inequality.

13.4 (R) The controlling expression of a for statement shall not contain any objects of floating type.

13.5 (R) The three expressions of a for statement shall be concerned only with loop control.

A violation is reported when the loop initialization or loop update expression modifies an object that is not
referenced in the loop test.

13.6 (R) Numeric variables being used within a for loop for iteration counting shall not be modified in the body of
the loop.

13.7 (R) Boolean operations whose results are invariant shall not be permitted.

Control flow

14.1 (R) There shall be no unreachable code.

14.2 (R) All non−null statements shall either:
a) have at least one side effect however executed, or
b) cause control flow to change.

14.3 (R) Before preprocessing, a null statement shall only occur on a line by itself; it may be followed by a
comment provided that the first character following the null statement is a white−space character.

14.4 (R) The goto statement shall not be used.

14.5 (R) The continue statement shall not be used.

14.6 (R) For any iteration statement there shall be at most one break statement used for loop termination.

14.7 (R) A function shall have a single point of exit at the end of the function.

14.8 (R) The statement forming the body of a switch, while, do ... while or for statement be a compound
statement.

14.9 (R) An if (expression) construct shall be followed by a compound statement. The else keyword shall
be followed by either a compound statement, or another if statement.

14.10 (R) All if ... else if constructs shall be terminated with an else clause.

Switch statements

15.1 (R) A switch label shall only be used when the most closely−enclosing compound statement is the body of a
switch statement.

15.2 (R) An unconditional break statement shall terminate every non−empty switch clause.

15.3 (R) The final clause of a switch statement shall be the default clause.

15.4 (R) A switch expression shall not represent a value that is effectively Boolean.

15.5 (R) Every switch statement shall have at least one case clause.
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Functions

16.1 (R) Functions shall not be defined with variable numbers of arguments.

16.2 (R) Functions shall not call themselves, either directly or indirectly.

A violation will be reported for direct or indirect recursive function calls in the source file being checked.
Recursion via functions in other source files, or recursion via function pointers is not detected.

16.3 (R) Identifiers shall be given for all of the parameters in a function prototype declaration.

16.4 (R) The identifiers used in the declaration and definition of a function shall be identical.

16.5 (R) Functions with no parameters shall be declared with parameter type void.

16.6 (R) The number of arguments passed to a function shall match the number of parameters.

16.7 (A) A pointer parameter in a function prototype should be declared as pointer to const if the pointer is not
used to modify the addressed object.

16.8 (R) All exit paths from a function with non−void return type shall have an explicit return statement with an
expression.

16.9 (R) A function identifier shall only be used with either a preceding &, or with a parenthesized parameter list,
which may be empty.

16.10 (R) If a function returns error information, then that error information shall be tested.

A violation is reported when the return value of a function is ignored.

Pointers and arrays

x 17.1 (R) Pointer arithmetic shall only be applied to pointers that address an array or array element.

x 17.2 (R) Pointer subtraction shall only be applied to pointers that address elements of the same array.

17.3 (R) >, >=, <, <= shall not be applied to pointer types except where they point to the same array.

In general, checking whether two pointers point to the same object is impossible. The compiler will only
report a violation for a relational operation with incompatible pointer types.

17.4 (R) Array indexing shall be the only allowed form of pointer arithmetic.

17.5 (A) The declaration of objects should contain no more than 2 levels of pointer indirection.

A violation is reported when a pointer with three or more levels of indirection is declared.

17.6 (R) The address of an object with automatic storage shall not be assigned to another object that may persist
after the first object has ceased to exist.

Structures and unions

18.1 (R) All structure or union types shall be complete at the end of a translation unit.

18.2 (R) An object shall not be assigned to an overlapping object.

x 18.3 (R) An area of memory shall not be reused for unrelated purposes.

18.4 (R) Unions shall not be used.

Preprocessing directives

19.1 (A) #include statements in a file should only be preceded by other preprocessor directives or comments.

19.2 (A) Non−standard characters should not occur in header file names in #include directives.

x 19.3 (R) The #include directive shall be followed by either a <filename> or "filename" sequence.

19.4 (R) C macros shall only expand to a braced initializer, a constant, a parenthesized expression, a type
qualifier, a storage class specifier, or a do−while−zero construct.

19.5 (R) Macros shall not be #define’d or #undef’d within a block.

19.6 (R) #undef shall not be used.

19.7 (A) A function should be used in preference to a function−like macro.

19.8 (R) A function−like macro shall not be invoked without all of its arguments.
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19.9 (R) Arguments to a function−like macro shall not contain tokens that look like preprocessing directives.

A violation is reported when the first token of an actual macro argument is ’#’.

19.10 (R) In the definition of a function−like macro each instance of a parameter shall be enclosed in parentheses
unless it is used as the operand of # or ##.

19.11 (R) All macro identifiers in preprocessor directives shall be defined before use, except in #ifdef and
#ifndef preprocessor directives and the defined() operator.

19.12 (R) There shall be at most one occurrence of the # or ## preprocessor operators in a single macro definition.

19.13 (A) The # and ## preprocessor operators should not be used.

19.14 (R) The defined preprocessor operator shall only be used in one of the two standard forms.

19.15 (R) Precautions shall be taken in order to prevent the contents of a header file being included twice.

19.16 (R) Preprocessing directives shall be syntactically meaningful even when excluded by the preprocessor.

19.17 (R) All #else, #elif and #endif preprocessor directives shall reside in the same file as the #if or
#ifdef directive to which they are related.

Standard libraries

20.1 (R) Reserved identifiers, macros and functions in the standard library, shall not be defined, redefined or
undefined.

20.2 (R) The names of standard library macros, objects and functions shall not be reused.

x 20.3 (R) The validity of values passed to library functions shall be checked.

20.4 (R) Dynamic heap memory allocation shall not be used.

20.5 (R) The error indicator errno shall not be used.

20.6 (R) The macro offsetof, in library <stddef.h>, shall not be used.

20.7 (R) The setjmp macro and the longjmp function shall not be used.

20.8 (R) The signal handling facilities of <signal.h> shall not be used.

20.9 (R) The input/output library <stdio.h> shall not be used in production code.

20.10 (R) The library functions atof, atoi and atol from library <stdlib.h> shall not be used.

20.11 (R) The library functions abort, exit, getenv and system from library <stdlib.h> shall not be used.

20.12 (R) The time handling functions of library <time.h> shall not be used.

Run−time failures

x 21.1 (R) Minimization of run−time failures shall be ensured by the use of at least one of:
a) static analysis tools/techniques;
b) dynamic analysis tools/techniques;
c) explicit coding of checks to handle run−time faults.
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−−no−double, 4−27
−−no−stdinc, 4−28
−−no−warnings, 4−29
−−optimize, 4−30
−−option−file, 4−32
−−output, 4−33
−−preprocess, 4−34
−−profile, 4−35
−−rename−sections, 4−37
−−runtime, 4−38
−−sdata, 4−39
−−signed−bitfields, 4−40
−−source, 4−41
−−static, 4−42
−−stdout, 4−43
−−tradeoff, 4−44
−−uchar, 4−45
−−undefine, 4−46
−−use−hardware, 4−47
−−version, 4−48
−−warnings−as−errors, 4−49
−A, 4−20
−c, 4−18
−D, 4−7
−E, 4−34
−F, 4−27
−f, 4−32
−g, 4−6
−H, 4−15
−I, 4−14
−k, 4−19
−m, 4−4
−n, 4−43
−O, 4−30
−o, 4−33
−p, 4−35
−R, 4−37
−r, 4−38
−s, 4−41
−t, 4−44
−U, 4−46
−u, 4−45
−V, 4−48
−w, 4−29
debug information, 4−6
diagnostics, 4−29, 4−49
language, 4−18, 4−20, 4−40, 4−45
MISRA−C, 4−24
optimization, 4−30, 4−44
preprocessing, 4−7, 4−15, 4−34, 4−46

C++ style comments, 4−20
call, 1−8
Call graph, 3−14
calloc, 2−6, 2−17
calls, 3−14
cbrt functions, 2−8
ceil functions, 2−8
chdir, 2−21
Check source code, 4−5, 4−52, 4−119
clearerr, 2−16
clock, 2−20
clock_t, 2−19
CLOCKS_PER_SEC, 2−20
close, 2−21
cnt, 3−7
Code compaction, 4−16
Command file, 4−168
Comment, 3−1
Comments, 7−3
compiler options, −−misrac−version, 4−26
Conditional assembly, 3−48
Conditional make rules, 4−155
Control program, passing options, 4−145
Control program options, 4−117

−?, 4−128
−−adress−size, 4−118
−−check, 4−119
−−create, 4−120
−−debug−info, 4−121
−−define, 4−122
−−diag, 4−123
−−dry−run, 4−124
−−error file, 4−125
−−format, 4−126
−−fp−trap, 4−127
−−help, 4−128
−−ignore−default−library−path, 4−134
−−include−directory, 4−129
−−iso, 4−130
−−keep−output−files, 4−131
−−keep−temporary−files, 4−132
−−library, 4−133
−−library−directory, 4−134
−−lsl−file, 4−136
−−mil−link, 4−137
−−mil−split, 4−137
−−no−default−libraries, 4−138
−−no−double, 4−139
−−no−map−file, 4−140
−−no−preprocessing−only, 4−141
−−no−warnings, 4−142
−−option file, 4−143
−−output, 4−144
−−pass, 4−145
−−preprocess, 4−146
−−profile, 4−147
−−static, 4−149
−−undefine, 4−150
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−−verbose, 4−151
−−version, 4−152
−−warnings−as−errors, 4−153
−c, 4−120
−D, 4−122
−d, 4−136
−E, 4−146
−F, 4−139
−f, 4−143
−g, 4−121
−I, 4−129
−k, 4−131
−L, 4−134
−l, 4−133
−l (−−library), 4−135
−n, 4−124
−o, 4−144
−p, 4−147
−t, 4−132
−U, 4−150
−V, 4−152
−v, 4−151
−W, 4−145
−w, 4−142
preprocessing, 4−122

Copy table, 7−16, 7−32
copysign functions, 2−8
cos functions, 2−6
cosh functions, 2−7
ctime, 2−20

D
Data types, 1−2
db, 3−15
dd, 3−16
Debug info, 4−121
Debug information, 4−56
define, 3−17
defined, 3−7
Defining a macro, 3−45
Derivative definition, 7−1, 7−20
dh, 3−18
difftime, 2−20
Directives, 3−1
div, 2−18
Double as float, 4−139
ds, 3−19
dsb, 3−19
dsd, 3−19
dsh, 3−19
dsw, 3−19
dw, 3−20

E
ELF/DWARF object format, 6−1
end, 3−21
endextern_sdata, 1−8
endprofile, 1−9

endprotect, 1−10
EOF, 2−11
equ, 3−22
erf functions, 2−9
erfc functions, 2−9
errno, 2−3
exit, 2−17
EXIT_FAILURE, 2−16
EXIT_SUCCES, 2−16
exp functions, 2−7
exp2 functions, 2−7
expm1 functions, 2−7
Expressions, 3−4

absolute, 3−4
relative, 3−4
relocatable, 3−4

extern, 1−8, 3−23
extern_sdata, 1−8

F
fabs functions, 2−8
fclose, 2−12
fdim functions, 2−9
FE_ALL_EXCEPT, 2−4
FE_DIVBYZERO, 2−4
FE_INEXACT, 2−4
FE_INVALID, 2−4
FE_OVERFLOW, 2−4
FE_UNDERFLOW, 2−4
feclearexcept, 2−4
fegetenv, 2−4
fegetexceptflag, 2−4
feholdexept, 2−4
feof, 2−16
feraiseexcept, 2−4
ferror, 2−16
fesetenv, 2−4
fesetexceptflag, 2−4
fetestexcept, 2−4
feupdateenv, 2−4
fflush, 2−12
fgetc, 2−15
fgetpos, 2−16
fgets, 2−15
fgetwc, 2−15
fgetws, 2−15
FILENAME_MAX, 2−11
floor functions, 2−8
fma functions, 2−8
fmax functions, 2−9
fmin functions, 2−9
fmod functions, 2−8
fopen, 2−12
FOPEN_MAX, 2−11
for/endfor, 3−24
fpclassify, 2−9
fprintf, 2−14
fputc, 2−15



Index

Index−5

fputs, 2−15
fputwc, 2−15
fputws, 2−15
fread, 2−15
free, 2−6, 2−17
freopen, 2−12
frexp functions, 2−7
fscanf, 2−14
fseek, 2−15
fsetpos, 2−16
fstat, 2−22
ftell, 2−16
Function, syntax, 3−6
Function inlining, 1−13
Function qualifiers, __interrupt(), 1−15
fwprintf, 2−14
fwrite, 2−15
fwscanf, 2−14

G
Generic instructions, 3−1, 3−50
getc, 2−15
getchar, 2−15
getcwd, 2−21
getenv, 2−17
gets, 2−15
getwc, 2−15
getwchar, 2−15
global, 3−25
gmtime, 2−20
gprel, 3−7

H
Header files, 2−2

alert.h, 2−2
complex.h, 2−2
ctype.h, 2−2
errno.h, 2−3
fcntl.h, 2−3
fenv.h, 2−4
float.h, 2−4
fss.h, 2−4
inttypes.h, 2−5
io.h, 2−5
iso646.h, 2−5
limits.h, 2−6
locale.h, 2−6
malloc.h, 2−6
math.h, 2−6
setjmp.h, 2−10
signal.h, 2−10
stdarg.h, 2−10
stdbool.h, 2−10
stddef.h, 2−11
stdint.h, 2−5
stdio.h, 2−11
stdlib.h, 2−16
string.h, 2−18

tgmath.h, 2−6
time.h, 2−19
unistd.h, 2−21
wchar.h, 2−11, 2−18, 2−19, 2−22
wctype.h, 2−2, 2−23

Heap, 7−16
hi, 3−7
hypot functions, 2−8

I
if/elif/else/endif, 3−26
ilogb functions, 2−7
imaxabs, 2−5
imaxdiv, 2−5
include, 3−27
Include directory, 4−14, 4−28, 4−61, 4−93, 4−129
Include file, 4−15, 4−62
Inline assembly, __asm, 1−4
Inline functions, 1−13
inline/ noinline / smartinline, 1−9
Inlining, 4−16
Input specification, 3−1
Instructions, 3−1

generic, 3−1, 3−50
Intel hex, record type, 6−5
Intel Hex record format, 6−5
Interrupt functions, 1−15

__interrupt(), 1−15
Interrupt service routine, 1−15

defining, 1−15
Intrinsic functions, 1−14
isalnum, 2−2
isalpha, 2−2
isblank, 2−2
iscntrl, 2−2
isdigit, 2−2
isfinite, 2−9
isgraph, 2−2
isgreater, 2−9
isgreaterequal, 2−9
isinf, 2−9
isless, 2−9
islessequal, 2−9
islessgreater, 2−9
islower, 2−2
isnan, 2−9
isnormal, 2−9
ISO C standard, selecting, 4−18, 4−130
isprint, 2−2
ispunct, 2−2
isspace, 2−2
isunordered, 2−9
isupper, 2−2
iswalnum, 2−2, 2−23
iswalpha, 2−2, 2−23
iswblank, 2−2
iswcntrl, 2−2, 2−23
iswctype, 2−23
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iswdigit, 2−2, 2−23
iswgraph, 2−2, 2−23
iswlower, 2−2, 2−23
iswprint, 2−2, 2−23
iswpunct, 2−2, 2−23
iswspace, 2−2, 2−23
iswupper, 2−2, 2−23
iswxdigit, 2−2
iswxditig, 2−23
isxdigit, 2−2

L
L_tmpnam, 2−11
Label, 3−2
Labels, 3−1
labs, 2−18
ldexp functions, 2−7
ldiv, 2−18
lgamma functions, 2−9
Librarian options

−?, 4−181
−d, 4−182
−f, 4−183
−m, 4−184
−p, 4−185
−r, 4−186
−t, 4−188
−V, 4−189
−w, 4−190
−x, 4−191
add module, 4−186
create library, 4−186
delete module, 4−182
extract module, 4−191
move module, 4−184
print list of objects, 4−188
print list of symbols, 4−188
print module, 4−185
replace module, 4−186
warning level, 4−190

Libraries, linking, 4−90, 4−106
Library, specifying, 4−96, 4−97, 4−133, 4−134, 4−135
Linker macro, 4−85
Linker options, 4−82

−?, 4−91
−−case−insensitive, 4−83
−−chip−output, 4−84
−−define, 4−85
−−diag, 4−86
−−error−file, 4−87
−−error−limit, 4−88
−−extern, 4−89
−−extra−verbose, 4−114
−−first−library−first, 4−90
−−help, 4−91
−−ignore−default−library−path, 4−97
−−import−object, 4−92
−−include−directory, 4−93

−−incremental, 4−94
−−keep−output−files, 4−95
−−library, 4−96
−−library−directory, 4−97
−−link−only, 4−98
−−lsl−check, 4−99
−−lsl−dump, 4−100
−−lsl−file, 4−101
−−map−file, 4−102
−−map−file−format, 4−103
−−misra−c−report, 4−104
−−no−rescan, 4−106
−−no−rom−copy, 4−107
−−no−warnings, 4−108
−−non−romable, 4−105
−−optimize, 4−109
−−option−file, 4−110
−−output, 4−111
−−strip−debug, 4−112
−−user−provided−initialization−code, 4−113
−−verbose, 4−114
−−version, 4−115
−−warnings−as−errors, 4−116
−c, 4−84
−D, 4−85
−d, 4−101
−e, 4−89
−f, 4−110
−I, 4−93
−i, 4−113
−k, 4−95
−L, 4−97
−l, 4−96
−M, 4−102
−m, 4−103
−N, 4−107
−O, 4−109
−o, 4−111
−r, 4−94
−S, 4−112
−V, 4−115
−v, 4−114
−vv, 4−114
−w, 4−108
diagnostics, 4−108, 4−116
libraries, 4−96, 4−106
Map File, 4−102
miscellaneous, 4−83, 4−85, 4−89, 4−92, 4−100, 4−101
optimization, 4−109
output format, 4−84

Linker script file, 4−99, 4−100
architecture definition, 7−1
board specification, 7−2
bus definition, 7−2
derivative definition, 7−1
memory definition, 7−2
preprocessing, 7−3
processor definition, 7−2
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section layout definition, 7−2
specifying, 4−101, 4−136
structure, 7−1

List file, 4−64, 4−65
list/nolist, 3−28
llabs, 2−18
lldiv, 2−18
llrint functions, 2−8
llround functions, 2−8
lo, 3−8
Local label override operator, 3−48
localeconv, 2−6
localtime, 2−20
log functions, 2−7
log10 functions, 2−7
log1p functions, 2−7
log2 functions, 2−7
logb functions, 2−7
longjmp, 2−10
lrint functions, 2−8
lround functions, 2−8
lsb, 3−8
lseek, 2−21
lsh, 3−8
LSL expression evaluation, 7−13
LSL functions

absolute(), 7−5
addressof(), 7−5
exists(), 7−5
max(), 7−5
min(), 7−6
sizeof(), 7−6

LSL keywords
align, 7−16, 7−27
alloc_allowed, 7−31
allow_cross_references, 7−28
architecture, 7−15, 7−20
attributes, 7−26, 7−27
blocksize, 7−32
bus, 7−15, 7−18, 7−23
clustered, 7−28
contiguous, 7−28
copy, 7−17, 7−27
copy_unit, 7−16
copytable, 7−16, 7−32
core, 7−20
derivative, 7−20, 7−22
dest, 7−16, 7−18
dest_dbits, 7−18
dest_offset, 7−18
direction, 7−26, 7−28
else, 7−33
extends, 7−15, 7−20
fill, 7−17, 7−28, 7−31
fixed, 7−16, 7−30
group, 7−26, 7−27
grows, 7−16
heap, 7−16, 7−30

high_to_low, 7−16, 7−26
id, 7−15, 7−16
id_symbol_prefix, 7−17
if, 7−33
load_addr, 7−29
low_to_high, 7−16, 7−26
map, 7−15, 7−16, 7−18, 7−21
mau, 7−15, 7−16, 7−21, 7−23
mem, 7−29
memory, 7−21, 7−23
min_size, 7−16, 7−30
no_inline, 7−17
nocopy, 7−28
nvram, 7−21
ordered, 7−28
overflow, 7−31
overlay, 7−28
page, 7−16, 7−29
page_size, 7−16, 7−29
priority, 7−30
processor, 7−22
ram, 7−21
ref_tree, 7−27
reserved, 7−18, 7−21, 7−30
rom, 7−21
run_addr, 7−17, 7−18, 7−29
section, 7−31
section_layout, 7−25
section_setup, 7−24
select, 7−26
size, 7−17, 7−18, 7−21, 7−23, 7−30, 7−31
space, 7−15, 7−18
speed, 7−21, 7−23
src_dbits, 7−18
src_offset, 7−18
stack, 7−16, 7−30
start_address, 7−18
symbol, 7−18
template, 7−17
template_symbol, 7−17
type, 7−21, 7−23
vector, 7−17
vector_prefix, 7−17
vector_size, 7−17
vector_table, 7−17
width, 7−15

LSL syntax, 7−3
architecture definition, 7−7
board specification, 7−10
bus definition, 7−6
derivative definition, 7−9
memory definition, 7−6
processor definition, 7−10
section layout definition, 7−10

lstat, 2−22
lsw, 3−8
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M
macro / nomacro, 1−9
Macro argument string, 3−47
Macro call, 3−1
Macro definition, 4−7, 4−54, 4−122
Macro operations, 3−45
macro/endm, 3−29
Macros, 3−45

.for directive, 3−48

.repeat directive, 3−48
argument concatenation, 3−46
argument operator, 3−46
argument string, 3−47
calling, 3−45
conditional assembly, 3−48
defining, 3−45
local label override, 3−48
make utility, 4−155
return decimal value operator, 3−47
return hex value operator, 3−47

Macros (preprocessor), 1−11, 3−3
Make utility options

−?, 4−156
−a, 4−157
−c, 4−158
−D, 4−159
−d, 4−160
−DD, 4−159
−dd, 4−160
−e, 4−161
−err, 4−162
−f, 4−163
−G, 4−164
−i, 4−165
−K, 4−166
−k, 4−167
−m, 4−168, 4−173
−n, 4−169
−p, 4−170
−q, 4−171
−r, 4−172
−s, 4−174
−t, 4−175
−time, 4−176
−V, 4−177
−W, 4−178
−x, 4−179
defining a macro, 4−155

malloc, 2−6, 2−17
Map file generation, 4−102
Mappings, 7−18
MB_CUR_MAX, 2−16, 2−22
MB_LEN_MAX, 2−22
mblen, 2−18
mbrlen, 2−22
mbrtowc, 2−22
mbsinit, 2−22
mbsrtowcs, 2−22

mbstate_t, 2−22
mbstowcs, 2−18
mbtowc, 2−18
memchr, 2−19
memcmp, 2−19
memcpy, 2−18
memmove, 2−18
Memory definition, 7−2
Memory qualifiers, 1−3
memset, 2−19
Merging source code, 4−41
message, 1−9, 3−31
MISRA−C, 4−24, 4−25

MISRA−C report, 4−104
supported rules 1998, 8−1
supported rules 2004, 8−5
version, 4−26

mktime, 2−20
modf functions, 2−7
Motorola S−record format, 6−2
msb, 3−8
msh, 3−8
msw, 3−8

N
nan functions, 2−8
nearbyint functions, 2−8
nextafter functions, 2−8
nexttoward functions, 2−8
Functions, 1−12

intrinsic, 1−14
parameter passing, 1−12
return types, 1−12

NOP insertion, 4−67
nopinsertion/nonopinsertion, 3−32
NULL, 2−11

O
offset, 3−33
offsetof, 2−11
open, 2−3
Operands, 3−2
Optimization, 4−30, 4−69, 4−109

code compaction, 4−16
inlining, 4−17
optimize for speed/size, 4−44

optimize / endoptimize, 1−9
Option file, 4−32, 4−110, 4−143, 4−168
Options, saving / restoring, 4−32, 4−110

P
page, 3−34
Parameter passing, 1−12
Passing options, 4−145
perror, 2−16
pow functions, 2−8
Pragmas, 1−8
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Predefined preprocessor macros, 1−11, 3−3
Predefined preprocessor symbols, 3−3
Preprocessing, 4−54, 4−74, 4−141, 4−146, 7−3

storing output, 4−34
printf, 2−12, 2−14

conversion characters, 2−13
printf versions, 1−15
Processor definition, 7−2, 7−22
profile, 1−9
Profiling, 4−35, 4−147
profiling, 1−10
protect, 1−10
ptrdiff_t, 2−11
putc, 2−15
putchar, 2−15
puts, 2−15
putwc, 2−15
putwchar, 2−15

Q
qsort, 2−18

R
raise, 2−10
rand, 2−17
RAND_MAX, 2−16
read, 2−21
realloc, 2−6, 2−17
Register usage, 1−12
remainder functions, 2−8
remove, 2−16
remquo functions, 2−8
rename, 2−16
Renaming sections, 4−37
repeat/endrep, 3−35
Reserved address ranges, 7−18
Reset vector, 7−18
resume, 3−36
Return decimal value operator, 3−47
Return hex value operator, 3−47
rewind, 2−16
rint functions, 2−8
round functions, 2−8
Run−time checks, 4−38
runtime, 1−10

S
scalbln functions, 2−7
scalbn functions, 2−7
scanf, 2−13, 2−14

conversion characters, 2−14
scanf versions, 1−15
sdata, 1−10
Section, 3−37
section / endsection, 1−10
Section attributes, 3−37
Section information, 4−76
Section layout definition, 7−2, 7−25

Section renaming, 4−37
Section setup definition, 7−24
section_code_init, 1−10
section_const_init, 1−10
section_no_code_init, 1−10
section_no_const_init, 1−10
Sections, 3−37

grouping, 7−26
nested, 4−66

SEEK_CUR, 2−11, 2−15
SEEK_END, 2−11, 2−15
SEEK_SET, 2−11, 2−15
Service request, 1−15
set, 3−38
setbuf, 2−12
setjmp, 2−10
setlocale, 2−6
setvbuf, 2−12
SIGABRT, 2−10
SIGFPE, 2−10
SIGILL, 2−10
SIGINT, 2−10
signal, 2−10
signbit, 2−9
SIGSEGV, 2−10
SIGTERM, 2−10
sin functions, 2−6
sinh functions, 2−7
size, 3−39
size_t, 2−11
smartinline, 1−9
snprintf, 2−14
source, 3−40
source / nosource, 1−10
sprintf, 2−14
sqrt functions, 2−8
srand, 2−17
sscanf, 2−14
Stack, 7−16
Start address, 7−18
stat, 2−21
Statement, 3−1
stderr, 2−11
stdin, 2−11
stdinc, 1−10
stdout, 2−11
strcat, 2−18, 3−8
strchr, 2−19
strcmp, 2−19, 3−8
strcoll, 2−19
strcpy, 2−18
strcspn, 2−19
strerror, 2−19
strftime, 2−20
Strings, substring, 3−5
strlen, 3−9
strncat, 2−18
strncmp, 2−19
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strncpy, 2−18
strpbrk, 2−19
strpos, 3−9
strrchr, 2−19
strspn, 2−19
strstr, 2−19
strtod, 2−17
strtof, 2−17
strtoimax, 2−5
strtok, 2−19
strtol, 2−17
strtold, 2−17
strtoll, 2−17
strtoul, 2−17
strtoull, 2−17
strtoumax, 2−5
strxfrm, 2−19
Substring, 3−5
swprintf, 2−14
swscanf, 2−14
Symbol names, 3−2
Syntax error checking, 4−5, 4−52, 4−119
Syntax of an expression, 3−4
system, 2−17

T
tan functions, 2−6
tanh functions, 2−7
tgamma functions, 2−9
time, 2−20
time_t, 2−19
title, 3−41
tm (struct), 2−20
TMP_MAX, 2−11
tmpfile, 2−16
tmpnam, 2−16
tolower, 2−2
toupper, 2−2
towctrans, 2−23
towlower, 2−2, 2−23
towupper, 2−2, 2−23
tradeoff, 1−10
Transferring parameters between functions, 1−12
trunc functions, 2−8
type, 3−42
Type qualifier, __unaligned, 1−2

U
undef, 3−43
ungetc, 2−15
ungetwc, 2−15
unlink, 2−22
Using assembly in C source, 1−4

V
va_arg, 2−10
va_copy, 2−10
va_end, 2−10

va_start, 2−10
Vector table, 7−17
Version information, 4−177, 4−189
vfprintf, 2−14
vfscanf, 2−14
vfwprintf, 2−14
vfwscanf, 2−14
vprintf, 2−14
vscanf, 2−14
vsprintf, 2−14
vsscanf, 2−14
vswprintf, 2−14
vswscanf, 2−14
vwprintf, 2−14
vwscanf, 2−14

W
warning, 1−11
Warnings

suppressing, 4−29, 4−68, 4−108, 4−142
treat as errors, 4−81

wchar_t, 2−11
wcrtomb, 2−22
wcscat, 2−18
wcschr, 2−19
wcscmp, 2−19
wcscoll, 2−19
wcscpy, 2−18
wcscspn, 2−19
wcsncat, 2−18
wcsncmp, 2−19
wcsncpy, 2−18
wcspbrk, 2−19
wcsrchr, 2−19
wcsrtombs, 2−22
wcsspn, 2−19
wcsstr, 2−19
wcstod, 2−17
wcstof, 2−17
wcstoimax, 2−5
wcstok, 2−19
wcstol, 2−17
wcstold, 2−17
wcstoll, 2−17
wcstombs, 2−18
wcstoul, 2−17
wcstoull, 2−17
wcstoumax, 2−5
wcsxfrm, 2−19
wctob, 2−22
wctomb, 2−18
wctrans, 2−23
wctype, 2−23
weak, 1−11, 3−44
WEOF, 2−11
wmemchr, 2−19
wmemcmp, 2−19
wmemcpy, 2−18
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wmemmove, 2−18
wmemset, 2−19
wprintf, 2−14

write, 2−22
wscanf, 2−14
wstrftime, 2−20
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